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NetScaler Gateway Release Notes

October 5, 2020

Release notes describe how the software has changed in a particular build, and the issues known to
exist in that build.

The release notes document includes all or some of the following sections:

• What’s New: The enhancements and other changes released in the build.
• Fixed Issues: The issues that are fixed in the build.
• Known Issues: The issues that exist in the build.
• Points to Note: The important aspects to keep in mind while using the build.
• Limitations: The limitations that exist in the build.

Important: The NetScaler Gateway release notes are covered as a part of NetScaler release
notes. For detailed information about Gateway 12.0 enhancements, known issues, and bug fixes,
see release notes page.

Note:

• The [# XXXXXX] labels under the issue descriptions are internal tracking IDs used by the
NetScaler team.

• These release notes do not document security related fixes. For a list of security related fixes
and advisories, see the Citrix security bulletin.

About NetScaler Gateway

October 5, 2020

NetScaler Gateway is easy to deploy and simple to administer. The most typical deployment config-
uration is to locate the NetScaler Gateway appliance in the DMZ. You can install multiple NetScaler
Gateway appliances in the network for more complex deployments.

The first time you start NetScaler Gateway, you can perform the initial configuration by using a serial
console, the Setup Wizard in the configuration utility, or Dynamic Host Configuration Protocol (DHCP).
On the MPX appliance, you can use the LCD keypad on the front panel of the appliance to perform the
initial configuration. You can configure basic settings that are specific to your internal network, such
as the IP address, subnet mask, default gateway IP address, and Domain Name System (DNS) address.
After you configure the basic network settings, you then configure the settings specific to the NetScaler
Gateway operation, such as the options for authentication, authorization, network resources, virtual
servers, session policies, and endpoint policies.
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Before you install and configure NetScaler Gateway, review the topics in this section for information
about planning your deployment. Deployment planning can include determining where to install the
appliance, understanding how to install multiple appliances in the DMZ, as well as licensing require-
ments. You can install NetScaler Gateway in any network infrastructure without requiring changes to
the existing hardware or software running in the secure network. NetScaler Gateway works with other
networking products, such as server load balancers, cache engines, firewalls, routers, and IEEE 802.11
wireless devices.

You can write your settings in the Pre-Installation Checklist to have on hand before you configure
NetScaler Gateway.

NetScaler Gateway Appliances Provides information about NetScaler Gateway
appliances and the appliance installation
instructions.

Pre-Installation Checklist Provides planning information to review and a
list of tasks to complete before you install
NetScaler Gateway in your network.

Common Deployments Provides information about deploying the
NetScaler Gateway in the network DMZ, in a
secure network without a DMZ, and with
additional appliances to support load
balancing and failover. Also provides
information about deploying NetScaler
Gateway with Citrix XenApp and Citrix
XenDesktop.

Licensing Provides information about installing licenses
on the appliance. Also provides information
about installing licenses on multiple NetScaler
Gateway appliances.

NetScaler Gateway Architecture

October 5, 2020
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The core components of NetScaler Gateway are:

• Virtual servers. The NetScaler Gateway virtual server is an internal entity that is a representa-
tive of all the configured services available to users. The virtual server is also the access point
through which users access these services. You can configure multiple virtual servers on a sin-
gle appliance, allowing one NetScaler Gateway appliance to serve multiple user communities
with differing authentication and resource access requirements.

• Authentication, authorization, and accounting. You can configure authentication, authoriza-
tion, and accounting to allow users to log on to NetScaler Gateway with credentials that either
NetScaler Gateway or authentication servers located in the secure network, such as LDAP or RA-
DIUS, recognize. Authorization policies define user permissions, determining which resources
a given user is authorized to access. For more information about authentication and autho-
rization, see Configuring Authentication and Authorization. Accounting servers maintain data
about NetScaler Gateway activity, including user logon events, resource access instances, and
operational errors. This information is stored on NetScaler Gateway or on an external server.
For more information about accounting, see Configuring Auditing on NetScaler Gateway

• User connections. Users can log on to NetScaler Gateway by using the following access meth-
ods:

– The NetScaler Gateway Plug-in for Windows is software that is installed on a Windows-
based computer. Users log on by right-clicking an icon in the notification area on a
Windows-based computer. If users are using a computer in which the NetScaler Gateway
Plug-in is not installed, they can log on by using a web browser to download and install
the plug-in. If users have Citrix Receiver installed, users log on with the NetScaler Gateway
Plug-in from Receiver. When Receiver and the NetScaler Gateway Plug-in are installed on
the user device, Receiver adds the NetScaler Gateway Plug-in automatically.

– The NetScaler Gateway Plug-in for Mac OS X that allows users running Mac OS X to log
on. It has the same features and functions as the NetScaler Gateway Plug-in for Windows.
You can provide endpoint analysis support for this plug-in version by installing NetScaler
Gatway 10.1, Build 120.1316.e.

– The NetScaler Gateway Plug-in for Java that enables Mac OS X, Linux, and optionally, Win-
dows users to log on by using a web browser.

– Receiver that allows user connections to published applications and virtual desktops in a
server farm by using the Web Interface or Citrix StoreFront.

– Receiver, Worx Home, WorxMail, and WorxWeb that allows users access to web and SaaS
applications, iOS and Android mobile apps, and ShareFile data hosted in App Controller.

– Users can connect from an Android device that uses the NetScaler Gateway web address.
When users start an app, the connection uses Micro VPN to route network traffic to the in-
ternal network. If users connect from an Android device, you must configure DNS settings
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on NetScaler Gateway. For more information, see Supporting DNS Queries by Using DNS
Suffixes for Android Devices.

– Users can connect from an iOS device that uses the NetScaler Gateway web address. You
configure Secure Browse either globally or in a session profile. When users start an app
on their iOS device, a VPN connection starts and the connection routes through NetScaler
Gateway.

– Clientless access that provides users with the access they need without installing software
on the user device.

When configuring NetScaler Gateway, you can create policies to configure how users log
on. You can also restrict user logon by creating session and endpoint analysis policies.

• Network resources. These include all network services that users access through NetScaler
Gateway, such as file servers, applications, and web sites.

• Virtual adapter. The NetScaler Gateway virtual adapter provides support for applications that
require IP spoofing. The virtual adapter is installed on the user device when the NetScaler Gate-
way Plug-in is installed. When users connect to the internal network, the outbound connection
between NetScaler Gateway and internal servers use the intranet IP address as the source IP
address. The NetScaler Gateway Plug-in receives this IP address from the server as part of the
configuration.

If you enable split tunneling on NetScaler Gateway, all intranet traffic is routed through the vir-
tual adapter. When intercepting intranet bound traffic, the virtual adapter will intercept A and
AAAA record type DNS queries while leaving all other DNS queries intact. Network traffic that
is not bound for the internal network is routed through the network adapter installed on the
user device. Internet and private local area network (LAN) connections remain open and con-
nected. If you disable split tunneling, all connections are routed through the virtual adapter.
Any existing connections are disconnected and the user needs to reestablish the session.

If you configure an intranet IP address, traffic to the internal network is spoofed with the intranet
IP address through the virtual adapter.

HowUser Connections Work

October 5, 2020

Users can connect to their emails, file shares, and other network resources from a remote location.
Users can connect to internal network resources with the following software:

• NetScaler Gateway Plug-in
• Citrix Receiver
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• WorxMail and WorxWeb
• Android and iOS mobile devices

Connecting with the NetScaler Gateway Plug-in

The NetScaler Gateway Plug-in allows user access to resources in the internal network through the
following steps:

1. A user connects to NetScaler Gateway for the first time by typing the web address in a web
browser. The logon page appears and the user is prompted to enter a user name and password.
If external authentication servers are configured, NetScaler Gateway contacts the server and
the authentication servers verify the user’s credentials. If local authentication is configured,
NetScaler Gateway performs the user authentication.

2. If you configure a preauthentication policy, when the user types the NetScaler Gateway web
address in a web browser on a Windows-based computer or a Mac OS X computer, NetScaler
Gateway checks to see if any client-based security policies are in place before the logon page
appears. The security checks verify that the user device meets the security-related conditions,
such as operating system updates, antivirus protection, and a properly configured firewall. If
the user device fails the security check, NetScaler Gateway blocks the user from logging on. A
user who cannot log on needs to download the necessary updates or packages and install them
on the user device. When the user device passes the preauthentication policy, the logon page
appears and the user can enter his or her credentials. You can use Advanced Endpoint Analysis
on a Mac OS X computer if you install NetScaler Gateway 10.1, Build 120.1316.e.

3. When NetScaler Gateway successfully authenticates the user, NetScaler Gateway initiates the
VPN tunnel. NetScaler Gateway prompts the user to download and install the NetScaler Gate-
way Plug-in for Windows or NetScaler Gateway Plug-in for Mac OS X. If you are using the Network
Gateway Plug-in for Java, the user device is also initialized with a list of preconfigured resource
IP addresses and port numbers.

4. If you configure a post-authentication scan, after a user successfully logs on, NetScaler Gateway
scans the user device for the required client security policies. You can require the same security-
related conditions as for a preauthentication policy. If the user device fails the scan, either the
policy is not applied or the user is placed in a quarantine group and the user’s access to network
resources is limited.

5. When the session is established, the user is directed to a NetScaler Gateway home page where
the user can select resources to access. The home page that is included with NetScaler Gateway
is called the Access Interface. If the user logs on by using the NetScaler Gateway Plug-in for
Windows, an icon in the notification area on the Windows desktop shows that the user device is
connected and the user receives a message that the connection is established. The user can also
access resources in the network without using the Access Interface, such as opening Microsoft
Outlook and retrieving email.
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6. If the user request passes both preauthentication and post-authentication security checks,
NetScaler Gateway then contacts the requested resource and initiates a secure connection
between the user device and that resource.

7. The user can close an active session by right-clicking the NetScaler Gateway icon in the notifi-
cation area on a Windows-based computer and then clicking Logoff. The session can also time
out due to inactivity. When the session is closed, the tunnel is shut down and the user no longer
has access to internal resources. The user can also type the NetScaler Gateway web address in
a browser. When the user presses Enter, the Access Interface appears from which users can log
off.

Note: If you deploy XenMobile App Edition in your internal network, a user who connects from outside
the internal network must connect to NetScaler Gateway first. When the user establishes the connec-
tion, the user can access web and SaaS applications, Android and iOS mobile apps, and ShareFile data
hosted on App Controller. A user can connect with the NetScaler Gateway Plug-in through clientless
access, or by using Citrix Receiver or WorxHome.

Connecting with Citrix Receiver

Users can connect with Receiver to access their Windows-based applications and virtual desktops.
Users can also access applications from App Controller. To connect from a remote location, users also
install the NetScaler Gateway Plug-in on their device. Receiver automatically adds the NetScaler Gate-
way Plug-in to its list of plug-ins. When users log on to Receiver, they can also log on to the NetScaler
Gateway Plug-in. You can also configure NetScaler Gateway to perform single sign-on to the NetScaler
Gateway Plug-in when users log on to Receiver.

Connecting with iOS and Android Devices

Users can connect from an iOS or Android device by using Worx Home. Users can access their email
by using WorxMail and connect to web sites with WorxWeb.

When users connect from the mobile device, the connections route through NetScaler Gateway to
access internal resources. If users connect with iOS, you enable Secure Browse as part of the ses-
sion profile. If users connect with Android, the connection uses Micro VPN automatically. In addition,
WorxMail and WorxWeb use Micro VPN to establish connections through NetScaler Gateway. You do
not have to configure Micro VPN on NetScaler Gateway.

Common Deployments

October 5, 2020
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You can deploy NetScaler Gateway at the perimeter of your organization’s internal network (or in-
tranet) to provide a secure single point of access to the servers, applications, and other network re-
sources that reside in the internal network. All remote users must connect to NetScaler Gateway be-
fore they can access any resources in the internal network.

NetScaler Gateway is most commonly installed in the following locations in a network:

• In the network DMZ
• In a secure network that does not have a DMZ<

You can also deploy NetScaler Gateway with XenApp, XenDesktop, StoreFront, and XenMobile Server
to allow users to access their Windows, web, mobile, and SaaS applications. If your deployment in-
cludes XenApp, StoreFront, or XenDesktop 7, you can deploy NetScaler Gateway in a single-hop or
double-hop DMZ configuration. A double-hop deployment is not supported with earlier versions of
XenDesktop or XenMobile App Edition.

For more information about expanding your NetScaler Gateway installation with these and other sup-
ported Citrix solutions, see Integrating with Citrix Products topic.

Deploying in the DMZ

October 5, 2020

Many organizations protect their internal network with a DMZ. A DMZ is a subnet that lies between an
organization’s secure internal network and the Internet (or any external network). When you deploy
NetScaler Gateway in the DMZ, users connect with the NetScaler Gateway Plug-in or Citrix Receiver.

Figure 1. NetScaler Gateway deployed in the DMZ
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In the configuration shown in the preceding figure, you install NetScaler Gateway in the DMZ and con-
figure it to connect to both the Internet and the internal network.

NetScaler Gateway Connectivity in the DMZ

When you deploy NetScaler Gateway in the DMZ, user connections must traverse the first firewall to
connect to NetScaler Gateway. By default, user connections use SSL on port 443 to establish this
connection. To allow user connections to reach the internal network, you must allow SSL on port 443
through the first firewall.

NetScaler Gateway decrypts the SSL connections from the user device and establishes a connection
on behalf of the user to the network resources behind the second firewall. The ports that must be open
through the second firewall are dependent on the network resources that you authorize external users
to access.

For example, if you authorize external users to access a web server in the internal network, and this
server listens for HTTP connections on port 80, you must allow HTTP on port 80 through the second
firewall. NetScaler Gateway establishes the connection through the second firewall to the HTTP server
on the internal network on behalf of the external user devices.
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Deploying in the Secure Network

October 5, 2020

You can install NetScaler Gateway in the secure network. In this scenario, one firewall stands between
the Internet and the secure network. NetScaler Gateway resides inside the firewall to control access
to the network resources.

Figure 1. NetScaler Gateway deployed in the secure network

When you deploy NetScaler Gateway in the secure network, connect one interface on NetScaler Gate-
way to the Internet and the other interface to servers running in the secure network. Putting NetScaler
Gateway in the secure network provides access for local and remote users. Because this configuration
only has one firewall, however, makes the deployment less secure for users connecting from a remote
location. Although NetScaler Gateway intercepts traffic from the Internet, the traffic enters the secure
network before users are authenticated. When NetScaler Gateway is deployed in a DMZ, users are au-
thenticated before network traffic reaches the secure network.

When NetScaler Gateway is deployed in the secure network, NetScaler Gateway Plug-in connections
must traverse the firewall to connect to NetScaler Gateway. By default, user connections use the SSL
protocol on port 443 to establish this connection. To support this connectivity, you must open port
443 on the firewall.

Client Software Requirements

October 5, 2020

This section describes the system requirements for the NetScaler Gateway client software.

NetScaler Gateway supports user connections by using the NetScaler Gateway Plug-in. When users
log on with the plug-in, it establishes a full VPN tunnel. With the NetScaler Gateway Plug-in, users can
connect to and work with the network resources to which you allow access.
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If you configure endpoint policies on NetScaler Gateway, when users log on, NetScaler Gateway down-
loads and installs the Endpoint Analysis Plug-in on the user device automatically.

NetScaler Gateway plug-in System Requirements

November 12, 2020

NetScaler Gateway plug-in establishes a secure connection from the client machine to the NetScaler
Gateway appliance.

The plug-in is distributed as a desktop app for Microsoft Windows, macOS X, and Linux operating sys-
tems. After you authenticate to the secure URL of the NetScaler Gateway appliance with your Web
browser, the plug-in is downloaded and installed automatically on your machine.

The plug-in is provisioned as a mobile app for Android and iOS devices.

Note:

• To install the plug-in, admin/root privileges are required on the operating system.

• The browsers that support the Citrix Gateway plug-in also support clientless VPN.

NetScaler Gateway plug-in as a desktop app is supported for the following operating systems and Web
browsers.

Operating System Supported Browsers

macOS X (10.9 and later) Safari 7.1 or later; Google Chrome Release 30 or
later; Mozilla Firefox Release 30 or later

Windows 10 (x86 and x64) Internet Explorer 11; Google Chrome Release 30
or later; Mozilla Firefox Release 24 or later;
Edge Chromium

Windows 8.1 Internet Explorer 11; Google Chrome Release 30
or later; Mozilla Firefox Release 24 or later;
Edge Chromium

Windows 8 Internet Explorer 9 and 10; Google Chrome
Release 30 or later; Mozilla Firefox Release 24
or later; Edge Chromium

Linux; Ubuntu 18.04 LTS, 16.04 LTS, 14.04 LTS,
and 12.04 LTS. 32-bit and 64-bit OS is
supported.

Mozilla Firefox Release 44 and above; Google
Chrome 50 and above
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Important: Due to a bug (1573408) in Ubuntu 16.04 LTS, the VPN Gateway plug-in installation
fails. The workaround for the same is listed as follows.

Type the following command using the command line interface:

1 sudo dpkg -i nsgclient*.deb

If the required dependency packages are missing, the command lists them and the plug-in installation
fails. These dependency packages must be manually installed. Administrators can install a missing
package by typing the following command using the command line interface.

1 apt-get install <dependency package>

NetScaler Gateway plug-in as a mobile app is supported for the following operating systems.

VPN App Supported Operating Systems

Android Android 7.0 and later

iOS iOS 12.0 and later

Endpoint Analysis Requirements

November 12, 2020

Citrix Gateway installs the Endpoint Analysis plug-in on the user device. The Endpoint Analysis plug-in
scans the user device for the endpoint security requirements that you have configured on Citrix Gate-
way. The requirements include information, such as the operating system, antivirus, or web browser
versions.

When Windows users connect to Citrix Gateway using the browser for the first time, the portal requests
the installation of the Endpoint Analysis plug-in. On subsequent logon attempts, the plug-in checks
the upgrade control configuration to check if the client endpoint analysis plug-in upgrade is necessary.
If it is necessary, the user receives a prompt to download and install the newer Endpoint Analysis plug-
in. The Endpoint Analysis plug-in for Windows is installed as a Windows 32-bit application. No special
privileges are required to install or use it.

For macOS, the user is required to install the Endpoint Analysis Plug-in. The plug- in for macOS is
installed as a 32-bit application. No special privileges are necessary to install it. On subsequent logon
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attempts, if the plug-in versions do not match, the user is prompted to download and install the plug-
in.

The tooltips on the Admin UI console explain the scans in detail. For details on the EPA libraries, see
https://www.citrix.com/en-in/downloads/citrix-gateway/epa-libraries/.

Important:

• The browsers that support EPA also support clientless VPN.

• In pre-authentication endpoint analysis, the user cannot log on with the Citrix Gateway
plug-in if the user does not install the Endpoint Analysis plug-in or skips the scan.

• In post-authentication endpoint analysis, the user can access resources for which a scan is
not required by using either clientless access or by using the Citrix Workspace app.

• For OPSWAT related scans, you must install the binary package epaPackage.exe on the
client machine.

The following software is required on the user devices to use the Endpoint Analysis plug-in:

Operating System Supported Browsers

macOS (10.9 and later) Safari 7.1 or later; Google Chrome Release 30 or
later; Mozilla Firefox Release 30 or later

Windows 10 Internet Explorer 11; Google Chrome Release 30
or later; Mozilla Firefox Release 24 or later;
Edge Chromium

Windows 8.1 Internet Explorer 11; Google Chrome Release 30
or later; Mozilla Firefox Release 24 or later;
Edge Chromium

Windows 8 Internet Explorer 9 and 10; Google Chrome
Release 30 or later; Mozilla Firefox Release 24
or later; Edge Chromium

Windows 7 Internet Explorer 9 and 10, and 11; Google
Chrome Release 30 or later; Mozilla Firefox
Release 24 or later; Edge Chromium

Windows Vista Internet Explorer 9; Mozilla Firefox Release 9
and 10

Linux; Ubuntu 12.04 LTS, 14.04 LTS, 16.04 LTS,
and 18.04 LTS. Both 32-bit and 64-bit OS are
supported. Both 32-bit and 64-bit OS are
supported.

Mozilla Firefox Release 44 and later; Google
Chrome 50 and later
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Note:

• All editions of the operating system variants mentioned previously are supported.

• For Windows editions, all service packs and critical updates must be installed.

• For Internet Explorer versions, cookies must be enabled. The minimum required version is 7.0.

• For Mozilla Firefox versions, Endpoint Analysis must be plug-in enabled, the minimum required
version is 3.0.

Compatibility with Citrix Products

October 6, 2020

The following table provides the Citrix products and versions with which NetScaler Gateway 12.0 is
compatible.

Note: NetScaler Gateway features are available on NetScaler VPX.

Citrix products and supported versions

Citrix product Release version

NetScaler SD-WAN 9.3 through 10.2

NetScaler Platforms All current MPX and VPX models including FIPS
compliant appliances

StoreFront All currently supported StoreFront versions

Citrix Virtual Apps and Desktops 7.15, 1808, 1811, 1903, 1906, 1909, 2003, 1912
LTSR, 2009

XenMobile 10.5, 10.6, 10.7, 10.8, 10.9, 10.10, 10.11, 10.12

Receivers, Citrix Mobile Productivity Apps, and Plug-ins

Receiver or Plug-in Minimum Supported Version

NetScaler Gateway plug-in for macOS X 3.1.8

NetScaler Gateway plug-in for Windows 12.0

NetScaler Gateway plug-in for iOS 3.1.4
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Receiver or Plug-in Minimum Supported Version

NetScaler Gateway plug-in for Android 2.0.14

Receiver for Android 3.11

Receiver for iOS 7.1.3

Receiver for Mac 12.4

Receiver for Windows 4.4

Receiver for Linux 13.4

Receiver for HTML5 2.3

Receiver for Chrome 2.3

Secure Hub for iOS 10.5

Secure Hub for Android 10.5

Secure Mail for iOS 10.5

SecureWeb for iOS 10.5

Secure Mail for Android 10.5

SecureWeb for Android 10.5

Supported Citrix Gateway features and plug-in versions

Feature Minimum supported plug-in version

Device guard support 12.0.58.x and later

Opswat v4 support 12.0.57.x and later

SAML support Supported as part of nFactor and not
standalone

Note: For details on some of the commonly used features supported for each VPN client, see
Citrix Gateway VPN clients and supported features.

Licensing

October 5, 2020
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Before you can deploy NetScaler Gateway to support user connections, the appliance must be prop-
erly licensed.

Important: Citrix recommends that you retain a local copy of all license files you receive. When
you save a backup copy of the configuration file, all uploaded licenses files are included in the
backup. If you need to reinstall NetScaler Gateway appliance software and do not have a backup
of the configuration, you will need the original license files.

Before installing licenses on NetScaler Gateway, set the host name of the appliance and then restart
NetScaler Gateway. You use the Setup Wizard to configure the host name. When you generate the
Universal license for NetScaler Gateway, the host name is used in the license.

NetScaler Gateway License Types

October 5, 2020

NetScaler Gateway requires a Platform license. The Platform license allows an unlimited number of
connections to XenApp, XenDesktop, or StoreFront by using ICA Proxy. To allow VPN connections to
the network from the NetScaler Gateway plug-in, a SmartAccess log on point, or Citrix Secure Hub,
WorxWeb, or WorxMail, you must also add a Universal license. NetScaler Gateway VPX comes with the
Platform license.

The Platform license is supported on the following NetScaler Gateway versions:

• NetScaler Gateway 12.0
• NetScaler Gateway 11.1
• NetScaler Gateway 11.0
• NetScaler Gateway 10.5
• NetScaler Gateway 10.1
• Access Gateway 10
• NetScaler VPX

Important: Citrix recommends that you retain a local copy of all license files that you receive.
When you save a backup copy of the configuration file, all uploaded license files are included in
the backup. If you need to reinstall the NetScaler Gateway appliance software and do not have a
backup of the configuration, you need the original license files.

The Platform License

The Platform license allows unlimited user connections to published applications on XenApp or vir-
tual desktops from XenDesktop. Connections by using Citrix Receiver do not use a NetScaler Gateway
Universal license. These connections only need the Platform license. The Platform license is delivered
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electronically with all new NetScaler Gateway orders, whether physical or virtual. If you already own
an appliance covered by a warranty or maintenance agreement, you can obtain the Platform license
from the Citrix website.

The Universal License

The Citrix Gateway universal license limits the number of concurrent user sessions to the number of
licenses purchased. If you purchase 100 licenses, you can have 100 concurrent sessions at any time. If
you purchase a Standard edition license, you can have 500 concurrent sessions at any time. When a
user ends a session, that license is released for the next user. A user who logs on to NetScaler Gateway
from more than one computer occupies a license for each session.

If all licenses are occupied, no additional connections can be opened until a user ends a session or
you terminate the session. When a connection is closed, the license is released and can be used for a
new user.

When you receive your NetScaler Gateway appliance, licensing occurs in the following order:

• You receive the license access code (license access code) in an email.
• You use the Setup Wizard to configure NetScaler Gateway with the host name.
• You allocate the NetScaler Gateway licenses from the Citrix website. Use the host name to bind

the licenses to the appliance during the allocation process.
• You install the license file on NetScaler Gateway.

The Universal license supports the following features:

• Full VPN tunnel
• Micro VPN
• Endpoint analysis
• Policy-based SmartAccess
• Clientless access to websites and file shares

Obtaining the Universal License

You need the following information before going to the Citrix website for the universal license.

• Your Citrix account user ID and password.

Register at the Citrix website (https://www.citrix.com/welcome/create-account/) to receive
your user ID and password.
Note: If you cannot locate either the license code or your user ID and password, contact Citrix
Customer Service.

• The host name of the
Citrix Gateway
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The entry field for this name on the Citrix website is case-sensitive, so make sure that you copy
the host name exactly as it is configured on the NetScaler appliance.

• The number of licenses you want to include in the license file

You do not have to download all the licenses you are entitled to at once. For example, if your
company purchased 100 licenses, you can choose to download 50. You can allocate the rest in
another license file later. Multiple license files can be installed on the
Citrix Gateway.

Note: Before obtaining your licenses, make sure you configure the host name of the NetScaler
appliance using the Setup Wizard and then restart the appliance.

To obtain your universal license

1. Log in to the Citrix website (https://www.citrix.com/en-in/account/) using your Citrix creden-
tials.

2. Under Citrix Manage Licenses is here, follow the directions to obtain your license file.

Installing the Universal License

To install the license, see Installing the License. After installation, verify that the license was installed
correctly.

Verifying Installation of the Universal License

Before proceeding, verify that your universal license is installed correctly.

To verify installation of the universal license by using the CLI

1. Open an SSH connection to the NetScaler appliance by using an SSH client, such as PuTTY.
2. Log on to the NetScaler appliance by using the administrator credentials.
3. Use the show license command to verify that “SSL VPN = YES” and that Maximum Users have

increased from 5 to the expected number of concurrent users.

To verify installation of the universal license by using the CLI

1. In a Web browser, type the IP address of the NetScaler appliance, such as http://
192.168.100.1.

2. In User Name and Password, type the administrator credentials.
3. In the navigation pane, expand System, and then click Licenses.
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4. In the Licenses pane, you see a green check mark next to NetScaler Gateway. The field Max-
imum Citrix Gateway Users Allowed displays the number of concurrent user sessions licensed
on the NetScaler appliance.

The Express License
Important: The Express license is supported only until versions 12.0 build 56.20 and earlier. For
versions 12.0 build 56.20 and later, you must use the Universal license.

The Express license is used with the NetScaler VPX and allows for up to five concurrent user connec-
tions by using Receiver or the NetScaler Gateway plug-in. The Express license is available for the VPX
appliance and expires after one year. Users can connect to either Basic or SmartAccess virtual servers.

For more information about the system requirements for NetScaler VPX, see Getting Started with Citrix
NetScaler VPX. To download the appliance, see https://www.citrix.com/downloads/.

After you download NetScaler VPX, from the NetScaler VPX website, you acquire a license key, and
then you activate and download your license file. Enter the host name of your Citrix License Server or
the host name of the NetScaler appliance.

Important: The entry field for this name is case-sensitive, so make sure that you copy the host name
exactly as it is configured on the NetScaler appliance.

Obtaining Your Platform or Universal License Files

October 5, 2020

After you install NetScaler Gateway, you are ready to obtain your Platform or Universal license files
from Citrix. You log on to the Citrix web site to access your available licenses and generate a license
file. After the license file is generated, you download it to a computer. When the license file is on the
computer, you then upload it to NetScaler Gateway. For more information about Citrix licensing, see
Citrix Licensing System.

Before obtaining your license files, make sure you configure the host name of the appliance by using
the Setup Wizard and then restart the appliance.

Important: You must install licenses on NetScaler Gateway. The appliance does not obtain licenses
from Citrix License Server.

To obtain your licenses, go to the Activate, upgrade and manage Citrix licenses web page. On this
page, you can get your new license and activate, upgrade, and manage Citrix licenses.
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To install a license on NetScaler Gateway

October 5, 2020

After you successfully download the license file to your computer, you can then install the license on
NetScaler Gateway. The license is installed in the /nsconfig/license directory.

If you used the Setup Wizard to configure the initial settings on NetScaler Gateway, the license file is
installed when you run the wizard. If you allocate part of your licenses and then at a later date, you
allocate an additional number, you can install the licenses without using the Setup Wizard.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and
then click Licenses.

2. In the details pane, click Manage Licenses.

3. Click Add New License, then click Browse, navigate to the license file and then click OK.

A message appears in the configuration utility that you need to restart NetScaler Gateway. Click
Reboot.

To set themaximum number of users

After you install the license on the appliance, you need to set the maximum number of users that are
allowed to connect to the appliance. You set the maximum user count in the global authentication
policy.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Global Settings.

2. In the details pane, under Settings, click Change authentication AAA settings.

3. In Maximum Number of Users, type the total amount of users and then click OK.

The number in this field corresponds to the number of licenses contained within the license
file. This number should be less than or equal to the total number of licenses installed on the
appliance. For example, you install one license that contains 100 user licenses and a second
license that contains 400 user licenses. The total number of licenses equals 500. The maximum
number of users who can log on is equal to or less than 500. If 500 users are logged on, any
users who attempt to log on beyond that number are denied access until a user logs off or you
terminate a session.
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Verifying Installation of the Universal License

October 5, 2020

Before proceeding, verify that your Universal license is installed correctly.

To verify installation of the Universal license by using the configuration utility

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and
then click Licenses.

In the Licenses pane, you will see a green check mark next to NetScaler Gateway. The Maxi-
mum NetScaler Gateway Users Allowed field displays the number of concurrent user sessions
licensed on the appliance.

To verify installation of the Universal license by using the command line

1. Open a Secure Shell (SSH) connection to the appliance by using an SSH client, such as PuTTY.
2. Log on to the appliance using the administrator credentials.
3. At a command prompt, type: show license The license is installed correctly if the parameter SSL

VPN equals Yes and the maximum users parameter equals the number of licenses.

Before Getting Started

October 5, 2020

Before you install NetScaler Gateway, you should evaluate your infrastructure and collect information
to plan an access strategy that meets the specific needs of your organization. When you define your
access strategy, you need to consider security implications and complete a risk analysis. You also need
to determine the networks to which users are allowed to connect and decide on policies that enable
user connections.

In addition to planning for the resources available for users, you also need to plan your deployment
scenario. NetScaler Gateway works with the following Citrix products:

• XenMobile
• XenApp
• XenDesktop
• StoreFront
• Web Interface
• CloudBridge
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For more information about deploying NetScaler Gateway, see Common Deployments and Integrating
With Citrix Products

As you prepare your access strategy, take the following preliminary steps:

• Identify resources. List the network resources for which you want to provide access, such as
web, SaaS, mobile or published applications, virtual desktops, services, and data that you de-
fined in your risk analysis.

• Develop access scenarios. Create access scenarios that describe how users access network re-
sources. An access scenario is defined by the virtual server used to access the network, endpoint
analysis scan results, authentication type, or a combination thereof. You can also define how
users log on to the network.

• Identify client software. You can provide full VPN access with the NetScaler Gateway Plug-in,
requiring users to log on with Citrix Receiver, Worx Home, or by using clientless access. You
can also restrict email access to Outlook Web App or WorxMail. These access scenarios also
determine the actions users can perform when they gain access. For example, you can specify
whether users can modify documents by using a published application or by connecting to a file
share.

• Associate policies with users, groups, or virtual servers. The policies you create on NetScaler
Gateway enforce when the individual or set of users meets specified conditions. You determine
the conditions based on the access scenarios that you create. You then create policies that
extend the security of your network by controlling the resources users can access and the ac-
tions users can perform on those resources. You associate the policies with appropriate users,
groups, virtual servers, or globally.

This section includes the following topics to help you plan your access strategy:

• Planning for Security includes information about authentication and certificates.
• Prerequisites that define network hardware and software you might need.
• The Pre-Installation Checklist that you can use to write down your settings before you configure

NetScaler Gateway.

Planning for Security

October 5, 2020

When planning your NetScaler Gateway deployment, you should understand basic security issues as-
sociated with certificates, and with authentication and authorization.
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Configuring Secure Certificate Management

By default, NetScaler Gateway includes a self-signed Secure Sockets Layer (SSL) server certificate that
enables the appliance to complete SSL handshakes. Self-signed certificates are adequate for testing
or for sample deployments, but Citrix does not recommend using them for production environments.
Before you deploy NetScaler Gateway in a production environment, Citrix recommends that you re-
quest and receive a signed SSL server certificate from a known Certificate Authority (CA) and upload
it to NetScaler Gateway.

If you deploy NetScaler Gateway in any environment where NetScaler Gateway must operate as the
client in an SSL handshake (initiate encrypted connections with another server), you must also install
a trusted root certificate on NetScaler Gateway. For example, if you deploy NetScaler Gateway with
Citrix XenApp and the Web Interface, you can encrypt connections from NetScaler Gateway to the
Web Interface with SSL. In this configuration, you must install a trusted root certificate on NetScaler
Gateway.

Authentication Support

You can configure NetScaler Gateway to authenticate users and to control the level of access (or au-
thorization) that users have to the network resources on the internal network.

Before deploying NetScaler Gateway, your network environment should have the directories and au-
thentication servers in place to support one of the following authentication types:

• LDAP
• RADIUS
• TACACS+
• Client certificate with auditing and smart card support
• RSA with RADIUS configuration
• SAML authentication

If your environment does not support any of the authentication types in the preceding list, or you have
a small population of remote users, you can create a list of local users on NetScaler Gateway. You can
then configure NetScaler Gateway to authenticate users against this local list. With this configuration,
you do not need to maintain user accounts in a separate, external directory.

Prerequisites

October 5, 2020

Before you configure settings on NetScaler Gateway, review the following prerequisites:
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• NetScaler Gateway is physically installed in your network and has access to the network.
NetScaler Gateway is deployed in the DMZ or internal network behind a firewall. You can also
configure NetScaler Gateway in a double-hop DMZ and configure connections to a server farm.
Citrix recommends deploying the appliance in the DMZ.

• You configure NetScaler Gateway with a default gateway or with static routes to the internal
network so users can access resources in the network. NetScaler Gateway is configured to use
static routes by default.

• The external servers used for authentication and authorization are configured and running. For
more information, see Authentication and Authorization.

• The network has a domain name server (DNS) or Windows Internet Naming Service (WINS)
server for name resolution to provide correct NetScaler Gateway user functionality.

• You downloaded the Universal licenses for user connections with the NetScaler Gateway Plug-in
from the Citrix web site and the licenses are ready to be installed on NetScaler Gateway.

• NetScaler Gateway has a certificate that is signed by a trusted Certificate Authority (CA). For
more information, see Installing and Managing Certificates.

Before you install NetScaler Gateway, use the Pre-Installation Checklist to write down your settings.

Pre-Installation Checklist

October 5, 2020

The checklist consists of a list of tasks and planning information you should complete before you in-
stall NetScaler Gateway.

Space is provided so that you can check off each task as you complete it and make notes. Citrix recom-
mends that you make note of the configuration values that you need to enter during the installation
process and while configuring NetScaler Gateway.

For steps to install and configure NetScaler Gateway, see Installing NetScaler Gateway.

User Devices

• Ensure that user devices meet the installation prerequisites described in NetScaler Gateway
Plug-in System Requirements

• Identify the mobile devices with which users connect. Note: If users connect with an iOS device,
you need to enable Secure Browse in a session profile.
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NetScaler Gateway Basic Network Connectivity

Citrix recommends that you obtain licenses and signed server certificates before you start to configure
the appliance.

• Identify and write down the NetScaler Gateway host name. Note: This is not the fully qualified
domain name (FQDN). The FQDN is contained in the signed server certificate that is bound to
the virtual server.

• Obtain Universal licenses from the Citrix Website
• Generate a Certificate Signing Request (CSR) and send to a Certificate Authority (CA). Enter the

date you send the CSR to the CA.
• Write down the system IP address and subnet mask.
• Write down the subnet IP address and subnet mask.
• Write down the administrator password. The default password that comes with NetScaler Gate-

way is nsroot.
• Write down the port number. This is the port on which NetScaler Gateway listens for secure user

connections. The default is TCP port 443. This port must be open on the firewall between the
unsecured network (Internet) and the DMZ.

• Write down the default gateway IP address.
• Write down the DNS server IP address and port number. The default port number is 53. In ad-

dition, if you are adding the DNS server directly, you must also configure ICMP (ping) on the
appliance.

• Write down the first virtual server IP address and host name.
• Write down the second virtual server IP address and host name (if applicable).
• Write down the WINS server IP address (if applicable).

Internal Networks Accessible Through NetScaler Gateway

• Write down the internal networks that users can access through NetScaler Gateway. Example:
10.10.0.0/24

• Enter all internal networks and network segments that users need access to when they connect
through NetScaler Gateway by using the NetScaler Gateway Plug-in.

High Availability

If you have two NetScaler Gateway appliances, you can deploy them in a high availability configura-
tion in which one NetScaler Gateway accepts and manages connections, while a second NetScaler
Gateway monitors the first appliance. If the first NetScaler Gateway stops accepting connections for
any reason, the second NetScaler Gateway takes over and begins actively accepting connections.

• Write down the NetScaler Gateway software version number.
• The version number must be the same on both NetScaler Gateway appliances.
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• Write down the administrator password (nsroot). The password must be the same on both ap-
pliances.

• Write down the primary NetScaler Gateway IP address and ID. The maximum ID number is 64.
• Write down the secondary NetScaler Gateway IP address and ID.
• Obtain and install the Universal license on both appliances.
• You must install the same Universal license on both appliances.
• Write down the RPC node password.

Authentication and Authorization

NetScaler Gateway supports several different authentication and authorization types that can be used
in a variety of combinations. For detailed information about authentication and authorization, see
Authentication and Authorization.

LDAP Authentication

If your environment includes an LDAP server, you can use LDAP for authentication.

• Write down the LDAP server IP address and port.

If you allow unsecure connections to the LDAP server, the default is port 389. If you encrypt
connections to the LDAP server with SSL, the default is port 636.

• Write down the security type.

You can configure security with or without encryption.

• Write down the administrator bind DN.

If your LDAP server requires authentication, enter the administrator DN that NetScaler Gate-
way should use to authenticate when making queries to the LDAP directory. An example is
cn=administrator,cn=Users,dc=ace, dc=com.

• Write down the administrator password.

This is the password associated with the administrator bind DN.

• Write down the Base DN.

DN (or directory level) under which users are located; for example, ou=users,dc=ace,dc=com.

• Write down the server logon name attribute.

Enter the LDAP directory person object attribute that specifies a user’s logon name. The default
is sAMAccountName. If you are not using Active Directory, common values for this setting are
cn or uid.
For more information about LDAP directory settings, see Configuring LDAP Authentication
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• Write down the group attribute.
Enter the LDAP directory person object attribute that specifies the groups to which a user be-
longs. The default is memberOf. This attribute enables NetScaler Gateway to identify the direc-
tory groups to which a user belongs.

• Write down the subattribute name.

RADIUS Authentication and Authorization

If your environment includes a RADIUS server, you can use RADIUS for authentication.
RADIUS authentication includes RSA SecurID, SafeWord, and Gemalto Protiva products.

• Write down the primary RADIUS server IP address and port. The default port is 1812.
• Write down the primary RADIUS server secret (shared secret).
• Write down the secondary RADIUS server IP address and port. The default port is 1812.
• Write down the secondary RADIUS server secret (shared secret).
• Write down the type of password encoding (PAP, CHAP, MS-CHAP v1, MSCHAP v2).

SAML Authentication

The Security Assertion Markup Language (SAML) is an XML-based standard for exchanging authenti-
cation and authorization between Identity Providers (IdP) and Service Providers.

• Obtain and install on NetScaler Gateway a secure IdP certificate.
• Write down the redirect URL.
• Write down the user field.
• Write down the signing certificate name.
• Write down the SAML issuer name.
• Write down the default authentication group.

Opening Ports Through the Firewalls (Single-Hop DMZ)

If your organization protects the internal network with a single DMZ and you deploy the NetScaler
Gateway in the DMZ, open the following ports through the firewalls. If you are installing two NetScaler
Gateway appliances in a double-hop DMZ deployment, see Opening the Appropriate Ports on the Fire-
walls

On the Firewall Between the Unsecured Network and the DMZ

• Open a TCP/SSL port (default 443) on the firewall between the Internet and NetScaler Gateway.
User devices connect to NetScaler Gateway on this port.
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On the Firewall Between the Secured Network

• Open one or more appropriate ports on the firewall between the DMZ and the secured network.
NetScaler Gateway connects to one or more authentication servers or to computers running
XenApp or XenDesktop in the secured network on these ports.

• Write down the authentication ports.

Open only the port appropriate for your NetScaler Gateway configuration.

– For LDAP connections, the default is TCP port 389.
– For a RADIUS connection, the default is UDP port 1812. Write down the XenApp or XenDesk-

top ports.

• If you are using NetScaler Gateway with XenApp or XenDesktop, open TCP port 1494. If you
enable session reliability, open TCP port 2598 instead of 1494. Citrix recommends keeping both
of these ports open.

XenDesktop, XenApp, the Web Interface, or StoreFront

Complete the following tasks if you are deploying NetScaler Gateway to provide access to XenApp or
XenDesktop through the Web Interface or StoreFront. The NetScaler Gateway Plug-in is not required
for this deployment. Users access published applications and desktops through NetScaler Gateway
by using only web browsers and Citrix Receiver.

• Write down the FQDN or IP address of the server running the Web Interface or StoreFront.
• Write down the FQDN or IP address of the server running the Secure Ticket Authority (STA) (for

Web Interface only).

XenMobile App Edition

Complete the following tasks if you deploy App Controller in your internal network. If users connect
to App Controller from an external network, such as the Internet, users must connect to NetScaler
Gateway before accessing mobile, web, and SaaS apps.

• Write down the FQDN or IP address of App Controller.
• Identify web, SaaS, and mobile iOS or Android applications users can access.

Double-Hop DMZ Deployment with XenApp

Complete the following tasks if you are deploying two NetScaler Gateway appliances in a double-hop
DMZ configuration to support access to servers running XenApp.
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NetScaler Gateway in the First DMZ

The first DMZ is the DMZ at the outermost edge of your internal network (closest to the Internet or
unsecure network). Clients connect to NetScaler Gateway in the first DMZ through the firewall sepa-
rating the Internet from the DMZ. Collect this information before installing NetScaler Gateway in the
first DMZ.

• Complete the items in the NetScaler Gateway Basic Network Connectivity section of this check-
list for this NetScaler Gateway.

When completing those items, note that Interface 0 connects this NetScaler Gateway to the In-
ternet and Interface 1 connects this NetScaler Gateway to NetScaler Gateway in the second DMZ.

• Configure the second DMZ appliance information on the primary appliance.

To configure NetScaler Gateway as the first hop in the double-hop DMZ, you must specify the
host name or IP address of NetScaler Gateway in the second DMZ on the appliance in the first
DMZ. After specifying when the NetScaler Gateway proxy is configured on the appliance in the
first hop, bind it to NetScaler Gateway globally or to a virtual server.

• Write down the connection protocol and port between appliances.

To configure NetScaler Gateway as the first hop in the double DMZ, you must specify the connec-
tion protocol and port on which NetScaler Gateway in the second DMZ listens for connections.
The connection protocol and port is SOCKS with SSL (default port 443). The protocol and port
must be open through the firewall that separates the first DMZ and the second DMZ.

NetScaler Gateway in the Second DMZ

The second DMZ is the DMZ closest to your internal, secure network. NetScaler Gateway deployed in
the second DMZ serves as a proxy for ICA traffic, traversing the second DMZ between the external user
devices and the servers on the internal network.

• Complete the tasks in the NetScaler Gateway Basic Network Connectivity section of this check-
list for this NetScaler Gateway.

When completing those items, note that Interface 0 connects this NetScaler Gateway to
NetScaler Gateway in the first DMZ. Interface 1 connects this NetScaler Gateway to the secured
network.

Upgrading

October 5, 2020
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You can upgrade the software that resides on NetScaler Gateway when new releases are made avail-
able. You can check for updates on the Citrix website. You can upgrade to a new release only if your
NetScaler Gateway licenses are under the Subscription Advantage program when the update is re-
leased. You can renew Subscription Advantage at any time. For more information, see the Citrix Sup-
port website.

The upgrade path and compatible products information are also available in the Citrix Upgrade Guide.

For information about the latest NetScaler Gateway maintenance release, see the Citrix Knowledge
Center.

To check for software updates

1. Go to the Citrix website.
2. Click My Account and log on.
3. Click Downloads.
4. Under Find Downloads, select NetScaler Gateway.
5. In Select Download Type, select Product Software and then click Find.

You can also selectVirtual Appliances to download Citrix ADC VPX. When you select this option,
you receive a list of software for the virtual machine for each hypervisor.

6. On the NetScaler Gateway page, expand NetScaler Gateway or Access Gateway.
7. Click the appliance software version you want to download.
8. On the appliance software page for the version you want to download, select the virtual appli-

ance, and then click Download.
9. Follow the instructions on your screen to download the software.

When the software is downloaded to your computer, you can use the Upgrade Wizard or the command
prompt to install the software.

To upgrade the NetScaler Gateway by using the UpgradeWizard

1. In the configuration utility, on the Configuration tab, in the navigation pane, click System.
2. In the details pane, click UpgradeWizard.
3. Click Next and then follow the directions in the wizard.

To upgrade the NetScaler Gateway by using a command prompt

1. To upload the software to NetScaler Gateway, use a secure FTP client, such as WinSCP, to con-
nect to the appliance.

2. Copy the software from your computer to the /var/nsinstall directory on the appliance.
3. Use a Secure Shell (SSH) client, such as PuTTY, to open an SSH connection to the appliance.
4. Log on to NetScaler Gateway.
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5. At a command prompt, type: shell
6. To change to the nsinstall directory, at a command prompt, type: cd /var/nsinstall
7. To view the contents of the directory, type: ls
8. To unpack the software, type: tar –xvzf build_X_XX.tgz, where build_X_XX.tgz is the name of the

build to which you want to upgrade.
9. To start the installation, at a command prompt, type: ./installns

10. When the installation is complete, restart NetScaler Gateway.

After NetScaler Gateway restarts, to verify successful installation, start the configuration utility. The
NetScaler Gateway version that is on the appliance appears in the upper-right corner.

Install the system

October 5, 2020

When you receive your NetScaler Gateway appliance, you unpack the appliance and prepare the site
and rack. After you determine that the location where you will install your appliance meets the en-
vironmental standards and the server rack is in place according to the instructions, you install the
hardware. After you mount the appliance, you connect it to the network, to a power source, and to
the console terminal that you use for initial configuration. After you turn on the appliance, you per-
form the initial configuration, and assign management and network IP addresses. Be sure to observe
the cautions and warnings listed with the installation instructions.

When installing a NetScaler VPX virtual appliance, you must first acquire the virtual appliance image
and install it on a hypervisor or other virtual machine monitor.

Citrix recommends using the NetScaler Gateway Pre-Installation Checklist topic so you can make a
note of your settings before attempting to configure a NetScaler Gateway appliance. The checklist
includes information about installing NetScaler Gateway as well as an appliance.

Configuring NetScaler Gateway

October 5, 2020

After you configure the base network settings on NetScaler Gateway, you then configure the detailed
settings so users can connect to network resources in the secure network. These settings include:

• Virtual servers. You can configure multiple virtual servers on NetScaler Gateway, which allows
you to create different policies depending on the user scenario you need to implement. Each
virtual server has its own IP address, certificate, and policy set. For example, you can configure a
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virtual server and restrict users to network resources in the internal network depending on their
membership in groups and the policies you bind to the virtual servers. You can create virtual
servers by using the following methods:

– Quick Configuration wizard
– NetScaler Gateway wizard
– Configuration utility

• High availability. You can configure high availability when you deploy two NetScaler Gateway
appliances in your network. If the primary appliances fails, the secondary appliance can take
over without affecting user sessions.

• Certificates. You can use certificates to secure user connections to NetScaler Gateway. When
you create a Certificate Signing Request (CSR), you add the fully qualified domain name to the
certificate. You can bind certificates to virtual servers.

• Authentication. NetScaler Gateway supports several authentication types, including Local
LDAP, RADIUS, SAML, client certificates, and TACACS+. In addition, you can configure cascading
and two-factor authentication.
Note: If you use RSA, Safeword, or Gemalto Protiva for authentication, you configure these
types by using RADIUS.

• User connections. You can configure user connections by using session profiles. Within the
profile, you can determine the plug-ins users can log on with, along with any restrictions users
might require. Then, you can create a policy with one profile. You can bind session policies to
users, groups, and virtual servers.

• Home page. You can use the default Access Interface as your home page, or you can create a
custom home page. The home page appears after users successfully log on to NetScaler Gate-
way.

• Endpoint analysis. You can configure policies on NetScaler Gateway that check the user device
for software, files, registry entries, processes, and operating systems when users log on. End-
point analysis allows you to increase the security of your network by requiring the user device
to have the required software.

Using the Configuration Utility

October 5, 2020

The configuration utility allows you to configure most of the NetScaler Gateway settings. You use a
web browser to access the configuration utility.
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To log on to the configuration utility

1. In a web browser, type the system IP address of NetScaler Gateway, such as http://
192.168.100.1.
Note: NetScaler Gateway is preconfigured with a default IP address of
192.168.100.1 and subnet mask of
255.255.0.0.

2. In User Name and Password, type nsroot
3. In Deployment Type, select NetScaler Gateway and then click Login.

When you log on to the configuration utility for the first time, the Dashboard opens by default on the
Home tab. On the Home tab, you can use the Quick Configuration wizard to configure the settings for
a virtual server, authentication, certificates, and App Controller. You can also configure either Store-
Front or Web Interface settings in the Quick Configuration wizard.

For more information about configuring NetScaler Gateway, see:

• Configuring Initial Settings Using the Setup Wizard.
• Configuring Settings with the Quick Configuration Wizard
• Configuring Settings by Using the NetScaler Gateway Wizard.

Policies and Profiles on NetScaler Gateway

October 5, 2020

Policies and profiles on NetScaler Gateway allow you to manage and implement configuration set-
tings under specified scenarios or conditions. An individual policy states or defines the configuration
settings that go into effect when a specified set of conditions are met. Each policy has a unique name
and can have a profile bound to the policy.

For more information about policies with NetScaler Gateway, see the following topics:

How Policies Work

October 5, 2020

A policy consists of a Boolean condition and collection of settings called a profile. The condition is
evaluated at runtime to determine if the policy should be applied.

A profile is a collection of settings, using specific parameters. The profile can have any name and you
can reuse it in more than one policy. You can configure multiple settings within the profile, but you
can only include one profile per policy.
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You can bind policies, with the configured conditions and profiles, to virtual servers, groups, users, or
globally. Policies are referred to by the type of configuration settings they control. For example, in a
session policy, you can control how users log on and the amount of time users can stay logged on.

If you are using NetScaler Gateway with Citrix XenApp, NetScaler Gateway policy names are sent to
XenApp as filters. When configuring NetScaler Gateway to work with XenApp and SmartAccess, you
configure the following settings in XenApp:

• The name of the virtual server that is configured on the appliance. The name is sent to XenApp
as the NetScaler Gateway farm name.

• The names of the pre-authentication or session policies are sent as filter names.

For more information about configuring NetScaler Gateway to work with XenMobile App Edition,
see Configuring Settings for Your XenMobile Environment

For more information about configuring NetScaler Gateway to work with Citrix XenApp and XenDesk-
top, see Accessing XenApp and XenDesktop Resources with the Web Interface and Integrating with
App Controller or StoreFront.

For more information about preauthentication policies, see Configuring Endpoint Polices.

Setting the Priorities of Policies

October 5, 2020

Policies are prioritized and evaluated in the order in which the policy is bound.

The following two methods determine policy priority:

• The level to which the policy is bound: globally, virtual server, group, or user. Policy levels are
ranked from highest to lowest as follows:

– User (highest priority)
– Group
– Virtual server
– Global (lowest priority)

• Numerical priority takes precedence regardless of the level at which the policy is bound. If a
policy that is bound globally has a priority number of one and another policy bound to a user
has a priority number of two, the global policy takes precedence. A lower priority number gives
the policy a higher precedence.
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Configuring Conditional Policies

October 5, 2020

When configuring policies, you can use any Boolean expression to express the condition for when
the policy applies. When you configure conditional policies, you can use any of the available system
expressions, such as the following:

• Client security strings
• Network information
• HTTP headers and cookies
• Time of day
• Client certificate values

You can also create policies to apply only when the user device meets specific criteria, such as a session
policy for SmartAccess.

Another example of configuring a conditional policy is varying the authentication policy for users. For
example, you can require users who are connecting with the NetScaler Gateway Plug-in from outside
the internal network, such as from their home computer or by using Micro VPN from a mobile device,
to be authenticated by using LDAP and users who are connecting through a wide area network (WAN)
to be authenticated using RADIUS.

Note: You cannot use policy conditions based on endpoint analysis results if the policy rule is config-
ured as part of security settings in a session profile.

Creating Policies on NetScaler Gateway

October 5, 2020

You can use the configuration utility to create policies. After you create a policy, you bind the policy
to the appropriate level: user, group, virtual server, or global. When you bind a policy to one of these
levels, users receive the settings within the profile if the policy conditions are met. Each policy and
profile has a unique name.

If you have App Controller or StoreFront as part of your deployment, you can use the Quick Configu-
ration wizard to configure the settings for this deployment. For more information about the wizard,
see Configuring Settings with the Quick Configuration Wizard
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Configuring System Expressions

October 5, 2020

A system expression specifies the conditions under which the policy is enforced. For example, expres-
sions in a preauthentication policy are enforced while a user is logging on. Expressions in a session
policy are evaluated and enforced after the user is authenticated and logged on to NetScaler Gateway.

Expressions on NetScaler Gateway include:

• General expressions that limit the objects users can use when establishing a connection to
NetScaler Gateway

• Client security expressions that define the software, files, processes, or registry values that must
be installed and running on the user device

• Network-based expressions that restrict access based on network settings

NetScaler Gateway can also be used as a Citrix NetScaler appliance. Some expressions on the appli-
ance are more applicable to NetScaler. General and network-based expressions are used commonly
with NetScaler and are not generally used with NetScaler Gateway. Client security expressions are
used on NetScaler Gateway to determine that the correct items are installed on the user device.

Configuring Client Security Expressions

Expressions are a component of a policy. An expression represents a single condition that is evalu-
ated against a request or a response. You can create a simple expression security string to check for
conditions, such as:

• User device operating system including service packs
• Antivirus software version and virus definitions
• Files
• Processes
• Registry values
• User certificates

Creating Simple and Compound Expressions

October 5, 2020

Simple expressions check for a single condition. An example of a simple expression is:

REQ.HTTP.URL == HTTP://www.mycompany.com
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Compound expressions check
for multiple conditions. You
create compound expressions
by connecting to one or more
expression names using the
logical operators && and

. You can use the symbols to
group the expression in the
order of evaluation.

Compound expressions can be categorized as:

• Named expressions. As an independent entity, a named expression can be reused by other poli-
cies and are part of the policy. You configure named expressions at the system level in the con-
figuration utility. You can use a predefined named expression in the policy or create one of your
own.

• Inline expressions. An inline expression is one that you build within the policy that is specific to
the policy.

To create a named expression

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand AppExpert
and then click Expressions.

2. In the details pane, click Add.
3. In the Create Policy Expression dialog box, in Expression Name, type a name for the expression.
4. To create an expression, click Add.
5. Do one of the following:

a) In Frequently Used Expression, select an expression from the list, click OK, click Create and
then click Close.

b) Under Construct Expression, select the parameters for the expression string, click OK, click
Create and then click Close.

Adding Custom Expressions

October 5, 2020

If you are creating a policy, you can create a custom expression while configuring the policy. For ex-
ample, you are creating a session profile to allow users to log on with the NetScaler Gateway Plug-in,
set a time limit for the session, and allow single sign-on with Windows. After you create the session
profile, in the Create Session Policy dialog box, you can create the expression. The following example
shows an expression that checks for a process and antivirus application:
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CLIENT.APPLICATION.PROCESS(ccapp.exe)EXISTS -frequent 5 && CLIENT.APPLICATION.AV(Symantec).VERSION==14.20.0.29
-freshness 5 && ns_true

Using Operators and Operands in Policy Expressions

October 5, 2020

An operator is a symbol that identifies the operation—mathematical, Boolean, or relational, for
example—that manipulates one or more objects, or operands. The first section in this topic defines
the operators you can use and provides a definition. The second section lists the operators you can
use with specific qualifiers, such as method, URL and query.

Operators and Definitions

This section defines the operators that you can use when creating a policy expression and provides a
description of the operator.

• ==, !=, EQ, NEQ

These operators test for exact matches. They are case-sensitive (“cmd.exe” is NOT EQUAL to
“cMd.exe”). These operators are useful for creating permissions to allow particular strings that
meet an exact syntax, but to exclude other strings.

• GT

This operator is used for numerical comparisons; it is used on the length of the URLs and query
strings.

• CONTAINS, NOTCONTAINS

These operators perform checks against the specified qualifier to determine if the specified
string is contained in the qualifier. These operators are not case-sensitive.

• EXISTS, NOTEXISTS

These operators check for the existence of particular qualifier. For example, these operators can
be applied to HTTP headers to determine if a particular HTTP header exists or if the URL Query
exists.

• CONTENTS

This operator checks if the qualifier exists and if it has contents (that is, whether or not a header
exists and has a value associated with it, no matter what the value).
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Qualifiers, Operators, Operands, Actions, and Examples

This section shows the parameters you can use for operators and operands. Each item starts with the
qualifier and then lists the associated operator and operand, describes the action that the expression
will carry out, and provides an example.

• Method

Operator: EQ, NEQ
Operands: Required:

– Standard HTTP methods
– Supported methods
– GET, HEAD, POST, PUT, DELETE OPTIONS, TRACE, CONNECT

Actions: Verifies the incoming request method to the configured method.
Example: Method EQ GET

URL

• Operator: EQ, NEQ
Operands: Required: URL (Format: /[prefix][*][.suffix])
Actions: Verifies the incoming URL with the configured URL.
Example:
URL EQ / foo*.asp
URL EQ /foo*
URL EQ /*.asp
URL EQ /foo.asp

• Operator: CONTAINS, NOTCONTAINS
Operands: Required: Any string (in quotes)
Actions: Verifies the incoming URL for the presence of the configured pattern. (Includes URL
and URL query.)
Example: URL CONTAINS ‘ZZZ’

• URL LEN

Operator: GT
Operands: Required: Length (as an integer value)
Actions: Compares the incoming URL length with the configured length. (Includes URL and URL
query.)
Example: URLLEN GT 60

• URL QUERY

Operator: CONTAINS, NOTCONTAINS
Operands: Required: Any string (in quotes).
Optional: Length and offset
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Actions:
Verifies the incoming URL query for the presence of the configured pattern.
Used similarly to CONTENTS.
If no option is specified, the whole URL query after the pattern is used.
If options are present, only the length of the query after the pattern is used.
The offset is used to indicate from where to start the search for the pattern.
Example: URLQUERY CONTAINS ‘ZZZ’

• URL QUERY LEN

Operator: GT
Operands: Required: Length (as an integer value)
Actions: Compares the incoming URL query length with the configured length.
Example: URLQUERYLN GT 60

• URL TOKENS

Operator: EQ, NEQ
Operands: Required: URL tokens (Supported URL tokens =, +, %, !, &, ?).
Actions: Compares the incoming URL for the presence of configured tokens. A backward slash
(\) must be entered in front of the question mark.
Example: URLTOKENS EQ ‘% , +, &, \?’

• VERSION

Operator: EQ, NEQ
Operands: Required: Standard HTTP versions. Valid HTTP version strings HTTP/1.0, HTTP/1.1
Actions: Compares the incoming request’s HTTP version with the configured HTTP version.
Example: VERSION EQ HTTP/1.1

Header

• Operator: EXISTS, NOTEXISTS
Operands: None
Actions: Examines the incoming request for the presence of the HTTP header.
Example: Header Cookie EXISTS

• Operator: CONTAINS, NOTCONTAINS
Operands: Required: Any string (in quotes).
Optional: Length and offset
Actions: Verifies the incoming request for the presence of a configured pattern in the specific
header. Used similarly to CONTENTS. If no option is specified, the whole HTTP header value
after the pattern is used. If options are present, only the length of the header after the pattern
is used. The offset is used to indicate from where to start the search for the pattern.
Example: Header Cookie CONTAINS “\&sid”
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• Operator: CONTENTS
Operands: Optional: Length and offset
Actions: Uses the contents of the HTTP header. If no option is specified, the whole HTTP header
value is used. If options are present, only the length of the header starting from the offset is
used.
Example: Header User-Agent CONTENTS

• SOURCEIP

Operator: EQ, NEQ
Operands: Required: IP address
Optional: Subnet mask
Actions: Verifies the source IP address in the incoming request against the configured IP address.
If the optional subnet mask is specified, the incoming request is verified against the configured
IP address and subnet mask.
Example: Sourceip EQ 192.168.100.0 -netmask 255.255.255.0

• DESTIP

Operator: EQ, NEQ
Operands: Required: IP address
Optional: Subnet mask
Actions: Verifies the destination IP address in the incoming request against the configured IP
address. If the optional subnet mask is specified, the incoming request is verified against the
configured IP address and subnet mask.
Example: Sourceip EQ 192.168.100.0 -netmask 255.255.255.0

• SOURCEPORT

Operator: EQ, NEQ
Operands: Required: Port number
Optional: Port range
Actions: Verifies the source port number in the incoming request against the configured port
number.
Example: SOURCEPORT EQ 10-20

• DESTPORT

Operator: EQ, NEQ
Operands: Required: Port number
Optional: Port range
Actions: Verifies the destination port number in the incoming request against the configured
port number.
Example: DESTPORT NEQ 80
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• CLIENT.SSL.VERSION

Operator: EQ, NEQ
Operands: Required: SSL version
Actions: Checks the version of the SSL or TLS version used in the secure connection.
Example: CLIENT.SSL.VERSION EQ SSLV3

• CLIENT.CIPHER.TYPE

Operator: EQ, NEQ
Operands: Required: Client cipher type
Actions: Checks for the type of the cipher being used (export or non-export).
Example: CLIENT.CIPHER.TYPE EQ EXPORT

• CLIENT.CIPHER.BITS

Operator: EQ, NEQ, GE, LE, GT, LT
Operands: Required: Client cipher bits
Actions: Checks for the key strength of the cipher being used.
Example: CLIENT.CIPHER.BITS GE 40

• CLIENT.CERT

Operator: EXISTS, NOTEXISTS
Operands: none
Actions: Checks whether or not the client sent a valid certificate during the SSL handshake.
Example: CLIENT.CERT EXISTS

• CLIENT.CERT.VERSION

Operator: EQ, NEQ, GE, LE, GT, LT
Operands: Client certificate version
Actions: Checks the version of the client certificate.
Example: CLIENT.CERT.VERSION EQ 2

• CLIENT.CERT.SERIALNUMBER

Operator: EQ, NEQ
Operands: Required: Client certificate serial number
Actions: Checks the serial number of the client certificate. The serial number is treated as a
string.
Example: CLIENT.CERT.SER IALNUMBER EQ 2343323

• CLIENT.CERT.SIGALGO

Operator: EQ, NEQ
Operands: Required: Client certificate signature algorithm.
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Actions: Checks the signature algorithm used in the client certificate.
Example: CLIENT.CERT.SIGALGO EQ md5WithRSAEncryption

• CLIENT.CERT.SUBJECT

Operator: CONTAINS, NOTCONTAINS
Operands: Required: Client certificate subject
Optional: Length, offset
Actions: Checks the subject field of the client certificate.
Example: CLIENT.CERT.SUBJECT CONTAINS CN= Access_Gateway

• CLIENT.CERT.ISSUER

Operator: CONTAINS, NOTCONTAINS
Operands: Required: Client certificate issuer
Optional: Length, offset
Actions: Checks the issuer field of the client certificate.
Example: CLIENT.CERT.ISSUER CONTAINS O=VeriSign

• CLIENT.CERT.VALIDFROM

Operator: EQ, NEQ, GE, LE, GT, LT
Operands: Required: Date
Actions: Checks the date from which the client certificate is valid.
Valid date formats are:
Tue, 05 Nov 1994 08:12:31 GMT
Tuesday, 05-Nov-94 08:12:31 GMT
Tue Nov 14 08:12:31 1994
Example: CLIENT.CERT.VALIDFROM GE ‘Tue Nov 14 08:12:31 1994’

• CLIENT.CERT.VALIDTO

Operator: EQ, NEQ, GE, LE, GT, LT
Operands: Required: Date
Actions: Checks the date until which the client certificate is valid.
Valid date formats are:
Tue, 05 Nov 1994 08:12:31 GMT
Tuesday, 05-Nov-94 08:12:31 GMT
Tue Nov 14 08:12:31 1994
Example: CLIENT.CERT.VALIDTO GE ‘Tue Nov 14 08:12:31 1994’

Viewing NetScaler Gateway Configuration Settings

October 5, 2020
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When you make configuration changes to NetScaler Gateway, the changes are saved in log files. You
can view several types of configuration settings:

• Saved configuration. You can view the settings you have saved on NetScaler Gateway.
• Running configuration. You can view active settings, such as a virtual server or authentication

policy, that you have configured but have not saved as a saved configuration to NetScaler Gate-
way.

• Running versus saved configuration. You can compare side by side the running and saved con-
figuration on NetScaler Gateway.

You can also clear configuration settings on NetScaler Gateway.

Important: If you choose to clear settings on NetScaler Gateway, certificates, virtual servers, and poli-
cies are removed. Citrix recommends that you do not clear the configuration.

Saving the NetScaler Gateway Configuration

October 5, 2020

You can save your current configuration on NetScaler Gateway to a computer in your network, view
the current running configuration, and compare the saved and running configurations.

To save the configuration on NetScaler Gateway

1. In the configuration utility, above the details pane, click the Save icon and then click Yes.

To view and save the configuration file on NetScaler Gateway

The saved configuration are the settings that are saved in a log file on NetScaler Gateway, such as
settings for virtual servers, policies, IP addresses, users, groups, and certificates.

When you configure settings on NetScaler Gateway, you can save the settings to a file on your com-
puter. If you need to reinstall the NetScaler Gateway software or you accidentally remove some set-
tings, you can use this file to restore your configuration. If you need to restore the settings, you can
copy the file to NetScaler Gateway and restart the appliance by using the command-line interface or
a program, such as WinSCP, to copy the file to NetScaler Gateway.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and
then click Diagnostics.

2. In the details pane, under View Configuration, click Saved configuration.
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3. In the Saved Configuration dialog box, click Save output text to a file, name the file, and then
click Save.
Note: Citrix recommends saving the file using the file name ns.conf.

To view the current running configuration

Any changes to NetScaler Gateway that occur without an effort to save them is called the running
configuration. These settings are active on NetScaler Gateway, but are not saved on the appliance.
If you configured additional settings, such as a policy, virtual server, users, or groups, you can view
these settings in the running configuration.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and
then click Diagnostics.

2. In the details pane, under View Configuration, click Running configuration.

To compare the saved and running configuration

You can see which settings are saved on the appliance and compare those settings against the running
configuration. You can choose to save the running configuration or make changes to the configura-
tion.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and
then click Diagnostics.

2. In the details pane, under View Configuration, click Saved v/s running.

Clearing the NetScaler Gateway Configuration

October 5, 2020

You can clear the configuration settings on NetScaler Gateway. You can choose from among the fol-
lowing three levels of settings to clear:

Important: Citrix recommends saving your configuration before you clear the NetScaler Gateway con-
figuration settings.

• Basic. Clears all settings on the appliance except for the system IP address, default gateway,
mapped IP addresses, subnet IP addresses, DNS settings, network settings, high availability
settings, administrative password, and feature and mode settings.

• Extended. Clears all settings except for the system IP address, mapped IP addresses, subnet IP
addresses, DNS settings, and high availability definitions.
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• Full. Restores the configuration to the original factory settings, excluding the system IP (NSIP)
address and default route, which are required to maintain network connectivity to the appli-
ance.

When you clear all or part of the configuration, the feature settings are set to the factory default set-
tings.

When you clear the configuration, files that are stored on NetScaler Gateway, such as certificates and
licenses, are not removed. The file ns.conf is not altered. If you want to save the configuration before
clearing the configuration, save the configuration to your computer first. If you save the configuration,
you can restore the ns.conf file on NetScaler Gateway. After you restore the file to the appliance and
restart NetScaler Gateway, any configuration settings in ns.conf are restored.

Modifications to configuration files, such as rc.conf, are not reverted.

If you have a high availability pair, both NetScaler Gateway appliances are modified identically. For
example, if you clear the basic configuration on one appliance, the changes are propagated to the
second appliance.

To clear NetScaler Gateway configuration settings

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and
then click Diagnostics.

2. In the details pane, under Maintenance, click Clear configuration.
3. In Configuration Level, select the level you want to clear and then click Run.

Configuring the NetScaler Gateway by Using Wizards

October 5, 2020

NetScaler Gateway has the following six wizards that you can use to configure settings on the appli-
ance:

• The First-time Setup Wizard appears when you log on to the NetScaler Gateway appliance for
the first time.

• The Setup Wizard helps you configure basic NetScaler Gateway settings for the first time.
• XenMobile Integrated Configuration helps you configure your NetScaler Gateway and XenMobile

environment.
• The Quick Configuration wizard helps you configure the correct policies, expressions, and set-

tings for connections to XenMobile App Edition, StoreFront, and the Web Interface.
• The NetScaler Gateway wizard helps you configure NetScaler Gateway-specific settings.
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• The Published Applications wizard helps you configure settings for user connections by using
Citrix Receiver.

How the First-time SetupWizard Works

When you finish installing and configuring the initial settings on the NetScaler Gateway appliance,
when you log on to the configuration utility for the first time, the First-time Setup wizard appears if
the following conditions are not met:

• You did not install a license on the appliance.
• You did not configure a subnet or mapped IP address.
• If the default IP address of the appliances is 192.168.100.1.

How the SetupWizard Works

You use the Setup Wizard to configure the following initial settings on the appliance:

• System IP address and subnet mask
• Mapped IP address and subnet mask
• Host name
• Default gateway
• Licenses

Note: Before running the Setup Wizard, download your licenses from the Citrix website. For more
information, see
Licensing NetScaler Gateway

How Integrated XenMobile ConfigurationWorks

You can deploy NetScaler Gateway with XenMobile MDM that provides the ability to scale, ensure high
availability for apps, and maintain security. To use the XenMobile configuration, you need to install
Version 10.1, Build 120.1316.e.

The Integrated XenMobile Configuration creates the following:

• Load balancing servers for Device Manager.
• Load balancing servers for Microsoft Exchange with email filtering.
• Load balancing servers for ShareFile.

For more information about creating settings with the Integrated XenMobile Configuration, see Con-
figuring Settings for Your XenMobile Environment
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How the Quick ConfigurationWizard Works

The Quick Configuration wizard allows you to configure multiple virtual servers on NetScaler Gateway.
You can add, edit, and remove virtual servers.

The Quick Configuration wizard allows for seamless configuration for the following deployments:

• Web Interface connections to XenApp and XenDesktop, with the ability to configure multiple
instances of the Secure Ticket Authority (STA)

• XenMobile App Edition only
• StoreFront only
• XenMobile App Edition and StoreFront together

The Quick Configuration wizard allows you to configure the following settings on the appliance:

• Virtual server name, IP address, and port

• Redirection from an unsecure to a secure port

• LDAP server

• RADIUS server

• Certificates

• DNS server

• XenMobile and XenApp/XenDesktop

Note: To enable SSO, you have to manually enable the Single Sign-on to web applications
option in the Create Citrix Gateway Session Profile > Client Experience tab for the session
action.

NetScaler Gateway supports user connections directly to XenMobile App Edition, which gives users
access to their web, SaaS, and mobile apps, along with access to ShareFile. You can also configure
settings to StoreFront which gives users access to their Windows-based applications and virtual desk-
tops.

When you run the Quick Configuration wizard, the following policies are created based on your Xen-
Mobile App Edition, StoreFront, and Web Interface settings:

• Session policies, including policies and profiles for Receiver, Receiver for Web, NetScaler Gate-
way plug-in, and Program Neighborhood Agent

• Clientless access
• LDAP and RADIUS authentication

How the NetScaler GatewayWizard Works

You use the NetScaler Gateway wizard to configure the following settings on the appliance:
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• Virtual servers
• Certificates
• Name service providers
• Authentication
• Authorization
• Port redirection
• Clientless access
• Clientless access for SharePoint

How the Published Applications Wizard Works

You use the Published Applications wizard to configure NetScaler Gateway to connect to servers run-
ning XenApp or XenDesktop in the internal network. With the Published Applications wizard, you can:

• Select a virtual server for connections to the server farm.
• Configure the settings for user connections for the Web Interface or StoreFront, single sign-on,

and the Secure Ticket Authority.
• Create or select session policies for SmartAccess.

Within the wizard, you can also create session policy expressions for user connections. For more in-
formation about configuring NetScaler Gateway to connect to a server farm, see Providing Access to
Published Applications and Virtual Desktops Through the Web Interface.

Configuring NetScaler Gateway with the First-time SetupWizard

October 5, 2020

To configure the NetScaler Gateway (the physical appliance or the VPX virtual appliance) for the first
time, you need an administrative computer configured on the same network as the appliance.

You must assign a NetScaler Gateway IP (NSIP) address as the management IP address of your appli-
ance and a subnet IP (SNIP) address to which your servers can connect. You assign a subnet mask that
applies to both NetScaler Gateway and SNIP addresses. You must also configure a time zone. If you
assign a host name, you can access the appliance by specifying its name instead of the NSIP address.

There are two sections in the First-time Setup Wizard. In the first section, you configure the basic
system settings for the NetScaler Gateway appliance including:

• NSIP address, SNIP address, and subnet mask
• Appliance host name
• DNS servers
• Time zone
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• Administrator password

In the second section, you install licenses. If you specify the address of a DNS server, you can use the
hardware serial number (HSN) or license activation code (LAC) to allocate your licenses, instead of
uploading your licenses from a local computer to the appliance.

Note: Citrix recommends saving your licenses to your local computer.

When you finish configuring these settings, NetScaler Gateway prompts you to restart the appliance.
When you log on to the appliance again, you can use other wizards and the configuration utility to
configure additional settings.

Configuring Settings with the Quick ConfigurationWizard

October 5, 2020

You can configure settings in NetScaler Gateway to enable communication with App Controller, Store-
Front, or Web Interface by using the Quick Configuration wizard. When you complete the configura-
tion, the wizard creates the correct policies for communication between NetScaler Gateway, App Con-
troller, StoreFront, or the Web Interface. These policies include authentication, session, and clientless
access policies. When the wizard completes, the policies are bound to the virtual server.

When you complete the Quick Configuration wizard, NetScaler Gateway can communicate with App
Controller or StoreFront, and users can access their Windows-based applications and virtual desktops
and web, SaaS, and mobile apps. Users can then connect directly to App Controller.

During the wizard, you configure the following settings:

• Virtual server name, IP address, and port
• Redirection from an unsecure to a secure port
• Certificates
• LDAP server
• RADIUS server
• Client certificate for authentication (only for two-factor authentication)
• App Controller, StoreFront, or Web Interface

The Quick Configuration wizard supports LDAP, RADIUS, and client certificate authentication. You can
configure two-factor authentication in the wizard by following these guidelines:

• If you select LDAP as your primary authentication type, you can configure RADIUS as the sec-
ondary authentication type.

• If you select RADIUS as your primary authentication type, you can configure LDAP as the sec-
ondary authentication type.
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• If you select client certificates as your primary authentication type, you can configure LDAP or
RADIUS as the secondary authentication type.

You cannot create multiple LDAP authentication policies by using the Quick Configuration wizard. For
example, you want to configure one policy that uses sAMAccountName in the Server Logon Name At-
tribute field and a second LDAP policy that uses the User Principal Name (UPN) in the Server Logon
Name Attribute field. To configure these separate policies, use the NetScaler Gateway configuration
utility to create the authentication policies. For more information, see Configuring LDAP Authentica-
tion.

You can configure certificates for NetScaler Gateway in the Quick Configuration wizard by using the
following methods:

• Select a certificate that is installed on the appliance.
• Install a certificate and private key.
• Select a test certificate.

Note: If you use a test certificate, you must add the fully qualified domain name (FQDN) that is
in the certificate.

You can open the Quick Configuration wizard in one of the following two ways:

• When you are on the NetScaler Gateway logon page and select NetScaler Gateway in Deploy-
ment Type, the Home tab appears. If you select any other option in Deployment Type, the Home
does not appear.

• From the link Create/Monitor NetScaler Gateway in the NetScaler Gateway details pane. The
link appears if you install a license that enables NetScaler features. If you license the appliance
for NetScaler Gateway only, the link does not appear.

After you initially run the wizard, you can run the wizard again to create additional virtual servers and
settings.

Important: If you use the Quick Configuration wizard to configure an additional NetScaler Gateway
virtual server, you must use an unique IP address. You cannot use the same IP address that is used on
an existing virtual server. For example, you have a virtual server with the IP address 192.168.10.5 with
a port number of 80. You run the Quick Configuration wizard to create a second virtual server with the
IP address 192.168.10.5 with port number 443. When you try to save the configuration, an error occurs.

To configure settings with the Quick Configuration wizard

1. In the configuration utility, do one of the following:
a) If the appliance is licensed for NetScaler Gateway only, click the Home tab.
b) If the appliance is licensed to include NetScaler features, on the Configuration tab, in the

navigation pane, click NetScaler Gateway and then in the details pane, under Getting
Started, click Configure NetScaler Gateway for Enterprise Store.
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2. In the dashboard, click Create New NetScaler Gateway.
3. In NetScaler Gateway Settings, configure the following:

a) In Name, type a name for the virtual server.
b) In IP address, type the IP address for the virtual server.
c) In Port, type the port number. The default port number is 443.
d) Select Redirect requests from port 80 to secure port to allow user connections from port

80 to go to port 443.
4. Click Continue.
5. On the Certificate page, do one of the following:

a) Click Choose Certificate and then in Certificate, select the certificate.
b) Click Install Certificate and then in Choose Certificate and in Choose Key, click Browse to

navigate to the certificate and private key.
c) Click Use Test Certificate and then in Certificate FQDN enter the fully qualified domain

name (FQDN) contained in the test certificate.
6. Click Continue.
7. In Authentication Settings, do the following:

a) In Primary Authentication, select LDAP, RADIUS, or Cert.
b) Select an authentication server or configure the settings for the authentication type you

selected in the previous step. If you select Cert, either select the client certificate or install
a new client certificate.

c) In Secondary Authentication, select the authentication type and then configure the au-
thentication server settings.

8. Click Continue.

When you finish configuring the network and authentication settings, you can then configure XenMo-
bile (App Controller) or XenApp / XenDesktop (StoreFront or Web Interface) settings.

Configuring Enterprise Store Settings

NetScaler Gateway supports user access to web, SaaS, and mobile apps and ShareFile only through
App Controller. If you also deploy StoreFront or the Web Interface, users have access to Windows-
based apps and virtual desktops. You can configure settings for the following options:

• App Controller only
• StoreFront only
• App Controller and StoreFront together
• Web Interface only

When you click Continue from the preceding procedure, you can then configure the settings for your
deployment scenario. The following procedures start on the Citrix Integration Settings page.

After you create the virtual server, editing the virtual server in the Quick Configuration wizard does not
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allow you to change XenMobile or XenApp/XenDesktop settings.

For example, if you cancel the configuration of a virtual server at any stage before configuring the Citrix
Enterprise Store settings, the wizard automatically selects the Web interface without configuring any
settings. When this situation occurs, you can edit the virtual server details for configuring the Web
Interface, but you cannot switch to XenMobile. To switch, you must create a new virtual server and
must not cancel the wizard at any time during the configuration. If you do not need the Web Interface
virtual server, you can delete it by using the Quick Configuration wizard.

To configure settings for StoreFront only

1. Click XenApp / XenDesktop.
2. In Deployment Type, select StoreFront.
3. In StoreFront FQDN, enter the fully qualified domain name (FQDN) of the StoreFront server.
4. In Receiver for Web Path, leave the default path or enter your own path.
5. Select HTTPS for secure user connections.
6. In Single Sign-on Domain, enter the domain for StoreFront.
7. In STA URL, enter the complete IP address or FQDN of the server running the Secure Ticket Au-

thority (STA) if you deploy StoreFront and provide access to published applications from XenApp
or virtual desktops from XenDesktop.

8. Click Done.

When users connect through NetScaler Gateway to StoreFront, users can start their apps and desktops
from either Receiver for Web or Receiver.

To configure settings for App Controller only

1. Click XenMobile.
2. In App Controller FQDN, enter the FQDN for App Controller.
3. Click Done.

To configure Web Interface settings

1. In the Quick Configuration wizard, click XenApp / XenDesktop.
2. In Deployment Type, select Web Interface and then configure the following:

a) In XenApp Site URL, type the complete IP address or FQDN of the Web Interface.
b) In XenApp Services Site URL, type the complete IP address or FQDN of the Web Interface

with the PNAgent Path. You can enter the default path or enter your own path.
c) In Single Sign-on Domain, enter the domain to use.
d) In STA URL, type the complete IP address or FQDN of the server running the STA.

3. Click Done.
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Configuring Settings by Using the NetScaler GatewayWizard

October 5, 2020

After you run the Setup Wizard, you can run the NetScaler Gateway wizard to configure additional
settings on NetScaler Gateway. You run the NetScaler Gateway wizard from the configuration utility.

NetScaler Gateway comes with a test certificate. If you do not have a signed certificate from a Certifi-
cate Authority (CA), you can use the test certificate when using the NetScaler Gateway wizard. When
you receive the signed certificate, you can remove the test certificate and install the signed certificate.
Citrix recommends obtaining the signed certificate before making NetScaler Gateway publicly avail-
able for users.

Note: You can create a Certificate Signing Request (CSR) from within the NetScaler Gateway wizard. If
you use the NetScaler Gateway wizard to create the CSR, you must exit from the wizard and then start
the wizard again when you receive the signed certificate from the CA. For more information about
certificates, see
Installing and Managing Certificates.

You can configure user connections for Internet Protocol version 6 (IPv6) in the NetScaler Gateway wiz-
ard when you configure a virtual server. For more information about using IPv6 for user connections,
see Configuring IPv6 for User Connections.

To start the NetScaler Gateway wizard

1. In the configuration utility, click the Configuration tab and then in the navigation pane, click
NetScaler Gateway.

2. In the details pane, under Getting Started, click NetScaler Gateway wizard.
3. Click Next and then follow the directions in the wizard.

Configuring the Host Name and FQDN on NetScaler Gateway

October 5, 2020

The host name is the name of the NetScaler Gateway appliance that is associated with the license file.
The host name is unique to the appliance and is used when you download the Universal license. You
define the host name when you run the Setup Wizard to configure NetScaler Gateway for the first time.

The fully qualified domain name (FQDN) is included in the signed certificate that is bound to a virtual
server. You do not configure the FQDN on NetScaler Gateway. One appliance can have a unique FQDN
assigned to each virtual server that is configured on NetScaler Gateway by using certificates.
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You can find the FQDN of a certificate by viewing the details of the certificate. The FQDN is located in
the subject field of the certificate.

To view the FQDN of a certificate

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand SSL and
then click Certificates.

2. In the details pane, select a certificate, click Action and then click Details.
3. In the Certificate Details dialog box, click Subject. The FQDN of the certificate appears in the list.

Installing and Managing Certificates

October 5, 2020

On NetScaler Gateway, you use certificates to create secure connections and to authenticate users.

To establish a secure connection, a server certificate is required at one end of the connection. A root
certificate of the Certificate Authority (CA) that issued the server certificate is required at the other end
of the connection.

• Server certificate. A server certificate certifies the identity of the server. NetScaler Gateway
requires this type of digital certificate.

• Root certificate. A root certificate identifies the CA that signed the server certificate. The root
certificate belongs to the CA. A user device requires this type of digital certificate to verify the
server certificate.

When establishing a secure connection with a web browser on the user device, the server sends its
certificate to the device.

When the user device receives a server certificate, the web browser, such as Internet Explorer checks
to see which CA issued the certificate and if the CA is trusted by the user device. If the CA is not trusted,
or if it is a test certificate, the web browser prompts the user to accept or decline the certificate (effec-
tively accepting or declining the ability to access the site).

NetScaler Gateway supports the following three types of certificates:

• A test certificate that is bound to a virtual server and can also be used for connections to a server
farm. NetScaler Gateway comes with a pre-installed test certificate.

• A certificate in PEM or DER format that is signed by a CA and is paired with a private key.
• A certificate in PKCS#12 format that is used for storing or transporting the certificate and private

key. The PKCS#12 certificate is typically exported from an existing Windows certificate as a PFX
file and then installed on NetScaler Gateway.

Citrix recommends using a certificate signed by a trusted CA, such as Thawte or VeriSign.
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Creating a Certificate Signing Request

October 5, 2020

To provide secure communications using SSL or TLS, a server certificate is required on NetScaler Gate-
way. Before you can upload a certificate to NetScaler Gateway, you need to generate a Certificate Sign-
ing Request (CSR) and private key. You use the Create Certificate Request included in the NetScaler
Gateway wizard or the configuration utility to create the CSR. The Create Certificate Request creates
a .csr file that is emailed to the Certificate Authority (CA) for signing and a private key that remains
on the appliance. The CA signs the certificate and returns it to you at the email address you provided.
When you receive the signed certificate, you can install it on NetScaler Gateway. When you receive the
certificate back from the CA, you pair the certificate with the private key.

Important: When you use the NetScaler Gateway wizard to create the CSR, you must exit the wizard
and wait for the CA to send you the signed certificate. When you receive the certificate, you can run the
NetScaler Gateway wizard again to create the settings and install the certificate. For more information
about the NetScaler Gateway wizard, see
Configuring Settings by Using the NetScaler Gateway Wizard.

To create a CSR by using the NetScaler Gateway wizard

1. In the configuration utility, click the Configuration tab and then in the navigation pane, click
NetScaler Gateway.

2. In the details pane, under Getting Started, click NetScaler Gateway wizard.
3. Follow the directions in the wizard until you come to the Specify a server certificate page.
4. Click Create a Certificate Signing Request and complete the fields.

Note: The fully qualified domain name (FQDN) does not need to be the same as the NetScaler
Gateway host name. The FQDN is used for user logon.

5. Click Create to save the certificate on your computer and then click Close.
6. Exit the NetScaler Gateway wizard without saving your settings.

To create a CSR by using the NetScaler GUI

You can also use the NetScaler GUI to create a CSR, without running the NetScaler Gateway wizard.

1. Navigate to Traffic Management > SSL > SSL Files and select Create Certificate Signing Re-
quest (CSR).

2. Complete the settings for the certificate and then click Create.

After you create the certificate and private key, email the certificate to the CA, such as Thawte or
Verisign.

For detailed procedure, see Create a certificate.
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Installing the Signed Certificate on NetScaler Gateway

October 5, 2020

When you receive the signed certificate from the Certificate Authority (CA), pair it with the private key
on the appliance and then install the certificate on NetScaler Gateway.

To pair the signed certificate with a private key

1. Copy the certificate to NetScaler Gateway to the folder nsconfig/ssl by using a Secure Shell (SSH)
program such as WinSCP.

2. In the configuration utility, on the Configuration tab, in the navigation pane, expand SSL and
then click Certificates.

3. In the details pane, click Install.
4. In Certificate-Key Pair Name, type the name of the certificate.
5. In Certificate File Name, select the drop-down box in Browse and then click Appliance.
6. Navigate to the certificate, click Select and then click Open.
7. In Private Key File Name, select the drop-down box in Browse and then click Appliance. The

name of the private key is the same name as the Certificate Signing Request (CSR). The private
key is located on NetScaler Gateway in the directory \nsconfig\ssl.

8. Choose the private key and then click Open.
9. If the certificate is PEM-format, in Password, type the password for the private key.

10. If you want to configure notification for when the certificate expires, select Notifies When Ex-
pires.

11. In Notification Period, type the number of days, click Create and then click Close.

To bind the certificate and private key to a virtual server

After you create and link a certificate and private key pair, bind it to a virtual server.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Virtual Servers.

2. In the details pane, click a virtual server and then click Open.
3. On the Certificates tab, under Available, select a certificate, click Add and then click OK.

To unbind test certificates from the virtual server

After you install the signed certificate, unbind any test certificates that are bound to the virtual server.
You can unbind test certificates using the configuration utility.

© 1999-2021 Citrix Systems, Inc. All rights reserved. 73



NetScaler Gateway 12.0

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Virtual Servers.

2. In the details pane, click a virtual server and then click Open.
3. On the Certificates tab, under Configured, select the test certificate and then click Remove.

Configuring Intermediate Certificates

October 5, 2020

An intermediate certificate is a certificate that goes between NetScaler Gateway (the server certificate)
and a root certificate (usually installed on the user device). An intermediate certificate is part of a
chain.

Some organizations delegate the responsibility for issuing certificates to resolve the issue of geograph-
ical separation between organization units, or to apply different issuing policies to different sections
of the organization.

Responsibility for issuing certificates can be delegated by setting up subordinate Certificate Authori-
ties (CAs). CAs can sign their own certificates (that is, they are self-signed) or they can be signed by
another CA. The X.509 standard includes a model for setting up a hierarchy of CAs. In this model, as
shown in the following figure, the root CA is at the top of the hierarchy and is a self-signed certificate by
the CA. The CAs that are directly subordinate to the root CA have CA certificates signed by the root CA.
CAs under the subordinate CAs in the hierarchy have their CA certificates signed by the subordinate
CAs.

Figure 1. The X.509 model showing the hierarchical structure of a typical digital certificate chain
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If a server certificate is signed by a CA with a self-signed certificate, the certificate chain is composed
of exactly two certificates: the end entity certificate and the root CA. If a user or server certificate is
signed by an intermediate CA, the certificate chain is longer.

The following figure shows that the first two elements are the end entity certificate (in this case,
gwy01.company.com) and the certificate of the intermediate CA, in that order. The intermediate CA’s
certificate is followed by the certificate of its CA. This listing continues until the last certificate in the
list is for a root CA. Each certificate in the chain attests to the identity of the previous certificate.

Figure 2. A typical digital certificate chain
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To install an intermediate certificate

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand SSL and
then click Certificates.

2. In the details pane, click Install.
3. In Certificate-Key Pair Name, type the name of the certificate.
4. Under Details, in Certificate File Name, click Browse (Appliance) and in the drop-down box, se-

lect Local or Appliance.
5. Navigate to the certificate on your computer (Local) or on NetScaler Gateway (Appliance).
6. In Certificate Format, select PEM.
7. Click Install and then click Close.

When you install an intermediate certificate on NetScaler Gateway, you do not need to specify the
private key or a password.

After the certificate is installed on the appliance, the certificate needs to be linked to the server certifi-
cate.

To link an intermediate certificate to a server certificate

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand SSL and
then click Certificates.

2. In the details pane, select the server certificate and then in Action, click Link.
3. Next to CA Certificate Name, select the intermediate certificate from the list and then click OK.

Using Device Certificates for Authentication

October 5, 2020

Citrix Gateway supports the device certificate check that enables you to bind the device identity to a
certificate’s private key. The device certificate check can be configured as part of classic or advanced
Endpoint Analysis (EPA) policies. In classic EPA policies, the device certificate can be configured only
for preauthentication EPA.
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Citrix Gateway verifies the device certificate before the endpoint analysis scan runs or before the logon
page appears. If you configure endpoint analysis, the endpoint scan runs to verify the user device.
When the device passes the scan and after Citrix Gateway verifies the device certificate, users can then
log on to the NetScaler Gateway.

Important:

• By default, Windows mandates admin privileges for accessing device certificates.
• To add a device certificate check for non-admin users, you must install the VPN plug-in. The

VPN plug-in version must be the same version as the EPA plug-in on the device.
• If you install two or more device certificates on Citrix Gateway, users must select the correct

certificate when they start to log on to Citrix Gateway or before the endpoint analysis scan
runs.

• When you create the device certificate, it must be an X.509 certificate.
• If you have a device certificate issued by an intermediate CA, then both intermediate and

root CA certificates must be bound.
• The EPA client needs the user to have local administrator rights to be able to access the ma-

chine certificate store. This is rarely the case, so a workaround is to install the full NetScaler
Gateway plug-in which can access the local store.

For more information about creating device certificates, see the following:

• Network Device Enrollment Service (NDES) in Active Directory Certificate Services (AD CS) on
the Microsoft website.

• How to request a certificate from a Microsoft Certificate Authority using DCE/RPC and the Active
Directory Certificate profile payload on the Apple support website.

• iPad / iPhone Certificate Issuance on the Ask the Directory Services Team Microsoft support
blog.

• Setting Up Network Device Enrollment Service on the Windows IT Pro website.
• Step-by-Step Example Deployment of the PKI Certificates for Configuration Manager: Windows

Server 2008 Certification Authority - http://technet.microsoft.com/en-us/library/gg682023.
aspx on the Microsoft System Center website.

Steps to configure device certificates

To configure a device certificate, you must complete the following steps:

• Install the device certificate issuer’s certificate authority certificate on Citrix Gateway. For de-
tails, see Installing the Signed Certificate on Citrix Gateway.

• Bind the device certificate issuer’s certificate authority certificate to the Citrix Gateway virtual
server and enable OCSP check. For details, see Installing the Signed Certificate on Citrix Gate-
way.
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• Create and bind OCSP (responder) on device certificate issuer’s certificate authority certificate.
For details, see Monitor certificate status with OCSP.

Enable device certificate check on the virtual server and add device certificate issuer’s certificate au-
thority certificate to the device certificate checklist. For details, see Enable device certificate check on
a virtual server for classic EPA policy.

Complete the client-side configuration and verification of device certificate on the Windows machine.
For details, see Verification of device certificate on a Windows machine.

Note: All the clients intended to avail the device certificate EPA check must have the device certificate
installed in the system certificate store of the machine.

Enable device certificate check on a virtual server for classic EPA policy

After you create the device certificate, you install the certificate on Citrix Gateway by using the proce-
dure for Importing and Installing an Existing Certificate to Citrix Gateway.

1. On the Configuration tab, navigate to Citrix Gateway > Virtual Servers.
2. On the Citrix Gateway Virtual Servers page, select an existing virtual server and click Edit.
3. On the VPN Virtual Servers page, under Basic Settings section, click Edit.
4. Clear the Enable Authentication box to disable authentication.
5. Select the Enable Device Certificate box to enable device certificate
6. Click Add to add an available device certificate issuer’s CA certificate name to the list.
7. For binding a CA certificate to the virtual server, click CA certificate under the CA for Device

Certificate section, click Add, select the certificate, and then click +.

Verification of device certificate on aWindowsmachine

1. Open a browser and access the Citrix Gateway FQDN.

2. Allow the Citrix End Point Analysis (EPA) client to run. If not already installed then install EPA.

Citrix EPA runs and validates the Device Certificate and redirects to the authentication page if
the Device Certificate EPA check passes, else it redirects you to the EPA error page. In case you
have other EPA checks, then the EPA scan results depend on the configured EPA checks.

For further debugging on the client, examine the following EPA logs on the client:
C:\Users<User name>\AppData\Local\Citrix\AGEE\nsepa.txt

Note: Device certificate verification with CRL is not supported.
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Importing and Installing an Existing Certificate

October 5, 2020

You can import an existing certificate from a Windows-based computer running Internet Information
Services (IIS) or from a computer running the Secure Gateway.

When you export the certificate, make sure you also export the private key. In some cases, you cannot
export the private key, which means you cannot install the certificate on NetScaler Gateway. If this
occurs, use the Certificate Signing Request (CSR) to create a new certificate. For details, see Creating
a Certificate Signing Request.

When you export a certificate and private key from Windows, the computer creates a Personal Infor-
mation Exchange (.pfx) file. This file is then installed on NetScaler Gateway as a PKCS#12 certificate.

If you are replacing the Secure Gateway with NetScaler Gateway, you can export the certificate and
private key from the Secure Gateway. If you are doing an in-place migration from the Secure Gateway
to NetScaler Gateway, the fully qualified domain name (FQDN) on the application and the appliance
must be the same. When you export the certificate from the Secure Gateway, you immediately retire
the Secure Gateway, install the certificate on NetScaler Gateway, and then test the configuration. The
Secure Gateway and NetScaler Gateway cannot be running on your network at the same time if they
have the same FQDN.).

If you are using Windows Server 2003 or Windows Server 2008, you can use the Microsoft Management
Console to export the certificate. For more information, see the Windows online Help.

Leave the default values for all the other options, define a password, and save the .pfx file to your
computer. When the certificate is exported, you then install it on NetScaler Gateway.

To install the certificate and private key on NetScaler Gateway

1. In the configuration utility, click the Configuration tab and then in the navigation pane, click
NetScaler Gateway.

2. In the details pane, under Getting Started, click NetScaler Gateway wizard.

3. Click Next, select an existing virtual server and then click Next.

4. In Certificate Options, select Install a PKCS#12 (.pfx) file.

5. In PKCS#12 File Name, click Browse, navigate to the certificate and then click Select.

6. In Password, type the password for the private key.

This is the password you used when converting the certificate to PEM format.

7. Click Next to finish the NetScaler Gateway wizard without changing any other settings.
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When the certificate is installed on NetScaler Gateway, the certificate appears in the configuration
utility in the SSL > Certificates node.

To create a private Key

1. In the configuration utility, on the Configuration tab, in the navigation pane, click SSL.

2. In the details pane, under SSL Keys, click Create RSA Key.

3. In Key Filename, type the name of the private key or click Browse to navigate to an existing file.

4. In Key Size (Bits), type the size of the private key.

5. In Public Exponent Value, select F4 or 3.

The public exponent value for the RSA key. This is part of the cipher algorithm and is required
for creating the RSA key. The values are F4 (Hex: 0x10001) or 3 (Hex: 0x3). The default is F4.

6. In Key Format, select PEM or DER. Citrix recommends PEM format for the certificate.

7. In PEM Encoding Algorithm, select DES or DES3.

8. In PEM Passphrase and Verify Passphrase, type the password, click Create and then click Close.

Note: To assign a passphrase, the
Key Format must be PEM and you must select the encoding algorithm.

To create a DSA private key in the configuration utility, click Create DSA Key. Follow the same steps
above to create the DSA private key.

Certificate Revocation Lists

October 5, 2020

From time to time, Certificate Authorities (CAs) issue certificate revocation lists (CRLs). CRLs contain
information about certificates that can no longer be trusted. For example, suppose Ann leaves XYZ
Corporation. The company can place Ann’s certificate on a CRL to prevent her from signing messages
with that key.

Similarly, you can revoke a certificate if a private key is compromised or if that certificate expired and
a new one is in use. Before you trust a public key, make sure that the certificate does not appear on a
CRL.

NetScaler Gateway supports the following two CRL types:

• CRLs that list the certificates that are revoked or are no longer valid
• Online Certificate Status Protocol (OSCP), an Internet protocol used for obtaining the revocation

status of X.509 certificates
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To add a CRL

Before you configure the CRL on the NetScaler Gateway appliance, make sure that the CRL file is stored
locally on the appliance. In the case of a high availability setup, the CRL file must be present on both
NetScaler Gateway appliances, and the directory path to the file must be the same on both appliances.

If you need to refresh the CRL, you can use the following parameters:

• CRL Name: The name of the CRL being added on the NetScaler. Maximum 31 characters.
• CRL File: The name of the CRL file being added on the NetScaler. The NetScaler looks for the

CRL file in the /var/netscaler/ssl directory by default. Maximum 63 characters.
• URL: Maximum 127 characters
• Base DN: Maximum 127 characters
• Bind DN: Maximum 127 characters
• Password: Maximum 31 characters
• Day(s): Maximum 31

1. In the configuration utility, on the Configuration tab, expand SSL and then click on CRL.
2. In the details pane, click Add.
3. In the Add CRL dialog box, specify the values for the following:

• CRL Name
• CRL File
• Format (optional)
• CA Certificate (optional)

4. ClickCreateand then clickClose. In the CRL details pane, select the CRL that you just configured
and verify that the settings that appear at the bottom of the screen are correct.

To configure CRL autorefresh by using LDAP or HTTP in the configuration utility

A CRL is generated and published by a CA periodically or, in some cases, immediately after a particular
certificate is revoked. Citrix recommends that you update CRLs on the NetScaler Gateway appliance
regularly for protection against clients trying to connect with certificates that are not valid.

The NetScaler Gateway appliance can refresh CRLs from a web location or an LDAP directory. When
you specify refresh parameters and a web location or an LDAP server, the CRL does not have to be
present on the local hard disk drive at the time you run the command. The first refresh stores a copy
on the local hard disk drive, in the path specified by the CRL File parameter. The default path for
storing the CRL is /var/netscaler/ssl.

CRL Refresh Parameters

• CRL Name

The name of the CRL being refreshed on the NetScaler Gateway.
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• Enable CRL Auto Refresh

Enable or disable CRL auto refresh.

• CA Certificate

The certificate of the CA that has issued the CRL. This CA certificate must be installed on the
appliance. The NetScaler can update CRLs only from CAs whose certificates are installed on it.

• Method

Protocol in which to obtain the CRL refresh from a web server (HTTP) or an LDAP server. Possible
Values: HTTP, LDAP. Default: HTTP.

• Scope

The extent of the search operation on the LDAP server. If the scope specified is
Base, the search is at the same level as the base DN. If the scope specified is
One, the search extends to one level below the base DN.

• Server IP

The IP address of the LDAP server from which the CRL is retrieved. Select IPv6 to use an IPv6 IP
address.

• Port

The port number on which the LDAP or the HTTP server communicates.

• URL

The URL for the web location from which the CRL is retrieved.

• Base DN

The base DN used by the LDAP server to searchfor the CRL attribute.
Note: Citrix recommends using the base DN attribute instead of the Issuer-Name from the CA
certificate to search for the CRL in the LDAP server. The Issuer-Name field may not exactly match
the LDAP directory structure’s DN.

• Bind DN

The bind DN attribute used to access the CRL object in the LDAP repository. The bind DN at-
tributes are the administrator credentials for the LDAP server. Configure this parameter to re-
strict unauthorized access to the LDAP servers.

• Password

The administrator password used to access the CRL object in the LDAP repository. This is re-
quired if the access to the LDAP repository is restricted, that is, anonymous access is not al-
lowed.
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• Interval

The interval at which the CRL refresh should be carried out. For an instantaneous CRL refresh,
specify the interval as NOW. Possible values: MONTHLY, DAILY, WEEKLY, NOW, NONE.

• Days

The day on which CRL refresh should be performed. The option is not available if interval is set
to DAILY.

• Time

The exact time in 24-hour format when the CRL refresh should be performed.

• Binary

Set the LDAP-based CRL retrieval mode to binary. Possible values: YES, NO. Default: NO.

1. In the navigation pane, expand SSL and then click CRL.
2. Select the configured CRL for which you want to update refresh parameters and then click Open.
3. Select the Enable CRL Auto Refresh option.
4. In the CRL Auto Refresh Parameters group, specify values for the following parameters:

Note: An asterisk (*) indicates a required parameter.
• Method
• Binary
• Scope
• Server IP
• Port*
• URL
• Base DN*
• Bind DN
• Password
• Interval
• Day(s)
• Time

5. Click Create. In the CRL pane, select the CRL that you just configured and verify that the settings
that appear at the bottom of the screen are correct.

Monitoring Certificate Status with OCSP

October 5, 2020

Online Certificate Status Protocol (OCSP) is an Internet protocol that is used to determine the status
of a client SSL certificate. NetScaler Gateway supports OCSP as defined in RFC 2560. OCSP offers
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significant advantages over certificate revocation lists (CRLs) in terms of timely information. Up-to-
date revocation status of a client certificate is especially useful in transactions involving large sums
of money and high-value stock trades. It also uses fewer system and network resources. NetScaler
Gateway implementation of OCSP includes request batching and response caching.

NetScaler Gateway Implementation of OCSP

OCSP validation on an NetScaler Gateway appliance begins when NetScaler Gateway receives a client
certificate during an SSL handshake. To validate the certificate, NetScaler Gateway creates an OCSP
request and forwards it to the OCSP responder. To do so, NetScaler Gateway either extracts the URL
for the OCSP responder from the client certificate or uses a locally configured URL. The transaction is
in a suspended state until NetScaler Gateway evaluates the response from the server and determines
whether to allow the transaction or to reject it. If the response from the server is delayed beyond the
configured time and no other responders are configured, NetScaler Gateway allows the transaction or
displays an error, depending on whether you set the OCSP check to optional or mandatory. NetScaler
Gateway supports batching of OCSP requests and caching of OCSP responses to reduce the load on
the OCSP responder and provide faster responses.

OCSP Request Batching

Each time NetScaler Gateway receives a client certificate, it sends a request to the OCSP responder.
To help avoid overloading the OCSP responder, NetScaler Gateway can query the status of more than
one client certificate in the same request. For request batching to work efficiently, you need to define
a time-out so that processing of a single certificate is not delayed while waiting to form a batch.

OCSP Response Caching

Caching of responses received from the OCSP responder enables faster responses to the user and
reduces the load on the OCSP responder. Upon receiving the revocation status of a client certificate
from the OCSP responder, NetScaler Gateway caches the response locally for a predefined length of
time. When a client certificate is received during an SSL handshake, NetScaler Gateway first checks
its local cache for an entry for this certificate. If an entry is found that is still valid (within the cache
time-out limit), the entry is evaluated and the client certificate is accepted or rejected. If a certificate
is not found, NetScaler Gateway sends a request to the OCSP responder and stores the response in its
local cache for a configured length of time.

Configuring OCSP Certificate Status

October 5, 2020
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Configuring Online Certificate Status Protocol (OCSP) involves adding an OCSP responder, binding the
OCSP responder to a signed certificate from a Certificate Authority (CA), and binding the certificate and
private key to a Secure Sockets Layer (SSL) virtual server. If you need to bind a different certificate and
private key to an OCSP responder that you already configured, you need to first unbind the responder
and then bind the responder to a different certificate.

To configure OCSP

1. On the Configuration tab, in the navigation pane, expand SSL and then click OCSP Responder.

2. In the details pane, click Add.

3. In Name, type a name for the profile.

4. In URL, type the web address of the OCSP responder.

This field is mandatory. The Web address cannot exceed 32 characters.

5. To cache the OCSP responses, click Cache and in Time-out, type the number of minutes that
NetScaler Gateway holds the response.

6. Under Request Batching, click Enable.

7. In Batching Delay, specify the time, in milliseconds, allowed for batching a group of OCSP re-
quests.

The values can be from 0 through 10000. The default is 1.

8. In Produced At Time Skew, type the amount of time NetScaler Gateway can use when the appli-
ance needs to check or accept the response.

9. Under Response Verification, select Trust Responses if you want to disable signature checks by
the OCSP responder.

If you enable Trust Responses, skip Step 8 and Step 9.

10. In Certificate, select the certificate that is used to sign the OCSP responses.

If a certificate is not selected, the CA that the OCSP responder is bound to is used to verify re-
sponses.

11. In Request Time-out, type the number of milliseconds to wait for an OCSP response.

This time includes the Batching Delay time. The values can be from 0 through 120000. The
default is 2000.

12. In Signing Certificate, select the certificate and private key used to sign OCSP requests. If you
do not specify a certificate and private key, the requests are not signed.

13. To enable the number used once (nonce) extension, select Nonce.
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14. To use a client certificate, click Client Certificate Insertion.

15. Click Create and then click Close.

Testing Your NetScaler Gateway Configuration

October 5, 2020

After you configure the initial settings on NetScaler Gateway, you can test your settings by connecting
to the appliance.

To test the NetScaler Gateway settings, create a local user account. Then, using either the virtual
server IP address or the fully qualified domain name (FQDN) of the appliance, open a web browser and
type the web address. For example, in the address bar, type https://my.company.com or https:
//192.168.96.183.

At the logon screen, enter the user name and password of the user account you created earlier. After
you log on, you are prompted to download and install the NetScaler Gateway Plug-in.

After you install and then successfully connect with the NetScaler Gateway Plug-in, the Access Inter-
face appears. The Access Interface is the default home page for NetScaler Gateway.

Creating a new user account by using the configuration utility

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway > User Administration, and then click AAA Users.

2. In the details pane, click Add.
3. In User Name, type the user name.
4. If using local authentication, clear the External Authentication check box. Authenticating users

with external authentication types, such as LDAP or RADIUS, is the default. If you clear this check
box, NetScaler Gateway authenticates users.

5. In Password and Confirm Password, type the password for the user, click Create and then click
Close.

When you add users by using the configuration utility, you can bind the following policies to the user:

• Authorization
• Traffic, session, and auditing
• Bookmarks
• Intranet applications
• Intranet IP addresses

If you have problems logging on with the test user account, check the following:
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• If you receive a certificate warning, either a test certificate or an invalid certificate is installed
on NetScaler Gateway. If a certificate signed by a Certificate Authority (CA) is installed on the
appliance, make sure that there is a corresponding root certificate on the user device.

• If you used a CA-signed certificate, verify that you generated the site certificate correctly by using
the signed Certificate Signing Request (CSR), and that the Distinguished Name (DN) data entered
in the CSR is accurate. The problem may also be that the host name does not match the IP
address that is on the signed certificate. Check that the configured certificate’s common name
corresponds to the configured virtual server IP address information.

• If the logon screen does not appear or if any other error message appears, review the setup pro-
cess and confirm that you performed all steps correctly and entered all parameters accurately.

Creating Virtual Servers

October 5, 2020

A virtual server is an access point to which users log on. Each virtual server has its own IP address, cer-
tificate, and policy set. A virtual server consists of a combination of an IP address, port, and protocol
that accepts incoming traffic. Virtual servers contain the connection settings for when users log on to
the appliance. You can configure the following settings on virtual servers:

• Certificates
• Authentication
• Policies
• Bookmarks
• Address pools (also known as IP pools or intranet IPs)
• Double-hop DMZ deployment with NetScaler Gateway
• Secure Ticket Authority
• SmartAccess ICA Proxy Session Transfer

If you run the NetScaler Gateway wizard, you can create a virtual server during the wizard. You can
configure additional virtual servers in the following ways:

• From the virtual servers node. This node is on the navigation pane in the configuration utility.
You can add, edit, and remove virtual servers by using the configuration utility.

• With the Quick Configuration wizard. If you deploy App Controller, StoreFront or the Web
Interface in your environment, you can use the Quick Configuration wizard to create the virtual
server and all of the policies needed for your deployment.

If you want users to log on and use a specific authentication type, such as RADIUS, you can configure
a virtual server and assign the server a unique IP address. When users log on, they are directed to the
virtual server and then prompted for their RADIUS credentials.
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You can also configure the ways users log on to NetScaler Gateway. You can use a session policy to
configure the type of user software, the access method, and the home page users see after logging on.

To create virtual servers

October 5, 2020

You can add, modify, enable or disable, and remove virtual servers by using the NetScaler Gateway
GUI or the Quick Configuration wizard. For more information about configuring a virtual server with
the Quick Configuration wizard, see
Configuring Settings with the Quick Configuration Wizard.

To create a virtual server by using the GUI

1. On the Configuration tab, Navigate to NetScaler Gateway > Virtual Servers.
2. In the details pane, click Add.
3. Configure the settings as per your requirement.
4. Click Create and then click Close.

To create a virtual server by using the CLI

At the command prompt, type;

1 add vpn vserver <name> <serviceType> [<IPAddress> [<port>]

Example:

1 add vpn vserver gatewayserver SSL 1.1.1.1 443

Configuring Connection Types on the Virtual Server

October 5, 2020

When you create and configure a virtual server, you can configure the following connection options:

• Connections with Citrix Receiver only to XenApp or XenDesktop without SmartAccess, endpoint
analysis, or network layer tunneling features.
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• Connections with the NetScaler Gateway Plug-in and SmartAccess, which allows the use of
SmartAccess, endpoint analysis, and network layer tunneling functions.

• Connections with Worx Home that establishes a Micro VPN connection from mobile devices to
NetScaler Gateway.

• Parallel connections made over the ICA session protocol by a user from multiple devices. The
connections are migrated to a single session to prevent the use of multiple Universal licenses.

If you want users to log on without user software, you can configure a clientless access policy and bind
it to the virtual server.

To configure Basic or SmartAccess connections on a virtual server

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Virtual Servers.

2. In the details pane, click Add.
3. In Name, type a name for the virtual server.
4. In IP Address and Port, type the IP address and port number for the virtual server.
5. Do one of the following:

• To allow ICA connections only, click Basic Mode.
• To allow user logon with Worx Home, the NetScaler Gateway Plug-in and SmartAccess,

click SmartAccess Mode.
• To allow SmartAccess to manage ICA Proxy sessions for multiple user connections, click

ICA Proxy Session Migration.
6. Configure the other settings for the virtual server, click Create and then click Close.

Configuring a Listen Policy for Wildcard Virtual Servers

October 5, 2020

You can configure NetScaler Gateway virtual servers to restrict the ability for a virtual server to listen
on a specific virtual local area network (VLAN). You can create a wildcard virtual server with a listen
policy that restricts it to processing traffic on the specified VLAN.

The configuration parameters are:
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Parameter Description

Name The name of the virtual server. The name is
required and you cannot change it after you
create the virtual server. The name cannot
exceed 127 characters and the first character
must be a number or letter. You can also use
the following characters: at symbol (@),
underscore (_), dash (-), period (.), colon (:),
pound sign (#), and a space.

IP The IP address of the virtual server. For a
wildcard virtual server bound to the VLAN, the
value is always *.

Type The behavior of the service. Your choices are
HTTP, SSL, FTP, TCP, SSL_TCP, UDP,
SSL_BRIDGE, NNTP, DNS, ANY, SIP-UDP,
DNS-TCP, and RTSP.

Port The port on which the virtual server listens for
user connections. The port number must be
between 0 and 65535. For the wildcard virtual
server bound to a VLAN, the value is usually *.

Listen Priority The priority that is assigned to the listen policy.
Priority is evaluated in reverse order; the lower
the number, the higher the priority assigned to
the listen policy.

Listen Policy Rule The policy rule to use to identify the VLAN to
which the virtual server should listen. The rule
is: CLIENT.VLAN.ID.EQ (<ipaddressat>) For
<ipaddressat>, substitute the ID number
assigned to the VLAN.

To create a wildcard virtual server with a listen policy

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Virtual Servers.

2. In the details pane, click Add.
3. In Name, type a name for the virtual server.
4. In Protocol, select the protocol.
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5. In IP Address, type the IP address for the virtual server.
6. In Port, type the port for the virtual server.
7. On the Advanced tab, under Listen Policy, in Listen Priority, type the priority for the listen policy.
8. Next to Listen Policy Rule, click Configure.
9. In the Create Expression dialog box, click Add, configure the expression and then click OK.

10. Click Create and then click Close.

Configuring IP Addresses on NetScaler Gateway

October 5, 2020

You can configure IP addresses to log on to the configuration utility and for user connections.
NetScaler Gateway is configured with a default IP address of 192.168.100.1 and subnet mask of
255.255.0.0 for management access. The default IP address is used whenever a user-configured value
for the system IP (NSIP) address is absent.

• NSIP address. The management IP address for NetScaler Gateway that is used for all
management-related access to the appliance. NetScaler Gateway also uses the NSIP address
for authentication.

• Default gateway. The router that forwards traffic from outside the secure network to NetScaler
Gateway.

• Subnet IP (SNIP) address. The IP address that represents the user device by communicating
with a server on a secondary network.

The SNIP address uses ports 1024 through 64000.

HowNetScaler Gateway Uses IP Addresses

NetScaler Gateway sources traffic from IP addresses based on the function that is occurring. The fol-
lowing list describes several functions and the way NetScaler Gateway uses IP addresses for each, as
a general guideline:

• Authentication. The IP address that NetScaler Gateway uses depends on the authentication
server type.

– LDAP/RADIUS/TACACS servers. If AAAD directly communicates with the authentication vir-
tual server, then NSIP address is used.

– If a load balancer is used as proxy, then the load balancer uses the SNIP address for au-
thentication. AAAD uses the NSIP address to communicate with the load balancer. The
IP address that the NetScaler uses depends on the entity that is communicating with the
authentication virtual server.

– SAML/OAUTH/WEBAUTH servers: These servers communicate using the SNIP address.
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• File transfers from the home page. NetScaler Gateway uses the SNIP address.
• DNS andWINS queries. NetScaler Gateway uses the SNIP address.
• Network traffic to resources in thesecurenetwork. NetScaler Gateway uses the SNIP address

or IP pooling, depending on the configuration on NetScaler Gateway.
• ICA proxy setting. NetScaler Gateway uses the SNIP address.

Changing or Deleting Mapped IP Addresses

October 5, 2020

NetScaler Gateway supports one mapped IP address. If you configure one mapped IP address on the
appliance, you cannot change or delete the address. If you need to change the mapped IP address,
you first create a new mapped IP address and then delete the original mapped IP address.

You can use either the Setup Wizard or the Network node in the configuration utility to configure ad-
ditional mapped IP addresses.

To create a newmapped IP address

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System >
Network, and then click IPs.

2. In the details pane, click Add.
3. In the Create IP dialog box, in IP Address, type the IP address.
4. In Netmask, type the subnet mask.
5. Under IP Type, select Mapped IP and then click Create.

To delete amapped IP address

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System >
Network, and then click IPs.

2. In the details pane, click the mapped address and then click Remove.

Configuring Subnet IP Addresses

October 5, 2020

The subnet IP address allows the user to connect to NetScaler Gateway from an external host that
resides on another subnet. When you add a subnet IP address, a corresponding route entry is made
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in the route table. Only one entry is made per subnet. The route entry corresponds to the first IP
address added in the subnet.

Unlike the system IP address and the mapped IP address, it is not mandatory to specify the subnet IP
address during initial configuration of NetScaler Gateway.

The mapped IP address and subnet IP addresses use ports 1024 through 64000.

To add a subnet IP address

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System >
Network, and then click IPs.

2. In the details pane, click Add.
3. In the Create IP dialog box, in IP Address, type the IP address.
4. In Netmask, type the subnet mask.
5. Under IP Type, select Subnet IP, click Close and then click Create.

Configuring IPv6 for User Connections

October 5, 2020

You can configure NetScaler Gateway to listen for user connections by using Internet Protocol version
6 (IPv6). When you configure one of the following settings, you can select the IPv6 check box and then
enter the IPv6 address in the dialog box:

• Global Settings - Published Applications - ICA Proxy
• Global Authentication - Radius
• Global Authentication - LDAP
• Global Authentication - TACACS
• Session Profile - Published Applications - ICA Proxy
• NetScaler Gateway Virtual Servers
• Create Authentication Server - Radius
• Create Authentication Server - LDAP
• Create Authentication Server - TACACS
• Create Auditing Server
• High Availability Setup
• Bind / Unbind Route Monitors for High Availability
• Virtual server (Load Balancing)

When you configure the NetScaler Gateway virtual server to listen on an IPv6 address, users can con-
nect only with Citrix Receiver. User connections with the NetScaler Gateway Plug-in are not supported
with IPv6.
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You can use the following guidelines for configuring IPv6 on NetScaler Gateway:

• XenApp and Web Interface. When you configure IPv6 for user connections and if there is a
mapped IP address that uses IPv6, XenApp and Web Interface servers can also use IPv6. The Web
Interface must be installed behind NetScaler Gateway. When users connect through NetScaler
Gateway, the IPv6 address is translated to IPv4. When the connection returns, the IPv4 address
is translated to IPv6.

• Virtual servers. You can configure IPv6 for a virtual server when you run the NetScaler Gateway
wizard. In the NetScaler Gateway wizard on the Virtual Servers page, click IPv6 and enter the IP
address. You can only use configure an IPv6 address for a virtual server by using the NetScaler
Gateway wizard.

• Other. To configure IPv6 for ICA Proxy, authentication, auditing, and high availability, select the
IPv6 check box in the dialog box and then type the IP address.

Resolving DNS Servers Located in the Secure Network

October 5, 2020

If your DNS server is located in the secure network behind a firewall and the firewall is blocking ICMP
traffic, you cannot test connections to the server because the firewall is blocking the request. You can
resolve this issue by doing the following steps:

• Creating a DNS service with a custom DNS Monitor that resolves to a known fully qualified do-
main name (FQDN).

• Creating a non-directly addressable DNS virtual server on NetScaler Gateway.
• Binding the service to the virtual server.

Note:

• Configure a DNS virtual server and DNS service only if your DNS server is located behind a fire-
wall.

• If you install a NetScaler load balancing license on the appliance, the Virtual Servers and Ser-
vices node does not appear in the navigation pane. You can perform this procedure by expand-
ing Load Balancing and then clicking Virtual Servers.

To configure a DNS service and DNSMonitor

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Virtual
Servers and Services and then click Virtual Servers.

2. In the details pane, click Add.
3. In Name, type a name for the service.
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4. In Protocol, select DNS.
5. In IP Address, type the IP address of the DNS server.
6. In Port, type the port number.
7. On the Services tab, click Add.
8. On the Monitors tab, under Available, select dns, click Add, click Create and then click Close.
9. In the Create Virtual Server (Load Balancing) dialog box, click Create and then click Close.

Next, create the DNS virtual server by using the procedure To configure a DNS virtual server and then
bind the DNS service to the virtual server.

To bind a DNS service to a DNS virtual server

1. In the Configure Virtual Service (Load Balancing) dialog box, on the Services tab, click Add, se-
lect the DNS service, click Create and then click Close.

Configuring DNS Virtual Servers

October 5, 2020

To configure a DNS virtual server, you specify a name and IP address. Like the NetScaler Gateway
virtual server, you must assign an IP address to the DNS virtual server. However, this IP address must
be on the internal side of the targeted network so that user devices resolve all internal addresses. You
must also specify the DNS port.

Note: If you install a NetScaler load balancing license on the appliance, the
Virtual Servers and Services node does not appear in the navigation pane. You can configure this
feature by using the load balancing virtual server. For more information, see the NetScaler documen-
tation in Citrix eDocs.

To configure a DNS virtual server

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Virtual
Servers and Services and then click Virtual Servers.

2. In the details pane, click Add.
3. In Name, type a name for the virtual server.
4. In IP Address, type the IP address of the DNS server.
5. In Port, type the port on which the DNS server listens.
6. In Protocol, select DNS and then click Create.

Finally, associate the DNS virtual server with NetScaler Gateway through one of the following two
methods, depending on the needs of your deployment:
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• Bind the server globally to NetScaler Gateway.
• Bind the DNS virtual server on a per-virtual server basis.

If you deploy the DNS virtual server globally, all users have access to it. Then, you can restrict users
by binding the DNS virtual server to the virtual server.

Configuring Name Service Providers

October 5, 2020

NetScaler Gateway uses name service providers to convert web addresses to IP addresses.

When you run the NetScaler Gateway wizard, you can configure either a DNS server or a WINS server.
You can use the configuration utility to also configure additional DNS or WINS servers.

To add a DNS server to NetScaler Gateway

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Global Settings.

2. In the details pane, under Settings, click Change global settings.
3. On the Network Configuration tab, click Add.
4. In the Insert Name Server dialog box, in IP Address, type the IP address of the DNS server, click

Create, and then click Close.
5. Click OK in the configuration utility.

To add aWINS server to NetScaler Gateway

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Global Settings.

2. In the details pane, under Settings, click Change global settings.
3. On the Network Configuration tab, in WINS Server IP, type the IP address of the WINS server and

then click OK.

Next, specify the DNS virtual server name and IP address. Like the NetScaler Gateway virtual server,
an IP address must be assigned to the virtual server. However, this IP address must be on the internal
side of the targeted network so that user devices resolve all internal addresses properly. You must
also specify the DNS port.

If you configure a DNS server and WINS server for name resolution, you can then use the NetScaler
Gateway wizard to select which server performs name lookup first.
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To specify name lookup priority

1. In the configuration utility, click the Configuration tab and then in the navigation pane, click
NetScaler Gateway.

2. In the details pane, under Getting Started, click NetScaler Gateway wizard.
3. Click Next to accept the current settings until you come to the Name Service Providers page.
4. In Name Lookup Priority, select WINS or DNS and then continue to the end of the wizard.

Configuring Server-Initiated Connections

October 5, 2020

For each user logged on to NetScaler Gateway with IP addresses enabled, the DNS suffix is appended
to the user name and a DNS address record is added to the appliance’s DNS cache. This technique
helps in providing users with a DNS name rather than the IP addresses of the users.

When an IP address is assigned to a user’s session, it is possible to connect to the user’s device from
the internal network. For example, users connecting with Remote Desktop or a virtual network com-
puting (VNC) client can access the user device for diagnosing a problem application. It is also possible
for two NetScaler Gateway users with internal network IP addresses who are remotely logged on to
communicate with each other through NetScaler Gateway. Allowing discovery of the internal network
IP addresses of the logged-on users on the appliance aids in this communication.

A remote user can use the following ping command to discover the internal network IP address of a
user who could be logged on to NetScaler Gateway at that time:

ping <username.domainname>

A server can initiate a connection to a user device in the following different ways:

• TCP or UDP connections. The connections can originate from an external system in the internal
network or from another computer logged on to NetScaler Gateway. The internal network IP
address that is assigned to each user device logged on to NetScaler Gateway is used for these
connections. The different types of server-initiated connections that NetScaler Gateway sup-
ports are described below.
For TCP or UDP server-initiated connections, the server has prior knowledge about the user
device’s IP address and port and makes a connection to it. NetScaler Gateway intercepts this
connection.

Then, the user device makes an initial connection to the server and the server connects to the
user device on a port that is known or derived from the first configured port.

In this scenario, the user device makes an initial connection to the server and then exchanges
ports and IP addresses with the server by using an application-specific protocol where this in-
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formation is embedded. This enables the NetScaler Gateway to support applications, such as
active FTP connections.

• Port command.. This is used in an active FTP and in certain Voice over IP protocols.

• Connections between plug-ins. NetScaler Gateway supports connections between plug-ins
through the use of the internal network IP addresses.

With this type of connection, two NetScaler Gateway user devices that use the same NetScaler
Gateway can initiate connections with each other. An example of this type is using instant mes-
saging applications, such as Office Communicator or Yahoo! Messenger.

If a user logs off NetScaler Gateway and the logoff request did not reach the appliance, the user can
log on again by using any device and replace the previous session with a new session. This feature
might be beneficial in deployments where one IP address is assigned per user.

When a user logs on to NetScaler Gateway for the first time, a session is created and an IP address is as-
signed to the user. If the user logs off but the logoff request gets lost or the user device fails to perform
a clean logoff, the session is maintained on the system. If the user tries to log on again from the same
device or another device, after successful authentication, a transfer logon dialog box appears. If the
user chooses to transfer logon, the previous session on NetScaler Gateway is closed and a new session
is created. The transfer of logon is active for only two minutes after logoff, and if logon is attempted
from multiple devices simultaneously, the last logon attempt replaces the original session.

Configuring Routing on NetScaler Gateway

October 5, 2020

To provide access to internal network resources, NetScaler Gateway must be capable of routing data
to your internal, secure networks. By default, NetScaler Gateway uses a static route.

The networks to which NetScaler Gateway can route data are determined by the way you configure
the NetScaler Gateway routing table and the default gateway that you specify for NetScaler Gateway.

The NetScaler Gateway routing table must contain the routes necessary to route data to any internal
network resource that a user may need to access.

NetScaler Gateway supports the following routing protocols:

• Routing Information Protocol (RIP v1 and v2)
• Open Shortest Path First (OSPF)
• Border Gateway Protocol (BGF)
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Configuring a Static Route

When setting up communication with another host or network, you may need to configure a static
route from NetScaler Gateway to the new destination if you do not use dynamic routing.

To configure a static route

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System >
Network > Advanced and then click Routes.

2. In the details pane, on the Basic tab, click Add.
3. Configure the settings for the route and then click Create.

To test a static route

1. In the configuration utility, in the navigation pane, expand System and then click Diagnostics.

2. In the details pane, under Utilities, click Ping.

3. Under Parameters, in Host name, type the name of the device.

4. Under Advanced, in Source IP Address, type the IP address of the device and then click Run.

If you are successfully communicating with the other device, messages indicate that the same
number of packets were transmitted and received, and zero packets were lost.

If you are not communicating with the other device, the status messages indicate that zero pack-
ets were received and all the packets were lost. To correct this lack of communication, repeat
the procedure to add a static route.

To stop the test, in the Ping dialog box, click Stop and then click Close.

Configuring Auto Negotiation

October 5, 2020

By default, the appliance is configured to use auto negotiation, in which NetScaler Gateway transmits
network traffic both directions simultaneously and determines the appropriate adapter speed. If you
leave the default setting to
Auto Negotiation, NetScaler Gateway uses full-duplex operation, in which the network adapter is ca-
pable of sending data in both directions simultaneously.

If you disable auto negotiation, NetScaler Gateway uses half-duplex operation, in which the adapter
can send data in both directions between two nodes, but the adapter can only use one direction or
the other at a time.
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For first time installation, Citrix recommends that you configure NetScaler Gateway to use auto nego-
tiation for ports that are connected to the appliance. After you log on initially and configure NetScaler
Gateway, you can disable auto negotiation. You cannot configure auto negotiation globally. You must
enable or disable the setting for each interface.

To enable or disable auto negotiation

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System >
Network and then click Interfaces.

2. In the details pane, select the interface and then click Open.
3. Do one of the following in the Configure Interface dialog box:

• To enable auto negotiation, click Yes next to Auto Negotiation and then click OK.
• To disable auto negotiation, click No next to Auto Negotiation and then click OK.

Authentication and Authorization

October 5, 2020

NetScaler Gateway employs a flexible authentication design that permits extensive customization of
user authentication for NetScaler Gateway. You can use industry-standard authentication servers and
configure NetScaler Gateway to authenticate users with the servers. NetScaler Gateway also supports
authentication based on attributes present in a client certificate. NetScaler Gateway authentication
is designed to accommodate simple authentication procedures that use a single source for user au-
thentication, as well as more complex, cascaded authentication procedures that rely upon multiple
authentication types.

NetScaler Gateway authentication incorporates local authentication for the creation of local users and
groups. This design centers around the use of policies to control the authentication procedures that
you configure. The policies you create can be applied at NetScaler Gateway global or virtual server lev-
els and can be used to set authentication server parameters conditionally based on the user’s source
network.

Because policies are bound either globally or to a virtual server, you can also assign priorities to your
policies to create a cascade of multiple authentication servers as part of authentication.

NetScaler Gateway includes support for the following authentication types:

• Local
• Lightweight Directory Access Protocol (LDAP)
• RADIUS
• SAML
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• TACACS+
• Client certificate authentication (including smart card authentication)

NetScaler Gateway also supports RSA SecurID, Gemalto Protiva, and SafeWord. You use a RADIUS
server to configure these types of authentication.

While authentication allows users to log on to NetScaler Gateway and connect to the internal network,
authorization defines the resources within the secure network to which users have access. You con-
figure authorization with LDAP and RADIUS policies.

Configuring Default Global Authentication Types

October 5, 2020

When you installed NetScaler Gateway and ran the NetScaler Gateway wizard, you configured authen-
tication within the wizard. This authentication policy is bound automatically to the NetScaler Gate-
way global level. The authentication type you configure within the NetScaler Gateway wizard is the
default authentication type. You can change the default authorization type by running the NetScaler
Gateway wizard again or you can modify the global authentication settings in the configuration utility.

If you need to add additional authentication types, you can configure authentication policies on
NetScaler Gateway and bind the policies to NetScaler Gateway by using the configuration utility.
When you configure authentication globally, you define the type of authentication, configure the
settings, and set the maximum number of users that can be authenticated.

After configuring and binding the policy, you can set the priority to define which authentication type
takes precedence. For example, you configure LDAP and RADIUS authentication policies. If the LDAP
policy has a priority number of 10 and the RADIUS policy has a priority number of 15, the LDAP policy
takes precedence, regardless of where you bind each policy. This is called cascading authentication.

You can select to deliver logon pages from the NetScaler Gateway in-memory cache or from the HTTP
server running on NetScaler Gateway. If you choose to deliver the logon page from the in-memory
cache, the delivery of the logon page from NetScaler Gateway is significantly faster than from the
HTTP server. Choosing to deliver the logon page from the in-memory cache reduces the wait time
when a large number of users log on at the same time. You can only configure the delivery of logon
pages from the cache as part of a global authentication policy.

You can also configure the network address translation (NAT) IP address that is a specific IP address for
authentication. This IP address is unique for authentication and is not the NetScaler Gateway subnet,
mapped, or virtual IP addresses. This is an optional setting.

Note: You cannot use the NetScaler Gateway wizard to configure SAML authentication.
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You can use the Quick Configuration wizard to configure LDAP, RADIUS, and client certificate authen-
tication. When you run the wizard, you can select from an existing LDAP or RADIUS server configured
on NetScaler Gateway. You can also configure the settings for LDAP or RADIUS. If you use two-factor
authentication, Citrix recommends using LDAP as the primary authentication type.

To configure authentication globally

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Global Settings.

2. In the details pane, under Settings, click Change authentication settings.
3. In Maximum Number of Users, type the number of users who can be authenticated by using this

authentication type.
4. In NAT IP address, type the unique IP address for authentication.
5. Select Enable static caching to deliver logon pages faster.
6. Select Enable Enhanced Authentication Feedback to provide a message to users if authentica-

tion fails. The message users receive include password errors, account disabled or locked, or
the user is not found, to name a few.

7. In Default Authentication Type, select the authentication type.
8. Configure the settings for your authentication type and then click OK.

Configuring Authentication Without Authorization

October 5, 2020

Authorization defines the resources to which users are allowed to connect through NetScaler Gateway.
You configure authorization policies by using an expression and then setting the policy to be allowed
or denied. You can configure NetScaler Gateway to use authentication only, without authorization.

When you configure authentication without authorization, NetScaler Gateway does not perform a
group authorization check. The policies that you configure for the user or group are assigned to the
user.

For more information about configuring authorization, see Configuring Authorization.

Configuring Authorization

October 5, 2020
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Authorization specifies the network resources to which users have access when they log on to
NetScaler Gateway. The default setting for authorization is to deny access to all network resources.
Citrix recommends using the default global setting and then creating authorization policies to define
the network resources users can access.

You configure authorization on NetScaler Gateway by using an authorization policy and expressions.
After you create an authorization policy, you can bind it to the users or groups that you configured on
the appliance.

Configuring Authorization Policies

October 5, 2020

When you configure an authorization policy, you can set it to allow or deny access to network resources
in the internal network. For example, to allow users access to the 10.3.3.0 network, use the following
expression:

CLIENT.IP.DST.IN_SUBNET(10.3.0.0/16)

Authorization policies are applied to users and groups. After a user is authenticated, Citrix Gateway
performs a group authorization check by obtaining the user’s group information from either an RA-
DIUS, LDAP, or TACACS+ server. If group information is available for the user, NetScaler Gateway
checks the network resources allowed for the group.

To control which resources users can access, you must create authorization policies. If you do not
need to create authorization policies, you can configure default global authorization.

If you create an expression within the authorization policy that denies access to a file path, you
can only use the subdirectory path and not the root directory. For example, use fs.path contains
“\\dir1\\dir2” instead of fs.path contains “\\rootdir\\dir1\\dir2”. If you use the second version in this
example, the policy fails.

After you configure the authorization policy, you then bind it to a user or group as shown in the tasks
below.

By default, authorization policies are validated first against policies that you bind to the virtual server
and then against policies bound globally. If you bind a policy globally and want the global policy to
take precedence over a policy that you bind to a user, group, or virtual server, you can change the
priority number of the policy. Priority numbers start at zero. A lower priority number gives the policy
higher precedence.

For example, if the global policy has a priority number of one and the user has a priority of two, the
global authentication policy is applied first.
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Important:

• Classic Authorization policies are applied only on TCP traffic.

• Starting with Citrix ADC release 12.0 build 56.x, advanced authorization policy can be ap-
plied on all types of traffic (TCP/UDP/ICMP/DNS).

– To apply policy on UDP/ICMP/DNS traffic, policies must be bound at type UDP_REQUEST,
ICMP_REQUEST, and DNS_REQUEST respectively.

– While binding, if “type” is not explicitly mentioned or “type” is set to REQUEST, the
behavior does not change from earlier builds, that is these policies are applied only to
TCP traffic.

– The policies bound at UDP_REQUEST do not apply for DNS traffic. For DNS, policies
must be explicitly bound to DNS_REQUEST. TCP_DNS is similar to other TCP requests.

For more details on advanced authorization policies, see article https://support.citrix.com/article/
CTX232237.

To configure an authorization policy by using the GUI

1. Navigate to Citrix Gateway > Policies > Authorization.
2. In the details pane, click Add.
3. In Name, type a name for the policy.
4. In Action, select Allow or Deny.
5. In Expression, click Expression Editor.
6. To start to configure the expression, click Select and choose the necessary elements.
7. Click Done when your expression is complete.
8. Click Create.

To bind an authorization policy to a user by using the GUI

1. Navigate to Citrix Gateway > User Administration.
2. Click AAA Users.
3. In the details pane, select a user and then click Edit.
4. In Advanced Settings, click Authorization Policies.
5. In Policy Binding page, select a policy or create a policy.
6. In Priority, set the priority number.
7. In Type, select the request type and then click OK.

To bind an authorization policy to a group by using the GUI

1. Navigate to Citrix Gateway > User Administration.

© 1999-2021 Citrix Systems, Inc. All rights reserved. 104

https://support.citrix.com/article/CTX232237
https://support.citrix.com/article/CTX232237


NetScaler Gateway 12.0

2. Click AAA Groups.
3. In the details pane, select a group and then click Edit.
4. In Advanced Settings, click Authorization Policies.
5. In Policy Binding page, select a policy or create a policy.
6. In Priority, set the priority number.
7. In Type, select the request type and then click OK.

Setting Default Global Authorization

October 5, 2020

To define the resources to which users have access on the internal network, you can configure default
global authorization. You configure global authorization by allowing or denying access to network
resources globally on the internal network.

Any global authorization action you create is applied to all users who do not already have an autho-
rization policy associated with them, either directly or through a group. A user or group authorization
policy always overrides the global authorization action. If the default authorization action is set to
Deny, you must apply authorization policies for all users or groups in order to make network resources
accessible to those users or groups. This requirement helps to improve security.

To set default global authorization:

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Global Settings.

2. In the details pane, under Settings, click Change global settings.
3. On the Security tab, next to Default Authorization Action, select Allow or Deny then and click

OK.

Disabling Authentication

October 5, 2020

If your deployment does not require authentication, you can disable it. You can disable authentication
for each virtual server that does not require authentication.

Important: Citrix recommends disabling authentication with caution. If you are not using an external
authentication server, create local users and groups to allow NetScaler Gateway to authenticate users.
Disabling authentication stops the use of authentication, authorization, and accounting features that
control and monitor connections to NetScaler Gateway. When users type a web address to connect to
NetScaler Gateway, the logon page does not appear.
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To disable authentication

1. In the configuration utility, in the navigation pane, expand NetScaler Gateway and then click
Virtual Servers.

2. In the details pane, click a virtual server and then click Open.
3. On the Authentication tab, under User Authentication, click to clear Enable Authentication.

Configuring Authentication for Specific Times

October 13, 2020

You can configure an authentication policy so users are allowed access to the internal network at spe-
cific times, such as during normal working hours. When users try to log on at a different time, logon
is denied.

To restrict when users log on to NetScaler Gateway, create an expression within the authentication
policy and then bind it to a virtual server or globally.

To configure authentication for time, date, or day of week

1. In the configuration utility, on the Configuration tab, expand NetScaler Gateway > Policies >
Authentication.

2. Under Authentication, select the authentication type.

3. In the details pane, click the Policies tab, select an authentication policy and then click Open.

4. In the Configure Authentication Policy dialog box, under Expression, next to Match Any Expres-
sion, click Add.

5. In the Add Expression dialog box, in Expression Type, select Date/Time.

6. In Qualifier, select one of the following:

• TIME to configure the time users cannot log on.
• DATE to configure the date users cannot log on.
• DAYOFWEEK to configure the day users cannot log on.

Example: TIME: 2020-10-12-02:30:00GMT DATE: 2020-10-12 DAYOFWEEK: Monday

7. In Operator, select the value.

8. In Value, click the calendar next to the text box and then select the day, date, or time.

9. Click OK twice, click Close, and click OK.
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How Authentication Policies Work

October 5, 2020

When users log on to NetScaler Gateway, they are authenticated according to a policy that you cre-
ate. The policy defines the authentication type. A single authentication policy can be used for simple
authentication needs and is typically bound at the global level. You can also use the default authen-
tication type, which is local. If you configure local authentication, you must also configure users and
groups on NetScaler Gateway.

You can configure multiple authentication policies and bind them to create a detailed authentication
procedure and virtual servers. For example, you can configure cascading and two-factor authentica-
tion by configuring multiple policies. You can also set the priority of the authentication policies to
determine which servers and the order in which NetScaler Gateway checks user credentials. An au-
thentication policy includes an expression and an action. For example, if you set the expression to
True value, when users log on, the action evaluates user logon to true and then users have access to
network resources.

After you create an authentication policy, you bind the policy at either the global level or to virtual
servers. When you bind at least one authentication policy to a virtual server, any authentication po-
lices that you bound to the global level are not used when users log on to the virtual server, unless the
global authentication type has a higher precedence than the policy bound to the virtual server.

When a user logs on to NetScaler Gateway, authentication is evaluated in the following order:

• The virtual server is checked for any bound authentication policies.
• If authentication policies are not bound to the virtual server, NetScaler Gateway checks for

global authentication policies.
• If an authentication policy is not bound to a virtual server or globally, the user is authenticated

through the default authentication type.

If you configure LDAP and RADIUS authentication policies and want to bind the policies globally for
two-factor authentication, you can select the policy in the configuration utility and then select if the
policy is the primary or secondary authentication type. You can also configure a group extraction
policy.

Configuring Authentication Profiles

October 5, 2020

You can create an authentication profile by using the NetScaler Gateway wizard or the configuration
utility. The profile contains all of the settings for the authentication policy. You configure the profile
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when you create the authentication policy.

With the NetScaler Gateway wizard, you can use the chosen authentication type to configure authen-
tication. If you want to configure additional authentication policies after running the wizard, you can
use the configuration utility. For more information about the NetScaler Gateway wizard, see Config-
uring Settings by Using the NetScaler Gateway Wizard.

To create an authentication policy by using the configuration utility

1. In the configuration utility, on the Configuration tab, expand NetScaler Gateway > Policies >
Authentication.

2. In the navigation pane, under Authentication, select an authentication type.
3. In the details pane, on the Policies tab, click Add.
4. If you are using an external authentication type, next to Server, click New.
5. In the Create Authentication Server dialog box, configure the settings for your authentication

type, click Create and then click Close.
6. In the Create Authentication Policy dialog box, next to Named Expressions, select True value,

click Add Expression, click Create and then click Close.
Note: When you select an authentication type and save the authentication profile, you cannot
change the authentication type. To use a different authentication type, you must create a new
policy.

Tomodify an authentication policy by using the configuration utility

You can modify configured authentication policies and profiles, such as the IP address of the authen-
tication server or the expression.

1. In the configuration utility, on the Configuration tab, expand NetScaler Gateway > Policies >
Authentication.

2. In the navigation pane, under Authentication, select an authentication type.
3. In the details pane, on the Servers tab, select a server and then click Open.

To remove an authentication policy

If you changed or removed an authentication server from your network, remove the corresponding
authentication policy from NetScaler Gateway.

1. In the configuration utility, on the Configuration tab, expand NetScaler Gateway > Policies >
Authentication.

2. In the navigation pane, under Authentication, select an authentication type.
3. In the details pane, on the Policies tab, select a policy and then click Remove.

© 1999-2021 Citrix Systems, Inc. All rights reserved. 108

/en-us/netscaler-gateway/12/install/ng-config-ng-with-wizards-con/ng-config-settings-ng-wizard-tsk.html
/en-us/netscaler-gateway/12/install/ng-config-ng-with-wizards-con/ng-config-settings-ng-wizard-tsk.html


NetScaler Gateway 12.0

Binding Authentication Policies

October 5, 2020

After you configure the authentication policies, you bind the policy either globally or to a virtual server.
You can use either the configuration utilityto bind an authentication policy.

To bind an authentication policy globally by using the configuration utility:

1. In the configuration utility, on the Configuration tab, expand NetScaler Gateway > Policies >
Authentication.

2. Click an authentication type.

3. In the details pane, on the Policies, tab, click a server and then in Action, click Global Bindings.

4. On the Primary or Secondary tab, under Details, click Insert Policy.

5. Under Policy Name, select the policy and then click OK.

Note: When you select the policy, NetScaler Gateway sets the expression to True value automat-
ically.

To unbind a global authentication policy by using the configuration utility:

1. In the configuration utility, on the Configuration tab, expand NetScaler Gateway > Policies >
Authentication.

2. On the Policies tab, in Action, click Global Bindings.
3. In the Bind/Unbind Authentication Policies to Global dialog box, on the Primary or Secondary

tab, in Policy Name, select the policy, click Unbind Policy and then click OK.

Setting Priorities for Authentication Policies

October 5, 2020

By default, authentication polices are validated first against policies that you bind to the virtual server
and then against policies bound globally. If you bind an authentication policy globally and want the
global policy to take precedence over a policy that you bind to a virtual server, you can change the
priority number of the policy. Priority numbers start at zero. A lower priority number gives the au-
thentication policy higher precedence.

For example, if the global policy has a priority number of one and the virtual server has a priority of
two, the global authentication policy is applied first.
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To set or change the priority for global authentication policies

1. In the configuration utility, on the Configuration tab, expand NetScaler Gateway > Policies >
Authentication.

2. On the Policies tab, in Action, click Global Bindings.
3. In the Bind/Unbind Authentication Global Policies dialog box, on either the Primary or Sec-

ondary tab, under Priority, type the number and then click OK.

To change the priority for an authentication policy bound to a virtual server

You can also modify an authentication policy that is bound to a virtual server.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Virtual Servers.

2. Select a virtual server and then click Open.
3. Click the Authentication tab and then select either Primary or Secondary.
4. Select the policy and in Priority, type the number of the priority and then click OK.

Configuring Local Users

October 5, 2020

You can create user accounts locally on NetScaler Gateway to supplement the users on authentica-
tion servers. For example, you might want to create local user accounts for temporary users, such as
consultants or visitors, without creating an entry for those users on the authentication server.

If you are using local authentication, create users and then add them to groups that you create on
NetScaler Gateway. After configuring users and groups, you can apply authorization and session poli-
cies, create bookmarks, specify applications, and specify the IP address of file shares and servers to
which users have access.

To create local users

1. In the configuration utility, click the Configuration tab and in the navigation pane, expand
NetScaler Gateway > User Administration and then click AAA Users.

2. In the details pane, click Add.
3. In User Name, type the user name.
4. If you are using local authentication, clear External Authentication.

Note: Select
External Authentication to have users authenticate against an external authentication server,
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such as LDAP or RADIUS. Clear the check box to have NetScaler Gateway authenticate against
the local user database.

5. In Password and Confirm Password, type the password for the user, click Create and then click
Close.

To change a user password

After creating a local user, you can change the user’s password or configure the user account to be
authenticated against an external authentication server.

1. In the configuration utility, click the Configuration tab and in the navigation pane, expand
NetScaler Gateway > User Administration and then click AAA Users.

2. In the details pane, select a user and then click Open.
3. In Password and Confirm Password, type the new password for the user and then click OK.

To change a user’s authenticationmethod

If you have users who are configured for local authentication, you can change the authentication to
an external authentication server. To do this, enable external authentication.

1. In the configuration utility, click the Configuration tab and in the navigation pane, expand
NetScaler Gateway > User Administration and then click AAA Users.

2. In the details pane, select a user and then click Open.
3. Select External Authentication and then click OK.

To remove a user

You can also remove a user from NetScaler Gateway.

1. In the configuration utility, click the Configuration tab and in the navigation pane, expand
NetScaler Gateway > User Administration and then click AAA Users.

2. In the details pane, select a user and then click Remove.

When you remove a user from NetScaler Gateway, all associated policies are also removed from the
user profile.

Configuring Groups

October 5, 2020

You can have groups on NetScaler Gateway that are local groups and can authenticate users with local
authentication. If you are using external servers for authentication, groups on NetScaler Gateway are
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configured to match groups configured on authentication servers in the internal network. When a
user logs on and is authenticated, if a group name matches a group on an authentication server, the
user inherits the settings for the group on NetScaler Gateway.

After you configure groups, you can apply authorization and session policies, create bookmarks, spec-
ify applications, and specify the IP address of file shares and servers to which the user has access.

If you are using local authentication, create users and add them to groups that are configured on
NetScaler Gateway. The users then inherit the settings for that group.

Important: If users are a member of an Active Directory group, the name of the group on NetScaler
Gateway must be the same as the Active Directory group.

To create a new group

1. In the configuration utility, click the Configuration tab and in the navigation pane, expand
NetScaler Gateway > User Administration and then click AAA Groups.

2. In the details pane, click Add.
3. In Group Name, type a name for the group, click Create and then click Close.

To delete a group

You can also delete user groups from NetScaler Gateway.

1. In the configuration utility, click the Configuration tab and in the navigation pane, expand
NetScaler Gateway > User Administration and then click AAA Groups.

2. In the details pane, select the group and then click Remove.

Adding Users to Groups

October 5, 2020

You can add users to a group either during creation of the group or at a later time. You can add users
to multiple groups so users can inherit the policies and settings that are bound to those groups.

To add users to groups:

1. In the configuration utility, click the Configuration tab and in the navigation pane, expand
NetScaler Gateway > User Administration and then click AAA Groups.

2. In the details pane, select a group, and then click Open.
3. On the Users tab, under Available Users, select the users, click Add and click OK.
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Configuring Policies with Groups

October 5, 2020

After you configure groups, you can use the Group dialog box to apply policies and settings that specify
user access. If you are using local authentication, you create users and add them to groups that are
configured on NetScaler Gateway. The users then inherit the settings for that group.

You can configure the following policies or settings for a group of users in the Group dialog box:

• Users
• Authorization policies
• Auditing policies
• Session policies
• Traffic policies
• Bookmarks
• Intranet applications
• Intranet IP addresses

In your configuration, you might have users that belong to more than one group. In addition, each
group might have one or more bound session policies, with different parameters configured. Users
that belong to more than one group inherit the session policies assigned to all the groups to which the
user belongs. To ensure which session policy evaluation takes precedence over the other, you must
set the priority of the session policy.

For example, you have group1 that is bound with a session policy configured with the home
page www.homepage1.com. Group2 is bound with a session policy configured with home page
www.homepage2.com. When these policies are bound to respective groups without a priority
number or with same priority number, the home page that appears to users who belong to both the
groups depends on which policy is processed first. By setting a lower priority number, which gives
higher precedence, for the session policy with home page www.homepage1.com, you can ensure
that users who belong to both the groups will always receive the home page www.homepage1.com.

If session policies do not have a priority number assigned or have the same priority number, prece-
dence is evaluated in the following order:

• User
• Group
• Virtual server
• Global

If policies are bound to the same level, without a priority number or if the policies have the same
priority number, the order of evaluation is per the policy bind order. Policies that are bound first to a
level receive precedence over policies bound later.
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Configuring LDAP Authentication

October 5, 2020

You can configure the NetScaler Gateway to authenticate user access with one or more LDAP servers.

LDAP authorization requires identical group names in Active Directory, on the LDAP server, and on
NetScaler Gateway. The characters and case must also match.

By default, LDAP authentication is secure by using Secure Sockets Layer (SSL) or Transport Layer Se-
curity (TLS). There are two types of secure LDAP connections. With one type, the LDAP server accepts
the SSL or TLS connections on a port separate from the port that the LDAP server uses to accept clear
LDAP connections. After users establish the SSL or TLS connections, LDAP traffic can be sent over the
connection.

The port numbers for LDAP connections are:

• 389 for unsecured LDAP connections
• 636 for secure LDAP connections
• 3268 for Microsoft unsecure LDAP connections
• 3269 for Microsoft secure LDAP connections

The second type of secure LDAP connections use the StartTLS command and uses port number 389.
If you configure port numbers 389 or 3268 on NetScaler Gateway, the server tries to use StartTLS to
make the connection. If you use any other port number, the server attempts to make connections by
using SSL or TLS. If the server cannot use StartTLS, SSL, or TLS, the connection fails.

If you specify the root directory of the LDAP server, NetScaler Gateway searches all of the subdirec-
tories to find the user attribute. In large directories, this approach can affect performance. For this
reason, Citrix recommends that you use a specific organizational unit (OU).

The following table contains examples of user attribute fields for LDAP servers:

LDAP server User attribute Case sensitive

Microsoft Active Directory
Server

sAMAccountName No

Novell eDirectory ou Yes

IBM Directory Server uid Yes

Lotus Domino CN Yes

Sun ONE directory (formerly
iPlanet)

uid or cn Yes
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This table contains examples of the base DN:

LDAP server Base DN

Microsoft Active Directory Server DC=citrix,DC=local

Novell eDirectory ou=users,ou=dev

IBM Directory Server cn=users

Lotus Domino OU=City,O=Citrix, C=US

Sun ONE directory (formerly iPlanet) ou=People,dc=citrix,dc=com

The following table contains examples of bind DN:

LDAP server Bind DN

Microsoft Active Directory Server CN=Administrator, CN=Users, DC=citrix,
DC=local

Novell eDirectory cn=admin, o=citrix

IBM Directory Server LDAP_dn

Lotus Domino CN=Notes Administrator, O=Citrix, C=US

Sun ONE directory (formerly iPlanet) uid=admin,ou=Administrators,
ou=TopologyManagement,o=NetscapeRoot

Note: For more information regarding LDAP server settings, see
Determining Attributes in Your LDAP Directory.

To configure LDAP authentication by using the configuration utility

October 5, 2020

1. Navigate to NetScaler Gateway >Policies > Authentication/Authorization > Authentication.

2. Click LDAP.

3. In the details pane, on the Policies tab, click Add.

4. In Name, type a name for the policy.

5. Next to Server, click New.
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6. In Name, type the name of the server.

7. Under Server, in IP Address and Port, type the IP address and port number of the LDAP server.

8. In Type, select either AD for Active Directory or NDS for Novell Directory Services.

9. Under Connection Settings, complete the following:

a) In Base DN (location of users), type the base DN under which users are located.

The base DN is usually derived from the Bind DN by removing the user name and specifying
the group where users are located. Examples of syntax for base DN are:

1 ou=users,dc=ace,dc=com
2 cn=Users,dc=ace,dc=com

b) In Administrator Bind DN, type the administrator bind DN for queries to the LDAP direc-
tory. Examples for syntax of bind DN are:

1 domain/user name
2 ou=administrator,dc=ace,dc=com
3 user@domain.name (for Active Directory)
4 cn=Administrator,cn=Users,dc=ace,dc=com

For Active Directory, the group name specified as cn=groupname is required. The group
name that you define in NetScaler Gateway and the group name on the LDAP server must
be identical.

For other LDAP directories, the group name either is not required or, if required, is specified
as ou=groupname.

NetScaler Gateway binds to the LDAP server using the administrator credentials and then
searches for the user. After locating the user, NetScaler Gateway unbinds the administrator
credentials and rebinds with the user credentials.

c) In Administrator Password and Confirm Administrator Password, type the administra-
tor password for the LDAP server.

10. To retrieve additional LDAP settings automatically, click Retrieve Attributes.

When you click Retrieve Attributes, the fields under Other Settings populate automatically. If
you don’t want to do this, continue with Steps 12 and 13. Otherwise, skip to Step 14.

11. Under Other Settings, in Server Logon Name Attribute, type the attribute under which
NetScaler Gateway should look for user logon names for the LDAP server that you are
configuring. The default is samAccountName.
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12. In Group Attribute, leave the default memberOf for Active Directory or change the attribute to
the attribute of the LDAP server type you are using. This attribute enables NetScaler Gateway
to obtain the groups associated with a user during authorization.

13. In Security Type, select the security type and then click Create.

14. To allow users to change their LDAP password, select Allow Password Change.

Note:

• If you select PLAINTEXT as the security type, allowing users to change their passwords is
not supported.

• If you select PLAINTEXT or TLS for security, use port number 389. If you select SSL, use
port number 636.

Determining Attributes in Your LDAP Directory

October 5, 2020

If you need help determining your LDAP directory attributes so you can configure authentication set-
tings on NetScaler Gateway, you can easily look them up with the free LDAP browser from Softerra.

You can download the LDAP browser from the Softerra LDAP Administrator Web site. After you install
the browser, set the following attributes:

• The host name or IP address of your LDAP server.
• The port of your LDAP server. The default is 389.
• The base DN field, which you can leave blank. The information provided by the LDAP browser

can help you determine the base DN that you need to configure this setting on NetScaler Gate-
way.

• The Anonymous Bind check determines if the LDAP server requires user credentials to connect
to it. If the LDAP server requires credentials, leave the check box cleared.

After completing the settings, the LDAP browser displays the profile name in the left pane and connects
to the LDAP server.

Configuring LDAP Group Extraction

October 5, 2020

If you are using two-factor authentication, groups extracted from both the primary and secondary
authentication sources are concatenated. Authorization policies can be applied to the group that is
extracted from the primary or secondary authentication server.
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The group names obtained from the LDAP server are compared with the group names created locally
on NetScaler Gateway. If the two group names match, the properties of the local group apply to the
group obtained from the LDAP servers.

If users belong to more than one LDAP group, NetScaler Gateway extracts user information from all
the groups to which users belong. If a user is a member of two groups on NetScaler Gateway and each
group has a bound session policy, the user inherits the session policies from both groups. To make
sure that users receive the correct session policy, set the priority for the session policy.

For more information about LDAP group membership attributes that will and will not work with
NetScaler Gateway authorization, see the following:

• How LDAP Group Extraction Works from the User Object Directly
• How LDAP Group Extraction Works from the Group Object Indirectly

How LDAP Group Extraction Works from the User Object Directly

October 5, 2020

LDAP servers that evaluate group memberships from group objects work with NetScaler Gateway au-
thorization.

Some LDAP servers enable user objects to contain information about groups to which the objects
belong, such as Active Directory (by using the memberOf attribute) or IBM eDirectory (by using the
groupMembership attribute). A user’s group membership can be attributes from the user object, such
as IBM Directory Server (by using ibm-allGroups) or Sun ONE directory server (by using nsRole). Both
of these types of LDAP servers work with NetScaler Gateway group extraction.

For example, in IBM Directory Server, all group memberships, including the static, dynamic, and
nested groups, can be returned through the use of the ibm-allGroups attribute. In Sun ONE, all roles,
including managed, filtered, and nested, are calculated through the use of the nsRole attribute.

How LDAP Group Extraction Works from the Group Object Indirectly

October 5, 2020

LDAP servers that evaluate group memberships from group objects indirectly will not work with
NetScaler Gateway authorization.

Some LDAP servers, such as Lotus Domino, enable group objects only to contain information about
users. These LDAP servers do not enable the user object to contain information about groups and
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thus will not work with NetScaler Gateway group extraction. For this type of LDAP server, group mem-
bership searches are performed by locating the user in the member list of groups.

LDAP Authorization Group Attribute Fields

October 5, 2020

The following table contains examples of LDAP group attribute fields:

LDAP servers LDAP attribute

Microsoft Active Directory Server memberOf

Novell eDirectory groupMembership

IBM Directory Server ibm-allGroups

Sun ONE directory (formerly iPlanet) nsRole

To configure LDAP authorization

October 5, 2020

You configure LDAP authorization in the authentication policy by setting the group attribute name and
the subattribute.

1. In the configuration utility, on the Configuration tab, expand NetScaler Gateway > Policies >
Authentication.

2. Under Authentication, click an authentication type.
3. In the details pane, click Add.
4. In Name, type a name for the policy.
5. Next to Server, click New.
6. In Name, type the name of the server.
7. Under Server, type the IP address and port of the LDAP server.
8. In Group Attribute, type memberOf.
9. In Sub attribute Name, type CN and then click Create.

10. In the Create Authentication Policy dialog box, next to Named Expressions, select the expres-
sion, click Add Expression, click Create and then click Close.
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Configuring LDAP Nested Group Extraction

October 5, 2020

NetScaler Gateway can query LDAP groups and extract group and user information from ancestor
groups that you configure on the authentication server. For example, you created group1 and within
that group, you created group2 and group3. If the user belongs to group3, NetScaler Gateway extracts
information from all the nested ancestor groups (group2, group1) up to the specified level.

You can use an authentication policy to configure LDAP nested group extraction. When the query is
run, NetScaler Gateway searches the groups until it reaches the maximum nesting level or until it
searches all available groups.

To configure LDAP nested group extraction

1. In the configuration utility, in the navigation pane, expand NetScaler Gateway > Policies > Au-
thentication/Authorization > Authentication >> > Authentication and then click LDAP.

2. In the details pane, on the Policies tab, click Add.
3. In Name, type a name for the policy.
4. Next to Server, click New.
5. In Name, type the name of the server.
6. Configure the settings for the LDAP server.
7. Expand Nested Group Extraction and then click Enable.
8. In Maximum Nesting Level, type the number of levels that NetScaler Gateway checks.
9. In Group Name Identifier, type the LDAP attribute name that uniquely identifies a group name

on the LDAP server, such as sAMAccountName.
10. In Group Search Attribute, type the LDAP attribute name that is to be obtained in the search

response to determine the parent groups of any group, such as memberOf.
11. In Group Search Sub-Attribute, type the LDAP subattribute name that is to be searched for as

part of the Group Search Attribute to determine the parent groups of any group. For example,
type CN.

12. In Group Search Filter, type the query string. For example, the filter could be (&(samaccount-
name=test)(objectClass=*)).

13. Click Create and then click Close.
14. In the Create Authentication Policy dialog box, next to Named Expressions, select the expres-

sion, click Add Expression, click Create and then click Close.
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Configuring LDAP Group Extraction for Multiple Domains

October 5, 2020

If you have multiple domains for authentication and are using StoreFront or the Web Interface, you
can configure NetScaler Gateway to use group extraction to send the correct domain name to the Web
Interface.

In Active Directory, you need to create a group for each domain in your network. After you create the
group, you add users that belong to the group and specified domain. After the groups are configured
in Active Directory, you configure LDAP group extraction for multiple domains on NetScaler Gateway.

To configure NetScaler Gateway for group extraction for multiple domains, you need to create the
same number of session and authentication polices as the number of domains in your network. For
example, you have two domains, named Sampa and Child. Each domain receives one session policy
and one authentication policy.

After creating the policies, you create groups on NetScaler Gateway, and you bind the session policies
to the group. Then, you bind the authentication policies to a virtual server.

If you deploy StoreFront in multiple domains, there must be a trust relationship between domains.

If you deploy App Controller or the Web Interface in multiple domains, the domains do not need to
trust each other.

Creating Session Policies for Group Extraction

October 5, 2020

The first step when you create session policies for group extraction is to create two session profiles
and set the following parameters:

• Enable ICA proxy.
• Add the Web Interface Web address.
• Add the Windows domain.
• Add the profile to a session policy and set the expression to true.

To create the session profiles for group extraction

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway > Policies and then click Session.

2. In the details pane, click the Profiles tab and then click Add.
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3. In Name, type a name for the profile. For example, type Sampa.
4. On the Published Applications tab, do the following:

a) Next to ICA Proxy, click Override Global and then select ON.
b) Next to Web Interface Address, click Override Global and then type the Web address of the

Web Interface.
c) Next to Single Sign-On Domain, click Override Global, type the name of the Windows do-

main and then click Create.
5. In Name, clear the name of the first domain and type the name of the second domain, such as

Child.
6. Next to Single Sign-On Domain, clear the name of the first Windows domain and type the name

of the second domain, click Create and then click Close.

After you create the session profiles, you create two session policies. Each session policy uses one of
the profiles.

To create a session policy

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway > Policies and then click Session.

2. In the details pane, on the Policies tab, click Add.
3. In Name, type a name for the policy.
4. In Request Profile, select the profile for the first domain.
5. Next to Named Expressions, click General, select True value, click Add Expression and then click

Create.
6. In Name, change the name to the second domain.
7. In Request Profile, select the profile for the second domain, click Create and then click Close.

Creating LDAP Authentication Policies for Multiple Domains

October 5, 2020

After you create session policies on NetScaler Gateway, you create LDAP authentication policies that
are almost identical. When configuring the authentication policy, the important field is
Search Filter. In this field, you must type the name of the group you created in Active Directory.

Create the authentication profiles first and then create the authentication policy.
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To create authentication profiles for multiple domain group extraction

1. In the configuration utility, on the Configuration tab, expand NetScaler Gateway > Policies >
Authentication.

2. In the navigation pane, click LDAP.
3. In the details pane, click the Servers tab and then click Add.
4. In Name, type the name of the first domain, such as Sampa.
5. Configure the settings for the LDAP server and then click Create.
6. Repeat Steps 3, 4, and 5 to configure the authentication profile of the second domain and then

click Close.

After you create and save the profiles, create the authentication policies.

To create authentication policies for multiple domain group extraction

1. In the configuration utility, on the Configuration tab, expand NetScaler Gateway > Policies >
Authentication.

2. In the details pane, click the Policies tab and then click Add.
3. In Name, type the name of the first domain.
4. In Authentication Type, select LDAP.
5. In Server, select the authentication profile for the first domain.
6. Next to Named Expressions, click General, select True value, click Add Expression and then click

Create.
7. In Name, type the name of the second domain.
8. In Server, select the authentication profile for the second domain, click Create and then click

Close.

Creating Groups and Binding Policies for LDAP Group Extraction for
Multiple Domains

October 5, 2020

After you create authentication policies, you create groups on NetScaler Gateway. After you create the
groups, you bind the authentication policy to a virtual server.

To create groups on NetScaler Gateway

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway > User Administration, and then click AAA Groups.

2. In the details pane, click Add.
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3. In Group Name, type the name of the first Active Directory group.
Important: When creating groups on NetScaler Gateway for group extraction from multiple do-
mains, group names must be the same as the groups you defined in Active Directory. Group
names are also case-sensitive and the case must match the case you entered in Active Direc-
tory.

4. On the Policies tab, click Session and then click Insert Policy.
5. Under Policy Name, double-click the policy and then click Create.

To bind the authentication policies to a virtual server

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Virtual Servers.

2. In the configuration utility, in the navigation pane, expand NetScaler Gateway and then click
Virtual Servers.

3. In the details pane, click a virtual server and then click Open.
4. On the Authentication tab, click Primary, under Policy Name, double-click Insert Policy and then

select the first authentication policy.
5. Under Policy Name, click Insert Policy, double-click the second authentication policy and then

click OK.

Configuring Client Certificate Authentication

October 5, 2020

Users logging on to a NetScaler Gateway virtual server can also be authenticated based on the at-
tributes of the client certificate that is presented to the virtual server. Client certificate authentication
can also be used with another authentication type, such as LDAP or RADIUS, to provide two-factor
authentication.

To authenticate users based on the client-side certificate attributes, client authentication should be
enabled on the virtual server and the client certificate should be requested. You must bind a root
certificate to the virtual server on NetScaler Gateway.

When users log on to the NetScaler Gateway virtual server, after authentication, the user name in-
formation is extracted from the specified field of the certificate. Typically, this field is Subject:CN. If
the user name is extracted successfully, the user is then authenticated. If the user does not provide a
valid certificate during the Secure Sockets Layer (SSL) handshake or if the user name extraction fails,
authentication fails.

You can authenticate users based on the client certificate by setting the default authentication type to
use the client certificate. You can also create a certificate action that defines what is to be done during
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the authentication based on a client SSL certificate.

To configure the client certificate as the default authentication type

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Global Settings.

2. In the details pane, under Settings, click Change authentication settings.
3. In Maximum Number of Users, type the number of users who can be authenticated using the

client certificate.
4. In Default Authentication Type, select Cert.
5. In User Name Field, select the type of certificate field that holds the user names.
6. In Group Name Field, select the type of the certificate field that holds the group name.
7. In Default Authorization Group, type the name of the default group and then click OK.

Extracting the User Name from the Client Certificate

If client certificate authentication is enabled on NetScaler Gateway, users are authenticated based
on certain attributes of the client certificate. After authentication is completed successfully, the user
name or the user and group name of the user are extracted from the certificate and any policies spec-
ified for that user are applied.

Configuring and Binding a Client Certificate Authentication Policy

October 5, 2020

You can create a client certificate authentication policy and bind it to a virtual server. You can use
the policy to restrict access to specific groups or users. This policy takes precedence over the global
policy.

To configure a client certificate authentication policy:

1. In the configuration utility, on the Configuration tab, expand NetScaler Gateway > Policies >
Authentication.

2. In the navigation pane, under Authentication, click Cert.

3. In the details pane, click Add.

4. In Name field, type a name for the policy.

5. Next to Server, click +.

6. In Name, type a name for the profile.
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7. Next to Two Factor, select OFF.

8. In User Name Field and Group Name Field, select the values and then click Create.

Note

If you previously configured client certificates as the default authentication type, use the
same names that you used for the policy. If you completed the User Name Field and Group
Name Field for the default authentication type, use the same values for the profile.

9. In the Create Authentication Policy dialog box, next toNamed Expressions, select the expres-
sion, click Add Expression, click Create and then click Close.

To bind a client certificate policy to a virtual server:

After you configure the client certificate authentication policy, you can bind it to a virtual server.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Virtual Servers.

2. In the details pane, click a virtual server and then click Open.
3. In the configure NetScaler Gateway Virtual Server dialog box, click the Authentication tab.
4. Click Primary or Secondary.
5. Under Details, click Insert Policy.
6. In Policy Name, select the policy and then click OK.

To configure a virtual server to request the client certificate:

When you want to use a client certificate for authentication, you must configure the virtual server so
that client certificates are requested during the SSL handshake.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Virtual Servers.

2. In the details pane, click a virtual server and then click Open.
3. On the Certificates tab, click SSL Parameter.
4. Under Others, click Client Authentication.
5. In Client Certificate, select Optional or Mandatory and then click OK twice. Select Optional if

you want to allow other authentication types on the same virtual server and do not require the
use of client certificates.

Note

• For more information about Callback URL, see Import a Citrix Gateway.
• For more information about certificates see Install, link, and update certificates.
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Configuring Two-Factor Client Certificate Authentication

October 5, 2020

You can configure a client certificate to authenticate users first and then require users to log on with a
secondary authentication type, such as LDAP or RADIUS. In this scenario, the client certificate authen-
ticates users first. Then, a logon page appears where they can enter their user name and password.
When the Secure Sockets Layer (SSL) handshake is complete, the logon sequence can take one of the
following two paths:

• Neither the user name nor the group is extracted from the certificate. The logon page appears
to the user with a prompt to enter valid logon credentials. NetScaler Gateway authenticates the
user credentials as in the case of normal password authentication.

• The user name and group name are extracted from the client certificate. If only the user name
is extracted, a logon page appears to the user in which the logon name is present and the user
cannot modify the name. Only the password field is blank.

Group information that NetScaler Gateway extracts during the second round of authentication is ap-
pended to the group information, if any, that NetScaler Gateway extracted from the certificate.

Configuring Smart Card Authentication

October 5, 2020

You can configure NetScaler Gateway to use a cryptographic smart card to authenticate users.

To configure a smart card to work with NetScaler Gateway, you need to do the following:

• Create a certificate authentication policy. For more information, see Configuring Client Certifi-
cate Authentication.

• Bind the authentication policy to a virtual server.

• Add the root certificate of the Certificate Authority (CA) issuing the client certificates to NetScaler
Gateway. For more information, see To install a root certificate on NetScaler Gateway.

Important: When you add the root certificate to the virtual server for smart card authentication,
you must select the certificate from the
Select CA Certificate drop-down box, as shown in the following figure.
Figure 1. Adding a root certificate for smart card authentication
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After you create the client certificate, you can write the certificate, known as flash, onto the smart card.
When you complete that step, you can test the smart card.

If you configure the Web Interface for smart card passthrough authentication, if either of the following
conditions exist, single sign-on to the Web Interface fails:

• If you set the domain on the Published Applications tab as mydomain.com instead mydomain.
• If you do not set the domain name on the Published Applications tab and if you run the com-

mand wi-sso-split-upn setting the value to 1. In this instance, the UserPrincipalName contains
the domain name “mydomain.com.”

You can use smart card authentication to streamline the logon process for your users while also en-
hancing the security of user access to your infrastructure. Access to the internal corporate network is
protected by certificate-based two-factor authentication using public key infrastructure. Private keys
are protected by hardware controls and never leave the smart card. Your users get the convenience of
accessing their desktops and applications from a range of corporate devices using their smart cards
and PINs.

You can use smart cards for user authentication through StoreFront to desktops and applications pro-
vided by XenDesktop and XenApp. Smart card users logging on to StoreFront can also access applica-
tions provided by App Controller. However, users must authenticate again to access App Controller
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web applications that use client certificate authentication.

For more information, see Configure smart card authentication in the StoreFront documentation.

Configuring Smart Card Authentication with Secure ICA Connections

Users who log on and establish a secure ICA connection by using a smart card with single sign-on con-
figured on NetScaler Gateway might receive prompts for their personal identification number (PIN)
at two different times: when logging on and when trying to start a published resource. This situation
occurs if the web browser and Citrix Receiver are using the same virtual server that is configured to
use client certificates. Citrix Receiver does not share a process or a Secure Sockets Layer (SSL) connec-
tion with the web browser. Therefore, when the ICA connection completes the SSL handshake with
NetScaler Gateway, the client certificate is required a second time.

To prevent users from receiving the second PIN prompt, you have to change two settings:

• Client authentication on the VPN Virtual Server must be disabled.
• SSL renegotiation must be enabled.

After you configure the virtual server, bind one or more STA servers to the virtual server, as described
in Configuring NetScaler Gateway Settings in Web Interface 5.3.

You might also want to test smart-card authentication.

To disable client authentication:

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Virtual Servers.

2. Select the relevant virtual server in the main details pane, and then click Edit.
3. In the Advanced options pane, click SSL Parameters.
4. Clear the Client Authentication check box.
5. Click Done.

To enable SSL renegotiation:

1. Using the configuration utility, from the Configuration tab, navigate to Traffic Management, and
then clickSSL.

2. In the main panel, click Change advanced SSL settings.
3. From the Deny SSL Renegotiation menu, select NO.

To test smart card authentication:

1. Connect the smart card to the user device.
2. Open your web browser and log on to NetScaler Gateway.
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Configuring a Common Access Card

October 5, 2020

The United States Department of Defense uses common access cards for identification and authenti-
cation.

To configure a common access card:

1. In the configuration utility, on the Configuration tab, expand NetScaler Gateway > Policies >
Authentication.

2. On the Servers tab, click Add.
3. In Name, type a name.
4. In Authentication Type, select Cert.
5. In User Name Field, type SubjectAltName:PrincipalName and then click Create.
6. On the Policies tab, create a policy that uses this server and then bind the policy to the virtual

server.

Configuring RADIUS Authentication

October 5, 2020

You can configure NetScaler Gateway to authenticate user access with one or more RADIUS servers.
If you are using RSA SecurID, SafeWord, or Gemalto Protiva products, each of these is configured by
using a RADIUS server.

Your configuration might require using a network access server IP address (NAS IP) or a network access
server identifier (NAS ID). When configuring NetScaler Gateway to use a RADIUS authentication server,
use the following guidelines:

• If you enable use of the NAS IP, the appliance sends its configured IP address to the RADIUS
server, rather than the source IP address used in establishing the RADIUS connection.

• If you configure the NAS ID, the appliance sends the identifier to the RADIUS server. If you do
not configure the NAS ID, the appliance sends its host name to the RADIUS server.

• When you enable the NAS IP, the appliance ignores any NAS ID that is configured using the NAS
IP to communicate with the RADIUS server.

Configuring Gemalto Protiva

Protiva is a strong authentication platform that Gemalto developed to use the strengths of Gemalto’s
smart card authentication. With Protiva, users log on with a user name, password, and a one-time
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password that the Protiva device generates. Similar to RSA SecurID, the authentication request is
sent to the Protiva authentication server and the server either validates or rejects the password. To
configure Gemalto Protiva to work with NetScaler Gateway, use the following guidelines:

• Install the Protiva server.
• Install the Protiva SAS Agent Software, that extends the Internet Authentication Server (IAS), on

a Microsoft IAS RADIUS server. Make sure you note the IP address and port number of the IAS
server.

• Configure a RADIUS authentication profile on NetScaler Gateway and enter the settings of the
Protiva server.

Configuring SafeWord

The SafeWord product line provides secure authentication using a token-based passcode. After the
user enters the passcode, SafeWord immediately invalidates the passcode and it cannot be used
again. When you configure the SafeWord server, you need the following information:

• The IP address of NetScaler Gateway. This should be the same IP address that you configured
in the RADIUS server client configuration. NetScaler Gateway uses the internal IP address to
communicate with the RADIUS server. When you configure the shared secret, use the internal IP
address. If you configure two appliances for high availability, use the virtual internal IP address.

• A shared secret.
• The IP address and port of the SafeWord server. The default port number is 1812.

To configure RADIUS authentication

October 5, 2020

1. In the configuration utility, on the Configuration tab, expand NetScaler Gateway > Policies >
Authentication.

2. Click RADIUS, and then in the details pane, on the Policies tab, click Add .
3. In the Create Authentication Policy dialog box, in Name, type a name for the policy.
4. In Name, type a name for the policy.
5. Next to Server, click New.
6. In the Create Authentication Policy dialog box, in Name, type a name for the server.
7. Under Server, in IP Address, type the IP address of the RADIUS server.
8. In Port, type the port. The default is 1812.
9. Under Details, in Secret Key and Confirm Secret Key, type the RADIUS server secret.

10. In NAS ID, type the identifier number and then click Create.
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11. In the Create Authentication Policy dialog box, next to Named Expressions, select the expres-
sion, click Add Expression, click Create and then click Close.

Choosing RADIUS Authentication Protocols

October 5, 2020

NetScaler Gateway supports implementations of RADIUS that are configured to use several protocols
for user authentication, including:

• Password Authentication Protocol (PAP)
• Challenge-Handshake Authentication Protocol (CHAP)
• Microsoft Challenge-Handshake Authentication Protocol (MS-CHAP Version 1 and Version 2)

If your deployment of the NetScaler Gateway is configured to use RADIUS authentication and your
RADIUS server is configured to use PAP, you can strengthen user authentication by assigning a strong
shared secret to the RADIUS server. Strong RADIUS shared secrets consist of random sequences of
uppercase and lowercase letters, numbers, and punctuation and are at least 22 characters long. If
possible, use a random character generation program to determine RADIUS shared secrets.

To further protect RADIUS traffic, assign a different shared secret to each NetScaler Gateway appliance
or virtual server. When you define clients on the RADIUS server, you can also assign a separate shared
secret to each client. If you do this, you must configure separately each NetScaler Gateway policy that
uses RADIUS authentication.

When you create a RADIUS policy, you configure shared secrets on NetScaler Gateway as part of the
policy.

Configuring IP Address Extraction

October 5, 2020

You can configure NetScaler Gateway to extract the IP address from a RADIUS server. When a user
authenticates with the RADIUS server, the server returns a framed IP address (also called RADIUS At-
tribute 8 Framed-IP-Address in Access Requests) that is assigned to the user. The following are com-
ponents for IP address extraction:

• Allows a remote RADIUS server to supply an IP address from the internal network for a user
logged on to NetScaler Gateway.

• Allows configuration for any RADIUS attribute using the type ipaddress, including attributes
that are vendor encoded.
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When configuring the RADIUS server for IP address extraction, you configure the vendor identifier and
the attribute type. The vendor ID and attributes are used to make the association between the RADIUS
client and the RADIUS server.

• The vendor identifier (ID) enables the RADIUS server to assign an IP address to the client from
a pool of IP addresses that are configured on the RADIUS server. The vendor ID is the attribute
in the RADIUS response that provides the IP address of the internal network. A value of zero
indicates that the attribute is not vendor encoded

• The attribute type is the remote IP address attribute in a RADIUS response. The minimum value
is 1 and the maximum value is 255.

A common configuration is to extract the RADIUS attribute framed IP address. The vendor ID is set to
0 or is not specified. The attribute type is set to 8.

To configure IP address extraction from a RADIUS server:

1. In the configuration utility, on the Configuration tab, expand NetScaler Gateway > Policies >
Authentication.

2. Click RADIUS, and then in the details pane, on the Policies tab, select a RADIUS policy and then
click Open.

3. In the Configure Authentication Policy dialog box, next to Server, click Modify.
4. Under Details, in Group Vendor Identifier, type the value.
5. In Group Attribute Type, type the value and then click OK twice.

Configuring RADIUS Group Extraction

October 5, 2020

You can configure RADIUS authorization by using a method called group extraction. Configuring group
extraction allows you to administer users on your RADIUS server instead of adding them to NetScaler
Gateway.

You configure RADIUS authorization by using an authentication policy and configuring the group ven-
dor identifier (ID), the group attribute type, the group prefix, and a group separator. When you config-
ure the policy, you add an expression, and then bind the policy either globally or to a virtual server.

Configuring RADIUS onWindows Server 2003

If you are using Microsoft Internet Authentication Service (IAS) for RADIUS authorization on Windows
Server 2003, during configuration of NetScaler Gateway, you need to provide the following informa-
tion:

• Vendor ID is the vendor-specific code that you entered in IAS.
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• Type is the vendor-assigned attribute number.
• Attribute name is the type of attribute name that you defined in IAS. The default name is CTX-

SUserGroups=

If IAS is not installed on the RADIUS server, you can install it from Add or Remove Programs in Control
Panel. For more information, see the Windows online Help.

To configure IAS, use the Microsoft Management Console (MMC) and install the snap-in for IAS. Follow
the wizard, making sure you select the following settings:

• Select local computer.

• Select Remote Access Policies and create a custom policy.

• Select Windows-Groups for the policy.

• Select one of the following protocols:

– Microsoft Challenge-Handshake Authentication Protocol version 2 (MS-CHAP v2)
– Microsoft Challenge-Handshake Authentication Protocol (MS-CHAP)
– Challenge-Handshake Authentication Protocol (CHAP)
– Unencrypted authentication (PAP, SPAP)

• Select the Vendor-Specific Attribute.

The Vendor-Specific Attribute needs to match the users whom you defined in the group on the
server with the users on NetScaler Gateway. To meet this requirement, you send the Vendor-
Specific Attributes to NetScaler Gateway. Make sure you select RADIUS=Standard.

• The RADIUS default is 0. Use this number for the vendor code.

• The vendor-assigned attribute number is 0.

This is the assigned number for the User Group attribute. The attribute is in string format.

• Select String for the Attribute format.

The Attribute value requires the attribute name and the groups.

For the Access Gateway, the attribute value is CTXSUserGroups=groupname. If two groups are
defined, such as sales and finance, the attribute value is CTXSUserGroups=sales;finance. Sepa-
rate each group with a semicolon.

• Remove all other entries in the Edit Dial-in Profile dialog box, leaving the one that says Vendor-
Specific.

After you configure the Remote Access Policy in IAS, you configure RADIUS authentication and autho-
rization on NetScaler Gateway.

When configuring RADIUS authentication, use the settings that you configured on the IAS server.
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Configuring RADIUS for Authentication onWindows Server 2008

On Windows Server 2008, you configure RADIUS authentication and authorization by using the Net-
work Policy Server (NPS), which replaces Internet Authentication Service (IAS). You can use Server
Manager and add NPS as a role to install NPS.

When you install NPS, select the Network Policy Service. After installation, you can configure RADIUS
settings for your network by starting the NPS from Administrative Services on the Start menu. When
you open the NPS, you add NetScaler Gateway as a RADIUS client and then configure server groups.

When you configure the RADIUS client, make sure you select the following settings:

• For the vendor name, select RADIUS Standard.
• Make note of the shared secret because you will need to configure the same shared secret on

NetScaler Gateway.

For the RADIUS groups, you need the IP address or host name of the RADIUS server. Do not change
the default settings.

After you configure the RADIUS client and groups, you then configure settings in the following two
policies:

• Connection Request Policies where you configure the settings for the NetScaler Gateway con-
nection including the type of network server, the conditions for the network policy, and the
settings for the policy.

• Network Policies where you configure the Extensible Authentication Protocol (EAP) authentica-
tion and the vendor-specific attributes.

When you configure the connection request policy, select Unspecified for the type of network server.
You then configure your condition by selecting NAS Port Type as the condition and Virtual (VPN) as the
value.

When you configure a network policy, you need to configure the following settings:

• Select Remote Access Server (VPN Dial-up) as the type of network access server.

• Select Encrypted Authentication (CHAP) and Unencrypted Authentication (PAP and SPAP) for
the EAP.

• Select RADIUS Standard for the Vendor-Specific Attribute.

The default attribute number is 26. This attribute is used for RADIUS authorization.

NetScaler Gateway needs the vendor-specific attribute to match the users defined in the group
on the server with those on NetScaler Gateway. This is done by sending the vendor-specific
attributes to the NetScaler Gateway.

• Select String for the attribute format.

The Attribute value requires the attribute name and the groups.
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For NetScaler Gateway, the attribute value is CTXSUserGroups= groupname. If two groups are
defined, such as sales and finance, the attribute value is CTXSUserGroups=sales;finance. Sepa-
rate each group with a semicolon.

• The separator is that which you used on the NPS to separate groups, such as a semicolon, a
colon, a space, or a period.

When you are finished configuring the remote access policy in IAS, you can configure RADIUS authen-
tication and authorization on NetScaler Gateway.

To configure RADIUS authorization

October 5, 2020

1. In the configuration utility, on the Configuration tab, expand NetScaler Gateway > Policies >
Authentication.

2. Click RADIUS.
3. In the Policies tab, click Add.
4. In Name, type a name for the policy.
5. Below the Server* click +
6. In Name, type the name of the RADIUS server.
7. Under Server, type the IP address and port of the RADIUS server.
8. Under Details, enter the values for Group Vendor Identifier and Group Attribute Type.
9. In Password Encoding, select the authentication protocol and then click Create.

10. In the Create Authentication Policy dialog box, next to Named Expressions, select the expres-
sion, click Add Expression, click Create and then click Close.

Configuring RADIUS user accounting

October 5, 2020

NetScaler Gateway can send user-session start and stop messages to your RADIUS accounting server.
The messages, which are sent for each user session, include a subset of the attributes defined
in RFC2866. Table 1 lists the supported attributes and the types of RADIUS accounting messages
(RAD_START and RAD_STOP) in which they are sent. Table 2 lists the predefined values that can be
assigned to the Acct-Terminate-Cause attribute, and the corresponding NetScaler Gateway events.

Table 1. Supported RADIUS Attributes
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Attribute Meaning RAD_START RAD_STOP

User-Name Name of user
associated with the
session.

X X

Session-Id The NetScaler session
ID.

X X

Acct-Session-Time Session duration
seconds.

X

Acct-Terminate-Cause Reason for account
termination (see
below).

X

Table 2. RADIUS Termination Causes

Netscaler Logout Method RADIUS Termination Cause

LOGOUT_SESSN_TIMEDOUT RAD_TERM_SESSION_TIMEOUT

LOGOUT_SESSN_INITIATEDBYUSER RAD_TERM_USER_REQUEST

LOGOUT_SESSN_KILLEDBYADMIN RAD_TERM_ADMIN_RESET

LOGOUT_SESSN_TLOGIN RAD_TERM_NAS_REQUEST

LOGOUT_SESSN_MAXLICRCHD RAD_TERM_NAS_REQUEST

LOGOUT_SESSN_CLISECCHK_FAILED RAD_TERM_NAS_REQUEST

LOGOUT_SESSN_PREAUTH_CHANGED RAD_TERM_NAS_REQUEST

LOGOUT_SESSN_COOKIE_MISMATCH RAD_TERM_NAS_REQUEST

LOGOUT_SESSS_DHT RAD_TERM_NAS_REQUEST

LOGOUT_SESSS_2FACTOR_FAIL RAD_TERM_NAS_REQUEST

LOGOUT_SESSN_ICALIC RAD_TERM_NAS_REQUEST

LOGOUT_SESSN_INTERNALERR RAD_TERM_NAS_ERROR

Other RAD_TERM_NAS_ERROR

Configuration of RADIUS user accounting requires the creation of a pair of policies. The first policy is a
RADIUS authentication policy that designates a RADIUS server to which to send accounting messages.
The second is a session policy that uses the RADIUS accounting policy as its action.
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To configure RADIUS user accounting, you must:

1. Create a RADIUS policy to define the RADIUS accounting server. The accounting server can be
the same server that you use for RADIUS authentication.

2. Create a session policy, using the RADIUS policy as an action that specifies the RADIUS user
accounting server.

3. Bind the session policy either globally, so that it applies to all traffic, or to a NetScaler Gateway
virtual server, so that it applies only to traffic flowing through that virtual server.

To create a RADIUS policy

1. In the configuration utility, in the navigation pane, expand the NetScaler Gateway node, and
then Policies.

2. Expand Authentication and select RADIUS.
3. In the details pane, on the Policies tab, click Add.
4. Enter a name for the policy.
5. Select a server from the Server menu, or click the + icon and follow the prompts to add a new

RADIUS server.
6. In the Expression pane, from the Saved Policy Expressions menu, select ns_true.
7. Click Create.

To create a session policy

After configuring a RADIUS policy that specifies the RADIUS accounting server, create a session policy
that applies this accounting server in an action, as follows:

1. In the configuration utility, in the navigation pane, expand the NetScaler Gateway node, and
then Policies.

2. Select Session.
3. In the main details pane, select Add.
4. Enter a name for the policy.
5. In the Action menu, click the + icon to add a new session action.
6. Enter a name for the session action.
7. Click the Client Experience tab.
8. In the Accounting Policy menu, select the RADIUS policy that you created earlier.
9. Click Create.

10. In the Expression pane, from the Saved Policy Expressions menu, select ns_true.
11. Click Create.
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To bind the session policy globally

1. In the configuration utility, in the navigation pane, expand the NetScaler Gateway node, and
then Policies.

2. Select Session.
3. From the Action menu in the main details pane, select Global Bindings.
4. Click Bind.
5. In the Policies pane, select the session policy that you created earlier, and then click Insert.
6. In the Policies listings, click the Priority entry for the session policy and enter a value from 0 to

64000.
7. Click OK.

To bind the session policy to a NetScaler Gateway virtual server

1. In the configuration utility, in the navigation pane, expand the NetScaler Gateway node, and
then select Virtual Servers.

2. In the main details pane, select a virtual server, and then click Edit.
3. In the Policies pane, click the + icon to select a policy.
4. From the Choose Policy menu, select Session and make sure that Request is selected in the

Choose Type menu.
5. Click Continue.
6. Click Bind.
7. In the Policies pane, select the session policy that you created earlier, and then click Insert.
8. Click OK.

Configuring SAML Authentication

October 5, 2020

The Security Assertion Markup Language (SAML) is an XML-based standard for exchanging authenti-
cation and authorization between Identity Providers (IdP) and Service Providers. NetScaler Gateway
supports SAML authentication.

When you configure SAML authentication, you create the following settings:

• IdP Certificate Name. This is the public key that corresponds to the private key at the IdP.
• Redirect URL. This is the URL of the authentication IdP. Users who are not authenticated are

redirected to this URL.
• User Field. You can use this field to extract the user name if the IdP sends the user name in a

different format than the NameIdentifier tag of the Subject tag. This is an optional setting.
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• Signing Certificate Name. This is the private key of the NetScaler Gateway server that is used
to sign the authentication request to the IdP. If you do not configure a certificate name, the
assertion is sent unsigned or the authentication request is rejected.

• SAML Issuer name. This value is used when the authentication request is sent. There must be a
unique name in the issuer field to signify the authority from which the assertion is sent. This is
an optional field.

• Default authentication group. This is the group on the authentication server from which users
are authenticated.

• Two Factor. This setting enables or disables two-factor authentication.
• Reject unsigned assertion. If enabled, NetScaler Gateway rejects user authentication if the sign-

ing certificate name is not configured.

NetScaler Gateway supports HTTP POST-binding. In this binding, the sending party replies to the user
with a 200 OK that contains a form-auto post with required information. Specifically, that default
form must contain two hidden fields called SAMLRequest and SAMLResponse, depending on whether
the form is a request or response. The form also includes RelayState, which is a state or information
used by the sending party to send arbitrary information that is not processed by relying party. The
relying party simply sends the information back so that when the sending party gets the assertion
along with RelayState, the sending party knows what to do next. Citrix recommends that you encrypt
or obfuscate RelayState.

Configuring Active Directory Federation Services 2.0

You can configure Active Directory Federation Services (AD FS) 2.0 on any Windows Server 2008 or
Windows Server 2012 computer that you use in a federated server role. When you configure the AD
FS server to work with NetScaler Gateway, you need configure the following parameters by using the
Relying Party Trust Wizard in Windows Server 2008 or Windows Server 2012.

Windows Server 2008 Parameters:

• Relying Party Trust. You provide the NetScaler Gateway metadata file location, such as https:
//vserver.fqdn.com/ns.metadata.xml, where vserver.fqdn.com is the fully qualified do-
main name (FQDN) of the NetScaler Gateway virtual server. You can find the FQDN on the server
certificate bound to the virtual server.

• Authorization Rules. You can allow or deny users access to the relying party.

Windows Server 2012 Parameters:

• Relying Party Trust. You provide the NetScaler Gateway metadata file location, such as https:
//vserver.fqdn.com/ns.metadata.xml, where vserver.fqdn.com is the fully qualified do-
main name (FQDN) of the NetScaler Gateway virtual server. You can find the FQDN on the server
certificate bound to the virtual server.

• AD FS Profile. Select the AD FS profile.
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• Certificate. NetScaler Gateway does not support encryption. You do not need to select a certifi-
cate.

• Enable support for the SAML 2.0 WebSSO protocol. This enables support for SAML 2.0
SSO. You provide the NetScaler Gateway virtual server URL, such as https:netScaler.
virtualServerName.com/cgi/samlauth.

This URL is the Assertion Consumer Service URL on the NetScaler Gateway appliance. This is a
constant parameter and NetScaler Gateway expects a SAML response on this URL.

• Relying party trust identifier. Enter the name NetScaler Gateway. This is a URL that identi-
fies relying parties, such ashttps://netscalerGateway.virtualServerName.com/adfs
/services/trust.

• Authorization Rules. You can allow or deny users access to the relying party.

• Configure claim rules. You can configure the values for LDAP attributes by using Issuance Trans-
form Rules and use the template Send LDAP Attributes as Claims. You then configure LDAP set-
tings that include:

– Email addresses
– sAMAccountName
– User Principal Name (UPN)
– MemberOf

• Certificate Signature. You can specify the signature verification certificates by selecting the
Properties of a Relaying Party and then adding the certificate.

If the signing certificate is less than 2048 bits, a warning message appears. You can ignore the
warning to proceed. If your are configuring a test deployment, disable the Certificate Revocation
List (CRL) on the Relaying Party. If you do not disable the check, AD FS tries the CRL to validate
the certificate.

You can disable the CRL by running the following command: Set-ADFWRelayingPartyTrust - Sign-
ingCertficateRevocatonCheck None-TargetName NetScaler

After you configure the settings, verify the relying party data before you complete the Relaying Party
Trust Wizard. You check the NetScaler Gateway virtual server certificate with the endpoint URL, such
as https://vserver.fqdn.com/cgi/samlauth.

After you finish configuring settings in the Relaying Party Trust Wizard, select the configured trust and
then edit the properties. You need to do the following:

• Set the secure hash algorithm to SHA-1.

Note: Citrix supports SHA-1 only.

• Delete the encryption certificate. Encrypted assertions are not supported.
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• Edit the claim rules, including the following:

– Select Transform Rule
– Add Claim Rule
– Select Claim Rule Template: Send LDAP attributes as claims
– Give a Name
– Select Attribute Store: Active Directory
– Select LDAP attribute: <Active Directory parameters>
– Select Out Going Claim Rule as “Name ID”

Note: Attribute Name XML tags are not supported.

• Configure the Logout URL for Single Sign-off. The claim rule is Send logout URL. The custom
rule should be the following:

pre codeblock => issue(Type = ”logoutURL”, Value = ”https://<adfs.fqdn
.com>/adfs/ls/”, Properties[”http://schemas.xmlsoap.org/ws/2005/05/
identity/claimproperties/attributename”] = ”urn:oasis:names:tc:SAML
:2.0:attrname-format:unspecified”);

After you configure AD FS settings, download the AD FS signing certificate and then create a certificate
key on NetScaler Gateway. You can then configure SAML authentication on NetScaler Gateway by
using the certificate and key.

Configuring SAML Two-Factor Authentication

You can configure SAML two-factor authentication. When you configure SAML authentication with
LDAP authentication, use the following guidelines:

• If SAML is the primary authentication type, disable authentication in the LDAP policy and con-
figure group extraction. Then, bind the LDAP policy as the secondary authentication type.

• SAML authentication does not use a password and only uses the user name. Also, SAML authen-
tication only informs users when authentication succeeds. If SAML authentication fails, users
are not notified. Since a failure response is not sent, SAML has to be either the last policy in the
cascade or the only policy.

• Citrix recommends that you configure actual user names instead of opaque strings.
• SAML cannot be bound as the secondary authentication type.

To configure SAML authentication

October 5, 2020
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1. In the configuration utility, on the Configuration tab, expand NetScaler Gateway > Policies >
Authentication.

2. In the navigation pane, click SAML.

3. In the details pane, click Add.

4. In the Create Authentication Policy dialog box, in Name, type a name for the policy.

5. Next to Server, click New.

6. In Name, type a name for the server profile.

7. In IdP Certificate Name, select a certificate or click Install. This is the certificate installed on the
SAML or IDP server.

If you click Install, add the certificate and private key. For more information, see Installing and
Managing Certificates.

8. In Redirect URL, enter the URL of the authentication Identity Provider (IdP).

This is the URL for user logon to the SAML server. This is the server to which NetScaler Gateway
redirects the initial request.

9. In User Field, enter the user name to extract.

10. In Signing Certificate Name, select the private key for the certificate you selected in Step 9.

This is the certificate that is bound to the AAA virtual IP address. The SAML Issuer Name is
the fully qualified domain name (FQDN) to which users log on, such as lb.example.com or
ng.example.com.

11. In SAML Issuer Name, enter the FQDN of the load balancing or NetScaler Gateway virtual IP
address to which the appliance sends the initial authentication (GET) request.

12. In Default authentication group, enter the group name.

13. To enable two-factor authentication, in Two Factor, click ON.

14. Disable Reject Unsigned Assertion. Enable this setting only if the SAML or IDP server is signing
the SAML response.

15. Click Create and then click Close.

16. In the Create authentication policy dialog box, next to Named Expressions, select General, select
True value, click Add Expression, click Create and then click Close.

Auth Improvements for SAML Authentication

October 5, 2020
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This feature is for those with SAML knowledge, and fundamental authentication proficiency is re-
quired to use this information. The reader must understand FIPS to use this information.

The following NetScaler features can be used with third party applications/servers that are compatible
with the SAML 2.0 specification:

• SAML Service Provider (SP)
• SAML Identity Provider (IdP)

SP and IdP allow a SingleSignOn (SSO) between cloud services. The SAML SP feature provides a way
of addressing user claims from an IdP. The IdP could be a third party service or another NetScaler
appliance. The SAML IdP feature is used to assert user logons and provide claims consumed by SPs.

As part of the SAML support, both IdP and SP modules digitally sign the data that is sent to peers. The
digital signature includes an authentication request from SP, Assertion from IdP, and logout messages
between these two entities. The digital signature validates the message authenticity.

The current implementation of SAML SP and IdP do the signature computation in a packet engine.
These modules use SSL certificates to sign the data. In a FIPS compliant NetScaler, the private key of
the SSL certificate is not available in the packet engine or user space, so the SAML module today is not
ready for FIPS hardware.

This document describes the mechanism to offload signature calculations to the FIPS card. Signature
verification is done in the software, as the public key is available.

Solution

The SAML feature set is enhanced to use an SSL API for signature offload. See docs.citrix.com for de-
tails about these affected SAML sub-features:

1. SAML SP Post Binding – Signing of AuthnRequest

2. SAML IdP Post Binding – Signing of Assertion/Response/Both

3. SAML SP Single Logout scenarios – Signing of LogoutRequest in SP initiated model and Signing
of LogoutResponse in IdP initiated model

4. SAML SP Artifact binding – Signing of ArtifactResolve request

5. SAML SP Redirect Binding – Signing of AuthnRequest

6. SAML IdP Redirect Binding – Signing of Response/Assertion/Both

7. SAML SP Encryption support – Decryption of Assertion

Platform

The API can be offloaded only to a FIPS platform.
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Configuration

Offload configuration is performed automatically on the FIPS platform.

However, since SSL private keys are not available to user space in FIPS hardware, there is a slight
configuration change in creating the SSL certificate on FIPS hardware.

Here’s the configuration information:

• add ssl fipsKey fips-key

You would then need to create a CSR and use it at the CA server to generate a certificate. You
can then copy that certificate in /nsconfig/ssl. Let’s assume that file is fips3cert.cer.

• add ssl certKey fips-cert -cert fips3cert.cer -fipsKey fips-key

You would then need to specify this certificate in the SAML action for SAML SP module.

• set samlAction <name> -samlSigningCertName fips-cert

Likewise, you need to use this in samlIdpProfile for SAML IdP module

• set samlidpprofile fipstest –samlIdpCertName fips-cert

The first time, you will not have the fips-key described above. If there’s no FIPS key, create one as
described in Create and transfer FIPS keys.

Configuring TACACS+ Authentication

October 5, 2020

You can configure a TACACS+ server for authentication. Similar to RADIUS authentication, TACACS+
uses a secret key, an IP address, and the port number. The default port number is 49.

To configure NetScaler Gateway to use a TACACS+ server, provide the server IP address and the
TACACS+ secret. You need to specify the port only when the server port number in use is something
other than the default port number of 49.

To configure TACACS+ authentication using user interface, perform the following steps.

1. In the configuration utility, on the Configuration tab, expand NetScaler Gateway > Policies >
Authentication.

2. Click TACACS.
3. In the details pane, click Add.
4. In Name, type a name for the policy.
5. Next to Server, click New.
6. In Name, type a name for the server.
7. Under Server, type the IP address and port number of the TACACS+ server.
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8. Under TACACS server information, in TACACS Key and Confirm TACACS key, type the key.
9. In Authorization, select ON and then click Create.

10. In the Create Authentication Policy dialog box, next to Named Expressions, select the expres-
sion, click Add Expression, click Create and then click Close.

To configure TACACS+ authentication using command line interface, type the following command.

1 add authentication tacacsAction <name> [-serverIP <ip_addr|ipv6_addr
|*>][-serverPort <port>] [-authTimeout <positive_integer>] {

2 -tacacsSecret }
3
4 [-authorization ( ON | OFF )] [-accounting ( ON | OFF )][-

auditFailedCmds ( ON | OFF )] [-groupAttrName <string>][-
defaultAuthenticationGroup <string>] [-Attribute1 <string>] [-
Attribute2 <string>] [-Attribute3 <string>] [-Attribute4 <string>]

5 [-Attribute5 <string>] [-Attribute6 <string>] [-Attribute7 <string>] [-
Attribute8 <string>] [-Attribute9 <string>] [-Attribute10 <string>]

6 [-Attribute11 <string>] [-Attribute12 <string>] [-Attribute13 <string>]
[-Attribute14 <string>] [-Attribute15 <string>] [-Attribute16 <
string>]

After you configure the TACACS+ server settings in NetScaler Gateway, bind the policy to make it active.
You can bind the policy on either the global or virtual server level. For more information about binding
authentication policies, see Binding Authentication Policies.

Clear Config Basic Should Not Clear TACACS Config

October 5, 2020

Overview

This enhancement focuses on NOT CLEARING all RBA (Role Based Access) related configurations when
the clear config command is executed.

The current clear config command is performed in one of three levels:

• Basic

• Extended

• Full

Based on the level chosen, NetScaler configurations are cleared and reset to the factory default.
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The command used is:

1 clear ns config \[-force\] \<level\>

The new command adds a knob to allow/deny the deletion of all RBA related configurations.

New Command

Described are the Clear RBAconfig features:

1. YES/NO knob with Default: YES.

The admin decides whether to retain the RBA config or not.

2. ONLY the BASIC LEVEL of clear config is supported.

3. The following configurations not cleared:

• Add/bind system user/group.

• Add cmd policy.

• TACACS commands.(add TACACS action/policy).

• Bind system global

Note: TACACS related config (action/policy) is preserved if the policy is bound to system global
or else it is cleared

CLI Configuration

The command used

1 clear config [ ‒ force] <level> [-RBAconfig]

By default it is set to YES, and clears the configurations based on the level specified.

If –RBAconfig is set to NO, the RBA related config is retained. The following is included:

• Add /bind system user /group
• Bind system global
• tacacs related commands (add tacacs action/policy)
• Add cmd policy
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Configuring Multifactor Authentication

October 5, 2020

You can configure two types of multifactor authentication in NetScaler Gateway:

• Cascading authentication that sets the authentication priority level
• Two-factor authentication that requires users to log on by using two types of authentication

If you have multiple authentication servers, you can set the priority of your authentication polices.
The priority levels you set determine the order in which the authentication server validates users’ cre-
dentials. A policy with a lower priority number takes precedence over a policy with a higher number.

You can have users authenticate against two different authentication servers. For example, you can
configure an LDAP authentication policy and an RSA authentication policy. When users log on, they
authenticate first with their user name and password. Then, they authenticate with a personal iden-
tification number (PIN) and the code from the RSA token.

Configuring Cascading Authentication

October 5, 2020

Authentication allows you to create a cascade of multiple authentication servers using policy prioriti-
zation. When you configure a cascade, the system traverses each authentication server, as defined by
the cascaded policies, to validate a user’s credentials. Prioritized authentication policies are cascaded
in ascending order and can have priority values in the range of 1 to 9999. You define these priorities
when binding your policies at either the global or the virtual server level.

During authentication, when a user logs on, the virtual server is checked first and then global authen-
tication policies are checked. If a user belongs to an authentication policy on both the virtual server
and globally, the policy from the virtual server is applied first and then the global authentication pol-
icy. If you want users to receive the authentication policy that is bound globally, change the priority
of the policy. When a global authentication policy has a priority number of one and an authentica-
tion policy bound to a virtual server has a priority number two, the global authentication policy takes
precedence. For example, you could have three authentication policies bound to the virtual server
and you can set the priority of each policy.

If a user fails to authenticate against a policy in the primary cascade, or if that user succeeds in au-
thenticating against a policy in the primary cascade but fails to authenticate against a policy in the
secondary cascade, the authentication process stops and the user is redirected to an error page.

Note: Citrix recommends that when you bind multiple policies to a virtual server or globally, you de-
fine unique priorities for all authentication policies.
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To set the priority for global authentication policies

1. In the configuration utility, on the Configuration tab, expand NetScaler Gateway > Policies >
Authentication.

2. Select the policy that is bound globally and then in Action, click Global Bindings.
3. In the Bind/Unbind Authentication Global Polices dialog box, under Priority, type the number

and then click OK.

To change the priority for an authentication policy bound to a virtual server

You can also modify an authentication policy that is bound to a virtual server.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Virtual Servers.

2. In the details pane, select a virtual server and then click Open.
3. Click the Authentication tab and then click either Primary or Secondary.
4. Next to the authentication policy, under Priority, type the number and then click OK.

Configuring Two-Factor Authentication

October 5, 2020

NetScaler Gateway supports two-factor authentication. Normally, when authenticating users,
NetScaler Gateway stops the authentication process as soon as it successfully authenticates a user
through any one of the configured authentication methods. In certain instances, you may need
to authenticate a user to one server, but extract groups from a different server. For example, if
your network authenticates users against a RADIUS server, but you also use RSA SecurID token
authentication and user groups are stored on that server, you may need to authenticate users to that
server so you can extract the groups.

If users are authenticated by using two authentication types, and if one of those types is client certifi-
cate authentication, you can configure the certificate authentication policy as the second method of
authentication. For example, you use LDAP as your primary authentication type and the client certifi-
cate as the secondary authentication. When users log on with their user name and password, they
then have access to network resources.

When you configure two-factor authentication, you select if the authentication type is the primary or
secondary type.
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To configure two-factor authentication

1. In the configuration utility, on the Configuration tab, expand NetScaler Gateway > Policies >
Authentication.

2. On the Policies tab, click Global Bindings.
3. In the Bind/Unbind Authentication Policies to Global dialog box, click Primary.
4. Click Insert Policy.
5. Under Policy Name, select the authentication policy.
6. Click Secondary, repeat Steps 4 and 5 and then click OK.

Selecting the Authentication Type for Single Sign-On

October 5, 2020

If you have single sign-on and two-factor authentication configured on NetScaler Gateway, you can
select which password to use for single sign-on. For example, you have LDAP configured as the pri-
mary authentication type and RADIUS configured as the secondary authentication type. When users
access resources that require single sign-on, the user name and primary password are sent by default.
You set which password should be used for single sign-on to web applications within a session profile.

To configure authentication for single sign-on

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway > Policies and then click Session.

2. In the details pane, click the Profiles tab and then do one of the following:
• To create a new profile, click Add.
• To modify an existing profile, click Open.

3. On the Client Experience tab, next to Credential Index, click Override Global, select either Pri-
mary or Secondary.

4. If this is a new profile, click Create and then click Close.
5. If you are modifying an existing profile, click OK.

Configuring Client Certificates and LDAP Two-Factor Authentication

October 5, 2020

You can use a secure client certificate with LDAP authentication and authorization, such as using smart
card authentication with LDAP. The user logs on and then the user name is extracted from the client
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certificate. The client certificate is the primary form of authentication and LDAP is the secondary form.
The client certificate authentication must take priority over the LDAP authentication policy. When you
set the priority of the policies, assign a lower number to the client certificate authentication policy
than the number you assign to the LDAP authentication policy.

To use a client certificate, you must have an enterprise Certificate Authority (CA), such as Certificate
Services in Windows Server 2008, running on the same computer that is running Active Directory. You
can use the CA to create a client certificate.

To use a client certificate with LDAP authentication and authorization, it must be a secure certificate
that uses Secure Sockets Layer (SSL). To use secure client certificates for LDAP, install the client cer-
tificate on the user device and install a corresponding root certificate on NetScaler Gateway.

Before configuring a client certificate, do the following:

• Create a virtual server.
• Create an LDAP authentication policy for the LDAP server.
• Set the expression for the LDAP policy to True value.

To configure client certificate authentication with LDAP

1. In the configuration utility, on the Configuration tab, expand NetScaler Gateway > Policies >
Authentication.

2. In the navigation pane, under Authentication, click Cert.
3. In the details pane, click Add.
4. In Name, type a name for the policy.
5. In Authentication Type, select Cert.
6. Next to Server, click New.
7. In Name, type a name for the server, and then click Create.
8. In the Create Authentication Server dialog box, in Name, type the name of the server.
9. Next to Two Factor, select ON.

10. In the User Name Field, select Subject:CN and then click Create.
11. In the Create Authentication Policy dialog box, next to Named Expressions, select True value,

click Add Expression, click Create and then click Close.

After you create the certificate authentication policy, bind the policy to the virtual server. After binding
the certificate authentication policy, bind the LDAP authentication policy to the virtual server.

Important: You must bind the certificate authentication policy to the virtual server before you bind
the LDAP authentication policy to the virtual server.
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To install a root certificate on NetScaler Gateway

After you create the certificate authentication policy, you download and install a root certificate from
your CA in Base64 format and save it on your computer. You can then upload the root certificate to
NetScaler Gateway.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand SSL and
then click Certificates.

2. In the details pane, click Install.
3. In Certificate - Key Pair Name, type a name for the certificate.
4. In Certificate File Name, click Browse and in the drop-down box, select either Appliance or Local.
5. Navigate to the root certificate, click Open and then click Install.

To add a root certificate to a virtual server

After installing the root certificate on NetScaler Gateway, add the certificate to the certificate store of
the virtual server.

Important: When you add the root certificate to the virtual server for smart card authentication, you
must select the certificate from the
Select CA Certificate drop-down box, as shown in the following figure.

Figure 1. Adding a root certificate as a CA
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1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Virtual Servers.

2. In the details pane, select a virtual server and then click Open.

3. On the Certificates tab, under Available, select the certificate, next to Add, in the drop down box,
click as CA and then click OK.

4. Repeat Step 2.

5. On the Certificates tab, click SSL Parameters.

6. Under Others, select Client Authentication.

7. Under Others, next to Client Certificate, select Optional and then click OK twice.

8. After configuring the client certificate, test the authentication by logging on to NetScaler Gate-
way with the NetScaler Gateway Plug-in. If you have more than one certificate installed, you
receive a prompt asking you to select the correct certificate. After you select the certificate, the
logon screen appears with the user name populated with the information obtained from the
certificate. Type the password and then click Login.
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If you do not see the correct user name in the User Name field on the logon screen, check the user
accounts and groups in your LDAP directory. The groups that are defined on NetScaler Gateway must
be the same as those in the LDAP directory. In Active Directory, configure groups at the domain root
level. If you create Active Directory groups that are not in the domain root level, incorrect reading of
the client certificate could result.

If users and groups are not at the domain root level, the NetScaler Gateway logon page displays the
user name that is configured in Active Directory. For example, in Active Directory, you have a folder
called Users and the certificate says CN=Users. In the logon page, in User Name, the word Users ap-
pears.

If you do not want to move your group and user accounts to the root domain level, when configuring
the certificate authentication server on NetScaler Gateway, leave User Name Field and Group Name
Field blank.

Configuring Single Sign-On

October 5, 2020

You can configure NetScaler Gateway to support single sign-on with Windows, to Web applications
(such as SharePoint), to file shares, and to the Web Interface. Single sign-on also applies to file shares
that users can access through the file transfer utility in the Access Interface or from the NetScaler Gate-
way icon menu in the notification area.

If you configure single sign-on when users log on, they are automatically logged on again without
having to enter their credentials a second time.

Configuring Single Sign-Onwith Windows

October 5, 2020

Users open a connection by starting the NetScaler Gateway Plug-in from the desktop. You can specify
that the NetScaler Gateway Plug-in start automatically when the user logs on to Windows by enabling
single sign-on. When you configure single sign-on, users’ Windows logon credentials are passed to
NetScaler Gateway for authentication. Enabling single sign-on for the NetScaler Gateway Plug-in fa-
cilitates operations on the user device, such as installation scripts and automatic drive mapping.

Enable single sign-on only if user devices are logging on to your organization’s domain. If single sign-
on is enabled and a user connects from a device that is not on your domain, the user is prompted to
log on.
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You configure single sign-on with Windows either globally or by using a session profile that is attached
to a session policy.

To configure single sign-on with Windows globally

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Global Settings.

2. In the details pane, under Settings, click Change global settings.
3. On the Client Experience tab, click Single Sign-on with Windows and then click OK.

To configure single sign-on with Windows by using a session policy

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway > Policies and then click Session.

2. In the details pane, click Add.
3. In Name, type a name for the policy.
4. Next to Request Profile, click New.
5. In Name, type a name for the profile.
6. On the Client Experience tab, next to Single Sign-On with Windows, click Override Global, click

Single Sign-on with Windows and then click OK.
7. In the Create Session Policy dialog box, next to Named Expressions, select General, select True

value, click Add Expression, click Create and then click Close.

Configuring Single Sign-On toWeb Applications

October 5, 2020

You can configure NetScaler Gateway to provide single sign-on to servers in the internal network that
use web-based authentication. With single sign-on, you can redirect the user to a custom home page,
such as a SharePoint site or to the Web Interface. You can also configure single sign-on to resources
through the NetScaler Gateway Plug-in from a bookmark configured on the home page or a web ad-
dress that users type in the web browser.

If you are redirecting the home page to a SharePoint site or Web Interface, provide the web address
for the site. When users are authenticated, either by NetScaler Gateway or an external authentication
server, users are redirected to the specified home page. User credentials are passed transparently to
the web server. If the web server accepts the credentials, users are logged on automatically. If the
web server denies the credentials, users receive an authentication prompt asking for their user name
and password.
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You can configure single sign-on to web applications globally or by using a session policy.

To configure single sign-on to web applications globally

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Global Settings.

2. In the details pane, under Settings, click Change global settings.
3. On the Client Experience tab, click Single sign-on to Web Applications and then click OK.

To configure single sign-on to web applications by using a session policy

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway > Policies and then click Session.

2. In the details pane, on the Policies tab, select a session policy and then click Open.
3. In the Configure Session Policy dialog box, next to Request Profile, click Modify.
4. On the Client Experience tab, next to Single Sign-On to Web Applications, click Global Override,

click Single Sign-On to Web Applications and then click OK.

To define the HTTP port for single sign-on to web applications

Single sign-on is attempted only for network traffic where the destination port is considered an HTTP
port. To allow single sign-on to applications that use a port other than port 80 for HTTP traffic, add one
or more port numbers on NetScaler Gateway. You can enable multiple ports. The ports are configured
globally.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Global Settings.

2. In the details pane, under Settings, click Change global settings.

3. On the Network Configuration tab, click Advanced Settings.

4. Under HTTP Ports, type the port number, click Add and then click OK twice.

You can repeat Step 4 for each port you want to add.

Note: If web applications in the internal network use public IP addresses, single sign-on does not
function. To enable single sign-on, split tunneling must be enabled as part of the global policy setting,
regardless if clientless access or the NetScaler Gateway Plug-in is used for user device connections. If
it is not possible to enable split tunneling on a global level, create a virtual server that use a private
address range.
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Configuring Single Sign-on to Web Applications by Using LDAP

October 5, 2020

When you configure single sign-on and users log on by using the user principal name (UPN) with a
format of
username@domain.com, by default single sign-on fails and users must authenticate two times. If you
need to use this format for user logon, modify the LDAP authentication policy to accept this form of
user name.

To configure single sign-on to web applications

1. In the configuration utility, on the Configuration tab, expand NetScaler Gateway > Policies >
Authentication.

2. In the details pane, on the Policies tab, select an LDAP policy and then click Open.
3. In the Configure Authentication Policy dialog box, next to Server, click Modify.
4. Under Connection Settings, in Base DN (location of users), type DC=domainname,DC=com.
5. In Administrator Bind DN, type LDAPaccount@domainname.com, where domainname.com is

the name of your domain.
6. In Administrator Password and Confirm Administrator Password, type the password.
7. Under Other Settings, in Server Logon Name Attribute, type UserPrincipalName.
8. In Group Attribute, type memberOf.
9. In Sub Attribute Name, type CN.

10. In SSO Name Attribute, type the format by which users log on and then click OK twice. This value
is either SamAccountName or UserPrincipleName.

Configuring Single Sign-On to a Domain

October 5, 2020

If users connect to servers running Citrix XenApp and use SmartAccess, you can configure single sign-
on for users connecting to the server farm. When you configure access to published applications using
a session policy and profile, use the domain name for the server farm.

You can also configure single sign-on to file shares in your network.

To configure single sign-on to a domain

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway > Policies and then click Session.
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2. In the details pane, on the Policies tab, select a session policy and then click Open.
3. In the Configure Session Policy dialog box, next to Request Profile, click Modify.
4. In the Configure Session Profile dialog box, on the Published Applications tab, in Single-sign-on

Domain, click Override Global, type the domain name and then click OK twice.

For more information about configuring the NetScaler Gateway with XenApp, see Integrate NetScaler
Gateway with XenApp and XenDesktop.

Configuring One-Time Password Use

October 5, 2020

You can configure NetScaler Gateway to use one-time passwords, such as a token personal identifi-
cation number (PIN) or passcode. After a user enters the passcode or PIN, the authentication server
immediately invalidates the one-time password and the user cannot enter the same PIN or password
again.

Products that include using a one-time password include:

• RSA SecurID
• Imprivata OneSign
• SafeWord
• Gemalto Protiva
• Nordic SMS PASSCODE

To use each of these products, configure the authentication server in the internal network to use RA-
DIUS. For more information, see Configuring RADIUS Authentication.

If you configure authentication on NetScaler Gateway to use a one-time password with RADIUS, as
provided by an RSA SecurID token, for example, NetScaler Gateway attempts to reauthenticate users
by using the cached password. This reauthentication occurs when you make changes to NetScaler
Gateway or if the connection between the NetScaler Gateway Plug-in and NetScaler Gateway is inter-
rupted and then restored.

An attempt to reauthenticate can also occur when connections are configured to use Citrix Receiver
and users connect to the Web Interface by using RADIUS or LDAP. When a user starts an application
and uses the application, and then returns to Receiver to start another application, NetScaler Gateway
uses cached information to authenticate the user.
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Configuring RSA SecurID Authentication

October 5, 2020

When configuring the RSA/ACE server for RSA SecureID authentication, you need to complete the fol-
lowing steps:

Configure the RADIUS client with the following information:

• Provide the name of the NetScaler Gateway appliance.
• Provide a description (not mandatory).
• Provide the system IP address.
• Provide the shared secret between NetScaler Gateway and the RADIUS server.
• Configure the make/model as Standard RADIUS.

In the agent host configuration, you need the following information:

• Provide the fully qualified domain name (FQDN) of NetScaler Gateway (as it appears on the cer-
tificate bound to the virtual server). After providing the FQDN, click the Tab key and the Network
Address window populates itself.

After you enter the FQDN, the network address automatically appears. If it does not, enter the
system IP address.

• Provide the Agent Type by using Communication Server.

• Configure to import all users or a set of users who are allowed to authenticate through NetScaler
Gateway.

If it is not already configured, create an Agent Host entry for the RADIUS server, including the following
information:

• Provide the FQDN of the RSA server.

After you enter the FQDN, the network address automatically appears. If it does not, provide
the IP address of the RSA server.

• Provide the Agent Type, which is the RADIUS server.

For more information about configuring an RSA RADIUS server, see the manufacturer’s documenta-
tion.

To configure RSA SecurID, create an authentication profile and policy and then bind the policy globally
or to a virtual server. To create a RADIUS policy to use RSA SecurID, see Configuring RADIUS Authenti-
cation

After creating the authentication policy, bind it to a virtual server or globally. For more information,
see Binding Authentication Policies.
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Configuring Password Return with RADIUS

October 5, 2020

You can replace domain passwords with a one-time password that a token generates from a RADIUS
server. When users log on to NetScaler Gateway, they enter a personal identification number (PIN)
and the passcode from the token. After NetScaler Gateway validates their credentials, the RADIUS
server returns the user’s Windows password to NetScaler Gateway. NetScaler Gateway accepts the
response from the server and then uses the returned password for single sign-on instead of using
the passcode that users typed during logon. This password return with RADIUS feature allows you to
configure single sign-on without requiring users to recall their Windows password.

When users log on by using password return, they can access all of the allowed network resources in
the internal network, including App Controller, StoreFront, and the Web Interface.

To enable single sign-on by using returned passwords, you configure a RADIUS authentication policy
on NetScaler Gateway by using the Password Vendor Identifier and Password Attribute Type parame-
ters. These two parameters return the user’s Windows password to NetScaler Gateway.

NetScaler Gateway supports Imprivata OneSign. The minimum required version of Imprivata OneSign
is 4.0 with service pack 3. The default password vendor identifier for Imprivata OneSign is 398. The
default password attribute type code for Imprivata OneSign is 5.

You can use other RADIUS servers for password return, such as RSA, Cisco, or Microsoft. You must
configure the RADIUS server to return the user single sign-on password in a vendor-specific attribute
value pair. In an NetScaler Gateway authentication policy, you must add the Password Vendor Identi-
fier and Password Attribute Type parameters for these servers.

You can find a complete list of vendor identifiers on the Internet Assigned Numbers Authority (IANA)
web site. For example, the vendor identifier for RSA security is 2197, for Microsoft, it is 311, and for
Cisco Systems, it is 9. The vendor-specific attribute that a vendor supports must be confirmed with the
vendor. For example, Microsoft has published a list of vendor-specific attributes at Microsoft Vendor-
specific RADIUS Attributes.

You can select any of the vendor-specific attributes to store the single sign-on password for users on
the RADIUS server of the vendor. If you configure NetScaler Gateway with the vendor identifier and
attribute where the user password is stored on the RADIUS server, NetScaler Gateway requests the
value of the attribute in the access request packet that is sent to the RADIUS server. If the RADIUS
server responds with the corresponding attribute-value pair in the access-accept packet, password
return works regardless of the RADIUS server you use.

To configure single sign-on by using returned passwords:

1. In the configuration utility, on the Configuration tab, expand NetScaler Gateway > Policies >
Authentication.

© 1999-2021 Citrix Systems, Inc. All rights reserved. 160

http://www.iana.org/assignments/radius-types/radius-types.xml
http://www.iana.org/assignments/radius-types/radius-types.xml
http://tools.ietf.org/html/rfc2548
http://tools.ietf.org/html/rfc2548


NetScaler Gateway 12.0

2. In the navigation pane, click RADIUS.
3. In the details pane, click Add.
4. In the Create Authentication Policy dialog box, in Name, type a name for the policy.
5. Next to Server, click New.
6. In Name, type the name of the server.
7. Configure the settings for the RADIUS server.
8. In Password Vendor Identifier, type the vendor identifier that is returned by the RADIUS server.

This identifier must have a minimum value of 1.
9. In Password Attribute Type, type the attribute type that is returned by the RADIUS server in the

vendor-specific AVP code. The value can range from 1 through 255.
10. In the Create Authentication Policy dialog box, next to Named Expressions, select the expres-

sion, click Add Expression, click Create and then click Close.

Configuring SafeWord Authentication

October 5, 2020

The SafeWord product line helps to provide secure authentication through the use of a token-based
passcode. After users enter a passcode, it is immediately invalidated by SafeWord and cannot be used
again.

If Access Gateway is replacing the Secure Gateway in a Secure Gateway and Web Interface deployment,
you can choose to not configure authentication on Access Gateway and continue to allow the Web
Interface to provide SafeWord authentication for incoming HTTP traffic.

Access Gateway supports SafeWord authentication for the following products:

• SafeWord 2008
• SafeWord PremierAccess
• SafeWord for Citrix
• SafeWord RemoteAccess

You can configure Access Gateway to authenticate using SafeWord products in the following ways:

• Configure authentication to use a PremierAccess RADIUS server that is installed as part of Safe-
Word PremierAccess and allow it to handle authentication.

• Configure authentication to use the SafeWord IAS agent, which is a component of SafeWord
RemoteAccess, SafeWord for Citrix, and SafeWord PremierAccess 4.0.

• Install the SafeWord Web Interface Agent to work with the Citrix Web Interface. Authentication
does not have to be configured on Access Gateway and can be handled by the Citrix Web In-
terface. This configuration does not use the PremierAccess RADIUS server or the SafeWord IAS
Agent.

© 1999-2021 Citrix Systems, Inc. All rights reserved. 161



NetScaler Gateway 12.0

When configuring the SafeWord RADIUS server, you need the following information:

• The IP address of Access Gateway. When you configure client settings on the RADIUS server, use
the Access Gateway IP address.

• A shared secret.
• The IP address and port of the SafeWord server.

Configuring Gemalto Protiva Authentication

October 5, 2020

Protiva is a strong authentication platform that was developed to use the strengths of Gemalto’s smart
card authentication. With Protiva, users log on with a user name, password, and one-time password
generated by the Protiva device. Similar to RSA SecurID, the authentication request is sent to the
Protiva Authentication Server and the password is either validated or rejected.

To configure Gemalto Protiva to work with the NetScaler Gateway, use the following guidelines:

• Install the Protiva server.
• Install the Protiva Internet Authentication Server (IAS) agent plug-in on a Microsoft IAS RADIUS

server. Make sure you note the IP address and port number of the IAS server.

nFactor for Gateway Authentication

October 5, 2020

Introduction

nFactor authentication enables a whole new set of possibilities for authentication. Administrators
using nFactor enjoy authentication, authorization, and auditing (Citrix ADC AAA) flexibility when con-
figuring authentication factors for virtual servers.

Two policy banks or two factors no longer restrict an administrator. The number of policy banks can
be extended to suit different needs. Based on previous factors, nFactor determines a method of au-
thentication. Dynamic login forms and on-failure actions are possible by using nFactor.

Note: nFactor is not supported for Citrix ADC Standard Edition. It is supported for Citrix ADC
Enterprise Edition and Citrix ADC Platinum Edition.
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Use-cases

nFactor authentication enables dynamic authentication flows based on the user profile. Sometimes,
these can be simple flows to be intuitive to the user. In other cases, they can be coupled with secur-
ing active directory or other authentication servers. The following are some requirements specific to
Gateway:

1. Dynamic username and password selection. Traditionally, Citrix clients (including Browsers
and Receivers) use the active directory (AD) password as the first password field. The second
password is reserved for the One-Time-Password (OTP). However, to secure AD servers, OTP is
required to be validated first. nFactor can do this without requiring client modifications.

2. Multi-Tenant Authentication End-point. Some organizations use different Gateway servers
for Certificate and non-certificate users. With users using their own devices to log in, user’s
access levels vary on NetScaler based on the device being used. Gateway can cater to different
authentication needs.

3. Authentication based on group membership. Some organizations obtain user properties
from AD servers to determine authentication requirements. Authentication requirements can
be varied for individual users.

4. Authentication co-factors. Sometimes, different pairs of authentication policies are used to
authenticate different sets of users. Providing pair policies increases effective authentication.
Dependent policies can be made from one flow. In this manner, independent sets of policies
become flows of their own that increase efficiency and reduce complexity.

Authentication Response Handling

The NetScaler Gateway callback registers handle authentication responses. AAAD (authentication
daemon) responses and success/failure/error/dialogue codes are feed to the callback handle. The
success/failure/error/dialogue codes direct Gateway to take the appropriate action.

Clients Support

The following table details configuration details.

Client nFactor Support
Authentication Policy
Bind Point EPA

Browsers Yes Auth Yes

Citrix Receivers No VPN N

Gateway Plug-in No VPN Yes
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Command Line Configuration

The Gateway virtual server needs an authentication virtual server named as an attribute. This is the
only configuration required for this model.

1 add authnProfile <name-of-profile> -authnVsName <name-of-auth-vserver>

The authnVsName is the name of authentication virtual server. This virtual server is should be config-
ured with advanced authentication policies and is used for nFactor authentication.

1 add vpn vserver <name> <serviceType> <IP> <PORT> -authnProfile <name-of
-profile>

2
3 set vpn vserver <name> -authnProfile <name-of-profile>

Where authnProfile is the previously created authentication profile.

Interop Challenges

Most of the Legacy Gateway clients, and rfWeb clients, are modeled on responses sent by Gateway. For
example, a 302 response to /vpn/index.html is expected for many clients. Also, these clients depend
on various Gateway cookies such as “pwcount,” “NSC_CERT,” and so forth

End Point Analysis (EPA)

EPA in nFactor is not supported for Citrix ADC authentication, authorization, and auditing module.
Hence, the NetScaler Gateway virtual server performs EPA. After EPA, the login credentials are sent
to the authentication virtual server using the previously mentioned API. Once authentication is com-
plete, Gateway continues to the post authentication process and it establishes the user session.

Misconfiguration Considerations

The Gateway client sends the user credentials only once. Gateway gets either one or two credentials
from the client with the login request. In the legacy mode, there are a maximum of two factors. One or
more passwords obtained are used for these factors. However, with nFactor the number of factors that
can be configured is practically unlimited. Passwords obtained from the Gateway client are reused (as
per configuration) for configured factors. Care must be taken such that one-time-password (OTP) is
not reused multiple times. Likewise, administrator must ensure that password reused at a factor is
indeed applicable to that factor.
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Defining Citrix Clients

The configuration option is provided to help NetScaler determine browser clients vs. thick clients such
as Receiver.

A pattern set, ns_vpn_client_useragents, is provided for the administrator to configure patterns for all
Citrix clients.

Likewise, binding the “Citrix Receiver” string to the above patset to ignore all Citrix clients that have
“Citrix Receiver” in the User-Agent.

Restricting nFactor for Gateway

nFactor for Gateway authentication will not happen if the following conditions are present.

1. The authnProfile is not set at NetScaler Gateway.

2. Advanced authentication policies are not bound to authentication virtual server and the same
authentication virtual server is mentioned in authnProfile.

3. The User-Agent string in HTTP request matches the User-Agents configured in patset
ns_vpn_client_useragents.

If these conditions are not met, the classic authentication policy bound to Gateway is used.

If a User-Agent, or portion of it is bound to the previously mentioned patset, requests coming from
those user-agents do not participate in the nFactor flow. For example, the command below restricts
configuration for all browsers (assuming all browsers contain “Mozilla” in the user-agent string):

bind patset ns_vpn_client_useragents Mozilla

LoginSchema

LoginSchema is a logical representation of the logon form. The XML language defines it. The Syntax
of the loginSchema conforms to Citrix’s Common Forms Protocol specification.

LoginSchema defines the “view” of the product. An Administrator can provide a customized descrip-
tion, assistive text, and so forth of the form. This includes the labels of the form itself. A customer can
provide success/failure message that describes the form presented at a given point.

LoginSchema and nFactor Knowledge Required

Pre-built loginSchema files are found in the following NetScaler location /nsconfig/loginschema/Lo-
ginSchema/. These pre-built loginSchema files cater to common use cases, and can be modified for
slight variations if necessary.

Also, most single factor use cases with few customizations do not need loginSchema(s) configuration.
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The administrator is advised to check documentation for additional configuration options that en-
able NetScaler to discover the factors. Once the user submits the credentials, the administrator can
configure more than one factor to flexibly choose and process the authentication factors.

Configuring Dual Factor Authentication Without Using LoginSchema

NetScaler automatically determines dual factor requirements based on configuration. Once the
user presents these credentials, the administrator can configure the first set of policies at the
virtual server. Against each policy there can be a “nextFactor” configured as a “passthrough.” A
“passthrough” implies that the NetScaler should process the logon using the existing credential set
without going to the user. By using “passthrough” factors, an administrator can programmatically
drive the authentication flow. Administrators are advised to read the nFactor specification or the
deployment guides for further details. See https://docs.citrix.com/en-us/netscaler/12/aaa-tm/multi-
factor-nfactor-authentication.html.

User name Password Expressions

To process the login credentials, the administrator must configure the loginSchema. Single factor or
dual factor use cases with few loginSchema customizations does not need a specified XML definition.
The LoginSchema has other properties such as userExpression and passwdExpression that can be
used to alter username/password that user presents. These are advanced policy expressions and can
be used to override the user input as well.

High-level steps in nFactor configuration

The following diagram illustrates the high-level steps involved in nFactor configuration.
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GUI Configuration

The following topics are described in this section:

• Create a Virtual Server

• Create Authentication Virtual Server

• Create Authentication CERT Profile

• Create an Authentication Policy

• Add an LDAP authentication server

• Add an LDAP authentication policy

• Add a RADIUS authentication server

• Add a RADIUS Authentication Policy

• Create an Authentication Login Schema

• Create a Policy Label

Create a Virtual Server

1. Navigate to NetScaler Gateway -> Virtual Servers.
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2. Click the Add button to create a Load Balancing Virtual server.

3. Enter the following information.

Parameter name Parameter Description

Enter the Name of the virtual server. Name for the NetScaler Gateway virtual server.
Must begin with an ASCII alphabetic or
underscore (_) character, and must contain
only ASCII alphanumeric, underscore, hash (#),
period (.), space, colon (:), at (@), equals (=),
and hyphen (-) characters. Can be changed
after the virtual server is created. The following
requirement applies only to the NetScaler CLI:
If the name includes one or more spaces,
enclose the name in double or single quotation
marks (for example, “my server” or ‘my
server’).

Enter the IP Address Type for the virtual server Select an IP Address or Non-addressable
option from the drop-down menu.

Enter the IP Address of the virtual server. An Internet Protocol address (IP address) is a
numerical label assigned to each device
participating in the computer network that
uses the Internet Protocol for communication.

Enter the Port number for the virtual server. Enter the port number.

Enter the Authentication Profile. Authentication Profile entity on virtual server.
This entity can be used to offload
authentication to Citrix ADC AAA virtual server
for multi-factor (nFactor) authentication

Enter the RDP Server Profile. Name of the RDP server profile associated with
the virtual server.
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Parameter name Parameter Description

Enter the Maximum Users. Maximum number of concurrent user sessions
allowed on this virtual server. The actual
number of users allowed to log on to this
virtual server depends on the total number of
user licenses.

Enter the Max Login Attempts. Maximum number of logon attempts.

Enter the Failed Login Timeout. Number of minutes an account will be locked if
user exceeds maximum permissible attempts.

Enter the Windows EPA plug-in upgrade. Option to set plug-in upgrade behavior for Win.

Enter the Linux EPA plug-in upgrade. Option to set plug-in upgrade behavior for
Linux.

Enter the MAC EPA plug-in upgrade Option to set plug-in upgrade behavior for Mac.

Login Once This option enables/disables seamless SSO for
this virtual server.

ICA Only When set to ON, it implies Basic mode where
the user can log on using either Citrix Receiver
or a browser and get access to the published
apps configured at the XenApp and
XenDesktop environment pointed out by the
Wihome parameter. Users are not allowed to
connect using the NetScaler Gateway plug-in
and end point scans cannot be configured. The
numbers of users that can log in and access the
apps are not limited by the license in this
mode. - When set to OFF, it implies
SmartAccess mode where the user can log on
using either Citrix Receiver or a browser or a
NetScaler Gateway plug-in. The admin can
configure end point scans to be run on the
client systems and then use the results to
control access to the published apps. In this
mode, the client can connect to the gateway in
other client modes namely VPN and clientless
VPN. The numbers of users that can log in and
access the resources are limited by the CCU
licenses in this mode.
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Parameter name Parameter Description

Enable Authentication Require authentication for users connecting to
NetScaler Gateway.

Double Hop Use the NetScaler Gateway appliance in a
double-hop configuration. A double-hop
deployment provides an extra layer of security
for the internal network by using three firewalls
to divide the DMZ into two stages. Such a
deployment can have one appliance in the
DMZ and one appliance in the secure network.

Down State Flush Close existing connections when the virtual
server is marked DOWN, which means the
server might have timed out. Disconnecting
existing connections frees resources and in
certain cases speeds recovery of overloaded
load balancing setups. Enable this setting on
servers in which the connections can safely be
closed when they are marked DOWN. Do not
enable DOWN state flush on servers that must
complete their transactions.

DTLS This option starts/stops the turn service on the
virtual server

AppFlow Logging Log AppFlow records that contain standard
NetFlow or IPFIX information, such as time
stamps for the beginning and end of a flow,
packet count, and byte count. Also log records
that contain application-level information,
such as HTTP web addresses, HTTP request
methods and response status codes, server
response time, and latency.

ICA Proxy Session Migration This option determines if an existing ICA Proxy
session is transferred when the user logs on
from another device.

State The current state of the virtual server, as UP,
DOWN, BUSY, and so on.
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Parameter name Parameter Description

Enable Device Certificate Indicates whether device certificate check as a
part of EPA is on or off.

4. Select the No Server Certificate section of the page.
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5. Click > to Select the Server Certificate.

6. Select the SSL Certificate and click the Select button.

7. Click Bind.
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8. If you see a warning about No usable ciphers, click OK

9. Click the Continue button.

10. In the Authentication section, click the + icon in the top right.

Create Authentication Virtual Server

1. Navigate to Security -> AAA – Application Traffic -> Virtual Servers.
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2. Click the Add button.

3. Complete the following Basic Settings to create the Authentication Virtual Server.

Note: The mandatory fields are indicated by an ***** to the right of the setting name.

• Enter the Name for the new authentication virtual server.

• Enter the IP Address Type. The IP Address Type can be configured as Non-addressable.

• Enter the IP Address. The IP Address can be zero.

• Enter the Protocol type of the authentication virtual server.

• Enter the TCP Port on which the virtual server accepts connections.

• Enter the domain of the authentication cookie set by Authentication virtual server.
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4. Click OK.

5. Click the No Server Certificate.

© 1999-2021 Citrix Systems, Inc. All rights reserved. 175



NetScaler Gateway 12.0

6. Select the desired Server Certificate from the list.

7. Choose the desired SSL Certificate and click the Select button.

Note: The Authentication virtual server does not need a certificate bound to it.

8. Configure the Server Certificate Binding.

• Check the Server Certificate for SNI box to bind one or more Cert keys used for SNI pro-
cessing.

• Click the Bind button.
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Create Authentication CERT Profile

1. Navigate to Security -> AAA – Application Traffic -> Policies -> Authentication -> Basic Poli-
cies -> CERT.

2. Select the Profiles tab and then select Add.

3. Complete the following fields to create the Authentication CERT Profile. The mandatory fields
are indicated by an * to the right of the setting name.

• Name - Name for the client cert authentication server profile (action).

• Two factor – In this instance the two-factor option is NOOP.

• User Name Field – enter the client-cert field from which the user name is extracted. Must
be set to either ““Subject”” or ““Issuer”” (include both sets of double quotation marks).
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• Group Name Field - enter the client-cert field from which the group is extracted. Must be
set to either ““Subject”” or ““Issuer”” (include both sets of double quotation marks).

• Default Authentication Group - This is the default group that is chosen when the authen-
tication succeeds in addition to extracted groups.

4. Click Create.

Create an Authentication Policy

1. Navigate to Security -> AAA – Application Traffic -> Policies -> Authentication -> Advanced
Policies -> Policy.

© 1999-2021 Citrix Systems, Inc. All rights reserved. 178



NetScaler Gateway 12.0

2. Select the Add button

3. Complete the following information to Create Authentication Policy. The mandatory fields are
indicated by an * to the right of the setting name.
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a) Name – enter the Name for the advance AUTHENTICATION policy. Must begin with a letter,
number, or the underscore character (_), and must contain only letters, numbers, and the hy-
phen (-), period (.) pound (#), space (), at (@), equals (=), colon (:), and underscore characters.
Cannot be changed after AUTHENTICATION policy is created.

The following requirement applies only to the NetScaler CLI: If the name includes one or more
spaces, enclose the name in double or single quotation marks (for example, “my authentication
policy” or ‘my authentication policy’).

b) Action Type - enter the type of the Authentication Action.

c) Action - enter the name of the authentication action to be performed if the policy matches.

d) LogAction - enter the name of message log action to use when a request matches this policy.

e)Expression - enter the name of the NetScaler named rule, or a default syntax expression, that
the policy uses to determine whether to attempt to authenticate the user with the AUTHENTI-
CATION server.

f) Comments – enter any comments to preserve information about this policy.

4. Click Create

Add an LDAP Authentication Server

1. Navigate to Security -> AAA – Application Traffic -> Policies -> Authentication -> Basic Poli-
cies -> LDAP.

© 1999-2021 Citrix Systems, Inc. All rights reserved. 180



NetScaler Gateway 12.0

2. Add an LDAP server by selecting the Server tab and selecting the Add button.

Add an LDAP Authentication Policy

1. Navigate to Security -> AAA – Application Traffic -> Policies -> Authentication -> Advanced
Policies -> Policy.
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2. Click Add to add an Authentication Policy.

3. Complete the following information to Create Authentication Policy. The mandatory fields are
indicated by an * to the right of the setting name.

a) Name - Name for the advance AUTHENTICATION policy.
Must begin with a letter, number, or the underscore character (_), and must contain only letters,
numbers, and the hyphen (-), period (.) pound (#), space (), at (@), equals (=), colon (:), and
underscore characters. Cannot be changed after AUTHENTICATION policy is created.
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The following requirement applies only to the NetScaler CLI: If the name includes one or more
spaces, enclose the name in double or single quotation marks (for example, “my authentication
policy” or ‘my authentication policy’).

b) Action Type - Type of the Authentication Action.

c) Action - Name of the authentication action to be performed if the policy matches.

d) Log Action - Name of message log action to use when a request matches this policy.

e) Expression - Name of the NetScaler named rule, or a default syntax expression, that the pol-
icy uses to determine whether to attempt to authenticate the user with the AUTHENTICATION
server.

f) Comments - Any comments to preserve information about this policy.

4. Click Create

Add a RADIUS Authentication Server

1. Navigate to Security -> AAA – Application Traffic -> Policies -> Authentication -> Basic Poli-
cies -> RADIUS.
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2. To add a Server select the Servers tab and select the Add button.

3. Enter the following to create an Authentication RADIUS Server. The mandatory fields are indi-
cated by an * to the right of the setting name.

• Enter a Name for the RADIUS Action.

• Enter the Server Name or Server IP Address assigned to the RADIUS server.

• Enter the Port number on which the RADIUS server listens for connections.

• Enter the Time-out value in few seconds. This is the value that the NetScaler appliance
waits for a response from the RADIUS server.

• Enter the Secret Key that is shared between the RADIUS server and the NetScaler appli-
ance. The Secret Key is required to allow the NetScaler appliance to communicate with
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the RADIUS server.

• Confirm the Secret Key.

4. Click Create
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Add a RADIUS Authentication Policy

1. Navigate to Security -> AAA – Application Traffic -> Policies -> Authentication -> Advanced
Policies -> Policy.

2. Click Add to create an Authentication Policy.

3. Complete the following information to Create Authentication Policy. The mandatory fields are
indicated by an * to the right of the setting name.

a) Name - Name for the advance AUTHENTICATION policy.
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Must begin with a letter, number, or the underscore character (_), and must contain only letters,
numbers, and the hyphen (-), period (.) pound (#), space (), at (@), equals (=), colon (:), and
underscore characters. Cannot be changed after AUTHENTICATION policy is created.

The following requirement applies only to the NetScaler CLI: If the name includes one or more
spaces, enclose the name in double or single quotation marks (for example, “my authentication
policy” or ‘my authentication policy’).

b) Action Type - Type of the Authentication Action.

c) Action - Name of the authentication action to be performed if the policy matches.

d) Log Action - Name of message log action to use when a request matches this policy.

e) Expression - Name of the NetScaler named rule, or a default syntax expression, that the pol-
icy uses to determine whether to attempt to authenticate the user with the AUTHENTICATION
server.

f) Comments - Any comments to preserve information about this policy.

4. Click OK

5. Verify that your Authentication Policy is listed.
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Create an Authentication Login Schema

1. Navigate to Security -> AAA – Application Traffic -> Log in Schema.
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2. Select the Profiles tab and Click the Add button.
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3. Complete the following fields to Create Authentication Login Schema:

a) Enter Name – this is the name for the new login schema.

b) EnterAuthenticationSchema - this is the name of the file for reading authentication schema
to be sent for Login Page UI. This file should contain xml definition of elements as per Citrix
Forms Authentication Protocol to be able to render login form. If administrator does not want
to prompt users for additional credentials but continue with previously obtained credentials,
then “noschema” can be given as argument. Please note that this applies only to loginSchemas
that are used with user-defined factors, and not the virtual server factor

c) Enter User Expression - this is the expression for user name extraction during login

d) Enter Password Expression - this is the expression for password extraction during login

e) Enter User Credential Index - this is the index at which user entered user name should be
stored in session.

f) Enter Password Credential Index - this is the index at which user entered password should
be stored in session.

g) Enter Authentication Strength - this is the weight of the current authentication.

4. Click Create
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a) Verify that your Login Schema Profile is listed.

Create a Policy Label

A policy label specifies the authentication policies for a particular factor. Each policy label corre-
sponds to a single factor. The policy label specifies the login form that must be presented to the user.
The policy label must be bound as the next factor of an authentication policy or of another authentica-
tion policy label. Typically, a policy label includes authentication policies for a specific authentication
mechanism. However, you can also have a policy label that has authentication policies for different
authentication mechanisms.

1. Navigate to Security -> AAA – Application Traffic -> Policies -> Authentication -> Advanced
Policies -> Policy Label.
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2. Click the Add button.

3. Complete the following fields to Create Authentication Policy Label:

a) Enter the Name for the new authentication policy label.

b) Enter the Login Schema associated with authentication policy label.

c) Click Continue.
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4. Select a Policy from the drop-down menu.

5. Choose the desired Authentication Policy and click the Select button.
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6. Complete the following fields:

a) Enter the Priority of the policy binding.

b) Enter the Goto Expression – the expression specifies the priority of the next policy that will
be evaluated if the current policy rule evaluates to TRUE.

7. Select the desired Authentication Policy and click the Select button.

8. Click the Bind button.
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9. Click Done.

10. Review the Authentication Policy Label.

Unified Gateway Visualizer

October 5, 2020

Overview

The Unified Gateway Visualizer provides a visual representation of the configurations using the Unified
Gateway Wizard. The Unified Gateway Visualizer is used to add and edit configuration, and diagnose
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a back-end issue.

The Unified Gateway Visualizer shows the following:

Configuration Configuration

Pre-authentication policies Authentication policies

CS virtual servers VPN virtual servers

LB virtual servers XA/XD apps

Web apps SaaS apps

Unified Gateway deployment enables secure remote access through one URL to your Enterprise or
SaaS applications, clientless access applications, Citrix Virtual Apps, and Desktops resources.

Configure Unified Gateway

1. Select Unified Gateway from the menu.

2. At the next screen, verify that you have the following information, then click Get Started:

• Public IP address for the Unified Gateway.
• Server certificate chain (.PFX or.PEM) with optional Root-CA certificate.
• LDAP/RADIUS/Client Certificate based authentication details.
• Application details (URLs for SaaS applications or Citrix Virtual Apps and Desktops server

details).

1. Click the Continue button.

Create a Unified Gateway Configuration virtual server.

1. Enter the configuration Name for the virtual server.
2. Enter the public facing Unified Gateway IP address for the Unified Gateway deployment.
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3. Enter the Port number. The port number range is 1–65535.
4. Click Continue.

Complete the following information to specify the Server Certificate.

1. Select either the Use existing certificate or Install Certificate radio buttons.
2. Select a Server Certificate from the menu.
3. Click the Continue button.

Complete the following information to specify Authentication.

1. Select a Primary authenticationmethod from the menu.
2. Select either the Use existing server or Add new server radio buttons.
3. Click the Continue button.
4. Select the Portal Theme from the menu.
5. Click Continue.
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6. Select either the Web Application or Citrix Virtual Apps Desktops radio buttons.
7. Click Continue.

Select application

Complete the following information to specify Web Application.

1. Enter the Name of the bookmark link.

2. Select the type of application the VPN URL represents. The possible values are:

• Intranet Application
• Clientless Access
• SaaS
• PreConfigured application on this Citrix ADC

3. Check this box to make this application accessible through the Unified Gateway URL.

4. Enter the URL for the bookmark link.

5. From the Icon URL choose a file to fetch an icon file. The MaxLength = 255

6. Click the Continue button.

7. Click Done.

8. Click Continue.

9. Click Done.

GUI Configuration

1. Select Unified Gateway from the menu.
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2. Click the Unified Gateway Visualizer icon to access configured Gateway instances.

The Unified Gateway Visualizer looks like a flow diagram as shown in the following image:

The Unified Gateway Visualizer has PreAuth,Auth, and an Apps section. If the VPN virtual server
has pre-authentication policy, only then the pre-auth is shown in the Unified Gateway Visual-
izer.
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The Unified Gateway Visualizer uses a color coding scheme for the load balancing and VPN vir-
tual servers to indicate their state.

Color Description

Red means the server is down.

Gray means webapps/Citrix Virtual Apps have not
been configured.

Green means everything is fine with the virtual server.

Orange means one of the load balancing virtual server
services. is down, but still it is functioning
properly.

Details of VPN Virtual Servers

To get the details of the VPN virtual servers, click the VPN virtual servers node. The popup renders
details like the C/S rule and all policies.

1. Add Policies to the VPN entity by clicking the (+) icon.
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2. Click the desired node for details of policies already configured.
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For VPN virtual server information, the VPN title in the popup is a clickable entity that goes to a
slider that details the VPN virtual server.

The details of the VPN server are shown here.
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The Pre Auth Block

If a VPN virtual server has preauthentication policies associated with it, the Unified Gateway Visualizer
shows a Pre Auth block. The Pre Auth block shows the policies, and provides an option to add
preauthentication policies to the VPN.

1. Click the + to add a preauth policy.
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In a case where no preauthentication policies are associated, this block would be hidden from the
view.

The Auth Block

The Auth block lists the primary and secondary policies. The Auth block provides an option to add
policies.

1. Click + in the Primary list to add a Primary Authentication Binding or Click + in the Secondary
list to add a Secondary Authentication Binding.
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2. Select an option from the Primary authenticationmethod menu.

3. Specify if it is an existing server or Add new server by selecting the radio button.

4. Select an option from the LDAP Policy Name menu.

5. Select RADIUS from the Secondary authenticationmethod menu.

6. Specify if you want to use existing server or Add new server by selecting the radio button.

7. Click Continue.

© 1999-2021 Citrix Systems, Inc. All rights reserved. 205



NetScaler Gateway 12.0

Adding StoreFront

1. Click + near the XA/XD, and it takes you to adding “XA/XD” apps.

You can choose your integration point. The options are StoreFront, WI, or WionNS. Click Continue.

1. Complete the following fields to configure StoreFront:

Field Description

StoreFront FQDN* Enter the FQDN of the StoreFront server. Max
length: 255
char.Example://storefront.xendt.net

Site Path* Enter the path to Receiver for the website
already configured on the StoreFront.

Single Sign-on Domain* Enter the default domain for user
authentication

Store Name* Enter the name for the StoreFront monitors.

The STORENAME is an argument defining the
StoreFront service store name to probe the
health of StoreFront servers. Applicable to
StoreFront monitors. Maximum Length: 31

Secure Ticket Authority Server* Enter the secure ticket authority URL, typically
present on the delivery controller.

Example: http://sta

StoreFront Server* Enter the IP Address of the StoreFront Server

Protocol* Enter the protocol used by the server.

Port* Enter the port used by the server.

Load Balancing Enter the load balancing configuration for the
StoreFront servers.

© 1999-2021 Citrix Systems, Inc. All rights reserved. 206



NetScaler Gateway 12.0

Field Description

Virtual Server* Enter the public facing IP address for the
Unified Gateway deployment.

2. Click Continue

Adding SaaS

1. Click + to add SaaS apps, it takes you to the Add SaaS page. Complete the following fields to
configure SaaS. The fields that require mandatory information are noted with the *.

Field Description

Name* Enter the name of the bookmark link.

Application Type Enter the type of application this VPN URL
represents. Possible values are: Intranet
Application/Clientless
Access/SaaS/PreConfigured application on this
Citrix ADC

Enter URL* Enter URL of the Intranet application.

Choose File Enter the URL to fetch the icon file for
displaying this resource. MaxLength = 255

Adding WebApps

1. Click + to add Web apps, it takes you to the Add Web apps page. Complete the following fields
to configure a Web Application. The fields that require mandatory information are noted with
the *.

Field Description

Name* Enter the name of the bookmark link.

Application Type Enter the type of application this VPN URL
represents. Possible values are: Intranet
Application/Clientless
Access/SaaS/PreConfigured application on this
Citrix ADC
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Field Description

Enter URL* Enter URL of the Intranet application.

Choose File Enter the URL to fetch the icon file for
displaying this resource.MaxLength = 255

If an application is accessible through the Unified Gateway URL, the details of the Load Balancing
server can be accessed by clicking the app:

New policies can be added by clicking (+) and all the bound policies can be viewed by clicking the
node that displays policy information.

The number of services bound to the load balancer are also shown, along with the overall state infor-
mation. Further click lists all the services. New services can be added to the load balancer.
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For further details of the load balancer, the title of the popup is clickable that lands to the load bal-
ancing virtual server details page.

Configure Citrix Gateway to use RADIUS and LDAP Authentication with
Mobile/Tablet Devices

October 5, 2020

This section describes how to configure Citrix Gateway appliance to use RADIUS authentication as
primary and LDAP authentication as secondary with mobile/tablet devices.

The configuration demonstrated in the section still allows all other connections to use LDAP first and
RADIUS second.

When you configure two-factor authentication on Citrix Receiver for use with mobile/tablet devices,
you must add the RSA SecureID (RADIUS authentication) as the primary authentication. But when the
users get the prompt for Username and Password, Passcode on Receiver they will be putting LDAP first
and RADIUS as second credentials. From administrator point of view it is a different configuration as
compared to non-mobile configuration.

Complete the following procedure to configure Citrix Gateway appliance to use RADIUS authentica-
tion as primary and LDAP authentication as secondary with mobile/tablet devices.

1. From the Configuration Utility, select Citrix Gateway > Policies > Authentication and create an
authentication policy for LDAP and RSA for mobile devices and non-mobile devices. This is nec-
essary to avoid a logic condition that could allow users to bypass the RADIUS authentication.
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2. Enter LDAP Server details after clicking add option under Servers tab for LDAP.

For more details on how to configure authentication server refer to the section “Creating au-
thentication Server” of How to Configure LDAP Authentication on NetScaler

3. Create LDAP policy for the mobile devices by choosing the required LDAP Server.

To bind this policy to only mobile devices, use the following expression:

1 `REQ.HTTP.HEADER User-Agent CONTAINS CitrixReceiver`
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4. Click Expression Editor to create policy:

5. Create a RADIUS policy and RADIUS Server for the mobile devices.

(a) Navigate to RADIUS option from Citrix Gateway > Policies > Authentication > RADIUS. Click
Add under Server tab.
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(b) Add the required details. The default port for RADIUS authentication is 1812.

(c) To bind this policy to only mobile devices, use the following expression:

6. Follow the same step to create an LDAP policy for non-mobile devices. To bind this policy to
only non-mobile devices, use the following expression:

1 `REQ.HTTP.HEADER User-Agent NOTCONTAINS CitrixReceiver`
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7. Create a RADIUS policy for non-mobile devices. To bind this policy to only non-mobile devices,
use the following expression:

1 `REQ.HTTP.HEADER User-Agent NOTCONTAINS CitrixReceiver`
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8. Go to the Properties of the Citrix Gateway Virtual Server and click the Authentication tab.
On the Primary Authentication Policies, add the RSA_Mobile policy as top priority and the
LDAP_NonMobile policy as secondary priority:

9. On the Secondary Authentication Policies, add the LDAP_Mobile policy as top priority, followed
by the RSA_NonMobile policy as secondary priority:
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The session policy must have the correct Single Sign-on Credential Index, that is, it must be
the LDAP credentials. For mobile devices, Credential Index under Session Profile> Client
Experience should be set to Secondary which is LDAP.

Therefore you need two session policies, one for mobile devices and the other for non-mobile
devices.

10. For mobile devices session policy and session profile will look as shown in the following screen-
shot.

To create session policy, navigate to required virtual server and, click Edit, go to policy section
and click + sign:

11. Choose Session option from the drop-down.

12. Enter the desired Session Policy name and click + to create a new profile. For mobile devices,
Credential Index under Session Profile > Client Experience should be set to Secondary which is
LDAP.
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13. For non-mobile device follow the same steps. Credential Index under Session Profile > Client
Experience should be set to Primary which is LDAP. The expression should be changed to:

REQ.HTTP.HEADER User-Agent NOTCONTAINS CitrixReceiver

14. To create new profile for non-mobile user,click + sign.
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15. Policies and profiles under the required virtual server will look similar to the following screen
shot:

16. Additionally on the StoreFront, under the Citrix Gateway configuration set to use “Logon Type”
= “Domain and Security token”
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Restrict access to Citrix Gateway for members of one Active Directory
group

February 8, 2021

Citrix Gateway supports two methods of restricting logon access.

• LDAP Search Filter – Only user names that match the LDAP Search Filter (for example, Active
Directory group membership) can log on to Citrix Gateway.

• Groups allowed to log on in a Citrix Gateway session policy or profile – This method supports
multiple Active Directory groups. For details see https://support.citrix.com/article/CTX125797.

This article describes the LDAP Search Filter method.

Overview

When a user enters the credentials on the logon page of the Citrix Gateway virtual server and presses
ENTER, the appliance first searches the Active Directory (LDAP) for the user name. If an LDAP Search
Filter is not defined in the LDAP policy or the server, then the appliance searches all Active Directory
user names for a match. Once a match is found, the appliance then pulls the user’s full Distinguished
Name (DN) and uses the user’s DN and password to authenticate to the Active Directory.

If an LDAP Search Filter is defined, then only user names that match the LDAP Search Filter are
searched for a user name match. For example, if the LDAP Search Filter is constructed to only search
members of an Active Directory group, then the user name entered by the user must match the
members of the group.

Prerequisites

The Citrix Gateway virtual server must be configured for LDAP authentication.

Steps to configure an LDAP Search Filter for members of one Active Directory group

1. Determine the Active Directory Group that has access permission, and get its full Distinguished
Name.

An easy way to get the full Distinguished Name of the group is through Active Directory Users
and Computers.

2. In Active Directory Users and Computers, from View menu, enable Advanced Features.
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3. Browse the tree to the group object, right-click, and then and click Properties.
Note: You cannot use Find. Instead, you must navigate through the tree to find the object.

4. On the right, switch to the Attribute Editor tab.
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This tab is only visible if Advanced Features are enabled, and if you have not use the Find fea-
ture.

5. Scroll down to distinguishedName, double-click it, and then copy it to the clipboard.

6. In the Citrix Gateway GUI, navigate to Citrix Gateway > Virtual Servers.

7. Select an existing Citrix Gateway virtual server and click Edit.

8. In the Basic Authentication section, click LDAP Policies.

9. Right-click an existing LDAP policy, and click Edit Server.

© 1999-2021 Citrix Systems, Inc. All rights reserved. 220



NetScaler Gateway 12.0

10. In theOther Settings section, in the Search Filter field, type inmemberOf= and then paste the
Distinguished Name of the Active Directory group after the equals sign (=).

An example Search Filter is the following:
memberOf=CN=Citrix Remote,OU=Citrix,DC=corp,DC=local
Note: By default, NetScaler only searches for user names that are direct members of the Active
Directory group. If you want to search nested groups, then add the Microsoft OID:: to the LDAP
Search Filter. The OID is inserted between memberOf and =.

Example: memberOf:1.2.840.113556.1.4.1941:=CN=Citrix Remote,OU=Citrix,DC=corp,DC=local

11. Click OK.

Optimizing Citrix Gateway VPN split tunnel for Office365

October 5, 2020
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As organizations are adapting to the remote work options more rapidly than before, the remote ac-
cess infrastructure must be optimized to facilitate seamless connectivity during increased traffic load
conditions.

Microsoft recommends excluding traffic destined to keyOffice 365 services from the scope of VPN connec-
tion by configuring split tunneling using published IPv4 and IPv6 address ranges. For best performance
and most efficient use of VPN capacity, traffic to this dedicated IP address ranges associated with Of-
fice 365 Exchange Online, SharePoint Online and Microsoft Teams (referred to as Optimize category in
Microsoft documentation) should be routed directly, outside of the VPN tunnel. Please refer to [Microsoft
guidance] https://docs.microsoft.com/en-us/Office365/Enterprise/office-365-vpn-split-tunnel for more
detailed information about this recommendation.

Microsoft’s recommendation in Citrix Gateway is achieved by routing the Microsoft provided list of IP
addresses directly to the internet for the O365 traffic by using the split tunnel reverse configuration.

The configuration involves the following that can be performed manually by using theGUI or CLI com-
mands.

• Configure split tunnel for reverse configuration
• Configure intranet applications for user access to resources

Configuration by using the GUI

To configure split tunneling by using the GUI

1. On the Configuration tab, Navigate to Citrix Gateway > Global Settings.

2. In the details pane, under Settings, click Change Global Settings.

3. On the Client Experience tab, in Split Tunnel, select Reverse.

4. Click OK.
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To create VPN intranet application by using the GUI

1. On the Configuration tab, Navigate to Citrix Gateway > Global Settings.

2. In the details pane, under Intranet Applications, click the link.

3. In the Configure VPN Intranet Application page, click Add, and then click New.
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4. In Name, type a name for the profile.

5. In Protocol, select the protocol that applies to the network resource.

6. In Destination Type, select IP Address and Netmask.

7. In IP Address, enter the IP address that must be routed directly to the internet for O365 traffic.
For the list of IP address, see List of IP addresses.

8. In Netmask, enter the netmask IP address.
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9. Click Create and then click Close.

Note: Repeat this procedure for all the IP addresses.
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Configuration by using the CLI

• To set split tunnel to reverse, at the command prompt, type;

1 set vpn parameter -splitTunnel REVERSE

• To add VPN intranet application, at the command prompt, type;

1 add vpn intranetApplication intranetapp1 ANY 13.107.6.152 -netmask
255.255.255.254 -destPort 1-65535 -interception TRANSPARENT

Note: Repeat this procedure for all the IP addresses.

• To bind the intranet application, at the command prompt type;

1 bind vpn global -intranetApplication intranetapp1

List of IP addresses of Office 365 services (EXO, SPO, and Teams)

Reference: https://docs.microsoft.com/en-us/office365/enterprise/urls-and-ip-address-ranges

Note fromMicrosoft:
As part of Microsoft’s response to the COVID-19 situation, Microsoft has declared a temporary morato-
rium on some planned URL and IP address changes. This moratorium is intended to provide customer
IT teamswith confidence and simplicity in implementing recommended network optimizations forwork-
from-home Office 365 scenarios. From March 24, 2020 through June 30, 2020 this moratorium will halt
changes for key Office 365 services (Exchange Online, SharePoint Online, and Microsoft Teams) to IP
ranges and URLs included in the Optimize category.

IPv4 address range

104.146.128.0/17
13.107.128.0/22
13.107.136.0/22
13.107.18.10/31
13.107.6.152/31
13.107.64.0/18
131.253.33.215/32
132.245.0.0/16
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150.171.32.0/22
150.171.40.0/22
191.234.140.0/22
204.79.197.215/32
23.103.160.0/20
40.104.0.0/15
40.108.128.0/17
40.96.0.0/13
52.104.0.0/14
52.112.0.0/14
52.96.0.0/14
52.120.0.0/14|

IPv6 address range

2603:1006::/40
2603:1016::/36
2603:1026::/36
2603:1036::/36
2603:1046::/36
2603:1056::/36
2603:1096::/38
2603:1096:400::/40
2603:1096:600::/40
2603:1096:a00::/39
2603:1096:c00::/40
2603:10a6:200::/40
2603:10a6:400::/40
2603:10a6:600::/40
2603:10a6:800::/40
2603:10d6:200::/40
2620:1ec:4::152/128
2620:1ec:4::153/128
2620:1ec:c::10/128
2620:1ec:c::11/128
2620:1ec:d::10/128
2620:1ec:d::11/128
2620:1ec:8f0::/46
2620:1ec:900::/46
2620:1ec:a92::152/128
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2620:1ec:a92::153/128
2a01:111:f400::/48
2620:1ec:8f8::/46
2620:1ec:908::/46
2a01:111:f402::/48

Configuring the VPN User Experience

October 5, 2020

Users can use the following methods to connect to your organization’s network resources through
NetScaler Gateway:

• Citrix Receiver that contains all Citrix plug-ins installed on the user device.
• Receiver for Web that allows user connections to applications, desktops, and ShareFile by using

a Web browser.
• Worx Home to allow users to access WorxMail, WorxWeb and mobile apps from their iOS and

Android devices.
• NetScaler Gateway Plug-in for Windows, Mac OS X, or Linux.
• NetScaler Gateway App for iOS and Android.
• NetScaler Gateway Plug-in for Java.
• Clientless access that provides users with the access they need without installing user software.
• Interoperability with Citrix Repeater Plug-in.

If users install the NetScaler Gateway Plug-in and then install Receiver from XenApp 6.5 for Windows
Server 2008 (including Feature Pack and Feature Pack 2), XenDesktop 7.0 or newer, Receiver automati-
cally adds the NetScaler Gateway Plug-in. Users can connect with the NetScaler Gateway Plug-in from
a web browser or from Receiver.

SmartAccess determines automatically the methods of access that are allowed for a user device based
on the results of an endpoint analysis scan. For more information about SmartAccess, see Configuring
SmartAccess topic.

NetScaler Gateway supports XenMobile Worx apps for iOS and Android mobile devices. NetScaler
Gateway contains Secure Browse that allows connections to NetScaler Gateway from iOS mobile de-
vices that establishes the Micro VPN tunnel. Android devices that connect with Worx Home also estab-
lish a Micro VPN tunnel automatically that provides secure web and mobile application-level access
to resources in your internal network. If users connect from an Android device with Worx apps, you
must configure DNS settings on NetScaler Gateway. For details, see Supporting DNS Queries by Using
DNS Suffixes for Android Devices topic.
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HowUser Connections Work with the NetScaler Gateway Plug-in

October 5, 2020

NetScaler Gateway operates as follows:

• When users attempt to access network resources across the VPN tunnel, the NetScaler Gate-
way Plug-in encrypts all network traffic destined for the organization’s internal network and
forwards the packets to NetScaler Gateway.

• NetScaler Gateway terminates the SSL tunnel, accepts any incoming traffic destined for the pri-
vate network, and forwards the traffic to the private network. NetScaler Gateway sends traffic
back to the remote computer over a secure tunnel.

When users type the web address, they receive a logon page where they enter their credentials and
log on. If the credentials are correct, NetScaler Gateway finishes the handshake with the user device.

If the user is behind a proxy server, the user can specify the proxy server and authentication creden-
tials. For more information, see Enabling Proxy Support for User Connections.

The NetScaler Gateway Plug-in is installed on the user device. After the first connection, if users log
on by using a Windows-based computer, they can use the icon in the notification area to establish the
connection.

Establishing the Secure Tunnel

October 5, 2020

When users connect with the NetScaler Gateway Plug-in, Worx Home, or Citrix Receiver, the client
software establishes a secure tunnel over port 443 (or any configured port on NetScaler Gateway) and
sends authentication information. When the tunnel is established, NetScaler Gateway sends configu-
ration information to the NetScaler Gateway Plug-in, Worx Home, or Receiver describing the networks
to be secured and containing an IP address if you enable address pools.

Tunneling Private Network Traffic over Secure Connections

When the NetScaler Gateway Plug-in starts and the user is authenticated, all network traffic destined
for specified private networks is captured and redirected over the secure tunnel to NetScaler Gateway.
Receiver must support the NetScaler Gateway Plug-in to establish the connection through the secure
tunnel when users log on.

Worx Home, Worx Mail, and WorxWeb use Micro VPN to establish the secure tunnel for iOS and Android
mobile devices.
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NetScaler Gateway intercepts all network connections that the user device makes and multiplexes
them over Secure Sockets Layer (SSL) to NetScaler Gateway, where the traffic is demultiplexed and
the connections are forwarded to the correct host and port combination.

The connections are subject to administrative security policies that apply to a single application, a
subset of applications, or an entire intranet. You specify the resources (ranges of IP address/subnet
pairs) that remote users can access through the VPN connection.

The NetScaler Gateway Plug-in intercepts and tunnels the following protocols for the defined intranet
applications:

• TCP (all ports)
• UDP (all ports)
• ICMP (types 8 and 0 - echo request/reply)

Connections from local applications on the user device are securely tunneled to NetScaler Gateway,
which reestablishes the connections to the target server. Target servers view connections as origi-
nating from the local NetScaler Gateway on the private network, thus hiding the user device. This is
also called reverse Network Address Translation (NAT). Hiding IP addresses adds security to source
locations.

Locally, on the user device, all connection-related traffic, such as SYN-ACK, PUSH, ACK, and FIN pack-
ets, is recreated by the NetScaler Gateway Plug-in to appear from the private server.

Operation Through Firewalls

October 5, 2020

Users of the NetScaler Gateway Plug-in are sometimes located inside another organization’s firewall,
as shown in the following figure:

Figure 1. Connection from user device through two internal firewalls
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NAT firewalls maintain a table that allows them to route secure packets from NetScaler Gateway back
to the user device. For circuit-oriented connections, NetScaler Gateway maintains a port-mapped,
reverse NAT translation table. The reverse NAT translation table enables NetScaler Gateway to match
connections and send packets back over the tunnel to the user device with the correct port numbers
so that the packets return to the correct application.

NetScaler Gateway plug-in Upgrade Control

October 5, 2020

System Administrators control how the NetScaler plug-in performs when its version does not match
the NetScaler Gateway revision. The new options control the plug-in upgrade behavior for Mac, and
Windows or operating systems.

For VPN plug-ins, the upgrade option can be set in two places in the NetScaler user interface:

• At the Global Settings
• At the Session Profile level

Plug-in Behaviors

For each client type, NetScaler Gateway allows the following three options to control plug-in upgrade
behavior:

• Always

The plug-in always gets upgraded whenever the end user’s plug-in version doesn’t match with the
plug-in shipped with NetScaler. This is the default behavior. Choose this option if you don’t want
multiple plug-in versions running in your enterprise.

• Essential (and security)

The plug-in only upgraded when it is deemed necessary. Upgrades are deemed necessary in the fol-
lowing two circumstances

• Installed Plug-in is incompatible with the current NetScaler version.

• Installed Plug-in must be updated for the necessary security fix.

Choose this option if you want to minimize the number of plug-in upgrades, but don’t want to miss
any plug-in security updates

• Never

The plug-in does not get upgraded.

© 1999-2021 Citrix Systems, Inc. All rights reserved. 231



NetScaler Gateway 12.0

CLI Parameters for Controlling VPN Plug-in Upgrade

NetScaler Gateway supports two types of plug-ins (EPA and VPN) for Windows and Mac operating sys-
tems. To support VPN plug-in upgrade control at the session level, NetScaler Gateway supports two
session profile parameters named WindowsinPluginUpgrade and MacPluginUpgrade.

These parameters are available at global, virtual server, group, and user level. Each parameter can
have a value of Always, Essential or Never. For a description of these parameters see Plug-in Behaviors.

CLI Parameters for Controlling EPA Plug-in Upgrade

NetScaler Gateway supports EPA plug-ins for Windows and Mac operating systems. To support EPA
plug-in upgrade control at the virtual server level, NetScaler Gateway supports two virtual server pa-
rameters named windowsEPAPluginUpgrade and macEPAPluginUpgrade.

The parameters are available at the virtual server level. Each parameter can have a value of Always,
Essential or Never. For a description of these parameters see Plug-in Behaviors

VPN Configuration

Follow these steps for the VPN configuration of Windows, Linux, and Mac plug-ins.

1. Go to Citrix NetScaler > Policies > Session.

2. Select the desired session policy, and then click Edit.

3. Select the Client Experience tab.
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4. These dialog boxes options affect the upgrade behavior.

• Always
• Essential
• Never

The default is Always.

5. Select the check box to the right of each option. Select the frequency to apply the upgrade
behavior.
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EPA Configuration

Follow these steps for the EPA configuration of Windows, Linux, and Apple plug-ins.

1. Go to NetScaler Gateway > Virtual Servers.

2. Select a Server and click the Edit button.

3. Click the pencil icon.

4. Click More
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5. The dialog boxes that appear affect the upgrade behavior. The available options are:
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• Always
• Essential
• Never

Requirements

• Windows EPA and VPN plug-in version must be greater than 11.0.0.0

• Mac EPA plug-in version must be greater than 3.0.0.31

• Mac VPN plug-in version must be greater than 3.1.4 (357)

Note: If NetScaler is upgraded to the 11.0 release, all previous VPN (and EPA) plug-ins upgrade to
the latest version irrespective of upgrade control configuration. For subsequent upgrades, they
respect the previous upgrade control configuration.

Choosing the User Access Method

October 5, 2020

You can configure NetScaler Gateway to provide user connections through the following scenarios:

• User connections by using Citrix Receiver. Receiver works with StoreFront or the Web Interface
to provide users with access to published applications or virtual desktops in a server farm. Re-
ceiver is software that uses the ICA network protocol to establish user connections. Users install
Receiver on the user device. When users install Receiver on their Windows-based or Mac-based
computer, Receiver subsumes all plug-ins, including the NetScaler Gateway Plug-in for user con-
nections. NetScaler Gateway also supports connections from Receiver for Android and Receiver
for iOS. Users can connect to their virtual desktops and Windows-based, web, mobile, and SaaS
applications through App Controller, StoreFront, or the Web Interface.
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• User connections with Worx Home. Users can connect to mobile, web, and SaaS applications
configured in App Controller. Users install Worx Home on their mobile device (Android or iOS).
When users log on to Worx Home, they can install WorxMail and WorxWeb, along with any other
mobile app you installed in App Controller. Worx Home, WorxMail, and WorxWeb use Micro VPN
technology to establish connections through NetScaler Gateway.

• User connections by using the NetScaler Gateway Plug-in as a standalone application. The
NetScaler Gateway Plug-in is software that users can download and install on a user device.
When users log on with the plug-in, users can access resources in the secure network as if they
were in the office. Resources include email servers, file shares, and intranet Web sites.

• User connections by using clientless access. Clientless access provides users with the access
they need without requiring installation of software, such as the NetScaler Gateway Plug-in or
Receiver, on the user device. Clientless access allows connections to a limited set of web re-
sources, such as Outlook Web Access or SharePoint, applications published on Citrix XenApp,
virtual desktops from Citrix XenDesktop, and file shares in the secure network through the Ac-
cess Interface. Users connect by entering the NetScaler Gateway web address in a web browser
and then select clientless access from the choices page.

• User connections if a preauthentication or post-authentication scan fails. This scenario is called
access scenario fallback. Access scenario fallback allows a user device to fall back from the
NetScaler Gateway Plug-in to StoreFront or the Web Interface, by using Receiver, if the user de-
vice does not pass the initial endpoint analysis scan.

If users log on to NetScaler Gateway through Receiver, the preauthentication scan does not
work. Post-authentication scans do work when NetScaler Gateway establishes the VPN tunnel.

Users can download and install the NetScaler Gateway Plug-in by using the following methods:

• Connecting to NetScaler Gateway by using a web browser.
• Connecting to StoreFront that is configured to accept NetScaler Gateway connections.
• Installing the plug-in by using a Group Policy Object (GPO).
• Uploading the NetScaler Plug-in to Merchandising Server.

Deploying NetScaler Gateway plug-ins for user access

October 5, 2020

NetScaler Gateway comes with the following plug-ins for user access:

• NetScaler Gateway plug-in for Windows
• NetScaler Gateway plug-in for Mac
• NetScaler Gateway plug-in for Java
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When users log on to NetScaler Gateway for the first time, they download and install the NetScaler
Gateway plug-in from a webpage. Users log on by clicking the NetScaler Gateway icon in the notifica-
tion area on a Windows-based computer. On a macOS X computer, users can log on from the Dock or
the Applications menu. If you upgrade NetScaler Gateway to a new software version, the NetScaler
Gateway plug-in updates automatically on the user device.

The NetScaler Gateway plug-in for Java can be used on any user device that supports Java. The
NetScaler Gateway plug-in for Java supports most TCP-based applications, but provides only some of
the features of the NetScaler Gateway plug-in for Windows or NetScaler Gateway plug-in for macOS X.
The NetScaler Gateway plug-in for Java provides limited access to the network resources you define.
For more information about the Java plug-in, see Connecting with the NetScaler Gateway plug-in for
Java.

Deploying the NetScaler Gateway plug-in by using the MSI installer package

You can deploy the NetScaler Gateway plug-in by using a Microsoft Active Directory infrastructure or a
standard third-party MSI deployment tool, such as Windows Server Update Services. If you use a tool
that supports Windows Installer packages, you can deploy the packages with any tool that supports
MSI files. Then, you use your deployment tool to deploy and install the software on the appropriate
user devices.

Advantages of using a centralized deployment tool

• Ability to adhere to security requirements. For example, you can install user software without
enabling software installation privileges for non-administrative users.

• Control over software versions. You can deploy an updated version of the software to all users
simultaneously.

• Scalability. A centralized deployment strategy easily scales to support additional users.
• Positive user experience. You can deploy, test, and troubleshoot installation-related issues with-

out involving users in this process.

Citrix recommends this option when administrative control over the installation of user software is
preferred and access to user devices is readily available.

For more information, see Deploying the NetScaler Gateway plug-in from Active Directory.

Determining which software plug-in to deploy

If your NetScaler Gateway deployment does not require any software plug-in on user devices, your de-
ployment is considered to provide clientless access. In this scenario, users need only a Web browser
to access network resources. However, certain features require the plug-in software on the user’s de-
vice.
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Selecting the NetScaler Gateway Plug-in for Users

October 5, 2020

When you configure NetScaler Gateway, you can choose how users log on. Users can log on with one
of the following plug-ins:

• NetScaler Gateway Plug-in for Windows
• NetScaler Gateway Plug-in for Mac OS X
• NetScaler Gateway Plug-in for Java

You complete the configuration by creating a session policy and then binding the policy to users,
groups, or virtual servers. You can also enable plug-ins by configuring global settings. Within the
global or session profile, you select either Windows/Mac OS X or Java as the plug-in type. When users
log on, they receive the plug-in as defined globally or in the session profile and policy. You must create
separate profiles for the plug-in type. You can only choose either Windows/Mac OS X or Java in the ses-
sion profile. To configure the NetScaler Gateway Plug-in for Java, see Connecting with the NetScaler
Gateway Plug-in for Java.

To configure the plug-in globally

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Global Settings.

2. In the details pane, under Settings, click Change global settings.
3. On the Client Experience tab, next to Plug-in Type, select Windows/Mac OS X and then click OK.

To configure the plug-in type for Windows or Mac OS X in a session profile

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway > Policies and then click Session.

2. Do one of the following:
• If you are creating a new session policy, in the details pane, click Add.
• If you are changing an existing policy, select a policy and then click Open.

3. Create a new profile or modify an existing profile. To do so, do one of the following:
• Next to Request Profile, click New.
• Next to Request Profile, click Modify.

4. On the Client Experience tab, next to Plug-in Type, click Override Global and then select Win-
dows/Mac OS X.

5. Do one of the following:
• If you are creating a new profile, click Create, set the expression in the policy dialog box,

click Create and then click Close.
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• If you are modifying an existing profile, after making the selection, click OK twice.

To set the interceptionmode for the NetScaler Gateway Plug-in for Windows

If you are configuring the NetScaler Gateway Plug-in for Windows, you also need to configure the in-
terception mode and set it to transparent.

1. In the configuration utility, click the Configuration tab, expand NetScaler Gateway > Resources
and then click Intranet Applications.

2. In the details pane, click Add.
3. In Name, type a name for the policy.
4. Click Transparent.
5. In Protocol, select ANY.
6. In Destination Type, select IP Address and Netmask..
7. in IP address type the IP address.
8. In Netmask, type the subnet mask, click Create and then click Close.

Installing the NetScaler Gateway Plug-in for Windows

October 5, 2020

When users log on to NetScaler Gateway, they download and install the NetScaler Gateway Plug-in on
the user device.

To install the plug-in, users must be a local administrator or a member of the Administrators group.
This restriction applies for first-time installation only. Plug-in upgrades do not require administrator
level access.

To enable users to connect to and use NetScaler Gateway, you need to provide them with the following
information:

• NetScaler Gateway web address, such as https://NetScalerGatewayFQDN/
• Any system requirements for running the NetScaler Gateway Plug-in if you configured endpoint

resources and policies

Depending on the configuration of the user device, you might also need to provide the following in-
formation:

• If users run a firewall on their computer, they might need to change the firewall settings so that
the firewall does not block traffic to or from the IP addresses corresponding to the resources for
which you granted access. The NetScaler Gateway Plug-in automatically handles Internet Con-
nection Firewall in Windows XP and Windows Firewall in Windows XP Service Pack 2, Windows
Vista, Windows 7, Windows 8, or Windows 8.1.
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• Users who want to send traffic to FTP over an NetScaler Gateway connection must set their FTP
application to perform passive transfers. A passive transfer means that the remote computer
establishes the data connection to your FTP server, rather than the establishment of the data
connection by the FTP server to the remote computer.

• Users who want to run X client applications across the connection must run an X server, such as
XManager, on their computers.

• Users who install Receiver for Windows or Receiver for Mac can start the NetScaler Gateway Plug-
in from Receiver or by using a web browser. Provide instructions to users about how to log on
with the NetScaler Gateway Plug-in through Receiver or a web browser.

Because users work with files and applications as if they were local to the organization’s network, you
do not need to retrain users or configure applications.

To establish a secure connection for the first time, log on to NetScaler Gateway by using the web logon
page. The typical format of a web address is https://companyname.com. When users log on, they can
download and install the NetScaler Gateway Plug-in on their computer.

To install the NetScaler Gateway Plug-in for Windows

1. In a web browser, type the web address of NetScaler Gateway.
2. Type the user name and password and then click Logon.
3. Select Network Access and then click Download.
4. Follow the instructions to install the plug-in.

When the download is complete, the NetScaler Gateway Plug-in connects and displays a message in
the notification area on a Windows-based computer.

If you want users to connect with the NetScaler Gateway Plug-in without using a web browser, you can
configure the plug-in to display the logon dialog box when users right-click the NetScaler Gateway icon
in the notification area on a Windows-based computer or start the plug-in from the Start menu.

To configure the logon dialog box for the NetScaler Gateway Plug-in for Windows

To configure the NetScaler Gateway Plug-in to use the logon dialog box, users must be logged on to
complete this procedure.

1. On a Windows-based computer, in the notification area, right-click the NetScaler Gateway icon
and then click Configure NetScaler Gateway.

2. Click the Profile tab and then click Change Profile.
3. On the Options tab, click Use the NetScaler Gateway Plug-in for logon.

Note: If users open the
Configure NetScaler Gateway dialog box from within Receiver, the
Options tab is not available.
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Deploying the NetScaler Gateway plug-in from Active Directory

October 5, 2020

If users do not have administrative privileges to install the NetScaler Gateway plug-in on the user de-
vice, you can deploy the plug-in for users from Active Directory.

When you use this method to deploy the NetScaler Gateway plug-in, you can extract the installation
program and then use a group policy to deploy the program. The general steps for this type of deploy-
ment are:

• Extracting the MSI package.

• Distributing the plug-in by using a group policy.

• Creating a distribution point.

• Assigning the NetScaler Gateway plug-in package by using a Group Policy Object.

Note: Distribution of the NetScaler Gateway plug-in from Active Directory is only supported on
Windows XP, Windows Vista, Windows 7, and Windows 8.

You can download the MSI package from the configuration utility or from the Citrix website.

To download the NetScaler Gateway plug-in MSI package from the configuration utility

1. In the configuration utility, click Downloads.

2. Under NetScaler Gateway plug-in, click Download NetScaler Gateway plug-in for Windows
and then save the file nsvpnc_setup.exe to your Windows server.

Note:

• For 64-bit machines, you must save the file Agee_setup.exe to your Windows server.

• If the File Download dialog box does not appear, press the CTRL key when you click the
link Download NetScaler Gateway plug-in for Windows.

3. At a command prompt, navigate to the folder where you saved nsvpnc_setup.exe to and then
type:

1 nsvpnc_setup /c

This extracts the file agee.msi.

Note: For 64-bit machines, navigate to the folder where you savedAgee_setup.exe to and then
type:
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1 Agee_setup.exe /c

This extracts the file agee64.msi.

4. Save the extracted file to a folder on the Windows server.

After you extract the file, you use a group policy on Windows Server to distribute the file.

Before starting the distribution, install the Group Policy Management Console on Windows Server
2003, Windows Server 2008, or Windows Server 2012. For more information, see the Windows online
help.

Note: When you use a group policy to publish the NetScaler Gateway plug-in, Citrix recommends
assigning the package to the user device. The MSI package is installed on a per-device basis.

Before you can distribute the software, create a distribution point on a network share on a publishing
server, such as Microsoft Internet Security and Acceleration (ISA) Server.

To create a distribution point

1. Log on to the publishing server as an administrator.
2. Create a folder and share it on the network with read permission for all accounts that need ac-

cess to the distribution package.
3. At the command prompt, navigate to the folder where you save the extracted file and then type:

msiexec -a agee.msi
4. On the Network Location screen, click Change and then navigate to the shared folder where

you want to create the administrative installation of the NetScaler Gateway plug-in.
5. Click OK and then click Install.

After you have added the extracted package on the network share, assign the package to a Group
Policy Object in Windows.

After you configure the NetScaler Gateway plug-in successfully as a managed software package, the
plug-in is installed automatically the next time the user device starts.

Note: When the installation package is assigned to a computer, the user must restart the computer.

When the installation starts, users receive a message that the NetScaler Gateway plug-in is installing.

Upgrading and Removing the NetScaler Gateway Plug-in by Using Active
Directory

October 5, 2020
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Each release of the NetScaler Gateway Plug-in is packaged as a full product installation, instead of as
a patch. When users log on and the NetScaler Gateway Plug-in detects a new version of the plug-in,
the plug-in upgrades automatically. You can also deploy the NetScaler Gateway Plug-in to upgrade
by using Active Directory.

To do so, create a new distribution point for the NetScaler Gateway Plug-in. Create a new Group Policy
Object and assign the new version of the plug-in to it. Then, create a link between the new package
and the existing package. After you create the link, the NetScaler Gateway Plug-in is updated.

Removing the NetScaler Gateway Plug-in fromUser Devices

To remove the NetScaler Gateway Plug-in from user devices, remove the assigned package from the
Group Policy Object Editor.

When the plug-in is removed from the user device, users receive a message that the plug-in is unin-
stalling.

Troubleshooting the NetScaler Gateway Plug-in Installation Using Active
Directory

October 5, 2020

If the assigned package fails to install when the user device starts, you might see the following warning
in the application event log:

Failed to apply changes to software installation settings. Software installation policy application has
been delayed until the next logon because an administrator has enabled logon optimization for group
policy. The error was: The group policy framework should call the extension in the synchronous fore-
ground policy refresh.

This error is caused by Fast Logon Optimization in Windows XP in which users are allowed to log on be-
fore the operating system initialized all of the networking components, including Group Policy Object
processing. Some policies might require more than one restart to take effect. To resolve this issue,
disable Fast Logon Optimization in Active Directory.

To troubleshoot other installation issues for managed software, Citrix recommends using a group pol-
icy to enable Windows Installer Logging.

Connecting with the NetScaler Gateway Plug-in for Java

October 5, 2020
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The NetScaler Gateway Plug-in for Java can be used on any user device that supports Java.

Note: Java Runtime Environment (JRE) Version 1.4.2 up to the most recent version of JRE is re-
quired for the following operating systems and web browsers.

• Mac OS X
• Linux
• Windows XP (all versions), Windows Vista, Windows 7, and Windows 8
• Internet Explorer
• Firefox
• Safari 1.2 up to the most recent version of the web browser

The NetScaler Gateway Plug-in for Java supports most TCP-based applications, but provides only
some of the features of the NetScaler Gateway Plug-in for Windows or NetScaler Gateway Plug-in for
Mac OS X.

Users do not require administrative privileges on the user device to use the NetScaler Gateway Plug-
in for Java. For security reasons, you might want to require using this plug-in version for a particular
virtual server, group, or user, regardless of which user device is used.

To configure NetScaler Gateway to install the NetScaler Gateway Plug-in for Java on user devices, con-
figure a session policy and then bind it to the virtual server, group, or user.

If users log on from a computer running Windows 7, the proxy server information is not set automat-
ically in Internet Explorer. Users must manually configure the proxy server on the computer running
Windows 7.

To configure the NetScaler Gateway Plug-in for Java

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway > Policies and then click Session.

2. In the details pane, click the Profiles tab.
3. Select a session profile and then click Open.
4. On the Client Experience tab, next to Plug-in Type, click Override Global, select Java and then

click OK.

To set the interceptionmode

After creating the session policy, create an intranet application to define the interception mode for
users who log on with the NetScaler Gateway Plug-in for Java.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway > Resources and then click Intranet Applications.

2. In the details pane, click Add.
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3. In Name, type a name.
4. Click Proxy.
5. In Destination IP Address, type the IP address.
6. In Destination Port, type the port number.
7. In Source IP Address, type the IP address.
8. In Source Port, type the port number, click Create and then click Close.

If you do not specify a source IP address and port number, NetScaler Gateway automatically uses
127.0.0.1 for the IP address and 0 for the port.

Updating the HOSTS File onWindows-Based Computers

When users log on using the NetScaler Gateway Plug-in for Java on a computer running Windows Vista,
Windows 7, or Windows 8, network traffic for TCP intranet applications is not tunneled. The HOSTS file
is not updated automatically on computers running Vista and Windows 7. You must add the intranet
applications manually to the HOSTS file.

On a Windows-based computer, you can edit the HOSTS file in Notepad or another text editor. If you
edit the HOSTS file in Notepad, you must run Notepad as an administrator. Add the mapping entries
for the intranet application for the NetScaler Gateway Plug-in for Java and then save the file.

Integrating the NetScaler Gateway plug-in with Citrix Receiver

October 5, 2020

NetScaler Gateway supports Receiver. The orchestrated system consists of the following components:

• Receiver for Windows 3.4 or newer
• Receiver for Mac
• Receiver for Android
• Receiver for iOS
• StoreFront 2.1 or newer
• AppController 2.8 and newer or XenMobile 10
• Citrix Update Service that is hosted on the Citrix Web site

For more information about NetScaler Gateway compatibility with Citrix products, see Compatibility
with Citrix Products.

You can configure NetScaler Gateway so that when users log on to the appliance, the NetScaler Gate-
way plug-in opens a web browser that allows single sign-on to the Receiver home page. Users can
download Receiver from the home page.
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When users log on with Receiver, user connections can route through NetScaler Gateway in the follow-
ing manner:

• Directly to App Controller
• Directly to StoreFront
• To StoreFront and then App Controller if you do not configure MDX mobile apps in App Controller
• To App Controller and then StoreFront if you do configure MDX mobile apps in App Controller

Note: Connections that are routed directly to App Controller are supported in AppController 2.0, Ap-
pController 2.5, AppController 2.6, App Controller 2.8, and App Controller 2.9 only. If you have App-
Controller 1.1 deployed in your network, user connections must route through StoreFront.

HowUser Connections Work with Citrix Receive

October 5, 2020

Users can connect to the following applications, desktops, and data from Citrix Receiver:

• Windows-based applications and virtual desktops published in StoreFront and the Web Inter-
face

• ShareFile data accessed through App Controller

Users can log on by using any of the following Receivers:

• Receiver for Web
• Receiver for Windows
• Receiver for Mac
• Receiver for iOS
• Receiver for Android

Users can log on with Receiver for Web by using a web browser or from the Receiver icon on the user
device.

When users log on with any version of Receiver, applications, ShareFile data, and desktops appear in
the browser or Receiver window.

Adding the NetScaler Gateway Plug-in to Citrix Receiver

October 5, 2020

When Citrix Receiver is installed on the user device, users can log on with the NetScaler Gateway Plug-
in through Receiver. You upload the NetScaler Gateway Plug-in to Merchandising Server, which then
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downloads and installs the plug-in to Receiver on the user device. If users have the NetScaler Gateway
Plug-in installed when they install Receiver for the first time, the plug-in is automatically added to
Receiver.

Delivering Plug-ins to User Devices

To deliver plug-ins to user devices, you must upload and configure the NetScaler Gateway Plug-in on
the Merchandising Server. When users make a selection, the plug-in downloads and installs from the
Merchandising Server.

If users install the NetScaler Gateway Plug-in and then later install Receiver, when the Receiver instal-
lation is complete, the NetScaler Gateway Plug-in appears in the Receiver menu.

If users have Citrix Receiver for Windows, users can install Receiver Updater for Windows. This is an op-
tional component that updates the plug-ins and communicates with Merchandising Server. Receiver
includes all of the plug-ins available for delivery, including the NetScaler Gateway Plug-in. For more
information about Receiver Updater for Windows, see the Receivers and Plug-ins section in the Citrix
eDocs library.

Connecting to NetScaler Gateway with Receiver

If users connect with Receiver for Windows, they can right-click the Receiver icon in the notification
area, click Preferences and then click Plug-in status. If the NetScaler Gateway Plug-in is installed on
the user device, users right-click the NetScaler Gateway Plug-in and then click Logon. When authenti-
cation succeeds, the NetScaler Gateway Plug-in establishes the connection to NetScaler Gateway and
establishes a full VPN tunnel.

Users can also log on with a web browser. Users enter the fully qualified domain name (FQDN) of
NetScaler Gateway and log on. When NetScaler Gateway establishes the connection, users can verify
the connection on the Preferences > Plug-in status panel in Receiver.

The NetScaler Gateway web address is part of the metadata configured on Merchandising Server and
users cannot change the address. The NetScaler Gateway Plug-in initiates the logon to NetScaler Gate-
way. If the version of NetScaler Gateway Plug-in for Windows that is installed on the user device is
different than the version on the NetScaler Gateway appliance, the plug-in downgrades or upgrades
automatically when users log on. The NetScaler Gateway Plug-in for Mac OS X does not downgrade
automatically. To install an earlier version of the plug-in on a Mac computer, users must first uninstall
the NetScaler Gateway Plug-in and then download the earlier version from NetScaler Gateway.

Upgrading or Downgrading the NetScaler Gateway Plug-in

During an upgrade or downgrade of the NetScaler Gateway Plug-in, the appliance removes, down-
loads, and then installs the correct version of the plug-in. Users can confirm the new installation by
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checking the plug-in entry on the Preferences > Plug-in status panel in Receiver. The newly installed
version of the NetScaler Gateway Plug-in might be a different version than what is configured on Mer-
chandising Server.

Adding the NetScaler Gateway Plug-in to Merchandising Server

You can also configure NetScaler Gateway Plug-in delivery on Merchandising Server, which provides a
web configuration interface that allows you to upload the NetScaler Gateway Plug-in MSI installation
package. On Merchandising Server, you can:

• Specify the version and metadata for the NetScaler Gateway Plug-in.

• Configure one or more Web addresses for the NetScaler Gateway appliance.

• Associate specific rules based on operating system or other parameters for delivery.

Users cannot add or remove servers from the list of servers configured on Merchandising Server,
although they can select a different server from the configured list in the Network Settings panel
in Receiver.

If you are using Access Scenario Fallback or load balancing, you can configure a fixed set of NetScaler
Gateway web addresses and designate Merchandising Server as the default address. Users connect
to the default server when they select Log On from the Receiver menu. Users can select a different ad-
dress from the provided list by using the Receiver’s Preferences > Network Settings panel in Receiver.

Users can continue to use a web browser to log on to any NetScaler Gateway. If users log on by using
a web browser, the NetScaler Gateway Plug-in upgrades or downgrades automatically to the version
that is on NetScaler Gateway.

The following are general steps for adding the NetScaler Gateway Plug-in to Merchandising Server. For
specific configuration steps, see Merchandising Server in the Technologies section in the Citrix eDocs
library.

• Configure the settings on the General tab in the Merchandising Server Administrator Console.

• Add the NetScaler Gateway Plug-in to Merchandising Server.

• Select the appropriate plug-in version for the target platform. The NetScaler Gateway Plug-in
must be added to the main page of Merchandising Server for the plug-in to appear in the Add
Plug-ins to Delivery page.

• Configure delivery for the NetScaler Gateway Plug-in.

• Use a friendly name for the location that identifies the NetScaler Gateway Web address. This
name appears in Receiver. You can also add additional NetScaler Gateway appliances.

• Specify authentication type and customize specific labels that appear in the Receiver logon di-
alog box, such as the user name, password, or personal identification number (PIN).
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• Add rules for the delivery.

• You must create rules if you want rules to appear in the Add Rule to Delivery page.

• Schedule the delivery.

Decoupling the Citrix Receiver Icon

December 4, 2020

When a XenApp and XenDesktop deployment is configured with the NetScaler Gateway plug-in inte-
grated with Citrix Receiver, the plug-in’s icon is not visible to a user who is connected to the VPN. The
NetScalerGatewayplug-in icon normally resides in the Windows system tray or the macOS X Finder’s
menu bar. This icon is the interface into the plug-in’s settings and controls. For Windows users, when
Citrix Receiver and the NetScaler Gateway plug-in are integrated, the About dialog in Citrix Receiver
displays the controls for the NetScaler Gateway plug-in. For macOS X users, there are no controls for
the NetScaler Gateway plug-in available after integration.

Some integrated deployments might present a need to expose the plug-in controls while retaining
the integration of the underlying functionality. To do so, use the following CLI command or NetScaler
configuration utility task to toggle the icon integration for VPN clients.

Setting icon integration using the CLI

Use the following command:

1 set vpn parameter [-iconWithReceiver (ON/OFF)]

Setting icon integration using the GUI

Using the NetScaler configuration utility:

1. On the Configuration tab, navigate to Citrix Gateway > Global Settings.

2. Click Change Global Settings, and then select the Client Experience tab.

3. Click Advanced Settings.

4. Select Show VPN Plug-in icon with Receiver.
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Important:

This configuration takes effect after the Windows VPN plug-in process is restarted.

Configuring IPv6 for ICA Connections

October 5, 2020

NetScaler Gateway supports IPv6 addresses for ICA connections. Connections with IPv6 to the Web In-
terface or StoreFront work the same as IPv4 connections. When users connect by using the NetScaler
Gateway web address, NetScaler Gateway proxies the connection to the Web Interface or StoreFront.

You can configure IPv6 for NetScaler Gateway deployed in one DMZ or deployed in a double-hop DMZ.

You enable IPv6 on NetScaler Gateway by using the command line. You can use the following guide-
lines:

• Enable IPv6 on the appliance.

• Configure subnet IP addresses.

• Set the DNS resolution order.

• Set the Web Interface or StoreFront web address.

• Bind the Secure Ticket Authority (STA) to NetScaler Gateway.

By default, the mapped IP address does not support IPv6 addresses. To route user communications
to the internal network, you need to create subnet IP addresses and then and configure NetScaler
Gateway to use the subnet IP addresses.

If you deploy multiple IPv6 subnets in your network, create multiple IPv6 subnet IP address on
NetScaler Gateway, on for each subnet in your network. Network routing sends the IPv6 packets to
the respective subnets by using the subnet IP addresses.

To configure IPv6 for ICA proxy

To configure IPv6 for ICA proxy:

1. Log on to NetScaler Gateway by using a Secure Shell (SSH) connection, such as from PuTTY.

2. At the command prompt, type enable ns feature IPv6PT. This enables IPv6.

3. At the command prompt, type enable ns mode USNIP. This enables the use of the subnet IP
addresses.

4. At the command prompt, type: set dns parameter –resolutionOrder AAAAThenAQuery
AThenAAAAQuery OnlyAAAAQuery OnlyAQuery
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5. At the command prompt, type: set vpn parameter -wihome http://XD_domain/Citrix/
StoreWeb.

Where is either the domain name or IP address of StoreFront.

For example, set vpn parameter -wihome http://storefront.domain.com/Citrix/
StoreWeb

or

set vpn parameter -wihome http://[1000:2000::3000]/Citrix/StoreWeb

If you use the IPv6 address to configure this parameter, the IP address must be contained in brack-
ets.

Configuring the Receiver Home Page on NetScaler Gateway

October 5, 2020

You can configure the Receiver home page either globally or as part of a session profile. If you want
to configure Receiver for Web and earlier Receiver versions that do not recognize StoreFront through
NetScaler Gateway, you need to create two separate session profiles. The field Citrix Receiver Home
Page needs to have the correct web address for each profile so users can log on successfully.

For Receivers that recognize StoreFront through NetScaler Gateway, you can have Receiver for Web
and Receiver share a profile. However, Citrix recommends that you configure a session profile for
Receiver for Web and a separate session profile for all other Receivers.

To configure the Receiver home page globally

To configure the Receiver home page globally:

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Global Settings.

2. In the details pane, under Settings, click Change global settings.

3. In the Global NetScaler Gateway Settings dialog box, click the Published Applications tab.

4. In Citrix Receiver Home Page, type the web address for Receiver or the Receiver for Web home
page and then click OK.

To configure the Receiver home page in a session profile

To configure the Receiver home page in a session profile:
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1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway > Policies and then click Session.

2. In the details pane, on the Profiles tab, click Add.

3. In the Create NetScaler Gateway Session Profile dialog box, on the Published Application
tab, next to Citrix Receiver Home Page, click Override Global.

4. In Citrix Receiver Home Page, type the web address for the Receiver or Receiver for Web home
page and then click Create.

Applying the Receiver Theme to the Logon Page

October 5, 2020

You can use the configuration utility to apply the Receiver theme to the logon page for NetScaler Gate-
way. You can switch between the Receiver theme, the default theme, or a custom theme that you
create. The feature is available on the following NetScaler Gateway versions:

• NetScaler Gateway 10.1 or newer.

• Access Gateway 10, Build 71.6014.e

• Access Gateway 10, Build 73.5002.e

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Global Settings.

2. In the details pane, under Settings, click Change global settings.

3. In the Global NetScaler Gateway Settings dialog box, click the Client Experience tab.

4. Next to UI Theme, click Green Bubble and then click OK.

This command overwrites the original logon page with the Receiver theme. Note: After you
apply a different theme, advise users to clear the browser cache to prevent cached pages from
appearing.

Creating a Custom Theme for the Logon Page

October 5, 2020

You can use the configuration utility to create a custom theme for the logon page for NetScaler Gate-
way. You can also leave the default theme or use the Citrix Receiver theme. When you choose to apply
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a custom theme to the logon page, you use the NetScaler Gateway command line to create and deploy
the theme. You then use the configuration utility to set the custom theme page.

You configure the custom theme page by using NetScaler Gateway global settings.

You can use this feature with the following versions of NetScaler Gateway:

• NetScaler Gateway 10.1

• Access Gateway 10, Build 73.5002.e (you must install this build after Build 71.6104.e to use this
feature with AppController Versions 2.5, 2.6, or 2.8)

• Access Gateway 10, Build 71.6104.e

Create and deploy the custom theme by using the command line

T0 create and deploy the custom theme by using the command line:

1. Log on to the NetScaler Gateway command line.

2. At a command prompt, type shell.

3. At command prompt, type mkdir /var/ns_gui_custom; cd /netscaler; tar -cvzf /var/ns_gui_custom/customtheme.tar.gz
ns_gui/* .

4. Use the configuration utility to switch to the custom theme and then make customization
changes under /var/ns_gui_custom/ns_gui/vpn. You can:

• Make edits to the css/ctx.authentication.css file.

• Copy a custom logo to the /var/ns_gui_custom/ns_gui/vpn/media folder. Note: You can
use WinSCP to transfer the files.

5. If you have multiple NetScaler Gateway appliances, repeat Steps 3 and 4 for all appliances.

Customizing the User Portal

October 5, 2020

NetScaler Gateway installations that serve the portal to VPN users include an option to select a portal
theme to create a customized look and feel for the portal pages. You can select from a supplied set
of themes, or you can use a theme as a template to build a customized or branded portal. Using the
configuration utility, you can modify a theme by adding new logos, background images, custom input
box labels, and various other attributes of the CSS based portal design. The built-in portal themes
include content for five languages: English, French, Spanish, German, and Japanese. Different users
are served in different languages, depending on the locales reported by their web browsers.
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You have the option to create a custom end-user license agreement (EULA) that is presented to VPN
users before they are allowed to sign in. The EULA feature supports locale-specific versions of a EULA,
which are presented to users based on their web browsers reported locales.

Both portal themes and EULA configurations can be bound independently at the VPN virtual server
and VPN global levels.

Important: Citrix does not support customization that requires code modifications and does not
offer support to resolve issues beyond reverting to a default theme.

Applying a Portal Theme

By default, the VPN portal is configured to use the Caxton theme. The Caxton theme is named Default.

Caxton Theme

NetScaler Gateway includes two additional themes that can be applied to the portal: The Greenbub-
ble and X1 themes.
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Greenbubble Theme

X1 Theme

You can apply any of the supplied themes directly to a VPN virtual server or as a global VPN binding.

Binding a Portal Theme to a VPN Virtual Server

You can bind a portal theme on an existing virtual server or when creating a new virtual server.
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Using the command line to bind a portal theme to an existing VPN virtual server

At the command prompt, type;

1 bind vpn vserver <name> -portaltheme <name>

Using the configuration utility to bind a portal theme to an existing VPN virtual server

1. On the Configuration tab, Navigate to NetScaler Gateway and click Virtual Servers.
2. Select a virtual server, and then click Edit.
3. If a portal theme has not yet been bound to the virtual server, click Portal Theme under Ad-

vanced Settings in the details pane. Otherwise, the Portal Theme option is already expanded
in the details pane.

4. In the details pane, under Portal Themes, click No Portal Theme to expand the Portal Theme
binding window.

5. Click Click to select.
6. In the Portal Themes window, click a theme name, and then click Select.
7. Click Bind.
8. Click Done.

If you are creating a VPN Virtual Server, you can follow the steps above starting with step 3 while in
the VPN Virtual Server edit pane to bind a Portal Theme.

Binding a Portal Theme to VPN Global

Using the command line to bind a portal theme to the VPN global scope

At the command prompt, type;

1 bind vpn global portaltheme <name>

Using the configuration utility to bind a portal theme to the VPN global scope

1. On the Configuration tab, Navigate to NetScaler Gateway.
2. In the main details pane, click NetScaler Gateway Policy Manager.
3. Click the ‘+’ icon.
4. In the Bind Point list, select Resources.
5. In the Connection Type list, select Portal Theme.
6. Click Continue.
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7. In the Bind Point screen, click Add Binding.
8. Click Click to select.
9. In the Portal Themes window, click a theme name, and then click Select.

10. Click Bind.
11. Click Close.
12. Click Done.

Tip: When you’ve completed a set of changes, use the ‘save ns config’ command on the com-
mand line or click the save icon in the configuration utility to ensure your changes are saved to
NetScaler configuration file.

Creating a Portal Theme

To create a custom portal design, you use one of the supplied portal themes as a template. The system
makes a copy of the selected template theme with a name that you specify.

Using a stock Portal Theme as a template for a custom Portal Theme

To create a Portal Theme, you can use the configuration utility or the command line to create the
theme entity. However, the detailed customization controls are available only within the configura-
tion utility.

Using the command line to create a portal theme

At the command prompt, type;

1 add portaltheme <name> basetheme <name>

Using the configuration utility to create a portal theme

1. On the Configuration tab, Navigate to NetScaler Gateway and click Portal Themes.
2. In the main details pane, click Add.
3. Enter a name for the theme and select a template from the template menu, and then click OK.
4. At this point, you are presented with the first-time view of the portal theme editing window.

Click OK to exit.

You can proceed to customize the new portal theme with the first-time view. However, you should read
the following Portal Theme Customization section about the interface, and the pop-up descriptions
of the customizable portal attributes within the interface before continuing to edit a portal theme.
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Once a new theme is created, you can bind it as described in Binding a Portal Theme to a VPN Virtual
Server or Binding a Portal Theme to VPN Global. You can bind a new theme immediately after creation
or after completing your customizations.

Portal Theme Customization

To customize a Portal Theme, use the Portal Theme interface in the configuration utility. To get the
best results, you should understand the various elements of this interface before you use it.

About the Portal Theme Interface

To open the Portal Theme interface in the NetScaler Gateway configuration utility, on the Configu-
ration tab, Navigate to NetScaler Gateway and click Portal Themes. You can either create a theme
as described in the Creating a Portal Theme or select an existing theme in the main details pane and
click Edit.

The portal theme customization page has four primary component panes for modifying a portal de-
sign: the Portal Theme pane, the Look & Feel pane, the Advanced Settings pane, and the Language
pane.
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Portal Theme interface

ThePortal Theme pane at the top of the page reports what theme is loaded for editing and what tem-
plate theme it is based on. The viewing option here allows you to view your customizations without
accessing the VPN with a user connection. Using the viewing option requires binding the theme to a
VPN virtual server and the binding remains in effect after the viewing window is closed.

With the Look & Feel pane in the center of the page, you configure a theme’s general properties, such
as headers, background colors and images, font properties, and logos. When this pane is in edit mode,
attribute legends are available for guidance on where the Look & Feel attributes are used on portal
pages.

The Advanced Settings pane contains the onscreen content controls for the individual portal pages.
To load a page’s content for editing, click any one of the pages listed. The page controls then open
below the other center panes. A page remains collapsed in the Advanced Settings pane across Portal
Theme edits as long as the page has not been modified.

In the Language pane, you can select which of the languages will be loaded when a page is selected
for edit from the Advanced Settings pane. The English language pages are loaded by default.
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Types of Customizable Page Attributes

When customizing a Portal Theme, you can modify a range of attributes in the Portal Theme interface.
Along with the text and the supported languages that can be edited, all of the graphical elements of
the portal’s layout can be tailored to suit your needs. Each of the page element types has parameters
or recommendations to consider before modifying them.

Colors

The portal design specifies the colors for attributes such as page backgrounds, highlights, text for titles
and body content, button controls, and hover responses. To customize a color attribute, you can enter
a color value directly for a selected item, or you can use the supplied color picker to generate a color
value. The interface supports entering valid HTML color values in RGBA format, HTML hexadecimal
triplet format, and X11 color names. The color picker can be accessed for any applicable color attribute
by clicking the color box next to the attribute’s input field.

The Color Picker
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Fonts

Along with font colors, you can modify font sizes for some page attributes. For each of these attributes,
a menu offers the sizes available for each attribute, as determined by the portal’s design.

Images

For images, a pop-up description available for each control provides size recommendations and other
requirements. The descriptions vary according to an attribute’s location on the page and its function.
You can use PNG or JPEG image file formats. You can select an image to upload by selecting the check
box beneath an item’s file name and then browsing to where the image resides on your local com-
puter’s drive.

Labels

In the Advanced Settings section, you can select a specific portal page’s text to modify. If you modify
the default English text for a page, the text for other languages is not retranslated. The alternative
language page content is provided as a convenience but requires manual updates for any customiza-
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tions. To edit another language version for a page, first collapse the window, if it is open, by clicking
the X icon for the open portal page. Then select the language in the Language pane and click OK. All
of the portal pages opened from the Advanced Settings pane will then be in that language until you
select a different one.

Important

In high availability or clustered deployments, Portal Themes are distributed across the shared
configuration only when Portal Theme settings are made on the primary or configuration coor-
dinator NetScaler entities respectively.

A Note on Older Portal Customizations

For installations with manually modified custom portal design created in NetScaler Gateway or Access
Gateway releases earlier than 11.0, Citrix strongly recommends starting with a new portal theme in
the customization interface. If you can’t do that, you can apply a customization manually, but direct
support for that is not provided.

When using a manually customized portal, you must set the customized portal as a global portal con-
figuration. Doing so though means that an applied global portal configuration cannot be overridden
with VPN virtual server level portal theme bindings. Attempting to create a VPN virtual server binding
in this case with the configuration utility or the command line returns an error.

Also, in the case of high availability and cluster configurations, any manual customizations must be
performed on every node in the deployment as the underlying files on the NetScaler file system are
not distributed in the automatically shared configuration.

Manually creating a custom portal configuration

To manually apply an older customized portal configuration after upgrading to NetScaler Gateway
11.0, you need to modify a copy of an existing portal page, put the customized portal files into the
NetScaler file system, and select CUSTOM as the UITHEME parameter.

You can use WinSCP or any other secure copy program to transfer files to the NetScaler file system.

1. Log on to the NetScaler Gateway command line.
2. At the command prompt, type shell
3. At the command prompt, type mkdir /var/ns_gui_custom; cd /netscaler; tar -cvzf

/var/ns_gui_custom/customtheme.tar.gz ns_gui/*.
4. At command prompt, type cd /var/netscaler/logon/themes/

• If you want to customize the Greenbubble theme, enter cp -r Greenbubble Custom to
make a copy of the Greenbubble theme.

• If you want to customize the Default theme (Caxton), type cp -r Default Custom.
• To customize the X1 theme, type cp -r X1 Custom.
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5. Make the needed changes to the copied files under /var/netscaler/logon/themes/Custom to
customize the theme manually.

• Make the necessary edits to css/base.css.
• Copy any custom images to the /var/ns_gui_custom/ns_gui/vpn/media directory.
• Make changes to labels in the files present in the resources/ directory. These files corre-

spond to the portal supported locales.
• If changes to HTML pages or javascript files are also needed, you can make the relevant to

the files in /var/ns_gui_custom/ns_gui/.
6. After all customization changes are complete, at the prompt enter: tar–cvzf /var/ns_gui_custom/customtheme.tar.gz

/var/ns_gui_custom/ns_gui/*

Important: When copying a theme directory in the preceding steps, the copied folder name must
be entered exactly as ‘Custom’ since directory names are case-sensitive within the NetScaler
shell interface. If the directory name is not entered precisely, the folder is not recognized when
the UITHEME setting is configured to CUSTOM.

Select the Customized Theme as a VPN Global Parameter

Once the manually customized portal configuration is complete and copied to the NetScaler file
system, it needs to be applied to the NetScaler Gateway configuration. This is done by setting the
UITHEME parameter to CUSTOM and can be completed with the command line or the configuration
utility.

To use the command line, enter the following command to set the UITHEME parameter.

1 set vpn parameter UITHEME CUSTOM

To set the UITHEME parameter using the configuration utility, use the following procedure.

1. On the Configuration tab, Navigate to NetScaler Gateway > Global Settings.
2. Click Change Global Settings.
3. Click the Client Experience tab.
4. Scroll to the bottom of the screen then select CUSTOM from the UI Theme list.
5. Click OK.

Your manually customized portal is now the portal design presented to VPN users.

Creating an End User License Agreement

The VPN portal system provides the option to apply an end-user license agreement (EULA) to a portal
configuration. Once a EULA is bound to the NetScaler Gateway configuration, either at the VPN global
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scope or to a relevant VPN virtual server, VPN users must agree to the EULA as Terms and Conditions
before they are allowed to authenticate into the VPN.

As with the portal themes, users are served a language specific EULA based on the locale reported
by their web browser. In cases of a locale that doesn’t match to any of the supported languages, the
default language served is English. For each EULA, you can enter a custom message in each of the
supported languages. Pre-translated content is not provided for EULA configurations as it is for the
portal themes. If a user’s reported locale matches for a language where no EULA content is entered,
the user is returned a blank page when they click the “Terms & Conditions” link in on the VPN login
page.

To create a EULA, you can use either of the controls in the configuration utility on the Configuration
tab atNetScaler Gateway >Global Settings > EULA orNetScaler Gateway >Resources > EULA. The
controls in the Global Settings pane are used to manage VPN global EULA bindings while the control
on theResources >EULAnode is for general operations on EULA configurations. You can manage VPN
virtual server EULA bindings by editing a VPN virtual server at NetScaler Gateway > Virtual Servers.
Some commands are also available with the command line for managing EULA entities. However, the
full EULA management controls are available only in the configuration utility.

Using the command line to create a EULA entity

At the command prompt, type;

1 add vpn eula <name>

Using the configuration utility to create a EULA entity

1. Navigate to NetScaler Gateway > Resources > EULA.
2. Click Add to create an entity.
3. Enter a name for the entity.
4. For each of the languages, paste in the content under the relevant tabs. You can use plain text

or HTML tags to format the content, including a <br> tag to add line breaks.
5. Click Create.

Once a EULA entity has been created, it can be globally bound to the VPN configuration, or can be
bound to a VPN virtual server.

Using the command line to bind a EULA to VPN Global

At the command prompt, type;
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1 bind vpn global eula <name>

Using the configuration utility tomake a global EULA VPN binding

1. On the Configuration tab, Navigate to NetScaler Gateway > Global Settings.
2. In the main details pane, click Configure an End User License Agreement.
3. Click Add Binding.
4. Click Click to select.
5. Select a EULA entity then click Select.
6. Click Bind.
7. Click Close.

Using the command line to bind a EULA to a VPN Virtual Server

At the command prompt, type;

1 bind vpn vserver <name> eula <name>

Using the configuration utility to bind a EULA to a VPN Virtual Server

1. At the Configuration tab browse to NetScaler Gateway > Virtual Servers.
2. In the main details pane, select a VPN virtual server and click Edit.
3. From the Advanced Settings pane on the right side of the page, click EULA.
4. In the newly added EULA pane, click No EULA.
5. Click Click to select.
6. Select a EULA entity and click Select.
7. Click Bind.
8. Click Done.

Prompt users to upgrade older or unsupported browsers by creating a
custom page

October 5, 2020
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If a client connects to a NetScaler VIP address using an insecure cipher such as SSLv3, they can be
redirected to a custom page prompting them to upgrade to the latest version of Internet Explorer,
Firefox, Chrome, or Safari.

Note: According to RFC6176 from the Internet Engineering Task Force (ITEF), TLS servers must not
support SSLv2. Therefore, the NetScaler appliance does not support SSLv2 from release 12.1 and later.

How to create a custom page to prompt users to upgrade older unsupported browsers
based on SSL

• Create a NetScaler responder policy with the rule client.ssl.version.eq(). The version
returns the SSL protocol version.

– Returns 0 if the transaction is not SSL based.
– Returns 0x002 if the transaction is SSLv2.
– Returns 0x300 if the transaction is SSLv3.
– Returns 0x301 if the transaction is TLSv1.

• You must enable SSLv3 (or other earlier version) to trigger the responder policy.

For example, if SSLv3 is disabled on the NetScaler appliance and a client with an older browser
using SSLv3 tries to connect, then the access is denied.

• If your deployment requires SSLv3 or an earlier version for a specified period (a month or two),
configure the following:

– Enable the SSLv3 protocol.
– Update the custom page to include information that after the specified period, the browser

cannot connect to the appliance.

Configuring Clientless Access

October 5, 2020

Clientless access allows users the access they need without requiring them to install user software,
such as the NetScaler Gateway Plug-in or Receiver. Users can use their web browser to connect to
web applications, such as Outlook Web Access.

You use the following steps to configure clientless access:

• Enabling clientless access either globally or by using a session policy bound to a user, group, or
virtual server.

• Selecting the web address encoding method.
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To enable clientless access for only a specific virtual server, disable clientless access globally, and then
create a session policy to enable it.

If you use the NetScaler Gateway wizard to configure the appliance, you have the choice of configur-
ing clientless access within the wizard. The settings in the wizard are applied globally. Within the
NetScaler Gateway wizard, you can configure the following client connection methods:

• NetScaler Gateway Plug-in. Users are allowed to log on by using the NetScaler Gateway Plug-in
only.

• Use the NetScaler Gateway Plug-in and allow access scenario fallback. Users log on to NetScaler
Gateway with the NetScaler Gateway Plug-in. If the user device fails an endpoint analysis scan,
users are permitted to log on using clientless access. When this occurs, users have limited access
to network resources.

• Allow users to log on using a Web browser and clientless access. Users can log on only by using
clientless access and receive limited access to network resources.

Enabling Clientless Access

October 5, 2020

When you enable clientless access on a global level, all users receive the settings for clientless access.
You can use the NetScaler Gateway wizard, a global policy, or a session policy to enable clientless
access.

In a global setting or a session profile, clientless access has the following settings:

• On. Enables clientless access. If you disable client choices and you do not configure or disable
StoreFront or the Web Interface, users log on by using clientless access.

• Allow. Clientless access is not enabled by default. If you disable client choices, and you do not
configure or disable StoreFront or the Web Interface, users log on with the NetScaler Gateway
Plug-in. If endpoint analysis fails when users log on, users receive the choices page with client-
less access available.

• Off. Clientless access is turned off. When you select this setting, users cannot log on by using
clientless access and the icon for clientless access does not appear on the choices page.

Note: If you configure clientless access by using the command-line interface, the options are ON, OFF,
or Disabled.

If you did not enable clientless access by using the NetScaler Gateway wizard, you can enable it glob-
ally or in a session policy by using the configuration utility.
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To enable clientless access globally

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Global Settings.

2. In the details pane, under Settings, click Change global settings.
3. On the Client Experience tab, next to Clientless Access, select ON and then click OK.

To enable clientless access by using a session policy

If you want only a select group of users, groups, or virtual servers to use clientless access, disable or
turn off clientless access globally. Then, using a session policy, enable clientless access and bind it to
users, groups, or virtual servers.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway > Policies and then click Session.

2. In the details pane, on the Policies tab, click Add.
3. In Name, type a name for the policy.
4. Next to Request Profile, click New.
5. In Name, type a name for the profile.
6. On the Client Experience tab, next to Clientless Access, click Override Global, select On and then

click Create.
7. In the Create Session Policy dialog box, next to Named Expressions, select General, select True

value, click Add Expression, click Create and then click Close.
8. Click Create and then click Close.

After you create the session policy that enables clientless access, you bind it to a user, group, or virtual
server.

Encoding the Web Address

October 5, 2020

When you enable clientless access, you can choose to encode the addresses of internal web applica-
tions or to leave the address as clear text. The settings are:

• Obscure. This uses standard encoding mechanisms to obscure the domain and protocol part of
the resource.

• Clear. The web address is not encoded and is visible to users.
• Encrypt. The domain and protocol are encrypted by using a session key. When the web address

is encrypted, the URL is different for each user session for the same web resource. If users book-
mark the encoded web address, save it in the web browser and then log off, when users log on
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and try to connect to the web address again using the bookmark, they cannot connect to the
web address.
Note: If users save the encrypted bookmark in the Access Interface during their session, the
bookmark works each time the user logs on.

You can configure this setting either globally or as part of a session policy. If you configure encoding
as part of session policy, you can bind it to the users, groups, or a virtual server.

To configure web address encoding globally

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Global Settings.

2. In the details pane, under Settings, click Change global settings.
3. On the Client Experience tab, next to Clientless Access URL Encoding, select the encoding level

and then click OK.

To configure web address encoding by creating a session policy

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway > Policies and then click Session.

2. In the details pane, on the Policies tab, click Add.
3. In Name, type a name for the policy.
4. Next to Request Profile, click New.
5. In Name, type a name for the profile.
6. On the Client Experience tab, next to Clientless Access URL Encoding, click Override Global, se-

lect the encoding level and then click OK.
7. In the Create Session Policy dialog box, next to Named Expressions, select General, select True

value, click Add Expression, click Create and then click Close.

How Clientless Access Policies Work

October 14, 2020

You configure clientless access to web applications by creating policies. You can configure the settings
for a clientless access policy in the configuration utility. A clientless access policy is composed of a
rule and a profile. You can use the preconfigured clientless access policies that come with NetScaler
Gateway. You can also create your own custom clientless access policies.

NetScaler Gateway provides preconfigured policies for the following:

• Outlook Web Access and Outlook Web App
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• SharePoint 2007
• All other Web applications

Note:

OWA 2016 and SharePoint 2016 are supported only using advanced clientless access.

Keep in mind the following characteristics of the preconfigured clientless access policies:

• They are configured automatically and cannot be changed.
• Each policy is bound at the global level.
• Each policy is not enforced unless you enable clientless access either globally or by creating a

session policy.
• You cannot remove or modify global bindings, even if you do not enable clientless access.

Support for other web applications depends on the level of rewrite policies you configure on NetScaler
Gateway. Citrix recommends testing any custom policies that you create to ensure that all compo-
nents of the application rewrite successfully.

If you allow connections from Receiver for Android, Receiver for iOS, or Citrix Secure Hub, you must
enable clientless access. For Citrix Secure Hub that runs on an iOS device, you must also enable Se-
cure Browse within the session profile. Secure Browse and clientless access work together to allow
connections from iOS devices. You do not have to enable Secure Browse if users do not connect with
iOS devices.

The Quick Configuration wizard configures the correct clientless access policies and settings for mo-
bile devices. Citrix recommends running the Quick Configuration wizard to configure the correct poli-
cies for connections to StoreFront and Endpoint Management.

You can bind custom clientless access policies either globally or to a virtual server. If you want to bind
clientless access policies to a virtual server, you need to create a custom policy and then bind it. To
enforce different policies for clientless access either globally or for a virtual server, change the priority
number of the custom policy so it has a lower number than the preconfigured policies thus giving the
custom policy higher priority. If no other clientless access policies are bound to the virtual server, the
preconfigured global policies take precedence.

Note: You cannot change the priority numbers of the preconfigured clientless access policies.

Creating New Clientless Access Policies

October 5, 2020

If you want to use the same settings as for the default clientless access policies but you want to bind
the policy to a virtual server, you can copy the default policies, providing a new name for the policy.
You can use the configuration utility to copy the default policies.
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After you bind the new policy to the virtual server, you can set the priority of the policy so that it exe-
cutes first when a user logs on.

To create a new clientless access policy using default settings

1. In the configuration utility, on the navigation pane, expand NetScaler Gateway > Policies and
then click Clientless Access.

2. In the details pane, on the Policies tab, click a default policy and then click Add.
3. In Name, type a new name for the policy, click Create and then click Close.

To bind a clientless access policy to a virtual server

After you create the new policy, bind it to the virtual server.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Virtual Servers.

2. In the details pane, select a virtual server and then click Open.
3. In the configure NetScaler Gateway Virtual Server dialog box, click the Policies tab and then

click Clientless.
4. Click Insert Policy, select a policy from the list and then click OK.

Creating and Evaluating Clientless Access Policy Expressions

When you create a new policy for clientless access, you can create your own expression for the policy.
When you are finished creating the expression, you can then evaluate the expression for accuracy.

1. In the configuration utility, on the navigation pane, expand NetScaler Gateway > Policies and
then click Clientless Access.

2. In the details pane, on the Policies tab, click a default policy and then click Add.
3. In Name, type a name for the policy.
4. Next to Profile, click New.
5. In Name, type a name for the profile.
6. Configure the rewrite settings and then click Create.
7. In the Create Clientless Access Policy dialog box, under Expression, click Add.
8. In the Add Expression dialog box, create the expression and then click OK.
9. In the Create Clientless Access Policy dialog box, click Evaluate, and if the expression tests as

correct, click Create.

© 1999-2021 Citrix Systems, Inc. All rights reserved. 272



NetScaler Gateway 12.0

Configuring Domain Access for Users

October 5, 2020

If users connect by using clientless access, you can restrict the network resources, domains, and web
sites users are permitted to access. You can use the NetScaler Gateway wizard or global settings to
create lists for including or excluding access to domains.

You can allow access to all network resources, domains, and web sites and then create an exclusion
list. The exclusion list cites a specific set of resources that users are not allowed to access. Users
cannot access any domains that are in the exclusion list.

You can also deny access to all network resources, domains, and web sites and then create a specific
inclusion list. The inclusion list cites the resources that users can access. Users cannot access any
domains that do not appear on the list.

Note: If you configure clientless access policies for App Controller or StoreFront and users connect
with Receiver for Web, you need to allow the domains that Receiver for Web can access. This is re-
quired so NetScaler Gateway can rewrite network traffic for StoreFront and App Controller.

To configure domain access by using the NetScaler Gateway wizard

1. In the configuration utility, click the Configuration tab and then in the navigation pane, click
NetScaler Gateway.

2. In the details pane, under Getting Started, click NetScaler Gateway wizard.
3. Click Next and then follow the directions in the wizard until you reach the Configure clientless

access page.
4. Click Configure Domains for Clientless Access and do one of the following:

• To create a list of excluded domains, click Exclude domains.
• To create a list of included domains, click Allow domains.

5. Under Domain Names, type the domain name and then click Add.
6. Repeat Step 5 for each domain you want to add to the list and then click OK when finished.
7. Continue configuring the appliance by using the NetScaler Gateway wizard.

To configure domain settings by using the configuration utility

You can also create or modify the domain list by using global settings in the configuration utility.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Global Settings.

2. In the details pane, under Clientless Access, click Configure Domains for Clientless Access.
3. Do one of the following:
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• To create a list of excluded domains, click Exclude domains.
• To create a list of included domains, click Allow domains.

4. Under Domain Names, type the domain name and then click Add.
5. Repeat Step 4 for each domain you want to add to the list and then click OK when finished.

Configuring Clientless Access for SharePoint 2003, SharePoint 2007, and
SharePoint 2013

October 5, 2020

NetScaler Gateway can rewrite content from one or more SharePoint 2003 or SharePoint 2007 or
SharePoint 2013 sites so that the content is available to users without requiring the NetScaler Gate-
way plug-in. For the rewrite process to complete successfully, you must configure NetScaler Gateway
with the host name for each SharePoint server in your network.

You can use the NetScaler Gateway wizard or the configuration utility to configure the host name for
SharePoint sites.

In the NetScaler Gateway wizard, navigate through the wizard to configure your settings. When you
come to the Configure clientless access page, type the web address for the SharePoint site and then
click Add.

To add additional websites or to configure SharePoint for the first time after running the NetScaler
Gateway wizard, you use the configuration utility.

Important: Classic Clientless Access supports versions until SharePoint 2013 and OWA13. Ad-
vanced Clientless Access supports later versions.

To configure clientless access for SharePoint by using the NetScaler GUI

1. Navigate to NetScaler Gateway > Global Settings.
2. In the details pane, under Clientless Access, click Configure Clientless Access for SharePoint.
3. Under Clientless Access for SharePoint, in Host name of the SharePoint server, type the host

name for the SharePoint site and then click Add.
4. Repeat Step 3 for each SharePoint site you want to add to the list and then click OK when fin-

ished.

Setting a SharePoint Site as the Home Page

October 5, 2020
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If you want to set a SharePoint site as the users’ home page, configure a session profile and enter the
host name of the SharePoint site.

To configure a SharePoint site as the home page

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway > Policies and then click Session.

2. In the details pane, click Add.
3. In Name, type a name for the policy.
4. Next to Request Profile, click New.
5. In Name, type a name for the profile.
6. On the Client Experience tab, next to Home Page click Override Global and then type the name

of the SharePoint site.
7. Next to Clientless Access, click Override Global, select On and then click Create.
8. In the Create Session Policy dialog box, next to Named Expressions, select General, select True

value, click Add Expression, click Create and then click Close.

After completing the session policy, bind it to users, groups, virtual servers, or globally. When users
log on, they see the SharePoint Web site as their home page.

Enabling Name Resolution for SharePoint 2007 Servers

October 5, 2020

SharePoint 2007 servers send the configured server name as the host name within various URLs as
part of the response. If a configured SharePoint server name is not the fully qualified domain name
(FQDN), NetScaler Gateway cannot resolve the IP address using the SharePoint server name, and some
user functions time out with the error message “HTTP:1.1 Gateway Time-out.” These functions can
include checking files in and out, viewing the workspace, and uploading multiple files when users are
logged on using clientless access.

To resolve this issue, you can try one of the following:

• Configure a DNS suffix on NetScaler Gateway so that the SharePoint host name is converted to
an FQDN before name resolution.

• Configure a local DNS entry on NetScaler Gateway for every SharePoint server name.
• Change all the SharePoint server names to use the FQDN, such as SharePoint.intranetdomain

instead of SharePoint,
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To configure a DNS suffix

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand DNS and
then click DNS Suffix.

2. In the details pane, click Add.
3. In DNS Suffix, type the intranet domain name as the suffix, click Create and then click Close.

You can repeat Step 3 for each domain you want to add.

To configure a local DNS record for every SharePoint server name on NetScaler
Gateway

1. In the configuration utility, in the navigation pane, expand DNS > Records and then click Address
Records.

2. In the details pane, click Add.
3. In Host Name, type the SharePoint host name for the DNS address record.
4. In IP Address, type the IP address of the SharePoint server, click Add, click Create and then click

Close.

The host name for which an A record is added should not have a CNAME record. Also, there cannot be
duplicate A records on the appliance.

Enabling Clientless Access Persistent Cookies

October 5, 2020

Persistent cookies are required for accessing certain features of SharePoint, such as opening and edit-
ing Microsoft Word, Excel, and PowerPoint documents hosted on the SharePoint server.

A persistent cookie remains on the user device and is sent with each HTTP request. NetScaler Gateway
encrypts the persistent cookie before sending it to the plug-in on the user device, and refreshes the
cookie periodically as long as the session exists. The cookie becomes stale if the session ends.

In the NetScaler Gateway wizard, administrators can enable persistent cookies globally. You can also
create a session policy to enable persistent cookies per user, group, or virtual server.

The following options are available for persistent cookies:

• Allow enables persistent cookies and users can open and edit Microsoft documents stored in
SharePoint.

• Deny disables persistent cookies and users cannot open and edit Microsoft documents stored
in SharePoint.

• Prompt prompts users to allow or deny persistent cookies during the session.
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Persistent cookies are not required for clientless access if users do not connect to SharePoint.

Configuring Persistent Cookies for Clientless Access for SharePoint

October 5, 2020

You can configure persistent cookies for clientless access for SharePoint either globally or as part of a
session policy.

To configure persistent cookies globally

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Global Settings.

2. In the details pane, under Settings, click Change global settings.
3. On the Client Experience tab, next to Clientless Access Persistent Cookies, select an option and

then click OK.

To configure persistent cookies as part of a session policy

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway > Policies and then click Session.

2. In the details pane, on the Policies tab, click Add.
3. In Name, type a name for the policy.
4. Next to Request Profile, click New.
5. In Name, type a name for the profile.
6. On the Client Experience tab, next to Clientless Access Persistent Cookies, click Override Global,

select an option and then click Create.
7. In the Create authentication policy dialog box, next to Named Expressions, select General, select

True value, click Add Expression, click Create and then click Close.

Saving User Settings for Clientless Access ThroughWeb Interface

October 5, 2020

When users log on and log off from the Web Interface by using clientless access, NetScaler Gateway
does not forward the client-consumed cookie set from the previous session, even if the cookies are
persistent when users log on multiple times. You can use the configuration utility or command line to
bind cookies to a pattern set of client cookies to preserve Web Interface settings between sessions.
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To bind cookies for Web Interface persistence by using the configuration utility

1. In the configuration utility, on the Configuration tab, expand NetScaler Gateway > Policies and
then click Clientless Access.

2. In the right pane, on the Policies tab, click Add.
3. In the Create Clientless Access Policy dialog box, in Name, type a name for the policy.
4. Next to Profile, click New.
5. In Name, type a name for the profile.
6. On the Client Cookies tab, in Client Cookies, select ns_cvpn_default_client_cookies and then

click Modify.
7. In the Configure Pattern Set dialog box, under Specify Pattern, in Pattern, enter the following

parameters:
• WIUser and then click Add.
• WINGDevice and then click Add.
• WINGSession and then click Add.

8. Click OK and then click Create.
9. In the Create Clientless Access Policy dialog box, in Expression, type true, click Create and then

click Close.

To bind cookies for Web Interface persistence by using the command line

1. Log on to the NetScaler Gateway command line by using a Secure Shell (SSH) connection, such
as PuTTY.

2. At the command prompt, type shell.
3. At the command prompt, enter the following commands:

• bind policy patset ns_cvpn_default_client_cookies WIUser and then press ENTER.
• bind policy patset ns_cvpn_default_client_cookies WINGDevice and then press ENTER.
• bind policy patset ns_cvpn_default_client_cookies WINGSession and then press ENTER.

Configuring the Client Choices Page

October 5, 2020

You can configure NetScaler Gateway to provide users with multiple logon options. By configuring the
client choices page, users have the option of logging on from one location with the following choices:

• NetScaler Gateway Plug-in for Windows
• NetScaler Gateway Plug-in for Mac OS X
• NetScaler Gateway Plug-in for Java
• StoreFront
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• Web Interface
• Clientless access

Users log on to NetScaler Gateway by using the web address in the certificate bound to NetScaler
Gateway or the virtual server. By creating a session policy and profile, you can determine the logon
choices users receive. Depending on how you configure NetScaler Gateway, the client choices page
displays up to three icons representing the following logon choices:

• Network Access. When users log on to NetScaler Gateway for the first time by using a web
browser and then select Network Access, the download page appears. When users click Down-
load, the plug-in downloads and installs on the user device. When the download and installation
is complete, the Access Interface appears. If you install a newer or revert to an older version
of NetScaler Gateway, the NetScaler Gateway Plug-in for Windows silently upgrades or down-
grades to the version on the appliance. If users connect by using the NetScaler Gateway Plug-in
for Mac, the plug-in silently upgrades if a new appliance version is detected when users log on.
This version of the plug-in does not silently downgrade.

• Web Interface or StoreFront. If users select the Web Interface to log on, the Web Interface page
appears. Users can then access their published applications or virtual desktops. If users select
StoreFront to log on, Receiver opens and users can access applications and desktops.
Note: If you configure StoreFront as a client choice, applications and desktops do not appear in
the left pane of the Access Interface.

• Clientless access. If users select clientless access to log on, the Access Interface or your cus-
tomized home page appears. In the Access Interface, users can navigate to file shares, web sites,
and use Outlook Web Access.

If users select the NetScaler Gateway Plug-in for Java, the plug-in starts and users are logged on. The
choices page does not appear.

Secure Browse allows users to connect through NetScaler Gateway from an iOS device. If you enable
Secure Browse, when users log on by using Worx Home, Secure Browse disables the client choices
page.

Showing the Client Choices Page at Logon

October 5, 2020

When you enable the client choices option, users can log on with the NetScaler Gateway Plug-in, the
Web Interface, Receiver or clientless access from one web page after successful authentication to
NetScaler Gateway. When log on is successful, icons appear in the web page from which users can
choose the method to establish a connection. You can also configure the NetScaler Gateway Plug-in
for Java to appear on the choices page.
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You can enable client choices without using endpoint analysis or implementing access scenario fall-
back. If you do not define a client security expression, users receive connection options for the settings
that are configured on NetScaler Gateway. If a client security expression exists for the user session and
the user device fails the endpoint analysis scan, the choices page offers only the option to use the Web
Interface if it is configured. Otherwise, users can use clientless access to log on.

You configure client choices either globally or by using a session profile and policy.

Important: When configuring client choices, do not configure quarantine groups. User devices
that fail the endpoint analysis scan and are quarantined are treated the same as user devices
that pass the endpoint scan.

To enable client choices options globally

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Global Settings.

2. In the details pane, under Settings, click Change global settings.
3. On the Client Experience tab, click Advanced Settings.
4. On the General tab, click Client Choices and then click OK.

To enable client choices as part of a session policy

You can also configure client choices as part of a session policy and then bind it to users, groups, and
virtual servers.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway > Policies and then click Session.

2. In the details pane, on the Policies tab, click Add.
3. In Name, type a name for the policy.
4. Next to Request Profile, click New.
5. In Name, type a name for the profile.
6. On the Client Experience tab, click Advanced.
7. On the General tab, next to Client Choices, click Override Global, click Client Choices, click OK

and then click Create.
8. In the Create Session Policy dialog box, next to Named Expressions, select General, select True

value, click Add Expression, click Create and then click Close.

Configuring Client Choices Options

October 5, 2020
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In addition to enabling client choices by using a session profile and policy, you need to configure the
settings for the user software. For example, you want users to log on using either the NetScaler Gate-
way Plug-in, StoreFront or the Web Interface, or clientless access. You create one session profile that
enables all three options and client choices. Then, you create a session policy with the expression set
to True value with the profile attached. Next, you bind the session policy to a virtual server.

Before creating the session policy and profile, you need to create an authorization group for users.

To create an authorization group

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway > User Administration, and then click AAA Groups.

2. In the details pane, click Add.
3. In Group Name, type the name of the group.
4. On the Users tab, select the users, click Add for each one, click Create and then click Close.

The following procedure is an example session profile for client choices with the NetScaler Gateway
Plug-in, StoreFront, and clientless access.

To create a session profile for client choices

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway > Policies and then click Session.

2. In the details pane, click the Profiles tab and then click Add.
3. In Name, type a name for the profile.
4. On the Client Experience tab, do the following:

a) Next to Home Page, click Override Global and then clear Display Home Page. This disables
the Access Interface.

b) Next to Clientless Access, click Override Global and then select OFF.
c) Next to Plug-in Type, click Override Global and then select Windows/Mac OS X.
d) Click Advanced Settings and next to Client Choices, click Override Global, click Client

Choices.
5. On the Security tab, next to Default Authorization Action, click Override Global and then select

ALLOW.
6. On the Security tab, click Advanced Settings.
7. Under Authorization Groups, click Override Global, click Add and then select the group.
8. On the Published Applications tab, do the following:

a) Next to ICA Proxy, click Override Global and then select OFF.
b) Next to Web Interface Address, click Override Global and then type the Web address of

StoreFront, such as http://ipAddress/Citrix/.
c) Next to Web Interface Portal Mode, click Override Global and then select COMPACT.
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d) Next to Single Sign-On Domain, click Override Global and then type the name of the do-
main.

9. Click Create and then click Close.

If you want to use the NetScaler Gateway Plug-in for Java as a client choice, on the Client Experience
tab, in Plug-in Type, select Java. If you select this choice, you must configure an intranet application
and set the interception mode to Proxy.

After creating the session profile, create a session policy. Within the policy, select the profile, and set
the expression to True value.

To use StoreFront as a client choice, you must also configure the Secure Ticket Authority (STA) on the
NetScaler Gateway. The STA is bound to the virtual server.

Note: If the server running the StoreFront is not available, the Citrix XenApp choice does not
appear on the choices page.

To configure the STA server globally

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Global Settings.

2. In the details pane, under Servers, click Bind/Unbind STA Servers to be used by the Secure Ticket
Authority.

3. In the Bind/Unbind STA Servers dialog box, click Add.
4. In the Configure STA Server dialog box, in URL, type the web address of the STA server and then

click Create.
5. Repeat Steps 3 and 4 to add more STA servers and then click OK.

To bind the STA to a virtual server

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Virtual Servers.

2. In the details pane, click a virtual server and then click Open.
3. On the Published Applications tab, under Secure Ticket Authority, under Active, select the STA

servers and then click OK,

You can also add STA servers on the Published Applications tab.

Configuring Access Scenario Fallback

October 5, 2020
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SmartAccess allows NetScaler Gateway to determine automatically the methods of access that are
allowed for a user device based on the results of an endpoint analysis scan. Access scenario fallback
further extends this capability by allowing a user device to fall back from the NetScaler Gateway Plug-
in to the Web Interface or StoreFront by using Citrix Receiver if the user device does not pass the initial
endpoint analysis scan.

To enable access scenario fallback, you configure a post-authentication policy that determines
whether or not users receive an alternative method of access when logging on to NetScaler Gateway.
This post-authentication policy is defined as a client security expression that you configure either
globally or as part of a session profile. If you configure a session profile, the profile is associated
to a session policy that you then bind to users, groups, or virtual servers. When you enable access
scenario fallback, NetScaler Gateway initiates an endpoint analysis scan after user authentication.
The results for user devices that do not meet the requirements of a fallback post-authentication scan
are as follows:

• If client choices is enabled, users can log on to the Web Interface or StoreFront by using Receiver
only.

• If clientless access and client choices are disabled, users can be quarantined into a group that
provides access only to the Web Interface or StoreFront.

• If clientless access and the Web Interface or StoreFront are enabled on NetScaler Gateway and
ICA proxy is disabled, users fall back to clientless access.

• If the Web Interface or StoreFront is not configured and clientless access is set to allow, users
fall back to clientless access.

When clientless access is disabled, the following combination of settings must be configured for the
access scenario fallback:

• Define client security parameters for the fallback post-authentication scan.
• Define the Web Interface home page.
• Disable client choices.
• If user devices fail the client security check, users are placed into a quarantine group that allows

access only to the Web Interface or StoreFront and to published applications.

Creating Policies for Access Scenario Fallback

October 5, 2020

To configure NetScaler Gateway for access scenario fallback, you need to create policies and groups
in the following ways:

• Create a quarantine group in which users are placed if the endpoint analysis scan fails.
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• Create a global Web Interface or StoreFront setting that is used if the endpoint analysis scan
fails.

• Create a session policy that overrides the global setting and then bind the session policy to a
group.

• Create a global client security policy that is applied if the endpoint analysis fails.

When configuring access scenario fallback, use the following guidelines:

• Using client choices or access scenario fallback requires the Endpoint Analysis Plug-in for all
users. If endpoint analysis cannot run or if users select Skip Scan during the scan, users are
denied access.
Note: The option to skip the scan is removed in NetScaler Gateway 10.1, Build 120.1316.e

• When you enable client choices, if the user device fails the endpoint analysis scan, users are
placed into the quarantine group. Users can continue to log on with either the NetScaler Gate-
way Plug-in or the Citrix Receiver to the Web Interface or StoreFront.
Note: Citrix recommends that you do not create a quarantine group if you enable client choices.
User devices that fail the endpoint analysis scan and are quarantined are treated in the same
way as user devices that pass the endpoint scan.

• If the endpoint analysis scan fails and the user is put in the quarantine group, the policies that
are bound to the quarantine group are effective only if there are no policies bound directly to
the user that have an equal or lower priority number than the policies bound to the quarantine
group.

• You can use different web addresses for the Access Interface and, the Web Interface or Store-
Front. When you configure the home pages, the Access Interface home page takes precedence
for the NetScaler Gateway Plug-in and the Web Interface home page takes precedence for Web
Interface users. The Receiver home page takes precedence for StoreFront.

To create a quarantine group

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway > User Administration, and then click AAA Groups.

2. In the details pane, click Add.
3. In Group Name, type a name for the group, click Create and then click Close.

Important: The name of the quarantine group must not match the name of any domain group
to which users might belong. If the quarantine group matches an Active Directory group name,
users are quarantined even if the user device passes the endpoint analysis security scan.

After creating the group, configure NetScaler Gateway to fall back to the Web Interface if the user de-
vice fails the endpoint analysis scan.
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To configure settings to quarantine user connections

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Global Settings.

2. In the details pane, under Settings, click Change global settings.
3. In the Global NetScaler Gateway Settings dialog box, on the Published Applications tab, next to

ICA Proxy, select OFF.
4. Next to Web Interface Address, type the web address for StoreFront or the Web Interface.
5. Next to Single Sign-On Domain, type the name of your Active Directory domain and then click

OK.

After configuring the global settings, create a session policy that overrides the global ICA proxy setting
and then bind the session policy to the quarantine group.

To create a session policy for Access Scenario Fallback

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway > Policies and then click Session.

2. In the details pane, click Add.
3. In Name, type a name for the policy.
4. Next to Request Profile, click New.
5. On the Published Applications tab, next to ICA Proxy, click Override Global, select On and then

click Create.
6. In the Create Session Policy dialog box, next to Named Expressions, select General, select True

value, click Add Expression, click Create and then click Close.

After creating the session policy, bind the policy to a quarantine group.

To bind the session policy to the quarantine group

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway > User Administration, and then click AAA Groups.

2. In the details pane, select a group and then click Open.
3. Click Session.
4. On the Policies tab, select Session, and then click Insert Policy.
5. Under Policy Name, select the policy and then click OK.

After creating the session policy and profile enabling the Web Interface or StoreFront on NetScaler
Gateway, create a global client security policy.
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To create a global client security policy

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Global Settings.

2. In the details pane, under Settings, click Change global settings.
3. On the Security tab, click Advanced Settings.
4. In Client Security, enter the expression. For more information about configuring system expres-

sions, see Configuring System Expressions and Configuring Compound Client Security Expres-
sions.

5. In Quarantine Group, select the group you configured in the group procedure and then click OK
twice.

Configuring Connections for the NetScaler Gateway Plug-in

October 5, 2020

You configure user device connections by defining the resources users can access in the internal net-
work. Configuring user device connections includes:

• Defining the domains to which users are allowed access.
• Configuring IP addresses for users, including address pools (intranet IPs).
• Configuring time-out settings.
• Configuring single sign-on.
• Configuring client interception.
• Configuring split tunneling.
• Configuring connections through a proxy server.
• Configuring user software to connect through NetScaler Gateway.
• Configuring access for mobile devices.

You configure most user device connections by using a profile that is part of a session policy. You
can also define user device connection settings by using intranet applications, preauthentication, and
traffic policies.

Configuring the Number of User Sessions

October 5, 2020

You can configure the maximum number of users who are allowed to connect to NetScaler Gateway
at a particular point in time, at either the global level or on a per virtual server level. Sessions are
not created on NetScaler Gateway when the number of users connecting to the appliance exceeds the
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value that you configure. If the number of users exceeds the number you allow, users receive an error
message.

To set the global user limit

When you configure the user limit globally, the restriction applies to all users who establish sessions
to different virtual servers on the system. When the number of user sessions reaches the value you
set, no new sessions can be established on any virtual server present on NetScaler Gateway.

You set the maximum number of users at the global level when you set the default authentication type
for NetScaler Gateway.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Global Settings.

2. In the details pane, under Settings, click Change authentication settings.
3. In the Global Authentication Settings dialog box, in Maximum Number of Users, type the number

of users and then click OK.

To set the user limit per virtual server

You can also apply the user limit to each virtual server on the system. When you configure the user
limit per virtual server, the restriction applies only to users who establish sessions with the particular
virtual server. Users who establish sessions with other virtual servers are not affected by this limit.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Virtual Servers.

2. In the details pane, click a virtual server and then click Open.
3. In Max Users, type the number of users and then click OK.

Configuring Time-Out Settings

October 5, 2020

You can configure NetScaler Gateway to force a disconnection if there is no activity on the connection
for a specified number of minutes. One minute before a session times out (disconnects), the user
receives an alert indicating the session will close. If the session closes, the user must log on again.

There are three time-out options:

• Forced time-out. If you enable this setting, NetScaler Gateway disconnects the session after
the time-out interval elapses regardless of what the user is doing. There is no action the user
can take to prevent the disconnection from occurring when the time-out interval elapses. This
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setting is enforced for users who connect with the NetScaler Gateway Plug-in, Citrix Receiver,
Worx Home, or through a web browser. The default setting is 30 minutes. If you set this value
to zero, the setting is disabled.

• Session time-out. If you enable this setting, NetScaler Gateway disconnects the session if no
network activity is detected for the specified interval. This setting is enforced for users who
connect with the NetScaler Gateway Plug-in, Receiver, Worx Home, or through a web browser.
The default time-out setting is 30 minutes. If you set this value to zero, the setting is disabled.

• Idle session time-out. The duration after which the NetScaler Gateway Plug-in terminates an
idle session if there is no user activity, such as from the mouse, keyboard, or touch for the speci-
fied interval. This setting is enforced for users who connect with the NetScaler Gateway Plug-in
only. The default setting is 30 minutes. If you set this value to zero, the setting is disabled.

Note: Some applications, such as Microsoft Outlook, automatically send network traffic probes
to email servers without any user intervention. Citrix recommends that you configure
Idle session time-out with
Session time-out to ensure that a session left unattended on a user device times out in a reason-
able time.

You can enable any of these settings by entering a value between 1 and 65536 to specify a number
of minutes for the time-out interval. If you enable more than one of these settings, the first time-out
interval to elapse closes the user device connection.

You configure time-out settings by configuring global settings or by using a session profile. When you
add the profile to a session policy, the policy is then bound to a user, group, or virtual server. When
you configure the time-out settings globally, the settings are applied to all user sessions.

Configuring Forced Time-Outs

October 5, 2020

A forced time-out disconnects the NetScaler Gateway Plug-in automatically after a specified amount
of time. You can configure a forced time-out globally or as part of a session policy.

To configure a global forced time-out

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Global Settings.

2. In the details pane, under Settings, click Change global settings.
3. On the Network Configuration tab, click Advanced Settings.
4. In Forced Time-out (mins), type the number of minutes users can stay connected.
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5. In Forced Time-out Warning (mins), type the number of minutes before users are warned that
the connection is due to be disconnected and then click OK.

To configure a forced time-out within a session policy

If you want to have further control over who receives the forced time-out, create a session policy and
then apply the policy to a user or group.

1. In the configuration utility, on theConfiguration tab, in the navigation pane, expandNetScaler
Gateway > Policies and then click Session.

2. In the details pane, click Add.
3. In Name, type a name for the policy.
4. Next to Request Profile, click New.
5. In Name, type a name for the profile.
6. On the Network Configuration tab, click Advanced.
7. Under Timeouts, click Override Global and in Forced Time-out (mins) type the number of min-

utes users can stay connected.
8. Next to Forced Time-out Warning (mins), clickOverrideGlobal and type the number of minutes

users are warned that the connection is due to be disconnected. Click OK twice.
9. In the Create Session Policy dialog box, next to Named Expressions, select General, select

True value, click Add Expression, click Create and then click Close.

Configuring Session or Idle Time-Outs

October 5, 2020

You can use the configuration utility to configure session and client time-out settings globally or to
create a session policy. When you create a session policy and profile, set the expression to
True.

To configure a session or client idle time-out globally

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Global Settings.

2. In the details pane, under Settings, click Change global settings.
3. On the Client Experience tab, do one or both of the following:

• In Session Time-out (mins), type the number of minutes.
• In Client Idle Time-out (mins), type the number of minutes and then click OK.
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To configure session or client idle time-out settings by using a session policy

1. On the Configuration tab, in the navigation pane, expand NetScaler Gateway > Policies and
then click Session

2. In the details pane, click Add.
3. In theNetScaler Gateway Session Policies andProfiles page, click SessionProfiles, and then

click Add.
4. In Name, type a name for the profile.
5. On the Client Experience tab, do one or both of the following:

• Next toSession Time-out (mins), clickOverrideGlobal and then type the number of min-
utes and then click Create.

• Next to Client Idle Time-out (mins), click Override Global, type the number of minutes
and then click Create.

6. In theCitrixGatewaySessionPolicies andProfilespage, clickSessionPolicies, and then click
Add.

• In Name, enter the name for the policy.
• In Profile, select the profile that specifies the action to be applied by the new session pol-

icy if the rule criteria are met.
• In the Expression field, add your expression or name of a named expression, specifying

the traffic that matches the policy.
• Click Create, and then click Close.

Connecting to Internal Network Resources

October 5, 2020

You can configure NetScaler Gateway to enable users to access resources in the internal network. If
you disable split tunneling, all network traffic from the user device is sent to NetScaler Gateway and
authorization policies determine whether the traffic is allowed to pass through to internal network re-
sources. When you enable split tunneling, only traffic destined for the internal network is intercepted
by the user device and sent to NetScaler Gateway. You configure which IP addresses NetScaler Gate-
way intercepts by using intranet applications.

If you are using the NetScaler Gateway Plug-in for Windows, set the interception mode to transparent.
If you are using the NetScaler Gateway Plug-in for Java, set the interception mode to proxy. When you
set the interception mode to transparent, you can allow access to network resources using:

• A single IP address and subnet mask
• A range of IP addresses

If you set the interception mode to proxy, you can configure destination and source IP addresses and
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port numbers.

To configure network access to internal network resources

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway, expand Resources and then click Intranet Applications.

2. In the details pane, click Add.
3. Complete the parameters for allowing network access, click Create and then click Close.

Configuring Split Tunneling

October 5, 2020

You can enable split tunneling to prevent the NetScaler Gateway Plug-in from sending unnecessary
network traffic to NetScaler Gateway.

When you do not enable split tunneling, the NetScaler Gateway Plug-in captures all network traffic
originating from a user device and sends the traffic through the VPN tunnel to NetScaler Gateway.

If you enable split tunneling, the NetScaler Gateway Plug-in sends only traffic destined for networks
protected by NetScaler Gateway through the VPN tunnel. The NetScaler Gateway Plug-in does not
send network traffic destined for unprotected networks to NetScaler Gateway.

When the NetScaler Gateway Plug-in starts, it obtains the list of intranet applications from NetScaler
Gateway. The NetScaler Gateway Plug-in examines all packets transmitted on the network from the
user device and compares the addresses within the packets to the list of intranet applications. If the
destination address in the packet is within one of the intranet applications, the NetScaler Gateway
Plug-in sends the packet through the VPN tunnel to NetScaler Gateway. If the destination address is
not in a defined intranet application, the packet is not encrypted and the user device routes the packet
appropriately. When you enable split tunneling, intranet applications define the network traffic that
is intercepted.

Note: If users connect to published applications in a server farm by using Citrix Receiver, you do
not need to configure split tunneling.

NetScaler Gateway also supports reverse split tunneling, which defines the network traffic that
NetScaler Gateway does not intercept. If you set split tunneling to reverse, intranet applications
define the network traffic that NetScaler Gateway does not intercept. When you enable reverse split
tunneling, all network traffic directed to internal IP addresses bypasses the VPN tunnel, while other
traffic goes through NetScaler Gateway. Reverse split tunneling can be used to log all non-local LAN
traffic. For example, if users have a home wireless network and are logged on with the NetScaler

© 1999-2021 Citrix Systems, Inc. All rights reserved. 291



NetScaler Gateway 12.0

Gateway Plug-in, NetScaler Gateway does not intercept network traffic destined to a printer or
another device within the wireless network.

For more information about intranet applications, see Configuring Client Interception.

You configure split tunneling as part of the session policy.

To configure split tunneling

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway Policies and then click Session.

2. In the details pane, on the Profiles tab, select a profile and then click Open.
3. On the Client Experience tab, next to Split Tunnel, select Global Override, select an option

and then click OK twice.

Configuring Split Tunneling and Authorization

When planning your NetScaler Gateway deployment, it is important to consider split tunneling and
the default authorization action and authorization policies.

For example, you have an authorization policy that allows access to a network resource. You have split
tunneling set to ON and you do not configure intranet applications to send network traffic through
NetScaler Gateway. When NetScaler Gateway has this type of configuration, access to the resource is
allowed, but users cannot access the resource.

If the authorization policy denies access to a network resource, you have split tunneling set to ON,
and intranet applications are configured to route network traffic through NetScaler Gateway, the
NetScaler Gateway Plug-in sends traffic to NetScaler Gateway, but access to the resource is denied.

Configuring Client Interception

October 5, 2020

You configure interception rules for user connections on NetScaler Gateway by using Intranet Appli-
cations. By default, when you configure the system IP address, a mapped IP address, or a subnet IP
address on the appliance, subnet routes are created based on these IP addresses. Intranet applica-
tions are created automatically based on these routes and can be bound to a virtual server. If you
enable split tunneling, you must define intranet applications in order for client interception to occur.

You can configure intranet applications by using the configuration utility. You can bind intranet appli-
cations to users, groups, or virtual servers.
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If you enable split tunneling and users connect by using WorxWeb or WorxMail, when you configure
client interception, you must add the IP addresses for App Controller and your Exchange server. If
you do not enable split tunneling, you do not need to configure the App Controller and Exchange IP
addresses in Intranet Applications.

Configuring Intranet Applications for the NetScaler Gateway Plug-in

October 5, 2020

You create intranet applications for user access to resources by defining the following:

• Access to one IP address and subnet mask
• Access to a range of IP addresses

When you define an intranet application on NetScaler Gateway, the NetScaler Gateway Plug-in for
Windows intercepts user traffic that is destined to the resource and sends the traffic through NetScaler
Gateway.

When configuring intranet applications, consider the following:

• Intranet applications do not need to be defined if the following conditions are met:
– Interception mode is set to transparent
– Users are connecting to NetScaler Gateway with the NetScaler Gateway Plug-in for Win-

dows
– Split tunneling is disabled

• If users connect to NetScaler Gateway by using the NetScaler Gateway Plug-in for Java, you must
define intranet applications. The NetScaler Gateway Plug-in for Java intercepts traffic only to
network resources defined by intranet applications. If users connect with this plug-in, set the
interception mode to proxy.

When configuring an intranet application, you must select an interception mode that corresponds to
the type of plug-in software used to make connections.

Note: You cannot configure an intranet application for both proxy and transparent interception. To
configure a network resource to be used by both the NetScaler Gateway Plug-in for Windows and
NetScaler Gateway Plug-in for Java, configure two intranet application policies and bind the policies
to the user, group, virtual server, or NetScaler Gateway global.

To create an intranet application for one IP address

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway Resources and then click Intranet Applications.

2. In the details pane, click Add.
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3. In Name, type a name for the profile.
4. In the Create Intranet Application dialog box, select Transparent.
5. In Destination Type, select IP Address and Netmask.
6. In Protocol, select the protocol that applies to the network resource.
7. In IP Address, type the IP address.
8. In Netmask, type subnet mask, click Create and then click Close.

To configure an IP address range

If you have multiple servers in your network, such as web, email, and file shares, you can configure a
network resource that includes the IP range for network resources. This setting allows users access to
the network resources contained in the IP address range.

1. In the configuration utility, on theConfiguration tab, in the navigation pane, expandNetScaler
Gateway Resources and then click Intranet Applications.

2. In the details pane, click Add.
3. In Name, type a name for the profile.
4. In Protocol, select the protocol that applies to the network resource.
5. In the Create Intranet Application dialog box, select Transparent.
6. In Destination Type, select IP Address Range.
7. In IP Start, type the starting IP address and in IP End, type the ending IP address, click Create

and then click Close.

Configuring Intranet Applications for the NetScaler Gateway Plug-in for
Java

October 5, 2020

If users connect with the NetScaler Gateway Plug-in for Java, you must configure an intranet applica-
tion and set the interception mode to proxy. The NetScaler Gateway Plug-in for Java intercepts traffic
by using the user device loopback IP address and port number specified in the profile.

If users are connecting from a Windows-based device, the NetScaler Gateway Plug-in for Java
attempts to modify the HOST file by setting the application HOST name to access the loopback IP
address and port specified in the profile. Users must have administrative privileges on the user
device for HOST file modification.

If users are connecting from a non-Windows device, you must configure applications manually by us-
ing the source IP address and port values specified in the intranet application profile.
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To configure an intranet application for the NetScaler Gateway Plug-in for Java

1. In the configuration utility, on theConfiguration tab, in the navigation pane, expandNetScaler
Gateway Resources and then click Intranet Applications.

2. In the details pane, click Add.

3. In Name, type a name for the profile.

4. Click Proxy.

5. In Destination IP Address and Destination Port, type the destination IP address and port.

6. Under Source IP Address and Source Port, type the source IP address and port.

Note: You should set the source IP address to the loopback IP address of 127.0.0.1. If you
do not specify an IP address, the loopback IP address is used. If you do not enter a port
value, the destination port value is used.

Configuring Name Service Resolution

October 5, 2020

During installation of NetScaler Gateway, you can use the NetScaler Gateway wizard to configure ad-
ditional settings, including name service providers. The name service providers translate the fully
qualified domain name (FQDN) to an IP address. In the NetScaler Gateway wizard, you can config-
ure a DNS or WINS server, set the priority of the DNS lookup, and the number of times to retry the
connection to the server.

When you run the NetScaler Gateway wizard, you can add a DNS server at that time. You can add
additional DNS servers and a WINS server to NetScaler Gateway by using a session profile. You can
then direct users and groups to connect to a name resolution server that is different from the one you
originally used the wizard to configure.

Before configuring an additional DNS server on NetScaler Gateway, create a virtual server that acts as
a DNS server for name resolution.

To add a DNS or WINS server within a session profile

1. In the configuration utility, on theConfiguration tab, in the navigation pane, expandNetScaler
Gateway Policies and then click Session.

2. In the details pane, on the Profiles tab, select a profile and then click Open.
3. On the Network Configuration tab, do one of the following:
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• To configure a DNS server, next to DNS Virtual Server, click Override Global, select the
server and then click OK.

• To configure a WINS server, next to WINS Server IP, click Override Global, type the IP ad-
dress and then click OK.

Enabling Proxy Support for User Connections

October 5, 2020

User devices can connect through a proxy server for access to internal networks. NetScaler Gateway
supports the HTTP, SSL, FTP, and SOCKS protocols. To enable proxy support for user connections, you
specify the settings on NetScaler Gateway. You can specify the IP address and port used by the proxy
server on NetScaler Gateway. The proxy server is used as a forward proxy for all further connections
to the internal network.

To configure proxy support for user connections

1. In the configuration utility, on theConfiguration tab, in the navigation pane, expandNetScaler
Gateway and then click Global Settings.

2. In the details pane, under Settings, click Change global settings.
3. On the Client Experience tab, click Advanced Settings.
4. On the Proxy tab, under Proxy Settings, select On.
5. For the protocols, type the IP address and port number and then click OK.

Note: If you select Appliance, you can configure proxy servers that support secure and unsecure
HTTP connections only.

After you enable proxy support on NetScaler Gateway, you specify configuration details on the user
device for the proxy server that corresponds to the protocol.

After you enable proxy support, NetScaler Gateway sends the proxy server details to the client Web
browser and changes the proxy configuration on the browser. After the user device connects to
NetScaler Gateway, the user device can communicate with the proxy server directly for connection
to the user’s network.

To configure one proxy server to use all protocols for NetScaler Gateway

You can configure one proxy server to support all of the protocols that NetScaler Gateway uses. This
setting provides one IP address and port combination for all of the protocols.

1. In the configuration utility, on theConfiguration tab, in the navigation pane, expandNetScaler
Gateway and then click Global Settings.
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2. In the details pane, under Settings, click Change global settings.
3. On the Client Experience tab, click Advanced Settings.
4. On the Proxy tab, under Proxy Settings, select On.
5. For the protocols, type the IP address and port number.
6. Click Use the same proxy server for all protocols and then click OK.

When you disable split tunneling and set all proxy settings to On, proxy settings are propagated to user
devices. If proxy settings are set to Appliance, the settings are not propagated to user devices.

NetScaler Gateway makes connections to the proxy server on behalf of the user device. The proxy set-
tings are not propagated to the user’s browser, so no direct communication between the user device
and the proxy server is possible.

To configure the NetScaler Gateway to be a proxy server

When you configure NetScaler Gateway as a proxy server, unsecure and secure HTTP are the only sup-
ported protocols.

1. In the configuration utility, on theConfiguration tab, in the navigation pane, expandNetScaler
Gateway and then click Global Settings.

2. In the details pane, under Settings, click Change global settings.
3. On the Client Experience tab, click Advanced Settings.
4. On the Proxy tab, under Proxy Settings, select Appliance.
5. For the protocols, type the IP address and port number and then click OK.

Configuring Address Pools

October 5, 2020

In some situations, users who connect with the NetScaler Gateway plug-in need a unique IP address
for NetScaler Gateway. For example, in a Samba environment, each user connecting to a mapped
network drive needs to appear to originate from a different IP address. When you enable address
pools (also known as IP pooling) for a group, NetScaler Gateway can assign a unique IP address alias
to each user.

You configure address pools by using intranet IP addresses. The following types of applications might
need to use a unique IP address that is drawn from the IP pool:

• Voice over IP
• Active FTP
• Instant messaging
• Secure shell (SSH)
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• Virtual network computing (VNC) to connect to a computer desktop
• Remote desktop (RDP) to connect to a client desktop

You can configure NetScaler Gateway to assign an internal IP address to users that connect to
NetScaler Gateway. Static IP addresses can be assigned to users or a range of IP addresses can be
assigned to a group, virtual server, or to the system globally.

NetScaler Gateway allows you to assign IP addresses from your internal network to your remote users.
A remote user can be addressed by an IP address on the internal network. If you choose to use a range
of IP addresses, the system dynamically assigns an IP address from that range to a remote user on
demand.

When you configure address pools, be aware of the following:

• Assigned IP addresses must be routed correctly. To ensure the correct routing, consider the
following:

– If you do not enable split tunneling, make sure that the IP addresses can be routed through
network address translation (NAT) devices.

– Any servers accessed by user connections with intranet IP addresses must have the proper
gateways configured to reach those networks.

– Configure gateways or a static route on NetScaler Gateway so that network traffic from
user software is routed to the internal network.

• Only contiguous subnet masks can be used when assigning IP address ranges. A subset of a
range can be assigned to a lower-level entity. For example, if an IP address range is bound to a
virtual server, bind a subset of the range to a group.

• IP address ranges cannot be bound to multiple entities within a binding level. For example, a
subset of an address range that is bound to a group cannot be bound to a second group.

• NetScaler Gateway does not allow you to remove or unbind IP addresses while they are actively
in use by a user session.

• Internal network IP addresses are assigned to users by using the following hierarchy:
– User’s direct binding
– Group assigned address pool
– Virtual server assigned address pool
– Global range of addresses

• Only contiguous subnet masks can be used in assigning address ranges. However, a subset of
an assigned range might be further assigned to a lower-level entity.
A bound global address range can have a range bound to the following:

– Virtual server
– Group
– User

• A bound virtual server address range can have a subset bound to the following:
– Group
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– User

A bound group address range can have a subset bound to a user.

When an IP address is assigned to a user, the address is reserved for the user’s next logon until the
address pool range is exhausted. When the addresses are exhausted, NetScaler Gateway reclaims the
IP address from the user who is logged off from NetScaler Gateway the longest.

If an address cannot be reclaimed and all addresses are actively in use, NetScaler Gateway does not
allow the user to log on. You can prevent this situation by allowing NetScaler Gateway to use the
mapped IP address as an intranet IP address when all other IP addresses are unavailable.

Intranet IP DNS registration

If an intranet IP is allotted to a client machine and after VIP tunnel establishment, VPN plug-in checks
if that client machine is domain joined. If the client machine is a domain-joined machine, VPN plug-in
initiates the DNS registration process to tie the machine’s host name intranet with the allotted intranet
IP address. This registration is reverted before tunnel de-establishment.

For successful DNS registration, make sure that the following nsapimgr knobs are set. Also make sure
that the authoritative DNS server is set to allow “non-secure” DNS updates.

• nsapimgr -ys enable_vpn_dns_override=1: This flag is sent to the NetScaler Gateway VPN
client along with the other configuration parameters. If this flag is unset and when the VPN
client intercepts a DNS/WINS request, it sends a corresponding “GET /DNS” http-request to the
NetScaler Gateway virtual server over the tunnel to get the resolved IP address. However, if the
‘enable_vpn_dnstruncate_fix’ flag is set, the VPN client forwards the DNS/WINS requests trans-
parently to the NetScaler Gateway virtual server. In this case, the DNS packet is sent as is to
the NetScaler Gateway virtual server over the VPN tunnel. This helps in cases when the DNS
records coming back from the name servers configured in the NetScaler Gateway are huge and
do not fit in the UPD response packet. In this case, when the client falls back to using TCP-DNS,
this TCP-DNS packet reaches NetScaler Gateway server as is, and hence the NetScaler Gateway
server makes a TCP-DNS query to a DNS server.

• nsapimgr -ys enable_vpn_dnstruncate_fix=1: This flag is used by the NetScaler Gateway
server itself. If this flag is set, NetScaler Gateway overrides destination for the “TCP-connections
on DNS-port” to the DNS servers configured on NetScaler Gateway (instead of trying to send
them to the DNS-server-IP originally present in the incoming TCP-DNS packet). For UDP DNS
requests, the default is to use the configured DNS servers for DNS resolution.

For more information on setting these knobs, see https://support.citrix.com/article/CTX200243.
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Configuring Address Pools

October 5, 2020

You use the configuration utility to configure address pools at the level to which you want to bind the
policy. For example, if you want to create an address pool for a virtual server, configure the intranet IP
addresses on that node. After you configure the address pool, the policy is bound to the entity where
it is configured. You can also create an address pool and bind it globally on NetScaler Gateway.

To configure address pools for a user, group, or virtual server

1. In the configuration utility, in the navigation pane, expand NetScaler Gateway, do one of the
following:

• Expand NetScaler Gateway User Administration and then click AAA Users.
• Expand NetScaler Gateway > User Administration and then click AAA Groups.
• Expand NetScaler Gateway and then click Virtual Servers.

2. In the details pane, click a user, group, or virtual server and then click Open.
3. On the Intranet IPs tab, in IP Address and Netmask, type the IP address and subnet mask and

then click Add.
4. Repeat Step 3 for each IP address you want to add to the pool and then click OK.

To configure address pools globally

1. In the configuration utility, on theConfiguration tab, in the navigation pane, expandNetScaler
Gateway and then click Global Settings.

2. In the details pane, under Intranet IPs, click To assign a unique, static IP Address or pool of IP
Addresses for use by all client NetScaler Gateway sessions, configure Intranet IPs.

3. In the Bind Intranet IPs dialog box, click Action and then click Insert.
4. In IP Address and Netmask, type the IP address and subnet mask and then click Add.
5. Repeat Step 3 and 4 for each IP address you want to add to the pool and then click OK.

Defining address pool options

October 5, 2020

You can use a session policy or the global NetScaler Gateway settings to control whether or not in-
tranet IP addresses are assigned during a user session. Defining address pool options allows you to
assign intranet IP addresses to NetScaler Gateway, while disabling the use of intranet IP addresses for
a particular group of users.
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You can configure address pools by using a session policy in one of the following three ways:

• Nospillover - When you configure address pools for intranet IP address, you get a session with
an available IP from the pool. For users who have used all available intranet IP addresses, the
Transfer Login page appears.

• Spillover - When you configure address pools and the mapped IP is used as an intranet IP ad-
dress, the mapped IP address is used for users who have used all available intranet IP addresses.

• Off - Address pools are not configured.

Note: If the mapped IP address is not configured then SNIP is used.

To configure address pools

1. In the configuration utility, on theConfiguration tab, in the navigation pane, expandNetScaler
Gateway > Policies, and then click Session.

2. In the details pane, on the Policies tab, click Add.
3. In Name, type a name for the policy.
4. Next to Request Profile, click New.
5. In Name, type a name for the profile.
6. On the Network Configuration tab, click Advanced.
7. Next to Intranet IP, click Override Global and then select an option.
8. If you select SPILLOVER in Step 9, next to Mapped IP, click Override Global, select the host

name of the appliance, click OK and then click Create.
9. In theCreateSessionPolicydialog box, create an expression, clickCreate and then clickClose.

Configuring the transfer login page

If a user does not have an intranet IP address available and then tries to establish another session with
NetScaler Gateway, the Transfer Login page appears. The Transfer Login page allows users to replace
their existing NetScaler Gateway session with a new session.

The Transfer Login page can also be used if the logoff request is lost or if the user does not perform a
clean logoff. For example:

• A user is assigned a static intranet IP address and has an existing NetScaler Gateway session.
If the user tries to establish a second session from a different device, the Transfer Login page
appears and the user can transfer the session to the new device.

• A user is assigned five intranet IP addresses and has five sessions through NetScaler Gateway.
If the user tries to establish a sixth session, the Transfer Login page appears and the user can
choose to replace an existing session with a new session.
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Note: If the user does not have an >assigned IP address available and a new >session cannot be
established by using the >Transfer Login page, the user receives an >error message.

The Transfer Login page appears only if you configure address pools and disable spillover.

Configuring a DNS suffix

When a user logs on to NetScaler Gateway and is assigned an IP address, a DNS record for the user
name and IP address combination is added to the NetScaler Gateway DNS cache. You can configure a
DNS suffix to append to the user name when the DNS record is added to the cache. This allows users
to be referenced by the DNS name, which can be easier to remember than an IP address. When the
user logs off from NetScaler Gateway, the record is removed from the DNS cache.

To configure a DNS suffix

1. In the configuration utility, on theConfiguration tab, in the navigation pane, expandNetScaler
Gateway > Policies, and then click Session.

2. In the details pane, on the Policies tab, select a session policy and then click Open.
3. Next to Request Profile, click Modify.
4. On the Network Configuration tab, click Advanced.
5. Next to Intranet IP DNS Suffix, clickOverrideGlobal, type the DNS suffix and then clickOK three

times.

Supporting VoIP Phones

October 5, 2020

When you install NetScaler Gateway as a standalone appliance and users connect with the NetScaler
Gateway plug-in, NetScaler Gateway supports two-way communication with Voice over IP (VoIP) soft-
phones.

NetScaler Gateway supports the following VoIP softphones.

• Cisco Softphone
• Avaya IP Softphone

Secure tunneling is supported between the IP PBX and the softphone software running on the user
device. To enable the VoIP traffic to traverse the secure tunnel, you must install the NetScaler Gateway
plug-in and one of the supported softphones on the same user device. When the VoIP traffic is sent
over the secure tunnel, the following softphone features are supported:

• Outgoing calls that are placed from the IP softphone

© 1999-2021 Citrix Systems, Inc. All rights reserved. 302



NetScaler Gateway 12.0

• Incoming calls that are placed to the IP softphone
• Bidirectional voice traffic

Support for VoIP softphones is configured by using intranet IP addresses. Configure an intranet IP
address for each user. If you are using Cisco Softphone Communication, after configuring the intranet
IP address and binding it to a user, no additional configuration is required. For more information
about configuring an intranet IP address, see Configuring Address Pools.

If you enable split tunneling, create an intranet application and specify the Avaya Softphone applica-
tion. In addition, you must enable transparent interception.

Configuring Application Access for the NetScaler Gateway Plug-in for
Java

October 5, 2020

You can configure the access level and the applications users are allowed to access in the secure net-
work. If users are logged on by using the NetScaler Gateway Plug-in for Java, in the Secure Access Re-
mote Session dialog box, users can click Applications. The Intranet Applications dialog box appears
and lists all of the applications the user is authorized to access.

When users are connected with the NetScaler Gateway Plug-in for Java, you can configure one of two
methods that allow users to access applications.

• HOSTS File Modification method
• SourceIP and SourcePort method

Accessing Applications by Using the HOSTS File Modification Method

When you use the HOSTS File Modification method, the NetScaler Gateway Plug-in for Java adds an
entry that corresponds to the applications that the you configure in the HOSTS file. To modify this
file on a Windows-based device, you must be logged on as an administrator or have administrator
privileges. If you are not logged on with administrator privileges, manually edit the HOSTS file and
add the appropriate entries.

Note: On a Windows-based computer, the HOSTS file is located in the following directory path:
%systemroot%\system32\drivers\etc. On a Macintosh or Linux computer, the HOSTS file is located at
/etc/hosts.

For example, you want to use Telnet to connect to a computer in the secure network. You use the
remote computer to work both within your secure network and remotely—for example, from home.
The IP address should be the localhost IP address, 127.0.0.1. In the HOSTS file, you add the IP address
and the application name, such as:

© 1999-2021 Citrix Systems, Inc. All rights reserved. 303

/en-us/netscaler-gateway/12/vpn-user-config/configure-plugin-connections/ng-plugin-ip-pooling-overview-con/ng-plugin-ip-pooling-config-tsk.html


NetScaler Gateway 12.0

127.0.0.1 telnet1

When the HOSTS file is edited and saved on the user device, you test your connection. You can test
your connection by opening a command prompt and using Telnet to connect. If users are employing a
user device that is not within the secure network, log on to NetScaler Gateway before starting Telnet.

To connect to a computer in the secure network:

1. Start a Telnet session using the available software for your computer.

2. From a command prompt, type: Open telnet

The logon prompt of the remote computer appears.

Accessing Applications by Using the SourceIP and SourcePort Method

If users need to access an application in the secure network and do not have administrative rights
on the user device, configure the HOSTS file by using the source IP address and port number that is
located in the Intranet Applications dialog box.

To open the Intranet Applications dialog box and locate the IP address and port number

1. When users log on with the plug-in, in the Secure Remote Access dialog box, click Applications.
2. Find the application in the list and note the SourceIP address and SourcePort number.

When you have the IP address and port number, start a Telnet session to connect to the computer in
the remote network.

Configuring the Access Interface

October 5, 2020

NetScaler Gateway includes a default home page that is a web page that appears after users log on.
The default home page is called the Access Interface. You use the Access Interface as the home page,
or configure the Web Interface as the home page, or a custom home page.

The Access Interface contains three panels. If you have the Web Interface in your deployment, users
can log on to Receiver in the left panel of the Access Interface. If you have StoreFront in your deploy-
ment, users cannot log on to Receiver from the left panel.

The Access Interface is used to provide links to web sites, both internal and external, and links to file
shares in the internal network. You can customize the Access Interface in the following ways:

• Changing the Access Interface.
• Creating Access Interface links.
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Users can customize the Access Interface as well by adding their own links to web sites and file shares.
Users can also use the home page to transfer files from the internal network to their device.

Note: When users log on and attempt to open file shares from the Access Interface, the file share
does not open and users receive the error message “Failed to make TCP connection to the server.”
To resolve this problem, configure your firewall to allow traffic from the NetScaler Gateway sys-
tem IP address to the file server IP address on TCP ports 445 and 139.

Replacing the Access Interface with a CustomHome Page

October 5, 2020

You can use either global settings or a session policy and profile to configure a custom home page to
replace the default home page, the Access Interface. After you configure the policy, you can bind the
policy to a user, group, virtual server, or globally. When you configure a custom home page, the Access
Interface does not appear when users log on.

To configure custom home page globally

1. In the configuration utility, on theConfiguration tab, in the navigation pane, expandNetScaler
Gateway and then click Global Settings.

2. In the details pane, under Settings, click Change global settings.
3. On the Client Experience tab, in HomePage, click Display HomePage and then enter the web

address of your custom home page.
4. Click OK and then click Close.

To configure a custom home page in a session profile

1. In the configuration utility, on theConfiguration tab, in the navigation pane, expandNetScaler
Gateway Policies and then click Session.

2. In the details pane, on the Policies tab, click Add.
3. In Name, type a name for the policy.
4. Next to Request Profile, click New.
5. In Name, type a name for the profile.
6. On the Client Experience tab, next to Home Page, click Override Global, click Display Home

Page and then type the web address of the home page.
7. In the Create Session Policy dialog box, next to Named Expressions, select General, select

True value, click Add Expression, click Create and then click Close.
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Changing the Access Interface

October 5, 2020

You might want to direct users to a customized home page, rather than relying on the Access Interface.
To do this, install the home page on NetScaler Gateway and then configure the session policy to use
the new home page.

To install a customized home page

1. In the configuration utility, click the Configuration tab and then in the navigation pane, click
NetScaler Gateway.

2. In the details pane, under Customize Access Interface, click Upload the Access Interface.
3. To install the home page from a file on a computer in your network, in Local File, click Browse,

navigate to the file and then click Select.
4. To use a home page that is installed on NetScaler Gateway, in Remote Path, clickBrowse, select

the file and then click Select.
5. Click Upload and then click Close.

Creating and Applying Web and File Share Links

October 5, 2020

You can configure the Access Interface to display a set of links to internal resources that are available
to users. Creating these links requires that you first define the links as resources. Then, you bind them
to a user, group, virtual server, or globally to make them active in the Access Interface. The links you
create appear on the Web Sites and File Shares panes under
Enterprise Web Sites and Enterprise File Shares. If users add their own links, these links appear
under Personal Web Sites and Personal File Shares.

Creating Enterprise bookmarks

To create an Access Interface link in a session policy

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix
Gateway > Resources and then click Portal Bookmarks.

2. In the details pane, click Add.
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3. In Name, type a name for the bookmark.

4. In Text to display, type the description of the link. The description appears in the Access Inter-
face.

5. In Bookmark, type the web address, click Create, and then click Close.

If you enable clientless access, you can make sure that requests to websites go through Citrix Gateway.
For example, you added a bookmark for Google. In the Create Bookmark dialog box, select the Use
Citrix Gateway as a reverse proxy check box. When you select this check box, website requests go
from the user device to Citrix Gateway and then to the website. When you clear the check box, requests
go from the user device to the website. This check box is only available if you enable clientless access.

To bind an Access Interface link

You can bind Access Interface links to the following locations:

• Users
• Groups
• Virtual servers

After you save the configuration, the links are available to users in the Access Interface on the Home
tab, which is the first page that users see after they successfully log on. The links are organized on the
page according to type, as website links or as file share links.

1. In the configuration utility, in the navigation pane, do one of the following:
• Expand Citrix Gateway User Administration and then click AAA Users.
• Expand Citrix Gateway User Administration and then click AAA Grpups.
• Expand Citrix Gateway and then click Virtual Servers.

2. In the details pane, do one of the following:
• Select a user and then click Open.
• Select a group and then click Open.
• Select a virtual server and then click Open.

3. In the dialog box, click the Bookmarks tab.
4. Under Available Bookmarks, select one or more bookmarks, click the right arrow to move the

bookmarks under Configured Bookmarks and then OK.

To bind bookmarks globally by using the GUI

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand Citrix
Gateway and then click Global Settings.

2. In the details pane, underBookmarks, clickCreate links to theHTTPandWindows File Share
applications that you want tomake accessible on the Citrix Gateway portal page.
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3. In the Configure VPN Global Binding* dialog box, click Add.

4. Under Available, select one or more bookmarks, click the right arrow to move the bookmarks
under Configured and then OK.

To add an Enterprise bookmark by using the CLI

At the command prompt, type:

1 add vpn url <urlName> <linkName> <actualURL> [-ssotype <ssotype>]

Example:

Web bookmark

1 add vpn url google google ”https://www.google.com”

File Share bookmark

1 add vpn url fileshare fileshare \\fileshare.abc.com/shares

To bind an Enterprise bookmark by using the CLI

You can bind Enterprise bookmarks to user, group, virtual server, and global level.
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1 bind aaa user <userName> -urlName <string>
2 bind aaa group <groupName> -urlName <string>
3 bind vpn vserver <vserverName> -urlName <string>
4 bind vpn global ‒ urlName <string>

Example:

1 bind vpn global -urlName google
2 bind vpn global ‒ urlName fileshare

Creating Personal Bookmarks

You can create personal websites and files shares from the VPN virtual server only. There is no Citrix
Gateway admin GUI for adding personal bookmarks.

1. Log on to a VPN virtual server.

2. Click Network Access or Clientless Access to add a bookmark or fileshare.

3. Click Add.

4. Enter the bookmark details such as website name, address, and description.
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5. Click Add.

The websites or the file shares that you added appear under the respective tabs.

Configuring User Name Tokens in Bookmarks

October 5, 2020

You can configure bookmark and file share URLs using a special token, %username%. When users
log on, the token is replaced with each users’ logon name. For example, you create a bookmark for
an employee named Jack for a folder as \\EmployeeServer\%username%\. When Jack logs on, the
file share URL is mapped to \\EmployeeServer\Jack\. When you configure user name tokens in book-
marks, keep the following situations in mind:

• If you are using one authentication type, the user name replaces the token %username%.
• If you are using two-factor authentication, the user name from the primary authentication type

is used to replace the %username% token.
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• If you are using client certificate authentication, the user name field in the client certificate au-
thentication profile is used to replace the %username% token.

How a Traffic Policy Works

October 5, 2020

Traffic policies allow you to configure the following settings for user connections:

• Enforcing shorter time-outs for sensitive applications that are accessed from untrusted net-
works.

• Switching network traffic to use TCP for some applications. If you select TCP, you need to enable
or disable single sign-on for certain applications.

• Identifying situations where you want to use other HTTP features for NetScaler Gateway Plug-in
traffic.

• Defining the file extensions that are used with file type association.

Creating a Traffic Policy

October 5, 2020

To configure a traffic policy, you create a profile and configure the following parameters:

• Protocol (HTTP or TCP)
• Application time-out
• Single sign-on to web applications
• Form single sign-on
• File type association
• Repeater Plug-in
• Kerberos Constrained Delegated (KCD) accounts

After you create the traffic policy, you can bind the policy to virtual servers, users, groups, or globally.

For example, you have the web application PeopleSoft Human Resources installed on a server in the
internal network. You can create a traffic policy for this application that defines the destination IP
address, the destination port, and you can set the amount of time a user can stay logged on to the
application, such as 15 minutes.

If you want to configure other features, such as HTTP compression to an application, you can use a
traffic policy to configure the settings. When you create the policy, use the HTTP parameter for the
action. In the expression, create the destination address for the server running the application.
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To configure a traffic policy

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway > Policies and then click Traffic.

2. In the details pane, on the Policies tab, click Add.

3. In the Create Traffic Policy dialog box, in Name, type a name for the policy.

4. Next to Request Profile, click New.

5. In Name, type a name for the profile.

6. In Protocol, select either HTTP or TCP.

Note: If you select TCP as the protocol, you cannot configure single sign-on and the setting
is disabled in the profile dialog box.

7. In AppTimeout (minutes), type the number of minutes. This setting limits the time users can
stay logged on to the web application.

8. To enable single sign-on to the web application, in Single Sign-On, select ON.

Note: If you want to use form-based single sign-on, you can configure the settings within the
traffic profile. For more information, see
Configuring Form-Based Single Sign-On.

9. To specify a file type association, in File Type Association, select ON.

10. To use the Repeater Plug-in to optimize network traffic, in Branch Repeater, select ON, click
Create and then click Close.

11. If you configure KCD on the appliance, in KCD Account, select the account.

For more information about configure KCD on the appliance, see Configuring Kerberos Con-
strained Delegation on a NetScaler Appliance.

12. In the Create Traffic Policy dialog box, create or add an expression, click Create and then click
Close.

Configuring Form-Based Single Sign-On

October 5, 2020

Form-based single sign-on allows users to log on one time to all protected applications in your net-
work. When you configure form-based single sign-on in NetScaler Gateway, users can access web
applications that require an HTML form-based logon without having to type their password again.
Without single sign-on, users are required to log on separately to access each application.
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After creating the form single sign-on profile, you then create a traffic profile and policy that includes
the form single sign-on profile. For more information, see Creating a Traffic Policy.

To configure form-based single sign-on

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway > Policies and then click Traffic.

2. In the details pane, click the Form SSO Profiles tab and then click Add.

3. In Name, type a name for the profile.

4. In Action URL, type the URL to which the completed form is submitted.

Note: The URL is the root relative URL.

5. In User Name Field, type the name of the attribute for the user name field.

6. In Password Field, type the name of the attribute for the password field.

7. In SSO Success Rule, create an expression that describes the action that this profile takes when
invoked by a policy. You can also create the expression by using the Prefix, Add, and Operator
buttons under this field.

This rule checks if single sign-on is successful or not.

8. In Name Value Pair, type the user name field value, followed by an ampersand (&), and then the
password field value.

Value names are separated by an ampersand (&), such as name1=value1&name2=value2.

9. In Response Size, type the number bytes to allow for the complete response size. Type the num-
ber of bytes in the response to be parsed for extracting the forms.

10. In Extraction, select if the name/value pair is static or dynamic. The default setting is Dynamic.

11. In Submit Method, select the HTTP method used by the single sign-on form to send the logon
credentials to the logon server. The default is Get.

12. Click Create and then click Close.

Configuring SAML Single Sign-On

October 5, 2020

You can create a SAML 1.1 or SAML 2.0 profile for single sign-on (SSO). Users can connect to web appli-
cations that support the SAML protocol for single sign-on. NetScaler Gateway supports the identity
provider (IdP) single sign-on for SAML web applications.
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To configure SAML single sign-on

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway > Policies and then click Traffic.

2. In the details pane, click the SAML SSO Profile tab.
3. In the details pane, click Add.
4. In Name, type a name for the profile.
5. In Signing Certificate Name, enter the name of the X.509 certificate.
6. In ACS URL, enter the assertion consumer service of the identity provider or service provider.

The AssertionConsumerServiceURL (ACS URL) provides SSO capability for users.
7. In Relay State Rule, build the expression for the policy from Saved Policy Expressions and Fre-

quently Used Expressions. Select from the Operator list to define how the expression is evalu-
ated. To test the expression, click Evaluate.

8. In Send Password select ON or OFF.
9. In Issuer Name enter the identity for the SAML application.

10. Click Create and then click Close.

Binding a Traffic Policy

October 5, 2020

You can bind traffic policies to virtual servers, groups, users, and to NetScaler Gateway Global. You
can use the configuration utility to bind a traffic policy.

To bind a traffic policy globally by using the configuration utility

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway > Policies and then click Traffic.

2. In the details pane, select a policy and then in Action, click Global Bindings.
3. In the Bind / Unbind Traffic Policies dialog box, under Details, click Insert Policy.
4. Under Policy Name, select the policy and then click OK.

Removing Traffic Policies

October 5, 2020

You can use either the configuration utility to remove traffic policies from NetScaler Gateway. If you
use the configuration utility to remove a traffic policy and the policy is bound to the user, group, or
virtual server level, you must first unbind the policy. Then, you can remove the policy.
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To unbind a traffic policy by using the configuration utility

1. In the configuration utility, in the navigation pane, do one of the following:
• Expand NetScaler Gateway and then click Virtual Servers.
• Expand NetScaler Gateway > User Administration and then click AAA Groups.
• Expand NetScaler Gateway > User Administration and then click AAA Users.

2. In the details pane, select a virtual server, group, or user and then click Open.
3. In the configure NetScaler Gateway Virtual Server, Configure AAA Group, or Configure AAA User

dialog box, click the Policies tab.
4. Click Traffic, select the policy and then click Unbind Policy.
5. Click OK and then click Close.

After the traffic policy is unbound, you can remove the policy.

To remove a traffic policy by using the configuration utility

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway > Policies and then click Traffic.

2. In the details pane, on the Policies tab, select the traffic policy and then click Remove.

Configuring Session Policies

October 5, 2020

A session policy is a collection of expressions and settings that are applied to users, groups, virtual
servers, and globally.

You use a session policy to configure the settings for user connections. You can define settings to
configure the software users log on with, such as the NetScaler Gateway Plug-in for Windows or the
NetScaler Gateway Plug-in for Mac. You can also configure settings to require users to log on with Citrix
Receiver or Worx Home. Session policies are evaluated and applied after the user is authenticated.

Session policies are applied according to the following rules:

• Session polices always override global settings in the configuration.
• Any attributes or parameters that are not set using a session policy are set on policies estab-

lished for the virtual server.
• Any other attributes that are not set by a session policy or by the virtual server are set by the

global configuration.
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Important: The following instructions are general guidelines for creating session policies.
There are specific instructions for configuring session policies for different configurations, such
as clientless access or for access to published applications. The instructions might contain
directions for configuring a specific setting; however, that setting can be one of many settings
that are contained within a session profile and policy. The instructions direct you to create a
setting within a session profile and then apply the profile to a session policy. You can change
settings within a profile and policy without creating a new session policy. In addition, you can
create all of your settings on a global level and then create a session policy to override global
settings.

If you deploy App Controller or StoreFront in your network, Citrix recommends using the Quick Con-
figuration wizard to configure session policies and profiles. When you run the wizard, you define the
settings for your deployment. NetScaler Gateway then creates the required authentication, session
and clientless access policies.

To create a session policy

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway > Policies and then click Session.

2. In the details pane, on the Policies tab, click Add.
3. In Name, type a name for the policy.
4. Next to Request Profile, click New.
5. In Name, type a name for the profile.
6. Complete the settings for the session profile and then click Create.
7. In the Create Session Profile dialog box, add an expression for the policy, click Create and then

click Close.
Note: In the expression, select
True value so the policy is always applied to the level to which it is bound.

Creating a Session Profile

October 5, 2020

A session profile contains the settings for user connections.

Session profiles specify the actions that are applied to a user session if the user device meets the policy
expression conditions. Profiles are used with session policies. You can use the configuration utility to
create session profiles separately from a session policy and then use the profile for multiple policies.
You can only use one profile with a policy.
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Configuring Network Settings for User Connections in a Session Profile

You can use the Network Configuration tab in the session profile to configure the following network
settings for user connections:

• DNS server
• WINS server IP address
• Mapped IP address that you can use as an intranet IP address
• Spillover settings for address pools (intranet IP addresses)
• Intranet IP DNS suffix
• HTTP ports
• Forced time-out settings

Configuring Connection Settings in a Session Profile

You can use the Client Experience tab in the session profile to configure the following connection set-
tings:

• Access Interface or customized home page
• Web address for web-based email, such as Outlook Web Access
• Plug-in type (NetScaler Gateway Plug-in for Windows, NetScaler Gateway Plug-in for Mac OS X,

or NetScaler Gateway Plug-in for Java)
• Split tunneling
• Session and idle time-out settings
• Clientless access
• Clientless access URL encoding
• Plug-in type (Windows, Mac, or Java)
• Single sign-on to web applications
• Credential index for authentication
• Single sign-on with Windows
• Client cleanup behavior
• Logon scripts
• Client debug settings
• Split DNS
• Access to private network IP addresses and local LAN access
• Client choices
• Proxy settings

For more information about configuring settings for user connections, see Configuring Connections
for the NetScaler Gateway Plug-in.
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Configuring Security Settings in a Session Profile

You can use the Security tab in a session profile to configure the following security settings:

• Default authorization action (allow or deny)
• Secure Browse for connections from iOS devices
• Quarantine groups
• Authorization groups

For more information about configuring authorization on NetScaler Gateway, see Configuring Autho-
rization.

Configuring XenApp and XenDesktop Settings in a Session Profile

You can use the Published Applications tab in a session profile to configure the following settings for
connections to servers running Citrix XenApp or XenDesktop:

• ICA proxy, which are client connections using Citrix Receiver
• Web Interface address
• Web Interface portal mode
• Single sign-on to the server farm domain
• Receiver home page
• Account Services Address

For more information about configuring settings for connecting to published applications in a server
farm, see Providing Access to Published Applications and Virtual Desktops Through the Web Interface.

You can create session profiles independently of a session policy. When you create the policy, you can
select the profile to attach to the policy.

To create a session profile by using the configuration utility

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway > Policies and then click Session.

2. In the details pane, click the Profiles tab and then click Add.
3. Configure the settings for the profile, click Create and then click Close.

After you create a profile, you can include it in a session policy.

To add a profile to a session policy by using the configuration utility

1. In the configuration utility, in the navigation pane, expand Access Gateway > Policies and then
click Session.

2. On the Policies tab, do one of the following:
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• Click Add to create a new session policy.
• Select a policy and then click Open.

3. In Request Profile, select a profile from the list.
4. Finish configuring the session policy and then do one of the following:

a) Click Create and then click Close to create the policy.
b) Click OK and then click Close to modify the policy.

Binding Session Policies

October 5, 2020

After you create a session policy, bind it to a user, group, virtual server, or globally. Session policies
are applied as a hierarchy in the following order:

• Users
• Groups
• Virtual servers
• Globally

To bind a session policy to a virtual server by using the GUI

1. Navigate to Citrix Gateway > Virtual Servers.
2. Select a virtual server and click Edit. You can also create a new virtual server.
3. Scroll down to the Policies section, and click the + icon.
4. In Choose Policy, select Session.
5. In Choose Type, select Request, and click Continue.
6. In Select Policy, select the policy that you want to bind to this virtual server.
7. In Priority, enter the priority number of the policy.
8. Click Bind.

To bind a session policy to a Citrix ADC AAA group by using the GUI

1. Navigate to Citrix Gateway > User Administration > AAA Groups.
2. Select an existing Citrix ADC AAA group, and click Edit. You can also create a Citrix ADC AAA

group.
3. In Advanced Settings, click Policies, and then click the + icon.
4. In Choose Policy, select Session, and click Continue.
5. In Select Policy, select the policy that you want to bind to this Citrix ADC AAA group.
6. In Priority, enter the priority number of the policy.
7. Click Bind.
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To bind a session policy to a Citrix ADC AAA user by using the GUI

1. Navigate to Citrix Gateway > User Administration > AAA Users.
2. Select an existing Citrix ADC user, and click Edit. You can also create a Citrix ADC AAA user.
3. In Advanced Settings, click Policies, and then click the + icon.
4. In Choose Policy, select Session, and click Continue.
5. In Select Policy, select the policy that you want to bind to this Citrix ADC AAA user.
6. In Priority, enter the priority number of the policy.
7. Click Bind.

Note: For details on priority, see https://support.citrix.com/article/CTX214588.

Configuring Endpoint Polices

October 5, 2020

Endpoint analysis is a process that scans a user device and detects information, such as the presence
and version level of an operating system, and of antivirus, firewall, or web browser software. You
can use endpoint analysis to verify that the user device meets your requirements before allowing it
to connect to your network or remain connected after users log on. You can monitor files, processes,
and registry entries on the user device during the user session to ensure that the device continues to
meet requirements.

How Endpoint Policies Work

October 5, 2020

You can configure NetScaler Gateway to check if a user device meets certain security requirements be-
fore a user logs on. This is called a preauthentication policy. You can configure NetScaler Gateway to
check a user device for antivirus, firewall, antispam, processes, files, registry entries, Internet security,
or operating systems that you specify within the policy. If the user device fails the preauthentication
scan, users are not allowed to log on.

If you need to configure additional security requirements that are not used in a preauthentication
policy, you configure a session policy and bind it to a user or group. This type of policy is called a
post-authentication policy, which runs during the user session to ensure the required items, such as
antivirus software or a process, is still true.

When you configure a preauthentication or post-authentication policy, NetScaler Gateway downloads
the Endpoint Analysis Plug-in and then runs the scan. Each time a user logs on, the Endpoint Analysis
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Plug-in runs automatically.

You use the following three types of policies to configure endpoint policies:

• Preauthentication policy that uses a yes or no parameter. The scan determines if the user device
meets the specified requirements. If the scan fails, the user cannot enter credentials on the
logon page.

• Session policy that is conditional and can be used for SmartAccess.
• Client security expression within a session policy. If the user device fails to meet the require-

ments of the client security expression, you can configure users to be placed into a quarantine
group. If the user device passes the scan, users can be placed into a different group that might
require additional checks.

You can incorporate detected information into policies, enabling you to grant different levels of ac-
cess based upon the user device. For example, you can provide full access with download permission
to users who connect remotely from user devices that have current antivirus and firewall software re-
quirements. For users connecting from untrusted computers, you can provide a more restricted level
of access that allows users to edit documents on remote servers without downloading them.

Endpoint analysis performs the following basic steps:

• Examines an initial set of information about the user device to determine which scans to apply.

• Runs all applicable scans. When users try to connect, the Endpoint Analysis Plug-in checks the
user device for the requirements specified within the preauthentication or session policy. If the
user device passes the scan, users are allowed to log on. If the user device fails the scan, users
are not allowed to log on.
Note: Endpoint analysis scans completes before the user session uses a license.

• Compares property values detected on the user device with desired property values listed in
your configured scans.

• Produces an output verifying whether or not desired property values are found.

Attention: The instructions for creating endpoint analysis policies are general guidelines.
You can have many settings within one session policy. Specific instructions for configuring
session policies might contain directions for configuring a specific setting; however, that
setting can be one of many settings that are contained within a session profile and policy.

Evaluating User Logon Options

October 5, 2020
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When users log on, they can choose to skip the endpoint analysis scan. If users skip the scan, NetScaler
Gateway processes this action as a failed endpoint analysis. When users fail the scan, they can only
have access to the Web Interface or through clientless access.

For example, you want to provide users access by using the NetScaler Gateway Plug-in. To log on to
NetScaler Gateway with the plug-in, users must be running an antivirus application, such as Norton
Antivirus. If the user device is not running the application, users can log on with Receiver only and use
published applications. You can also configure clientless access, which restricts access to specified
applications, such as Outlook Web Access.

To configure NetScaler Gateway to achieve this logon scenario, you assign a restrictive session policy
as the default policy. You then configure the settings to upgrade users to a privileged session pol-
icy when the user device passes the endpoint analysis scan. At that point, users have network-layer
access and can log on with the NetScaler Gateway Plug-in.

To configure NetScaler Gateway to enforce the restrictive session policy first, perform the following
steps:

• Configure the global settings with ICA proxy enabled and all other necessary settings if the spec-
ified application is not running on the user device.

• Create a session policy and profile that enables the NetScaler Gateway Plug-in.

• Create an expression within the rule portion of the session policy to specify the application, such
as:

(client.application.process(symantec.exe) exists)

When users log on, the session policy is applied first. If endpoint analysis fails or the user skips the
scan, NetScaler Gateway ignores the settings in the session policy (the expression in the session policy
is considered false). As a result, users have restricted access using the Web Interface or clientless
access. If endpoint analysis passes, NetScaler Gateway applies the session policy and users have full
access with the NetScaler Gateway Plug-in.

Setting the Priority of Preauthentication Policies

October 5, 2020

You can have multiple preauthentication policies that are bound to different levels. For example, you
have a policy that checks for a specific antivirus application bound to AAA Global and a firewall policy
bound to the virtual server. When users log on, the policy that is bound to the virtual server is applied
first. The policy that is bound at AAA Global is applied second.

You can change the order in which the preauthentication scans occur. To make NetScaler Gateway
apply the global policy first, change the priority number of the policy bound to the virtual server, giving
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it a higher priority number than the policy bound globally. For example, set the priority number for
the global policy to one and the virtual server policy to two. When users log on, NetScaler Gateway
runs the global policy scan first and the virtual server policy scan second.

To change the priority of a preauthentication policy

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Virtual Servers.

2. In the details pane, select a virtual server and then click Open.
3. On the Policies tab, click Pre-authentication.
4. Under Priority, type the priority number for the policy and then click OK.

Configuring Preauthentication Policies and Profiles

October 5, 2020

Warning

AAA preauthentication policy is deprecated from NetScaler 12.0 build 56.20 onwards and as an
alternative, Citrix recommends you to use the Nfactor authentication. For more information,
see Multi-Factor (nFactor) Authentication topic.

You can configure NetScaler Gateway to check for client-side security before users are authenticated.
This method ensures that the user device establishing a session with NetScaler Gateway conforms to
your security requirements. You configure client-side security checks through the use of preauthenti-
cation policies specific to a virtual server or globally, as described in the following two procedures.

Preauthentication policies consist of a profile and an expression. You configure the profile to use an
action to allow or deny a process to execute on the user device. For example, the text file, clienttext.txt,
is running on the user device. When the user logs on to NetScaler Gateway, you can either allow or
deny access if the text file is running. If you do not want to allow users to log on if the process is
running, configure the profile so the process is stopped before users log on.

You can configure the following settings for pre-authentication policies:

• Expression. Includes the following settings to help you to create expressions:
– Expression. Displays all of the created expressions.
– Match Any Expression. Configures the policy to match any of the expressions that are

present in the list of selected expressions.
– Match All Expressions. Configures the policy to match all the expressions that are present

in the list of selected expressions.
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Tabular Expressions. Creates
a compound expression with
the existing expressions by
using the OR (

) or AND (&&) operators.

–

Advanced Free-Form. Creates
custom compound
expressions by using the
expression names and the OR
(

) and AND (&&) operators.
Choose only those
expressions that you require
and omit other expressions
from the list of selected
expressions.

–
– Add. Creates a new expression.
– Modify. Modifies an existing expression.
– Remove. Removes the selected expression from the compound expressions list.
– Named Expressions. Select a configured named expression. You can select named expres-

sions from the drop-down list of expressions already present on NetScaler Gateway.
– Add Expression. Adds the selected named expression to the policy.
– Replace Expression. Replaces the selected named expression to the policy.
– Preview Expression. Displays the detailed client security string that will be configured on

NetScaler Gateway when you select a named expression.

To configure a preauthentication profile globally by using the configuration utility

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Global Settings.

2. In the details pane, under Settings, click Change pre-authentication settings.
3. In the Global Pre-authentication settings dialog box, configure the settings:

a) In Action, select Allow or Deny.
Denies or allows users to log on after endpoint analysis occurs.

b) In Processes to be cancelled, enter the process.
This specifies the processes to be stopped by the Endpoint Analysis Plug-in.

c) In Files to be deleted, enter the file name.
This specifies the files to be deleted by the Endpoint Analysis Plug-in.

4. In Expression you can leave the expression ns_true or build an expression for a specific applica-
tion, such as antivirus or security software and then click OK.
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To configure a preauthentication profile by using the configuration utility

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway > Policies > Authentication/Authorization, and then click Pre-Authentication EPA.

2. In the details pane, on the Profiles tab, click Add.

3. In Name, type the name of the application to be checked.

4. In Action, select ALLOW or DENY.

5. In Processes to be cancelled, type the name of the process to be stopped.

6. In Files to be deleted, type the name of the file to be deleted, such as c:\clientext.txt, click Create
and then click Close.

Note: If a file is to be deleted or a process stopped, users receive a message asking for
confirmation. Steps 5 and 6 are optional parameters.

If you use the configuration utility to configure a preauthentication profile, you then create the preau-
thentication policy by clicking Add on the Policies tab. In the Create Pre-Authentication Policy dialog
box, select the profile from the Request Profile drop-down list.

Configuring Endpoint Analysis Expressions

October 5, 2020

Preauthentication and client security session policies include a profile and an expression. The policy
can have one profile and multiple expressions. To scan a user device for an application, file, process,
or registry entry, you create an expression or compound expressions within the policy.

Types of Expressions

The expression consists of an expression type and the parameters of the expression. Expression types
include:

• General
• Client security
• Network based

Adding Preconfigured Expressions to a Preauthentication Policy

NetScaler Gateway comes with pre-configured expressions, called named expressions. When you con-
figure a policy, you can use a named expression for the policy. For example, you want the preauthen-
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tication policy to check for Symantec AntiVirus 10 with updated virus definitions. Create a preauthen-
tication policy and add the expression as described in the following procedure.

When you create a preauthentication or session policy, you can create the expression when you create
the policy. You can then apply the policy, with the expression, to virtual servers or globally.

The following procedure describes how to add a preconfigured antivirus expression to a policy by
using the configuration utility.

To add a named expression to a preauthentication policy

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway > Policies > Authentication/Authorization, and then click Pre-Authentication EPA.

2. In the details pane, select a policy and then click Open.
3. Next to Named Expressions, select Anti-Virus, select the antivirus product from the list, click Add

Expression, click Create and then click Close.

Configuring Custom Expressions

October 5, 2020

A custom expression is one that you create within the policy. When you create an expression, you
configure the parameters for the expression.

You can also create custom client security expressions to refer to commonly used client security
strings. This eases the process of configuring preauthentication policies and also in maintaining the
configured expressions.

For example, you want to create a custom client security expression for Symantec AntiVirus 10 and
make sure that the virus definitions are no more than three days old. Create a new policy and then
configure the expression to specify the virus definitions.

The following procedure shows how to create a client security policy in a preauthentication policy.
You can use the same steps in a session policy.

To create a preauthentication policy and custom client security expression

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway > Policies > Authentication/Authorization, and then click Pre-Authentication EPA.

2. In the details pane, click Add. The Create Pre-Authentication Policy dialog box opens.
3. In Name, type a name for the policy.
4. Next to Request Profile, click New.
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5. In the Create Authentication Profile dialog box, in Name, type a name for the profile and in Ac-
tion, select Allow and then click Create.

6. In the Create Pre-Authentication Policy dialog box, next to Match Any Expression, click Add.
7. In Expression Type, select Client Security.
8. Configure the following:

a) In Component, select Anti-Virus.
b) In Name, type a name for the application.
c) In Qualifier, select Version.
d) In Operator, select ==.
e) In Value, type the value.
f) In Freshness, type 3 and then click OK.

9. In the Create Pre-Authentication Policy dialog box, click Create and then click Close.

When you configure a custom expression, it is added to the Expression box in the policy dialog box.

Configuring Compound Expressions

October 5, 2020

A preauthentication policy can have one profile and multiple expressions. If you configure compound
expressions, you use operators to specify the conditions of the expression. For example, you can con-
figure compound expressions to require the user device to run one of the following antivirus applica-
tions:

• Symantec Antivirus 10
• McAfee Antivirus 11
• Sophos Antivirus 4

You configure the expression with the OR operator to check for the preceding three applications. If
NetScaler Gateway detects the correct version of any of the applications on the user device, users are
allowed to log on. The expression in the policy dialog box appears as follows:

av_5_Symantec_10 av_5_McAfeevirusscan_11 av_5_sophos_4

For more information about compound expressions, see Configuring Compound Expressions.
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Binding Preauthentication Policies

October 5, 2020

After you create the preauthentication or client security session policy, bind the policy to the level to
which it applies. You can bind the preauthentication policies to virtual servers or globally.

To create and bind a preauthentication policy globally

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Global Settings.

2. In the details pane, click Change pre-authentication settings.
3. In the Global Pre-Authentication Settings dialog box, in Action, select Allow or Deny.
4. In Name, type a name for the policy.
5. In the Global Pre-authentication settigns dialog box, next to Named Expressions, select General,

select True value, click Add Expression, click Create and then click Close.

To bind a preauthentication policy to a virtual server

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Virtual Servers.

2. In the details pane, select a virtual server and then click Open.
3. In the configure NetScaler Gateway Virtual Server dialog box, click the Policies tab and then

click Pre-authentication.
4. Under Details, click Insert Policy and then under Policy Name, select the preauthentication pol-

icy.
5. Click OK.

Unbinding and Removing Preauthentication Polices

October 5, 2020

You can remove a preauthentication policy from NetScaler Gateway if necessary. Before you remove
a preauthentication policy, unbind it from the virtual server or globally.

To unbind a global preauthentication policy

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway > Policies > Authentication/Authorization, and then click Pre-Authentication EPA.
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2. In the details pane, select a policy and then in Action, click Global Bindings.
3. In the Bind/Unbind Pre-authentication Policies to Global dialog box, select a policy, click Un-

bind Policy and then click OK.

To unbind a preauthentication policy from a virtual server

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Virtual Servers.

2. In the configure NetScaler Gateway Virtual Server dialog box, click the Policies tab and then
click Preauthentication.

3. Select the policy and then click Unbind Policy.

When the preauthentication policy is unbound, you can remove the policy from NetScaler Gateway.

To remove a preauthentication policy

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway > Policies > Authentication/Authorization, and then click Pre-Authentication EPA.

2. in the details pane, select a policy and then click Remove.

Configuring Post-Authentication Policies

October 5, 2020

A post-authentication policy is a set of generic rules that the user device must meet to keep the ses-
sion active. If the policy fails, the connection to NetScaler Gateway ends. When you configure the
post-authentication policy, you can configure any setting for user connections that can be made con-
ditional.

Note: This functionality works only with the NetScaler Gateway Plug-in. If users log on with Citrix
Receiver, the endpoint analysis scan runs at logon only.

You use session policies to configure post-authentication policies. First, you create the users to which
the policy applies. Then, you add the users to a group. Next, you bind session, traffic policies, and
intranet applications to the group.

You can also specify groups to be authorization groups. This type of group allows you to assign users
to groups on the basis of a client security expression within the session policy.

You can also configure a post-authentication policy to put users in a quarantine group if the user device
does not meet the requirements of the policy. A simple policy includes a client security expression
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and a client security message. When users are in the quarantine group, users can log on to NetScaler
Gateway; however, they receive limited access to network resources.

You cannot create an authorization group and a quarantine group by using the same session profile
and policy. The steps for creating the post-authentication policy are the same. When you create the
session policy, you select either an authorization group or a quarantine group. You can create two
session policies and bind each policy to the group.

Post-authentication policies are also used with SmartAccess. For more information about SmartAc-
cess, see Configuring SmartAccess on NetScaler Gateway.

Configuring a Post-Authentication Policy

October 5, 2020

You use a session policy to configure a post-authentication policy. A simple policy includes a client
security expression and a client security message.

To configure a post-authentication policy

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway > Policies and then click Session.

2. In the details pane, on the Policies tab, click Add.
3. In Name, type a name for the policy.
4. Next to Request Profile, click New.
5. In Name, type a name for the profile.
6. On the Security tab, click Advanced Settings.
7. Under Client Security, click Override Global and then click New.
8. Configure the client security expression and then click Create.
9. Under Client Security, in Quarantine Group, select a group.

10. In Error Message, type the message you want users to receive if the post-authentication scan
fails.

11. Under Authorization Groups, click Override Global, select a group, click Add, click OK and then
click Create.

12. In the Create Session Policy dialog box, next to Named Expressions, select General, select True
value, click Add Expression, click Create and then click Close.
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Configuring the Frequency of Post-Authentication Scans

October 5, 2020

You can configure NetScaler Gateway to run the post-authentication policy at specified intervals. For
example, you configured a client security policy and want it to run on the user device every 10 minutes.
You can configure this frequency by creating a custom expression within the policy.

Note: The frequency check functionality for post-authentication policies works only with the
NetScaler Gateway Plug-in. If users log on with Citrix Receiver, the endpoint analysis scan runs
at logon only.

You can set the frequency (in minutes) when you configure the client security policy by following the
procedure Configuring a Post-Authentication Policy. The following figure shows where you can enter
a frequency value in the Add Expression dialog box.

Figure 1. Dialog box for configuring the frequency of post-authentication scans

Configuring Quarantine and Authorization Groups

October 5, 2020

When users log on to NetScaler Gateway, you assign them to a group that you configure either
on NetScaler Gateway or on an authentication server in the secure network. If a user fails a post-
authentication scan, you can assign the user to a restricted group, called a quarantine group, which
restricts access to network resources.

You can also use authorization groups to restrict user access to network resources. For example, you
might have a group of contract personnel that has access only to your email server and a file share.
When user devices pass the security requirements that you defined on NetScaler Gateway, users can
become members of groups dynamically.
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You use either global settings or session policies to configure quarantine and authorization groups
that are bound to a user, group, or virtual server. You can assign users to groups on the basis of a
client security expression within the session policy. When the user is a member of a group, NetScaler
Gateway applies the session policy based on group membership.

Configuring Quarantine Groups

October 5, 2020

When you configure a quarantine group, you configure the client security expression using the Secu-
rity Settings - Advanced Settings dialog box within a session profile.

To configure the client security expression for a quarantine group

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway > Policies and then click Session.

2. In the details pane, on the Policies tab, click Add.
3. In Name, type a name for the policy.
4. Next to Request Profile, click New.
5. In Name, type a name for the profile.
6. On the Security tab, click Advanced Settings.
7. Under Client Security, click Override Global and then click New.
8. In the Client Expression dialog box, configure the client security expression and then click Cre-

ate.
9. In Quarantine Group, select the group.

10. In Error Message, type a message that describes the problem for users and then click Create.
11. In the Create Session Policy dialog box, next to Named Expressions, select General, select True

value, click Add Expression, click Create and then click Close.

After you create the session policy, bind it to a user, group, or virtual server.

Note: If the endpoint analysis scan fails and the user is put in the quarantine group, the policies
that are bound to the quarantine group are effective only if there are no policies bound directly
to the user that have an equal or lower priority number than the policies bound to the quarantine
group.

To configure a global quarantine group

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Global Settings.
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2. In the details pane, under Settings, click Change global settings.
3. On the Security tab, click Advanced Settings.
4. In Client Security, configure the client security expression.
5. In Quarantine Group, select the group.
6. In Error Message, type a message that describes the problem for users and then click OK.

Configuring Authorization Groups

October 5, 2020

When you configure an endpoint analysis scan, you can dynamically add users to an authorization
group when the user device passes the scan. For example, you create an endpoint analysis scan
that checks the user device domain membership. On NetScaler Gateway, create a local group called
Domain-Joined Computers and add it as an authorization group for anyone who passes the scan.
When users join the group, users inherit the policies associated with the group.

You cannot bind authorization policies globally or to a virtual server. You can use authorization groups
to provide a default set of authorization policies when users are not configured to be members of
another group on NetScaler Gateway.

To configure an authorization group by using a session policy

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway > Policies and then click Session.

2. In the details pane, on the Policies tab, click Add.
3. In Name, type a name for the policy.
4. Next to Request Profile, click New.
5. In Name, type a name for the profile.
6. On the Security tab, click Advanced Settings.
7. Under Authorization Groups, click Override Global, select a group from the drop-down list, click

Add, click OK and then click Create.
8. In the Create Session Policy dialog box, next to Named Expressions, select General, select True

value, click Add Expression, click Create and then click Close.

After you create the session policy, you can bind it to a user, group, or virtual server.

To configure a global authorization group

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Global Settings.
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2. In the details pane, under Settings, click Change global settings.
3. On the Security tab, click Advanced Settings.
4. Under Authorization Group, select a group from the drop-down list, click Add and then click OK

twice.

If you want to remove an authorization group either globally or from the session policy, in the Security
Settings - Advanced dialog box, select the authorization group from the list and then click Remove.

Configuring Security Preauthentication Expressions for User Devices

October 5, 2020

NetScaler Gateway provides various endpoint security checks during user logon or at other configured
times during a session that help in improving security. Only the user devices that pass these security
checks are allowed to establish an NetScaler Gateway session.

The following are the types of security checks on user devices that you can configure on NetScaler
Gateway:

• Antispam
• Antivirus
• File policies
• Internet security
• Operating system
• Personal firewall
• Process policies
• Registry policies
• Service policies

If a security check fails on the user device, no new connections are made until a subsequent check
passes (in the case of checks that are at regular intervals); however, traffic flowing through existing
connections continues to tunnel through NetScaler Gateway.

You can use the configuration utility to configure preauthentication policies or security expressions
within session policies that are designed to carry out security checks on user devices.

Configuring Antivirus, Firewall, Internet Security, or Antispam
Expressions

October 5, 2020
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You configure settings for antivirus, firewall, Internet security, and antispam policies within the Add
Expression dialog box. The settings for each policy are the same: the differences are the values that
you select. For example, if you want to check the user device for Norton AntiVirus Version 10 and
ZoneAlarm Pro, you create two expressions within the session or preauthentication policy that specify
the name and version number of each application.

When you select Client Security as the expression type, you can configure the following:

• Component: The type of client security, such as antivirus, firewall, or registry entry.
• Name: The name of the application, process, file, registry entry, or operating system.
• Qualifier: The version or the value of the component for which the expression checks.
• Operator: Checks if the value exists or is equal to the value.
• Value: The application version for antivirus, firewall, Internet security, or antispam software on

the user device.
• Frequency: Frequency with which a post-authentication scan is run, in minutes.
• Error weight: A weight assigned to each error message contained in a nested expression when

multiple expressions have different error strings. The weight determines which error message
appears.

• Freshness: Defines how old a virus definition can be. For example, you can configure the expres-
sion so virus definitions are no older than three days.

To add a client security policy to a preauthentication or session policy

1. In the configuration utility, in the navigation pane, do one of the following:
a) In the configuration utility, on the Configuration tab, in the navigation pane, expand

NetScaler Gateway > Policies and then click Session.
b) In the configuration utility, on the Configuration tab, in the navigation pane, ex-

pand NetScaler Gateway > Policies > Authentication/Authorization, and then click
Pre-Authentication EPA.

2. In the details pane, on the Policies tab, click Add.
3. In Name, type a name for the policy.
4. Next to Match Any Expression, click Add.
5. In the Add Expression dialog box, in Expression Type, select Client Security.
6. Configure the settings for the following:

a) In Component, select the item for which to scan.
b) In Name, type the name of the application.
c) In Qualifier, select Version.
d) In Operator, select the value.
e) In Value, type the client security string, click OK, click Create and then click Close.
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Configuring Service Policies

October 5, 2020

A service is a program the runs silently on the user device. When you create a session or preauthen-
tication policy, you can create an expression that ensures that user devices are running a particular
service when the session is established.

To configure a service policy

1. In the configuration utility, in the navigation pane, do one of the following:
a) In the configuration utility, on the Configuration tab, in the navigation pane, expand

NetScaler Gateway > Policies and then click Session.
b) In the configuration utility, on the Configuration tab, in the navigation pane, ex-

pand NetScaler Gateway > Policies > Authentication/Authorization, and then click
Pre-Authentication EPA.

2. In the details pane, on the Policies tab, click Add.
3. In Name, type a name for the policy.
4. Next to Match Any Expression, click Add.
5. In the Add Expression dialog box, in Expression Type, select Client Security.
6. Configure the settings for the following:

a) In Component, select Service.
b) In Name, type the name of the service.
c) In Qualifier, leave blank or select Version.
d) Depending on your selection in Qualifier, do one of the following:

• If left blank, in Operator, select == or !=
• If you selected Version, in Operator, in Value, type the value, click OK and then click

Close.

You can check a list of all available services and the status for each on a Windows-based computer at
the following location:

Control Panel > Administrative Tools > Services

Note: The service name for each service varies from its listed name. Check for the name of the
service by looking at the
Properties dialog box.
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Configuring Process Policies

October 5, 2020

When creating a session or preauthentication policy, you can define a rule that requires all user devices
to have a particular process running when users log on. The process can be any application and can
include customized applications.

Note: The list of all processes running on a Windows-based computer appears on the
Processes tab of Windows Task Manager.

To configure a process policy

1. In the configuration utility, in the navigation pane, do one of the following:
a) In the configuration utility, on the Configuration tab, in the navigation pane, expand

NetScaler Gateway > Policies and then click Session.
b) In the configuration utility, on the Configuration tab, in the navigation pane, ex-

pand NetScaler Gateway > Policies > Authentication/Authorization, and then click
Pre-Authentication EPA.

2. In the details pane, on the Policies tab, click Add.
3. In Name, type a name for the policy.
4. Next to Match Any Expression, click Add.
5. In the Add Expression dialog box, in Expression Type, select Client Security.
6. Configure the settings for the following:

a) In Component, select Process.
b) In Name, type the name of the application.
c) In Operator, select EXISTS or NOTEXISTS, click OK and then click Close.

When you configure an endpoint analysis policy (pre-authentication or post-authentication) to check
for a process, you can configure an MD5 checksum.

When you create the expression for the policy, you can add the MD5 checksum to the process you are
checking for. For example, if you are checking to see if notepad.exe is running on the user device, the
expression is:
CLIENT.APPLICATION.PROCESS(notepad.exe_md5_388b8fbc36a8558587afc90fb23a3b00) EXISTS

Configuring Operating System Policies

October 5, 2020
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When you create a session or preauthentication policy, you can configure client security strings to
determine whether or not the user device is running a particular operating system when users log on.
You can also configure the expression to check for a particular service pack or hotfix.

The values for Windows and Macintosh are:

Operating system Value

Mac OS X macos

Windows 8.1 win8.1

Windows 8 win8

Windows 7 win7

Windows Vista vista

Windows XP winxp

Windows Server 2008 win2008

Windows Server 2003 win2003

Windows 2000 Server win2000

Windows 64-bit platform win64

To configure an operating system policy

1. In the configuration utility, in the navigation pane, do one of the following:
a) In the configuration utility, on the Configuration tab, in the navigation pane, expand

NetScaler Gateway > Policies and then click Session.
b) In the configuration utility, on the Configuration tab, in the navigation pane, ex-

pand NetScaler Gateway > Policies > Authentication/Authorization, and then click
Pre-Authentication EPA.

2. In the details pane, on the Policies tab, click Add.
3. In Name, type a name for the policy.
4. Next to Match Any Expression, click Add.
5. In the Add Expression dialog box, in Expression Type, select Client Security.
6. Configure the settings for the following:

a) In Component, select Operating System.
b) In Name, type the name of the operating system.
c) In Qualifier, do one of the following:

• Leave blank.
• Select Service Pack.
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• Select Hotfix.
• Select Version for Mac OS X only.

d) Depending on your selection in Step C, in Operator, do one of the following:
• If Qualifier is blank, in Operator, select EQUAL (= =), NOTEQUAL (!=), EXISTS or NOTEX-

ISTS.
• If you selected Service Pack or Hotfix, select the operator and in Value, type the value.

7. Click Create and then click Close.

If you are configuring a service pack, such as client.os (winxp).sp, if a number is not in the Value field,
NetScaler Gateway returns an error message because the expression is invalid.

If the operating system has service packs present, such as Service Pack 3 and Service Pack 4, you
can configure a check just for Service Pack 4, because the presence of Service Pack 4 automatically
indicates that previous service packs are present.

Configuring Registry Policies

October 5, 2020

When you create a session or preauthentication policy, you can check for the existence and value of
registry entries on the user device. The session is established only if the particular entry exists or has
the configured or higher value.

When configuring a registry expression, use the following guidelines:

• Four backslashes are used to separate keys and subkeys, such as

HKEY_LOCAL_MACHINE\\\\SOFTWARE

• Underscores are used to separate the subkey and the associated value name, such as

HKEY_LOCAL_MACHINE\\\\SOFTWARE\\\\VirusSoftware_Version

• A backslash (\) is used to denote a space, such as in the following two examples:

HKEY_LOCAL_MACHINE\\\\SOFTWARE\\Citrix\\\\Secure\ Access\ Client_ProductVersion

CLIENT.REG(HKEY_LOCAL_MACHINE\\\\Software\\\\Symantec\\Norton\ AntiVirus_Version).VALUE
== 12.8.0.4 -frequency 5

The following is a registry expression that looks for the NetScaler Gateway Plug-in registry key when
users log on:

CLIENT.REG(secureaccess).VALUE==HKEY_LOCAL_MACHINE\\\\SOFTWARE\\\\CITRIX\\\\Secure\Access\Client_ProductVersion
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Note: If you are scanning for registry keys and values and you select
Advanced Free-Form in the
Expression dialog box, the expression must start with
CLIENT.REG

Registry checks are supported under the following most common five types:

• HKEY_CLASSES_ROOT
• HKEY_CURRENT_USER
• HKEY_LOCAL_MACHINE
• HKEY_USERS
• HKEY_CURRENT_CONFIG

Registry values to be checked use the following types:

• String

For the string value type, case-sensitivity is checked.

• DWORD

For DWORD type, the value is compared and must be equal.

• Expanded String

Other types, such as Binary and Multi-String, are not supported.

• Only the ‘==’ comparison operator is supported.

• Other comparison operators, such as <, > and case-sensitive comparisons are not supported.

• The total registry string length should be less than 256 bytes.

You can add a value to the expression. The value can be a software version, service pack version, or
any other value that appears in the registry. If the data value in the registry does not match the value
you are testing against, users are denied logon.

Note: You cannot scan for a value within a subkey. The scan must match the named value and
the associated data value.

To configure a registry policy

1. In the configuration utility, in the navigation pane, do one of the following:
a) In the configuration utility, on the Configuration tab, in the navigation pane, expand

NetScaler Gateway > Policies and then click Session.
b) In the configuration utility, on the Configuration tab, in the navigation pane, ex-

pand NetScaler Gateway > Policies > Authentication/Authorization, and then click
Pre-Authentication EPA.
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2. In the details pane, on the Policies tab, click Add.
3. In Name, type a name for the policy.
4. Next to Match Any Expression, click Add.
5. In the Add Expression dialog box, in Expression Type, select Client Security.
6. Configure the settings for the following:

a) In Component, select Registry.
b) In Name, type the name of the registry key.
c) In Qualifier, leave blank or select Value.
d) In Operator, do one of the following:

• If Qualifier is left blank, select EXISTS or NOTEXISTS
• If you selected Value in Qualifier, select either == or !==

e) In Value, type the value as it appears in the registry editor, click OK and then click Close.

Configuring Compound Client Security Expressions

October 5, 2020

You can combine client security strings to form compound client security expressions.

The Boolean operators that are supported in NetScaler Gateway are:

• And (&&)

Or ( )

•

• Not (!)

For greater precision, you can group the strings together using parentheses.

Note: If you use the command line to configure expressions, use parentheses to group security
expressions together when you form a compound expression. The use of parentheses improves
the understanding and debugging of the client expression.

Configuring Policies with the AND (&&) Operator

The AND (&&) operator works by combining two client security strings so that the compound check
passes only when both checks are true. The expression is evaluated from left to right and if the first
check fails, the second check is not carried out.

You can configure the AND (&&) operator using the keyword ‘AND’ or the symbols ‘&&’.
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Example:

The following is a client security check that determines if the user device has Version 7.0 of Sophos
AntiVirus installed and running. It also checks if the netlogon service is running on the same computer.

CLIENT.APPLICATION.AV(sophos).version==7.0 AND CLIENT.SVC(netlogon) EXISTS

This string can also be configured as:

CLIENT.APPLICATION.AV(sophos).version==7.0 && CLIENT.SVC(netlogon) EXISTS

Configuring Policies with the OR ( || ) Operator

The OR ( ) operator works by
combining two security
strings. The compound check
passes when either check is
true. The expression is
evaluated from left to right
and if the first check passes,
the second check is not
carried out. If the first check
does not pass, the second
check is carried out.

You can
configure the OR
(

) operator using
the keyword ‘OR’
or the symbols ‘

’.

Example:

The following is a client security check that determines if the user device has either the file c:\file.txt
on it or the putty.exe process running on it.

client.file(c:\\\\file.txt) EXISTS) OR (client.proc(putty.exe) EXISTS

This string can also be configured as

client.file(c:\\\\file.txt)
EXISTS)

(client.proc(putty.exe) EXISTS
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Configuring Policies Using the NOT ( ! ) Operator

The NOT (!) or the negation operator negates the client security string.

Example:

The following client security check passes if the file c:\sophos_virus_defs.dat file is NOT more than
two days old:

!(client.file(c:\\\\sophos_virus_defs.dat).timestamp==2dy)

Advanced Endpoint Analysis Scans

October 5, 2020

Advanced End-point Analysis (EPA) is used for scanning user devices for endpoint security require-
ment configured on a NetScaler Gateway appliance. If a user device tries to access the NetScaler Gate-
way appliance, the device is scanned for security information, such as operating system, antivirus,
web browser versions and so forth before an administrator can grant access to the NetScaler Gateway
appliance.

The Advanced EPA scan is a policy-based scan that you can configure on a NetScaler Gateway appli-
ance for pre-authentication and post-authentication sessions. The policy performs a registry check
on a user device and based on evaluation, the policy allows or denies access to the NetScaler network.

You can perform two types of EPA scan, OPSWAT scan and System scan. The following section explain
the scan types and its details.

OPSWAT scan. The scan mechanism provides security at different levels such as:

• Product specific scan
• Vendor specific scan
• Generic scan

Product specific scan: You can configure scan criteria for a particular product (e.g. Avast! Free An-
tivirus) offered by a particular vendor (e.g. AVAST Software a.s.) for a category (e.g. Antivirus). The
access is granted only to the computers fulfilling the specified criteria.**

Vendor specific scan: You can configure scan criteria for a particular vendor (e.g. AVAST Software
a.s.) of a category (eg. Antivirus). The configured scan checks for the specified criteria across all the
products offered by the vendor. The access is granted only to the computers fulfilling the specified
criteria.

Generic scan: You can configure scan criteria for a particular category (eg. Antivirus). The configured
scan checks for the specified criteria across all the vendors and the products offered by the vendors.
The access is granted only to the computers fulfilling the specified criteria.
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SystemScan. The System scan provides security for system level attributes such as MAC address. You
can configure scan criteria for a system attribute (e.g. MACAddress). The access is granted only to the
computers fulfilling the specified criteria.

Configuring Advanced Endpoint Analysis Scans

October 5, 2020

You can configure two types of EPA scan, OPSWAT scan and System scan.

Configuring OPSWAT Scan

The following OPSWAT scans are configured on a NetScaler Gateway appliance.

• Product specific scan
• Vendor specific scan
• Generic scan

Note: Scans that a particular product support is displayed in the GUI. Also, the following OPSWAT
scan configuration takes pre-authentication EPA as an example. OPSWAT scan can be configured for
post-authentication EPA as well.

Configuring Product specific OPSWAT Scan

To use the NetScaler GUI to configure product specific OPSWAT scan:

1. Navigate to Configuration > Citrix NetScaler > Global Settings.

2. On the Global Settings page, click Change Preauthentication settings link.

3. On the Configure AAA Preauthentication Parameter page, click OPSWAT EPA Editor link.

4. Under Expression Editor area, select the operating system.
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5. Select the category, for example Antivirus.

6. Select the vendor, for example AVAST Software a.s.

7. Select the product, for example Avast! Free Antivirus.
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8. Click + next to the product drop-down menu to configure the product scan.

9. Optionally enter a value for frequency of scan if you want a periodic scan.

Configuring Vendor specific OPSWAT Scan

To use the NetScaler GUI to configure Vendor specific OPSWAT scan:

1. Navigate to Configuration > Citrix NetScaler > Global Settings.

2. On the Global Settings page, click Change Preauthentication settings link.

3. On the Configure AAA Preauthentication Parameter page, click OPSWAT EPA Editor link.

4. Under Expression Editor area, select the operating system.
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5. Select the category, for example Antivirus.

6. Select the vendor, for example AVAST Software a.s.

7. Select Generic ‘AVAST Software a.s’ Scan vendor specific scan.
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8. Click + next to the product drop-down menu to configure your scan.

9. Optionally enter a value for frequency of scan if you want a periodic scan.

Configuring Generic OPSWAT Scan

To use the NetScaler GUI to configure Generic OPSWAT scan:

1. Navigate to Configuration > Citrix NetScaler > Global Settings.

2. On the Global Settings page, click Change Preauthentication settings link.

3. On the Configure AAA Preauthentication Parameter page, click OPSWAT EPA Editor link.
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4. Under Expression Editor area, select the operating system.

5. Select the category, for example Antivirus.

6. Select “Generic” category specific scan, for example Generic Antivirus Product Scan.

7. Click + next to the product menu to configure your scan.
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8. Optionally enter a value for the frequency of the scan if you want a periodic scan.

Configuring System Scan

The following system scans are configured on a NetScaler Gateway appliance.

• MAC Address
• Domain Check
• Numeric Registry
• Non-numeric Registry
• Windows Update

To use the NetScaler GUI to configure OPSWAT System scan:

1. Navigate to Configuration> Citrix NetScaler> Global Settings.

2. On the Global Settings page, click Change Preauthentication settings link.

3. On the Configure AAA Preauthentication Parameter page, click OPSWAT EPA Editor link.

4. Under Expression Editor area, select the operating system.
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5. Select the desired system scan from the menu. For example, MAC Address.

6. Click the + next to the product menu to configure your scan.

7. Optionally enter a value for the frequency of the scan if you want a periodic scan.
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Upgrade EPA libraries

To use the NetScaler GUI to upgrade EPA libraries:

1. Navigate to Configuration> Citrix NetScaler> Update Client Components.

2. Under Update Client Components, click Upgrade EPA Libraries link.

3. Choose the required file and click Upgrade.

For the list of Windows and MAC Supported applications by OPSWAT for NetScaler scans, see https:
//support.citrix.com/article/CTX234466.

To configure a preauthentication profile using Advanced Endpoint Analysis expressions

1. Navigate to Citrix Gateway > Policies.
2. Select Preauthentication.
3. In the details pane, on the Policies tab, click Add.
4. Enter a name for the profile.
5. Select an action.
6. Optionally, enter the names of any processes to be stopped or files to be deleted on the client

endpoint system.
7. Click Create.

Your profile is now available for use in a preauthentication policy as a Request Action.

To configure a preauthentication policy using Advanced Endpoint Analysis expressions

1. Navigate to Citrix Gateway > Policies.
2. Select Preauthentication.
3. In the details pane, on the Policies tab, click Add.
4. Enter a name for the policy.
5. From the Request Action menu, select the desired profile.
6. In the Expression pane, select OPSWAT EPA Editor.
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7. In the first menu, select a client operating system.
8. In the second menu, select a scan type.
9. When you finish building the policy, click Create.

Bind your Advanced Endpoint Analysis preauthentication policy to enable it.

To bind a preauthentication policy

1. Navigate to NetScaler Gateway > Policies.
2. Select Preauthentication.
3. In the details pane, on the Policies tab, click Add.
4. From the Action menu, select Global Bindings.
5. Click Bind.
6. In the Policies detail pane that appears, select the check box next to the desired policy.
7. Click Insert.
8. The policy is automatically assigned a priority (weight). Click the Priority entry to edit as

needed.
9. Click OK to bind the policy.

To configure an Advanced Endpoint Analysis policy for specific sessions

1. Navigate to NetScaler Gateway > Policies.
2. Select Session.
3. In the details pane, on the Policies tab, click Add.
4. Enter a name for the policy.
5. In the Action menu, do one of the following:

• a. Select an existing action.
• b. Click the plus icon to display the configuration parameters that can be set by the ses-

sion policy. Click the Override Global check box to the right of a configuration option to
activate it. Select Create.

6. In the Expression pane, select OPSWAT EPA Editor.
7. In the menu, select a client operating system.
8. In the second pull menu, select a scan type.
9. When you finish building the policy, click Create.

Bind your Advanced Endpoint Analysis session policy to enable it.

To bind a session policy

1. Navigate to NetScaler Gateway > Policies.
2. Select Session.
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3. In the details pane, on the Policies tab, click Add.
4. From the Action menu, select Global Bindings.
5. Click Bind.
6. In the Policies detail pane that appears, select the check box next to the desired policy.
7. Click Insert.
8. The policy is automatically assigned a priority (weight). Click the Priority entry to edit as

needed.
9. Click OK to bind the policy.

Advanced Endpoint Analysis Policy Expression Reference

October 5, 2020

This reference describes the format and construction of Advanced Endpoint Analysis expressions. The
expression elements contained here are built by the NetScaler Gateway configuration utility automat-
ically and do not require manual configuration.

Expression format

An Advanced Endpoint Analysis expression has the following format:

CLIENT.APPLICATION (SCAN-type_ Product-id_ Method-name _ Method-comparator_
Method-param _…)

Where:

SCAN-type is the type of application being analyzed.

Product-id is the product identification for the analyzed application.

Method-name is the product or system attribute being analyzed.

Method-comparator is the chosen comparator for the analysis.

Method-param is the attribute value or values being analyzed.

For example:

client.application(ANTIVIR_2600_RTP_==_TRUE)

Note: For non-application scan types, the expression prefix is
CLIENT.SYSTEM instead of
CLIENT.APPLICATION.
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Expression strings

Each of the supported scan types in Advanced Endpoint Analysis uses a unique identifier in expres-
sions. The following table enumerates the strings for each type of scan.

| Scan type | Scan type expression string |
| ————————- | ————————— |
| Anti-phishing | ANTIPHI |
| Antispyware | ANTISPY |
| Antivirus | ANTIVIR |
| Backup Client | BACKUP |
| Device Access Control | DEV-CONT |
| Data Loss Prevention | DATA-PREV |
| Desktop Sharing | DESK-SHARE |
| Firewall | FIREWALL |
| Health Agent | HEALTH |
| Hard disk Encryption | HD-ENC |
| Instant Messenger | IM |
| Web Browser | BROWSER |
| P2P | P2P |
| Patch Management | PATCH |
| URL Filtering | URL-FILT |
| MAC address | MAC |
| Domain check | DOMAIN |
| Numeric Registry Scan | REG-NUM |
| Non-Numeric Registry Scan | REG-NON-NUM |

Note: For macOS X specific scans, expressions include the prefix
MAC- before the method type. Therefore, for antivirus and anti-phishing scans, the methods are
MAC-ANTIVIR and
MAC-ANTIPHI respectively. For example:

1 client.application(MAC-ANTIVIR_2600_RTP_==_TRUE)

Application Scan Methods

In configuring Advanced Endpoint Analysis expressions, methods are used to define the parameters of
the endpoint scans. These methods include a method name, a comparator, and a value. The following
tables enumerate all of the methods available for use in expressions.

Common Scan Method:
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The following methods are used for multiple types of application scans.

Method Description Comparator Possible values

VERSION* Specifies version of
application.

<, <=, >, >=, !=, == Version string

AUTHENTIC** Check if given
application is
authentic or not.

== TRUE

ENABLED Check if application is
enabled.

== TRUE

RUNNING Check if application is
running.

== TRUE

COMMENT Comment field
(ignored by scan).
Delineated by []
within expressions.

== Any text

* The VERSION string can specify a decimal string of up to four values, such as 1.2.3.4.

** An AUTHENTIC check verifies the authenticity of the binary files for the application.

Note: You can select a generic version for application scan types. When generic scans are se-
lected, the product ID is 0.

Gateway provides an option to configure Generic scans for each type of software. Using generic scan,
admin can scan the client machine without restricting the scanning check to any particular product.

For Generic scans, scan methods work only if the product installed on users system supports that scan
method. To know which products support particular scan method, please contact Citrix support.

Unique Scan Methods:

The following methods are unique to the specified types of scans.
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Method Description Comparator Possible values

ENABLED-FOR Check whether
anti-phishing
software is enabled
for selected
application.

allof, anyof,noneof For Windows:
Internet Explorer,
Mozilla Firefox,
Google Chrome,
Opera, Safari. For
Mac: Safari, Mozilla
Firefox, Google,
Chrome, Opera

Table 2. Antispyware and Antivirus

Method Description Comparator Possible values

RTP Check whether real
time protection is on
or not.

== TRUE

SCAN-TIME How many minutes
since a full system
scan was performed.

<, <=, >, >=, !=, == Any positive number

VIRDEF-FILE-TIME How many minutes
since virus definition
file was updated (that
is, Number of minutes
between virus
definition file stamp
and current
timestamp).

<, <=, >, >=, !=, == Any positive number

VIRDEF-FILE-VERSION Version of definition
file.

<, <=, >, >=, !=, == Version string

ENGINE-VERSION Engine version. <, <=, >, >=, !=, == Version string

Table 3. Backup client
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Method Description Comparator Possible values

LAST-BK-ACTIVITY How many minutes
since last backup
activity was
completed.

<, <=, >, >=, !=, == Any positive number

Table 4. Data loss prevention

Method Description Comparator Possible values

ENABLED Check whether
application is
enabled or not and
time protection is on
or not on.

== TRUE

Table 5. Health check agent

Method Description Comparator Possible values

SYSTEM-COMPL Check whether
system is in
compliance.

== TRUE

Table 6. Hard disk encryption

Method Description Comparator Possible values

ENC-PATH PATH for checking
encryption status.

NO OPERATOR Any text

ENC-TYPE Check whether
encryption type for
specified path.

allof, anyof, noneof List with following
options:
UNENCRYPTED,
PARTIAL, ENCRYPTED,
VIRTUAL,
SUSPENDED,
PENDING
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Table 7. Web browser

Method Description Comparator Possible values

DEFAULT Check whether set as
default browser.

== TRUE

Table 8. Patch management </caption>

Method Description Comparator Possible values

SCAN-TIME How many minutes
since last scan for
patch was performed.

<, <=, >, >=, !=, == Any positive number

MISSED-PATCH Client system is not
missing patches of
these types.

anyof, noneof ANY Pre-selected
(Pre-selected patches
on Patch Manager
server)

NON

Method Description Comparator Possible values

ADDR Check whether client
machine MAC
addresses are or are
not in given list.

anyof, noneof Editable list

Table 10. Domain membership

Method Description Comparator Possible values

SUFFIX Check whether client
machine exists or
does not exist in given
list.

anyof, noneof Editable list
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Method Description Comparator Possible values

PATH Path for registry
check. In the format:
HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\Secure
Access
Client\EnableAutoUpdate.
No escaping of
special characters is
required. All registry
root keys:
HKEY_LOCAL_MACHINE,
HKEY_CURRENT_USER,
HKEY_USERS,
HKEY_CLASSES_ROOT,
HKEY_CURRENT_CONFIG

NO OPERATOR Any text
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Method Description Comparator Possible values

REDIR-64 Follow 64-bit
redirection. If set to
TRUE, WOW
redirection is
followed (that is,
Registry path is
checked on 32-bit
systems but WOW
redirected path is
checked for 64-bit
systems.) If not set,
WOW redirection is
not followed (that is,
Same registry path is
checked for 32-bit
and 64-bit systems.)
For registry entries
that are not
redirected this setting
has no effect. See the
following article for
the list of registry
keys that get
redirected on 64-bit
systems:
http://msdn.
microsoft.com/en
-us/library/
aa384253%28v=vs
.85%29.aspx

== TRUE

VALUE Expected value for
above path. This scan
works only for registry
types of REG_DWORD
and REG_QWORD.

<, <=, >, >=, !=, == Any number
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Method Description Comparator Possible values

PATH Path for registry
check.

Check Registry scan
for Numeric type.

NO OPERATOR Any text

REDIR-64 Follow 64-bit
redirection

Check registry scan
for Numeric type.

== TRUE

VALUE Expected value for
above path. For string
type registry entries,
the registry value is
directly compared
against the expected
value. For
REG_BINARY registry
entry type, the
registry value is
converted into an
uppercase hex string,
and this string is
compared against the
expected value.

==, != Any text

Troubleshooting Advanced Endpoint Analysis scans

October 5, 2020

To assist in troubleshooting Advanced Endpoint Analysis scans, the client plug-ins write logging infor-
mation to a file on client endpoint systems. These log files can be found in the following directories,
depending on the user’s operating system.

Windows Vista, Windows 7, Windows 8, Windows 8.1, andWindows 10:

C:\Users\<username>\AppData\Local\Citrix\AGEE\nsepa.txt

Windows XP:
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C:\Documents and Settings\All Users\Application Data\Citrix\AGEE\nsepa.txt

Mac OS X systems:

~/Library/Application Support/Citrix/EPAPlugin/epaplugin.log

(Where the ~ symbol indicates the relevant Mac OS X user’s home directory path.)

Managing User Sessions

October 5, 2020

You can manage user sessions in the configuration utility in the Active Users Sessions dialog box. This
dialog box displays a list of active user sessions on the NetScaler Gateway.

You can end user or group sessions in this dialog box by using the user name, group name, or IP ad-
dress.

You can also view active sessions within this dialog box. Session information includes:

• User name
• IP address of the user device
• Port number of the user device
• IP address of the virtual server
• Port number of the virtual server
• Intranet IP address assigned to the user

To view user sessions

1. In the configuration utility, click the Configuration tab and then in the navigation pane, click
NetScaler Gateway.

2. In the details pane, under Monitor Connections, click Active user sessions.
3. View the list of sessions under Sessions.

To refresh the session list

You can retrieve updated information about sessions to NetScaler Gateway.

1. In the configuration utility, click the Configuration tab and then in the navigation pane, click
NetScaler Gateway.

2. In the details pane, under Monitor Connections, click Active user sessions.
3. Click Refresh.
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To end user or group sessions

You can terminate user and group sessions. You can also end a session that has a specific intranet IP
address and subnet mask.

1. In the configuration utility, click the Configuration tab and then in the navigation pane, click
NetScaler Gateway.

2. In the details pane, under Monitor Connections, click Active user sessions.
3. Under Sessions, select a user or group and then click Terminate.

To end a session by using an intranet IP address

1. In the configuration utility, click the Configuration tab and then in the navigation pane, click
NetScaler Gateway.

2. In the details pane, under Monitor Connections, click Active user sessions.
3. Select Intranet IP
4. In Intranet IP, type the IP address.
5. In Netmask, type the subnet mask and then click Terminate.

AlwaysON

October 5, 2020

The AlwaysON feature of NetScaler Gateway ensures that users are always connected to the enterprise
network. This persistent VPN connectivity is achieved by automatic establishment of a VPN tunnel.

Note

AlwaysON feature supports captive portals for NetScaler 12.0 Build 51.24 and later.

When to Use AlwaysON

Use AlwaysON when you need to provide seamless VPN connectivity based on user location and have
to prevent network access by a user who is not connected to a VPN.

The following scenarios illustrate the use of AlwaysON.

• An employee starts the laptop outside the enterprise network and needs assistance to establish
VPN connectivity.
Solution: When the laptop is started outside the enterprise network, AlwaysON seamlessly
establishes a tunnel and provides VPN connectivity.
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• An employee using VPN connectivity moves into the enterprise network. The employee is
switched to enterprise network but remains connected to the VPN tunnel, which is not a
desirable state.
Solution: When the employee moves into the enterprise network, AlwaysOn tears down the
VPN tunnel and seamlessly switches the employee to the enterprise network.

• An employee moves outside the enterprise network and closes the laptop (not shut down). The
employee needs assistance to establish VPN connectivity upon resuming work on the laptop.
Solution: When the employee moves outside the enterprise network, AlwaysON seamlessly
establishes a tunnel and provides VPN connectivity.

• An enterprise wants to regulate the network access provided to its users when they are not con-
nected to a VPN tunnel.
Solution: Depending on the configuration, AlwaysON restricts access, allowing users to access
only the gateway network.

Understanding the AlwaysON Framework

AlwaysON automatically connects a user to a VPN tunnel that the client has previously established.
The first time the user needs a VPN tunnel, the user must connect to the NetScaler Gateway URL and
establish the tunnel. After the AlwaysON configuration is downloaded to the client, this configuration
drives subsequent establishment of the tunnel.

The NetScaler Gateway client executable is always running on the client machine. When the user logs
on or the network changes, the NetScaler Gateway client determines whether or not the user laptop
is on the enterprise network. Depending upon the location and the configuration, the NetScaler Gate-
way client either establishes a tunnel or tears down an existing tunnel.

Tunnel establishment is initiated only after the user logs on to the computer. The NetScaler Gateway
client uses the client machine’s credentials to authenticate with gateway server and tries to establish
a tunnel.

Automatic Reestablishment of a Tunnel

Automatic reestablishment of a tunnel is triggered when a VPN tunnel is torn down by NetScaler Gate-
way.

Note

In End-Point Analysis failure, the NetScaler Gateway client does not reattempt tunnel establish-
ment, but does display an error message. If there is an authentication failure, the Citrix Gateway
client prompts user for credentials.
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Supported user authenticationmethods for seamless tunnel establishment

The supported user authentication methods are as follows:

• Username + AD password: If the Windows user name and password are used for authentication,
the NetScaler Gateway client seamlessly establishes the tunnel by using these credentials.

• User certificate: If user certificate is used for authentication and there is only one certificate
on the machine, the NetScaler Gateway client seamlessly establishes the tunnel by using this
certificate. If multiple client certificates are installed, the tunnel is established after the user has
selected the preferred certificate. The NetScaler Gateway client uses this preference for later
established tunnels.

• User certificate and user name + AD Password: This authentication method is the combination
of previously described authentication methods.

Note

All other authentication mechanisms are supported but the tunnel establishment is not seamless
for any other authentication methods. User intervention is required for all other authentication
methods.

Configuration Requirements for AlwaysON

Enterprise administrator must enforce the following for the managed devices:

• User must not be able to end the process/service for specific configuration
• User must not be able to uninstall the package for specific configuration
• User must not be able to change specific registry entries

Note

The feature might not work as expected if the user has administration privileges, as in the case
of non-managed devices.

Considerations While Enabling the AlwaysON feature

Review the following section before enabling the AlwaysON feature.

Primary Network Access: When the tunnel is established, the traffic to the enterprise network is de-
cided based on split-tunnel configuration. Additional configurations are not provided to override this
behavior.

Proxy settings of client machine: Proxy settings of the client machine are ignored for connecting to
the gateway server.
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Note

The NetScaler appliance’s proxy configuration is not ignored. Only the proxy settings of the client
machine are ignored. Users who have a proxy configured on their systems are notified that the
VPN plug-in has ignored their proxy settings.

When the configuration value is set to “Deny,” the following changes apply:

• Client UI - The logoff and Exit options from the plug-in context menu and plug-in UI are disabled.
Users are not allowed to change the Gateway URL.

• Browser logon - Browser log on to a different gateway is not allowed. Client controls are dis-
abled.

Configuring AlwaysON

To configure AlwaysON, create an AlwaysOn profile on the NetScaler Gateway appliance and apply the
profile.

To create an AlwaysOn profile:

1. In the NetScaler GUI, navigate to Configuration > NetScaler Gateway > Policies > AlwaysON.
2. On the AlwaysON Profiles page, click Add.
3. On the Create AlwaysON Profile page, enter the following details:

• Name – The name for your profile.
• Location Based VPN – Select one of the following settings:

– Remote to enable a client to detect whether or not it is in the enterprise network and
establish the tunnel if not in the enterprise network. This is the default setting.

– Everywhere to let client skip the location detection and establish the tunnelregard-
less of the client’s location

• Client Control – Select one of the following settings:
– Deny to prevent the user from logging off and connecting to another gateway. This is

the default setting.
– Allow to enable user to log off and connect to another gateway.

• Network Access On VPN Failure – Select one of the following settings:
– Full Access to allow network traffic to flow to and from the client when the tunnel is

not established. This is the default setting.
– Only To Gateway to prevent network traffic from flowing to or from the client when

the tunnel is not established. However, the traffic to or from the Gateway IP address
is allowed.

4. Click Create to finish creating your profile.

To apply the AlwaysOn profile:

1. In the NetScaler interface, select Configuration > NetScaler Gateway > Global Settings.
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2. On the Global Settings page, click the Change Global Settings link, and then select the Client
Experience tab.

3. From the AlwaysONProfile Name drop down menu, select the newly created profile, and click
OK.

Note

Similar configuration can be done in Session profile to apply the policies at a group level, server
lever, or a user level.

Behavior summary of different configurations for admin users and non-admin users

The table below summarizes the behavior for different configurations. It also details the possibility of
certain user actions, which can affect AlwaysON functionality.

networkAccessONVPNFailureClient control Non-admin user Admin user

fullaccess Allow The tunnel gets
established
automatically. The
user can log off and
stay off the network.
The user can also
point to another
NetScaler Gateway.

The tunnel gets
established
automatically. The
user can log off and
stay off the enterprise
network. The user
can also point to
another NetScaler
Gateway.

fullaccess Deny The tunnel gets
establish
automatically. The
user cannot log off or
point to another
NetScaler Gateway.

The tunnel gets
established
automatically. The
user can uninstall
NetScaler Gateway
Client or move to
another NetScaler
Gateway.
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networkAccessONVPNFailureClient control Non-admin user Admin user

onlyToGateway Allow The tunnel gets
established
automatically. The
user can log off (no
network access). The
user can also point to
another NetScaler
Gateway, in which
case, the access is
given only to the
newly pointed
NetScaler Gateway.

The tunnel gets
established
automatically. The
user can uninstall
NetScaler Gateway
Client or move to
another NetScaler
Gateway.

onlyToGateway Deny The tunnel gets
establish
automatically. The
user cannot log off or
point to another
NetScaler Gateway.

The tunnel gets
established
automatically. The
user can uninstall
NetScaler Gateway
Client or move to
another NetScaler
Gateway.

Configuring Unified Gateway

October 5, 2020

NetScaler with Unified Gateway: One URL

NetScaler with Unified Gateway enables simplified secure access to any application through a single
URL for desktop and mobile users. Behind this single URL, administrators have a single point for con-
figuration, security, and control of remote access to applications. And remote users have an improved
experience with seamless single sign-on to all the applications they need along with login/logout once
ease of use.

To accomplish this, NetScaler with Unified Gateway, along with NetScaler’s Content Switching capac-
ities and extensive authentication infrastructure, provides access to organizational sites and apps
through this single URL. Additionally, remote users can use iOS or Android mobile devices and Linux,
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PC or Mac systems with the NetScaler Gateway client plug-ins for uniform access to the Unified Gate-
way URL, wherever they may be.

A Unified Gateway deployment allows single URL access to the following categories of applications:

• Intranet applications.
• Clientless applications
• Software as a Service applications
• Preconfigured applications served by NetScaler
• Citrix XenApp or XenDesktop published applications

Intranet applications may be any web-based application that resides inside the secure enterprise
network. These are internal resources such as an organizational intranet site, a bug tracking applica-
tion, or a wiki.

Typically also residing inside the secure enterprise network, the clientless applicationsUnified Gate-
way provides single URL access to are Outlook Web Access and SharePoint. These applications pro-
vide access to Exchange email and team resources without dedicated client software which need to
be available to remote users.

SaaS applications, also commonly know as Cloud Apps, are external, cloud-based applications that
organizations depend on such as Sharefile, SalesForce, or NetSuite. SAML based single sign-on is sup-
ported with those SaaS applications that offer it.

Some organizations may have preconfigured NetScaler served applications deployed in an
NetScaler ADC load balanced configuration; often times this is also referred as a ‘reverse-proxy’
application. Unified Gateway supports these applications when a virtual server for the deployment
resides on the same NetScaler Unified Gateway instance or appliance. These applications may
have their own authentication configuration which is independent of that for the Unified Gateway
configuration.

Any published Citrix XenApp and XenDesktop published applications can be made available
through a Unified Gateway URL. SmartAccess and SmartControl policies can optionally be applied to
granular policy and access control to these resources.

The Unified Gateway ConfigurationWizard

The recommended method to configuring a NetScaler with Unified Gateway deployment is to use
the Unified Gateway configuration wizard. The wizard walks you through configuration and creates
all the necessary virtual servers, policies, and expressions, and applies settings based on the details
provided. After initial setup, the wizard can be used to manage your deployment and monitor its
operation.
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Note
The Unified Gateway configuration wizard does not perform an initial systems configuration.
Your NetScaler Gateway appliance or VPX instance must have basic installation completed be-
fore configuring Unified Gateway. Refer to the installation instructions for Configuring NetScaler
Gateway with the First-time Setup Wizard to complete basic configuration.

The Unified Gateway elements configured by the wizard are:

• The Unified Gateway primary virtual server
• An SSL Server Certificate for the Unified Gateway virtual server
• A primary and any optional secondary authentication configuration
• A portal theme selection and optional customization
• The user applications that are to be accessed through the Unified Gateway portal

For each of these elements, you need to provide configuration information. For a basic Unified Gate-
way deployment, the following information is needed.

• For the primary Unified Gateway virtual server, the public IP address and IP port number for
the deployment. This will be the IP address that resolves in DNS to the Unified Gateway URL’s
hostname. For example, if your Unified Gateway deployment’s URL is https://mycompany.
com/, the IP address must to resolve to mycompany.com.

• The signed SSL Server Certificate for the deployment. NetScaler Gateway supports PEM or PFX
formatted certificates.

• Primary authentication server information. The authentication systems supported for this
authentication configuration are LDAP/Active Directory, RADIUS, and Certificate based. A
secondary LDAP or RADIUS authentication configuration may be created as well. The authenti-
cation server IP address(es) must be provided along with any relevant administrator credentials
or directory attributes. For Certificate authentication, the device certificate attributes and a CA
certificate must be provided.

• A portal theme may be selected. If a customized or branded portal design is desired, custom
graphics may be uploaded to the system with the wizard.

• For web-based user applications, the URLs for the individual applications must be specified.
For web applications that are to utilize SAML single sign-on authentication, the utility collects
the Assertion Consumer Service URL along with other optional SAML parameters. Gather the
configuration details in advance for the applications that use a SAML authentication system.

• For XenDesktop and XenApp published resources to be made available through the Unified Gate-
way deployment, you need to specify the integration point (StoreFront, the Web Interface, or
Web Interface on NetScaler). The utility requires the integration point’s fully qualified domain
name, the site path, the single sign-on domain, the Secure Ticket Authority (STA) server URL,
and others depending on the type of integration point.
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Additional Configuration Management

For site specific settings not available in the Unified Gateway configuration utility, such as alternative
SSL settings or session policies, you can manage the needed settings in the NetScaler Gateway con-
figuration utility. You can modify these settings on the Content Switching or VPN virtual servers once
they are created by the Unified Gateway configuration utility.

Content Switching Virtual Server

This is the NetScaler configuration entity behind the deployment’s main IP address and URL. The SSL
Server Certificates and parameters are managed on this virtual server. As this virtual server is the
responding network host for the deployment, the ICMP server response and RHI state can be modi-
fied on this virtual server, if necessary. The Content Switching virtual server can be found under the
Configuration tab at Traffic Management > Content Switching > Virtual Servers.

VPN Virtual Server

All of the other VPN parameters, profiles, and policy bindings for the Unified Gateway configuration
are managed on this virtual server, including the main authentication configuration. This entity is
managed under the Configuration tab at NetScaler Gateway > Virtual Servers. The relevant VPN virtual
server’s name will include the name given to the Content Switching virtual server during initial Unified
Gateway configuration.

Note
The VPN virtual servers created for a Unified Gateway deployment are non-addressable and as-
signed the 0.0.0.0 IP address.

Deploying in a Double-Hop DMZ

October 5, 2020

Some organizations use three firewalls to protect their internal networks. The three firewalls divide
the DMZ into two stages to provide an extra layer of security for the internal network. This network
configuration is called a double-hop DMZ.

Figure 1. NetScaler Gateway appliances deployed in a double-hop DMZ
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Note: For illustration purposes, the preceding example describes a double-hop configuration
using three firewalls with StoreFront, the Web Interface and XenApp, but you can also have a
double-hop DMZ with one appliance in the DMZ and one appliance in the secure network. If
you configure a double-hop configuration with one appliance in the DMZ and one in the secure
network, you can ignore the instructions for opening ports on the third firewall.

You can configure a double-hop DMZ to work with Citrix StoreFront or the Web Interface installed par-
allel to the NetScaler Gateway proxy. Users connect by using Citrix Receiver.

Note: If you deploy NetScaler Gateway in a double-hop DMZ with StoreFront, email-based auto-
discovery for Receiver does not work.

Deploying in a Double-Hop DMZ

October 5, 2020

Some organizations use three firewalls to protect their internal networks. The three firewalls divide
the DMZ into two stages to provide an extra layer of security for the internal network. This network
configuration is called a double-hop DMZ.

Figure 1. NetScaler Gateway appliances deployed in a double-hop DMZ
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Note: For illustration purposes, the preceding example describes a double-hop configuration
using three firewalls with StoreFront, the Web Interface and XenApp, but you can also have a
double-hop DMZ with one appliance in the DMZ and one appliance in the secure network. If
you configure a double-hop configuration with one appliance in the DMZ and one in the secure
network, you can ignore the instructions for opening ports on the third firewall.

You can configure a double-hop DMZ to work with Citrix StoreFront or the Web Interface installed par-
allel to the NetScaler Gateway proxy. Users connect by using Citrix Receiver.

Note: If you deploy NetScaler Gateway in a double-hop DMZ with StoreFront, email-based auto-
discovery for Receiver does not work.

Deploying NetScaler Gateway in a Double-Hop DMZ

October 5, 2020

Some organizations use three firewalls to protect their internal networks. The three firewalls divide
the DMZ into two stages to provide an extra layer of security for the internal network. This network
configuration is called a double-hop DMZ. You can deploy NetScaler Gateway in a double-hop DMZ
with XenApp and StoreFront.

Figure 1. NetScaler Gateway appliances deployed in a double-hop DMZ

Note: For illustration purposes, the preceding example describes a double-hop configuration using
three firewalls and the Web Interface, but you can also have a double-hop DMZ with one appliance in
the DMZ and one appliance in the secure network. If you configure a double-hop configuration with
one appliance in the DMZ and one in the secure network, you can ignore the instructions for opening
ports on the third firewall.
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You can configure a double-hop DMZ to work with Citrix StoreFront or the Web Interface. Users con-
nect by using Citrix Receiver.

Note

If you deploy NetScaler Gateway in a double-hop DMZ with StoreFront, email-based auto-
discovery for Receiver does not work.

How a Double-Hop Deployment Works

October 5, 2020

You can deploy NetScaler Gateway appliances in a double-hop DMZ to control access to servers run-
ning Citrix XenApp. The connections in a double-hop deployment occur as follows:

• Users connect to NetScaler Gateway in the first DMZ by using a web browser and by using Citrix
Receiver to select a published application.

• Citrix Receiver starts on the user device. The user connects to NetScaler Gateway to access the
published application running in the server farm in the secure network.

Note: Worx Home and the NetScaler Gateway Plug-in are not supported in a double-hop DMZ
deployment. Only Citrix Receiver is used for user connections.

• NetScaler Gateway in the first DMZ handles user connections and performs the security func-
tions of an SSL VPN. This NetScaler Gateway encrypts user connections, determines how the
users are authenticated, and controls access to the servers in the internal network.

• NetScaler Gateway in the second DMZ serves as a NetScaler Gateway proxy device. This
NetScaler Gateway enables the ICA traffic to traverse the second DMZ to complete user con-
nections to the server farm. Communications between NetScaler Gateway in the first DMZ and
the Secure Ticket Authority (STA) in the internal network are also proxied through NetScaler
Gateway in the second DMZ.

NetScaler Gateway supports IPv4 and IPv6 connections. You can use the configuration utility to con-
figure the IPv6 address.

Communication Flow in a Double-Hop DMZ Deployment

October 5, 2020

To understand the configuration issues involved in a double-hop DMZ deployment, you should have a
basic understanding of how the various NetScaler Gateway and XenApp components in a double-hop
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DMZ deployment communicate to support a user connection. The connection process for StoreFront
and the Web Interface is the same.

Although the user connection process occurs in one continuous flow, the steps are detailed in the four
following topics:

• Authenticating Users
• Creating a Session Ticket
• Starting Citrix Receiver
• Completing the Connection

The following figure shows the steps that occur in the user connection process to either StoreFront
or the Web Interface. In the secure network, computers running XenApp are also running the Secure
Ticket Authority (STA), XML Service, and published applications.

Figure 1. Double-hop DMZ user connection process

Authenticating Users

October 5, 2020

Authenticating users is the first step of the user connection process in a double-hop DMZ deployment.
The following figure shows the user connection process in this deployment.

Figure 1. Communication flow for user authentication in a double-hop DMZ
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During the user authentication stage, the following basic process occurs:

1. A user types the address of NetScaler Gateway, such as https://www.ng.wxyco.com in a web
browser to connect to NetScaler Gateway in the first DMZ. If you enabled logon page authenti-
cation on NetScaler Gateway, NetScaler Gateway authenticates the user.

2. NetScaler Gateway in the first DMZ receives the request.
3. NetScaler Gateway redirects the web browser connection to the Web Interface.
4. The Web Interface sends the user credentials to the Citrix XML Service running in the server farm

in the internal network.
5. The Citrix XML Service authenticates the user.
6. The XML Service creates a list of the published applications that the user is authorized to access

and sends this list to the Web Interface.

If you enable authentication on NetScaler Gateway, the appliance sends the NetScaler Gateway logon
page to the user. The user enters authentication credentials on the logon page and the appliance
authenticates the user. NetScaler Gateway then returns the user credentials to the Web Interface.

If you do not enable authentication, NetScaler Gateway does not perform authentication. The appli-
ance connects to the Web Interface, retrieves the Web Interface logon page, and sends the Web Inter-
face logon page to the user. The user enters authentication credentials on the Web Interface logon
page and NetScaler Gateway passes the user credentials back to the Web Interface.

Creating a Session Ticket

October 5, 2020

Creating the session ticket is the second stage of the user connection process in a double-hop DMZ
deployment.

During the session ticket creation stage, the following basic process occurs:

1. The Web Interface communicates with both the XML Service and the Secure Ticket Authority
(STA) in the internal network to produce session tickets for each of the published applications
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the user is authorized to access. The session ticket contains an alias address for the computer
running Citrix XenApp that hosts a published application.

2. The STA saves the IP addresses of the servers that host the published applications. The STA
then sends the requested session tickets to the Web Interface. Each session ticket includes an
alias that represents the IP address of the server that hosts the published application, but not
the actual IP address.

3. The Web Interface generates an ICA file for each of the published applications. The ICA file con-
tains the ticket issued by the STA. The Web Interface then creates and populates a web page
with a list of links to the published applications and sends this web page to the web browser on
the user device.

Starting Citrix Receiver

October 5, 2020

Starting Citrix Receiver is the third stage of the user connection process in a double-hop DMZ deploy-
ment. The basic process is as follows:

1. The user clicks a link to a published application in the Web Interface. The Web Interface sends
the ICA file for that published application to the browser for the user device.

The ICA file contains data instructing the web browser to start Receiver.

The ICA file also contains the fully qualified domain name (FQDN) or the Domain Name System
(DNS) name of the NetScaler Gateway in the first DMZ.

2. The web browser starts Receiver and the user connects to NetScaler Gateway in the first DMZ
by using the NetScaler Gateway name in the ICA file. Initial SSL/TLS handshaking occurs to
establish the identity of the server running NetScaler Gateway.

Completing the Connection

October 5, 2020

Completing the connection is the fourth and last stage of the user connection process in a double-hop
DMZ deployment.

During the connection completion stage, the following basic process occurs:

• The user clicks a link to a published application in the Web Interface.
• The web browser receives the ICA file generated by the Web Interface and starts Citrix Receiver.

Note: The ICA file contains code that instructs the web browser to start Receiver.

© 1999-2021 Citrix Systems, Inc. All rights reserved. 379



NetScaler Gateway 12.0

• Receiver initiates an ICA connection to NetScaler Gateway in the first DMZ.
• NetScaler Gateway in the first DMZ communicates with the Secure Ticket Authority (STA) in the

internal network to resolve the alias address in the session ticket to the real IP address of a
computer running XenApp or StoreFront. This communication is proxied through the second
DMZ by the NetScaler Gateway proxy.

• NetScaler Gateway in the first DMZ completes the ICA connection to Reciever.
• Receiver can now communicate through both NetScaler Gateway appliances to the computer

running XenApp on the internal network.

The detailed steps for completing the user connection process are as follows:

1. Receiver sends the STA ticket for the published application to NetScaler Gateway in the first
DMZ.

2. NetScaler Gateway in the first DMZ contacts the STA in the internal network for ticket validation.
To contact the STA, NetScaler Gateway establishes a SOCKS or SOCKS with SSL connection to
the NetScaler Gateway proxy in the second DMZ.

3. The NetScaler Gateway proxy in the second DMZ passes the ticket validation request to the STA
in the internal network. The STA validates the ticket and maps it to the computer running Xe-
nApp that hosts the published application.

4. The STA sends a response to the NetScaler Gateway proxy in the second DMZ, which is passed to
NetScaler Gateway in the first DMZ. This response completes the ticket validation and includes
the IP address of the computer that hosts the published application.

5. NetScaler Gateway in the first DMZ incorporates the address of the XenApp server into the user
connection packet and sends this packet to the NetScaler Gateway proxy in the second DMZ.

6. The NetScaler Gateway proxy in the second DMZ makes a connection request to the server spec-
ified in the connection packet.

7. The server responds to the NetScaler Gateway proxy in the second DMZ. The NetScaler Gateway
proxy in the second DMZ passes this response to NetScaler Gateway in the first DMZ to complete
the connection between the server and NetScaler Gateway in the first DMZ.

8. NetScaler Gateway in the first DMZ completes the SSL/TLS handshake with the user device by
passing the final connection packet to the user device. The connection from the user device to
the server is established.

9. ICA traffic flows between the user device and the server through NetScaler Gateway in the first
DMZ and the NetScaler Gateway proxy in the second DMZ.

Preparing for a Double-Hop DMZ Deployment

October 5, 2020

To prepare appropriately and avoid unnecessary problems when configuring a double-hop DMZ de-
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ployment, you should answer the following questions:.

• Do I want to support load balancing?
• What ports do I need to open on the firewalls?
• How many SSL certificates will I need?
• What components do I need before I begin the deployment?

The topics in this section contain information to help you answer these questions as appropriate for
your environment.

Components Required to Begin the Deployment

Before you begin a double-hop DMZ deployment, ensure that you have the following components:

• At minimum, two NetScaler Gateway appliances must be available (one for each DMZ).

• Servers running XenApp must be installed and operational in the internal network.

• The Web Interface or Storefront must be installed in the second DMZ and configured to operate
with the server farm in the internal network.

• At minimum, one SSL server certificate must be installed on NetScaler Gateway in the first DMZ.
This certificate ensures that the Web browser and user connections to NetScaler Gateway are
encrypted.

You need additional certificates if you want to encrypt connections that occur among the other
components in a double-hop DMZ deployment.

Installing and Configuring NetScaler Gateway in a Double-Hop DMZ

October 5, 2020

You need to complete several steps to deploy NetScaler Gateway in a double-hop DMZ. The steps in-
clude installation of appliances in both DMZs and configuring the appliances for user device connec-
tions.

Installing NetScaler Gateway in the First DMZ

To install Citrix Gateway in the first DMZ, follow the instructions in Install the hardware.

If you are installing multiple Citrix Gateway appliances in the first DMZ, you can deploy the appliances
behind a load balancer.
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Configuring NetScaler Gateway in the First DMZ

In a double-hop DMZ deployment, it is mandatory that you configure each NetScaler Gateway in the
first DMZ to redirect connections to either StoreFront or the Web Interface in the second DMZ.

Redirection to StoreFront or the Web Interface is performed at the NetScaler Gateway Global or virtual
server level. To connect to the Web Interface through NetScaler Gateway, a user must be associated
with an NetScaler Gateway user group for which redirection to the Web Interface is enabled.

Installing NetScaler Gateway in the Second DMZ

The NetScaler Gateway appliance in the second DMZ is called the NetScaler Gateway proxy because
it proxies ICA and Secure Ticket Authority (STA) traffic across the second DMZ.

Follow the instructions in Install the hardware to install each NetScaler Gateway appliance in the sec-
ond DMZ.

You can use this installation procedure to install additional appliances in the second DMZ.

After you install NetScaler Gateway appliances in the second DMZ, you configure the following set-
tings:

• Configure a virtual server on the NetScaler Gateway proxy.
• Configure NetScaler Gateway appliances in the first and second DMZ to communicate with each

other.
• Bind the NetScaler Gateway in the second DMZ globally or to a virtual server.
• Configure the STA on the appliance in the first DMZ.
• Open ports in the firewalls separating the DMZ.
• Install certificates on the appliances.

Configuring Settings on the Virtual Servers on the NetScaler Gateway
proxy

October 5, 2020

To allow connections to pass between the NetScaler Gateway appliances, you enable double-hop in
the virtual server on the NetScaler Gateway proxy.

When users connect, the NetScaler Gateway appliance authenticates users and then proxies the
connection to the proxy appliance. On the NetScaler Gateway in the first DMZ, configure the virtual
server to communicate with NetScaler Gateway in the second DMZ. Do not configure authentication
or policies on the NetScaler Gateway proxy. Citrix recommends disabling authentication on the
virtual server.
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To enable double hop on the virtual server on the NetScaler Gateway proxy by using
the GUI

1. Navigate to Configuration > NetScaler Gateway > Virtual Servers.

2. Select a virtual server and click Edit.

3. In the Basic Settings section, click the edit icon and then click More.

4. Select Double Hop.

5. Click OK.

To disable authentication on the virtual server on the NetScaler Gateway proxy by
using the GUI

1. Navigate to Configuration > NetScaler Gateway > Virtual Servers.

2. Select a virtual server and click Edit.

3. In the Basic Settings section, click the edit icon and then click More.
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4. Clear the Enable Authentication check box.

5. Click OK.

Configuring the Appliance to Communicate with the Appliance Proxy

October 5, 2020

When you deploy NetScaler Gateway in a double-hop DMZ, you must configure NetScaler Gateway in
the first DMZ to communicate with the NetScaler Gateway proxy in the second DMZ.

If you deploy multiple appliances in the second DMZ, you configure each appliance in the first DMZ to
communicate with every proxy appliance in the second DMZ.

Note: If you want to use IPv6, you configure the next hop server by using the configuration utility. To
do so, expand
NetScaler Gateway > Resources and then click
Next Hop Servers. Follow the steps in the following procedure and then select the
IPv6 check box.
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To configure NetScaler Gateway to communicate with the NetScaler Gateway Proxy

1. In the configuration utility, on the Configuration tab, expand NetScaler Gateway > Resources
and then click Next Hop Servers.

2. In the details pane, click Add.
3. In Name, type a name for the first NetScaler Gateway.
4. In IP address, type the virtual server IP address of the NetScaler Gateway proxy in the second

DMZ.
5. In Port, type the port number, click Create and then click Close. If you are using a secure port,

such as 443, select Secure.

You must configure each NetScaler Gateway installed in the first DMZ to communicate with all
NetScaler Gateway proxy appliances installed in the second DMZ.

After you configure the settings for the NetScaler Gateway proxy, bind the policy to Next Hop Servers
in NetScaler Gateway Global or to a virtual server.

To bind the NetScaler Gateway next hop server globally

1. In the configuration utility, on the Configuration tab, expand NetScaler Gateway > Resources
and then click Next Hop Servers.

2. In the details pane, select a next hop server and then in Action, select Global Bindings.
3. In the Configure Next Hop Server Global Binding dialog box, in Next Hop Server Name, select

the proxy appliance and then click OK.

To bind the NetScaler Gateway next hop server to a virtual server

1. In the configuration utility, on the Configuration tab, expand NetScaler Gateway and then click
Virtual Servers.

2. In the details pane, select a virtual server and then click Open.
3. On the Published Applications tab, under Next Hop Servers, click an item and then click OK.

You can also add a next hop server from the Published Applications tab.

Configuring NetScaler Gateway to Handle the STA and ICA Traffic

October 5, 2020

When you deploy NetScaler Gateway in a double-hop DMZ, you must configure NetScaler Gateway in
the first DMZ to handle communications with the Secure Ticket Authority (STA) and ICA traffic appro-
priately. The server running the STA can be bound either globally or to a virtual server.
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After you configure the STA, you can bind the STA either globally or to a virtual server.

To configure and bind the STA globally:

1. In the configuration utility, on the Configuration tab, expand NetScaler Gateway and then click
Global Settings.

2. In the details pane, under Servers, click Bind/Unbind STA Servers to be used by the Secure Ticket
Authority.

3. In the Bind/Unbind STA Servers dialog box, click Add.
4. In the Configure STA Server dialog box, in URL, type the path to the server running the STA, such

as http://mycompany.com or http://ipAddress and then click Create.

To configure and bind the STA to a virtual server:

1. In the configuration utility, on the Configuration tab, expand NetScaler Gateway and then click
Virtual Servers.

2. In the details pane, select a virtual server and then click Open.
3. On the Published Applications tab, under Secure Ticket Authority, click Add.
4. In the Configure STA Server dialog box, in URL, type the path to the server running the STA, such

as http://mycompany.com or http://ipAddress and then click Create.

Opening the Appropriate Ports on the Firewalls

October 5, 2020

You must ensure that the appropriate ports are open on the firewalls to support the different con-
nections that occur among the various components involved in a double-hop DMZ deployment. For
more information about the connection process, see Communication Flow in a Double-Hop DMZ De-
ployment.

The following figure shows common ports that can be used in a double-hop DMZ deployment.
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The following table shows the connections that occur through the first firewall and the ports that must
be open to support the connections.

Connections through the first firewall Ports used

The web browser from the Internet connects to
NetScaler Gateway in the first DMZ. Note:
NetScaler Gateway includes an option to
redirect connections that are made on port 80
to a secure port. If you enable this option on
NetScaler Gateway, you can open port 80
through the first firewall. When a user makes
an unencrypted connection to NetScaler
Gateway on port 80, NetScaler Gateway
automatically redirects the connection to a
secure port.

Open TCP port 443 through the first firewall.

Citrix Receiver from the Internet connects to
NetScaler Gateway in the first DMZ.

Open TCP port 443 through the first firewall.

The following table shows the connections that occur through the second firewall and the ports that
must be open to support the connections.

Connections through the second firewall Ports used

NetScaler Gateway in the first DMZ connects to
the Web Interface in the second DMZ.

Open either TCP port 80 for an unsecure
connection or TCP port 443 for a secure
connection through the second firewall.
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Connections through the second firewall Ports used

NetScaler Gateway in the first DMZ connects to
NetScaler Gateway in the second DMZ.

Open TCP port 443 for a secure SOCKS
connection through the second firewall.

If you enabled authentication on NetScaler
Gateway in the first DMZ, this appliance might
need to connect to an authentication server in
the internal network.

Open the TCP port on which the authentication
server listens for connections. Examples
include port 1812 for RADIUS and port 389 for
LDAP.

The following table shows the connections that occur through the third firewall and the ports that
must be open to support the connections.

Connections through the third firewall Ports used

StoreFront or the Web Interface in the second
DMZ connects to the XML Service hosted on a
server in the internal network.

Open either port 80 for an unsecure
connection or port 443 for a secure connection
through the third firewall.

StoreFront or the Web Interface in the second
DMZ connects to the Secure Ticket Authority
(STA) hosted on a server in the internal
network.

Open either port 80 for an unsecure
connection or port 443 for a secure connection
through the third firewall.

NetScaler Gateway in the second DMZ connects
to the STA residing in the secure network.

Open either port 80 for an unsecure
connection or port 443 for a secure connection
through the third firewall.

NetScaler Gateway in the second DMZ makes
an ICA connection to a published application
or virtual desktop on a server in the internal
network.

Open TCP port 1494 to support ICA
connections through the third firewall. If you
enabled session reliability on XenApp, open
TCP port 2598 instead of 1494.

If you enabled authentication on NetScaler
Gateway in the first DMZ, this appliance may
need to connect to an authentication server in
the internal network.

Open the TCP port on which the authentication
server listens for connections. Examples
include port 1812 for RADIUS and port 389 for
LDAP.

Managing SSL Certificates in a Double-Hop DMZ Deployment

October 5, 2020
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You must install the SSL certificates necessary to encrypt the connections among components in a
double-hop DMZ deployment.

In a double-hop DMZ deployment, several different types of connections occur among the various
components involved in the deployment. There is no end-to-end SSL encryption of these connec-
tions. However, each connection can be encrypted individually.

Encrypting a connection requires you to install the appropriate SSL certificate (either a trusted root
or a server certificate) on the components involved in the connection.

The following table shows the connections that occur through the first firewall and the SSL certificates
required to encrypt each of these connections. Encrypting the connections through the first firewall
is mandatory to secure traffic sent over the Internet.

Connections through the first firewall Certificates required for encryption

The web browser from the Internet connects to
NetScaler Gateway in the first DMZ.

NetScaler Gateway in the first DMZ must have
an SSL server certificate installed. The web
browser must have a root certificate installed
that is signed by the same Certificate Authority
(CA) as the server certificate on NetScaler
Gateway.

Citrix Receiver from the Internet connects to
NetScaler Gateway in the first DMZ.

The certificate management for this
connection is the same as the web browser to
NetScaler Gateway connection. If you installed
the certificates to encrypt the web browser
connection, this connection is also encrypted
using those certificates.

The following table shows the connections that occur through the second firewall and the SSL certifi-
cates required to encrypt each of these connections. Encrypting these connections enhances security
but is not mandatory.

Connections through the second firewall Certificates required for encryption

NetScaler Gateway in the first DMZ connects to
the Web Interface in the second DMZ.

StoreFront or the Web Interface must have an
SSL server certificate installed. NetScaler
Gateway in the first DMZ must have a root
certificate installed that is signed by the same
CA as the server certificate on the Web
Interface.
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Connections through the second firewall Certificates required for encryption

NetScaler Gateway in the first DMZ connects to
NetScaler Gateway in the second DMZ.

NetScaler Gateway in the second DMZ must
have an SSL server certificate installed.
NetScaler Gateway in the first DMZ must have a
root certificate installed that is signed by the
same CA as the server certificate on NetScaler
Gateway in the second DMZ.

The following table below shows the connections that occur through the third firewall and the SSL
certificates required to encrypt each of these connections. Encrypting these connections enhances
security but is not mandatory.

Connections through the third firewall Certificates required for encryption

StoreFront or the Web Interface in the second
DMZ connects to the XML Service hosted on a
server in the internal network.

If the XML Service runs on Microsoft Internet
Information Services (IIS) server on the XenApp
server, an SSL server certificate must be
installed on the IIS server. If the XML Service is
a standard Windows service (does not reside in
IIS), an SSL server certificate must be installed
within the SSL Relay on the server. StoreFront
or the Web Interface must have a root
certificate installed that is signed by the same
CA as the server certificate installed on either
the Microsoft IIS server or the SSL Relay.

StoreFront or the Web Interface in the second
DMZ connects to the STA hosted on a server in
the internal network.

The certificate management for this
connection is the same as the Web Interface to
XML Service connection. You can use the same
certificates to encrypt this connection. (The
server certificate must reside on either the
Microsoft IIS server or the SSL Relay. A
corresponding root certificate must be
installed on the Web Interface.)
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Connections through the third firewall Certificates required for encryption

NetScaler Gateway in the second DMZ
connects to the STA hosted on a server in the
internal network.

The SSL server certificate management for the
STA in this connection is the same as described
for the two previous connections discussed in
this table. (The server certificate must reside
on either the Microsoft IIS server or the SSL
Relay.) NetScaler Gateway in the second DMZ
must have a root certificate installed that is
signed by the same CA as the server certificate
used by the STA and XML service.

NetScaler Gateway in the second DMZ makes
an ICA connection to a published application
on a server in the internal network.

An SSL server certificate must be installed
within the SSL Relay on the server hosting the
published application. NetScaler Gateway
proxy in the second DMZ must have a root
certificate installed that is signed by the same
CA as the server certificate installed within the
SSL Relay.

Using High Availability

October 5, 2020

A high availability deployment of two NetScaler Gateway appliances can provide uninterrupted oper-
ation in any transaction. When you configure one appliance as the primary node and the other as the
secondary node, the primary node accepts connections and manages servers while the secondary
node monitors the primary. If, for any reason, the primary node is unable to accept connections, the
secondary node takes over.

The secondary node monitors the primary by sending periodic messages (often called heartbeat mes-
sages or health checks) to determine whether the primary node is accepting connections. If a health
check fails, the secondary node retries the connection for a specified period, after which it determines
that the primary node is not functioning normally. The secondary node then takes over for the pri-
mary (a process called failover).

After a failover, all clients must reestablish their connections to the managed servers, but the session
persistence rules are maintained as they were before the failover.

With Web server logging persistence enabled, no log data is lost due to the failover. For logging persis-
tence to be enabled, the log server configuration must carry entries for both systems in the log.conf
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file.

The following figure shows a network configuration with a high availability pair.

Figure 1. NetScaler Gateway Appliances in a High Availability Configuration

The basic steps to configure high availability are as follows:

1. Create a basic setup, with both nodes in the same subnet.
2. Customize the intervals at which the nodes communicate health-check information.
3. Customize the process by which nodes maintain synchronization.
4. Customize the propagation of commands from the primary to the secondary.
5. Optionally, configure fail-safe mode to prevent a situation in which neither node is primary.
6. Configure virtual MAC addresses if your environment includes devices that do not accept

NetScaler Gateway gratuitous ARP messages.

When you are ready for a more complex configuration, you can configure high availability nodes in
different subnets.

To improve the reliability of your high availability setup, you can configure route monitors and create
redundant links. In some situations, such as when troubleshooting or performing maintenance tasks,
you might want to force a node to fail over (assign primary status to the other node), or you might want
to force the secondary node to stay secondary or the primary node to stay primary.
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How high availability works

October 5, 2020

When you configure NetScaler Gateway in a high availability pair, the secondary NetScaler Gateway
monitors the first appliance by sending periodic messages, also called a heartbeat message or health
check, to determine if the first appliance is accepting connections. If a health check fails, the sec-
ondary NetScaler Gateway tries the connection again for a specified amount of time until it deter-
mines that the primary appliance is not working. If the secondary appliance confirms the health check
failure, the secondary NetScaler Gateway takes over for the primary NetScaler Gateway. This is called
failover.

The following ports are used to exchange information related to high availability between NetScaler
Gateway appliances:

• UDP port 3003 is used to exchange hello packets for communicating the status for intervals.
• TCP port 3010 is used for the high availability configuration synchronization.
• TCP port 3011 is used to synchronize configuration settings.

Guidelines for configuring high availability

Before configuring a high availability pair, you should review these guidelines:

• Each NetScaler Gateway appliance must be running the same version of the NetScaler Gateway
software. You can find the version number at the top of the page in the configuration utility.

• NetScaler Gateway does not automatically synchronize passwords between two appliances.
You can choose to configure each NetScaler Gateway with the user name and password of the
other appliance in the pair.

• Entries in the configuration file, ns.conf, on both the primary and the secondary NetScaler Gate-
way must match, with the following exceptions:

– The primary and secondary NetScaler Gateway appliance must each be configured with
its own unique system IP address. Use the Setup Wizard to configure or modify the system
IP address on either NetScaler Gateway.

– In a high availability pair, the NetScaler Gateway ID and associated IP address must point
to the other NetScaler Gateway.
For example, if you have two appliances, named AG1 and AG2, you must configure AG1 with
the unique NetScaler Gateway ID and IP address of AG2. You must configure AG2 with the
unique NetScaler Gateway ID and IP address of AG1.
Note: Each NetScaler Gateway appliance are always identified as Node 0. Configure each
appliance with a unique node ID.

• Each appliance in the high availability pair must have the same license. For more information
about licensing, see Licensing.
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• If you create a configuration file on either node by using a method that does not go directly
through the configuration utility or the command-line interface (for example, importing SSL
certificates, or changing to startup scripts), you must copy the configuration file to the other
node or create an identical file on that node.

• When you configure a high availability pair, make sure the mapped IP addresses and default
gateway address of both the primary and the secondary appliances are identical. If necessary,
you can change the mapped IP address at any time by running the Setup Wizard. For more
information, see Configuring Initial Settings by Using the Setup Wizard.

You can use the pre-installation checklist to view a list of the specific settings you need to configure in
a high availability deployment, For details, see Pre-Installation Checklist.

Configuring settings for high availability

October 5, 2020

To set up a high availability configuration, you create two nodes, each of which defines the other’s
NetScaler Gateway IP address as a remote node. You can start by logging on to one of the two
NetScaler appliances that you want to configure for high availability and add a node. Specify the
other appliance’s NetScaler Gateway IP address as the address of the new node. Then, log on to the
other appliance and add a node that has the NetScaler Gateway IP address of the first appliance. An
algorithm determines which node becomes primary and which becomes secondary.

Before you configure the appliances, add a high availability node. This node represents either the
first or second NetScaler Gateway in the high availability pair. To configure high availability, you first
create the node and then you configure the high availability settings.

To add a high availability node

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and
then click High Availability.

2. In the details pane, on the Nodes tab, click Add.
3. In the High Availability Setup dialog box, in the HA Setup dialog box, in Remote Node IP Address

text box, type the NSIP address of the NetScaler that is to be added as the remote node. If the
NetScaler Gateway IP address is an IPv6 address, select the IPv6 check box before entering the
address.

4. If you want to add the local node to the remote node automatically, select Configure remote
system to participate in High Availability setup. If you do not select this option, you will have to
log in to the appliance represented by the remote node and add the node that you are currently
configuring.
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5. Click to enable Turn off HA monitor on interfaces/channels that are down.
6. If the remote appliance has a different user name and password, in Remote System Logon Cre-

dentials, click Login credentials for remote system are different from self node.
7. In User Name, type the user name of the remote appliance.
8. In Password, type the password of the remote appliance.
9. Click OK.

To enable or disable the secondary node

You can disable or enable the secondary node only. When you disable a secondary node, it stops
sending heartbeat messages to the primary node, and therefore the primary node can no longer check
the status of the secondary node. When you enable a node, the node takes part in the high availability
configuration.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and
then click High Availability.

2. In the details pane, on the Nodes tab, select the local node and then click Open.
3. In the HA Configure Node dialog box, in High Availability Status, select ENABLED (Do not partic-

ipate in HA).
4. Click OK. A message appears in the status bar, stating that the node has been configured suc-

cessfully.

To configure settings for high availability

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and
then click High Availability.

2. In the details pane, on the Nodes tab, select a node and then click Edit.
3. In the HA Configure Node dialog box, in ID, type the number of the node identifier. ID specifies

the unique node number for the other appliance.
4. In IP Address, type the system IP address and then click OK. The IP Address specifies the IP

address of the other appliance.

Note: The maximum ID for nodes in a high availability pair is 64.

Changing an RPC node password

October 5, 2020

To communicate with other NetScaler Gateway appliances, each appliance requires knowledge of the
other appliances, including how to authenticate on NetScaler Gateway. RPC nodes are internal system
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entities used for system-to-system communication of configuration and session information. One RPC
node exists on each NetScaler Gateway and stores information, such as the IP addresses of the other
NetScaler Gateway appliance and the passwords used for authentication. The NetScaler Gateway that
makes contact with another NetScaler Gateway checks the password within the RPC node.

NetScaler Gateway requires RPC node passwords on both appliances in a high availability pair. Ini-
tially, each NetScaler Gateway is configured with the same RPC node password. To enhance security,
you must change the default RPC node passwords. You can use the configuration utility to configure
and change RPC nodes.

RPC nodes are implicitly created when adding a node or adding a Global Server Load Balancing (GSLB)
site. You cannot create or delete RPC nodes manually.

Important: You must also secure the network connection between the appliances. You can configure
security when you configure the RPC node password by selecting the Secure check box.

To change an RPC node password and enable a secure connection

1. Navigate to System > Network > RPC.

2. In the details pane, select the node and then click Edit.

3. In Password and Confirm Password, type the new password.

4. In Source IP Address, type the system IP address of the other NetScaler Gateway appliance.

5. Click Secure and then click OK.

Configuring the primary and secondary appliances for high availability

October 5, 2020

After changing the RPC node password and enabling secure communication, use the configuration
utility to configure the primary and secondary NetScaler Gateway High Availability nodes.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and
then click High Availability.

2. In the details pane, on the Nodes tab, select a node and then click Edit.
3. Under High Availability Status, click Enabled (Actively Participate in HA) and then click OK.

Configuring communication intervals

October 5, 2020
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When you configure NetScaler Gateway as a high availability pair, you can configure the secondary
NetScaler Gateway to listen at specific intervals, measured in milliseconds (msec). These intervals
are known as hello intervals and dead intervals.

The hello interval is the interval at which the heartbeat messages are sent to the peer node. The dead
interval is the time interval after which the peer node is marked DOWN if heartbeat packets are not
received. The heartbeat messages are UDP packets sent to port 3003 of the other node in a high avail-
ability pair.

When you configure the hello interval, you can use the values 200 to 1000. The default value is 200.
The dead interval values are 3 to 60. The default value is 3.

Note

Dead interval must be set as a multiple of hello interval.

To configure communication intervals for the secondary NetScaler Gateway

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and
then click High Availability.

2. In the details pane, on the Nodes tab, select a node and then click Edit.
3. Under Intervals, do one or both of the following:

• In Hello Interval (msec), type the value and then click OK. The default is 200 milliseconds.
• In Dead Interval (secs), type the value and then click OK. The default setting is three sec-

onds.

Synchronizing NetScaler Gateway appliances

October 5, 2020

Automatic synchronization of NetScaler Gateway appliances in a high availability pair is enabled by
default. With automatic synchronization, you can make changes to one appliance and enable the
changes to propagate automatically to the second appliance. Synchronization uses port 3010.

Synchronization starts when the following occurs:

• The secondary node restarts.
• The primary node becomes secondary after a failover.

You can disable synchronization, which prevents the secondary NetScaler Gateway from synchroniz-
ing its configuration with the primary NetScaler Gateway when a change occurs on the primary appli-
ance. You can also force synchronization.

You enable or disable high availability synchronization on the secondary node in the pair.

© 1999-2021 Citrix Systems, Inc. All rights reserved. 397



NetScaler Gateway 12.0

To enable or disable high availability synchronization

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and
then click High Availability.

2. In the details pane, on the Nodes tab, select a node and then click Edit.
3. In the Configure Node dialog box, under HA Synchronization, do one of the following:

• To disable synchronization, clear the Secondary node will fetch the configuration from Pri-
mary check box.

• To enable synchronization, select the Secondary node will fetch the configuration from
Primary check box.

4. Click OK. A message appears in the status bar stating that the node configuration is successful.

To force synchronization between appliances

In addition to automatic synchronization, NetScaler Gateway supports forced synchronization be-
tween the two nodes in a high availability pair.

You can force synchronization on both the primary and secondary NetScaler Gateway appliances.
However, if synchronization is already in progress, the command fails and NetScaler Gateway displays
a warning. Forced synchronization also fails in the following circumstances:

• You force synchronization on a standalone system.
• The secondary node is disabled.
• You disable high availability synchronization on the secondary node.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and
then click High Availability.

2. On the Nodes tab, click Force Synchronization.

Synchronizing configuration files in a high availability setup

October 5, 2020

In a high availability setup, you can synchronize various configuration files from the primary node to
the secondary node.

Parameters for synchronizing files in a high availability setup

• Mode

The type of synchronization to be performed. The following descriptions include, in parenthe-
ses, the command-line argument that specifies the option.
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– Everything except licenses and rc.conf (all). Synchronizes files related to system con-
figuration, NetScaler Gateway bookmarks, SSL certificates, SSL CRL lists, HTML injection
scripts, and Application Firewall XML objects.

– Bookmarks (bookmarks). Synchronizes all NetScaler Gateway bookmarks.
– SSL certificates and keys (ssl). Synchronizes all certificates, keys, and CRLs for the SSL

feature.
– Licenses and rc.conf (misc). Synchronizes all license files and the rc.conf file.
– Everything including licenses and rc.conf (all_plus_misc). Synchronizes files related to

system configuration, NetScaler Gateway bookmarks, SSL certificates, SSL CRL lists, HTML
injection scripts, Application Firewall XML objects, licenses, and the rc.conf file.

Note: There are more options available if you install a NetScaler license on the appliance.

To synchronize files in a high availability setup by using the configuration utility

1. In the navigation pane, expand System and then click Diagnostics.
2. In the details pane, under Utilities, click Start HA files synchronization.
3. In the Start file synchronization dialog box, in the Mode drop-down list, select the appropriate

type of synchronization (for example, Everything except licenses and rc.conf) and then click OK.

Configuring command propagation

October 5, 2020

In a high availability setup, any command issued on the primary node propagates automatically to,
and runs on, the secondary node before the command runs on the primary node. If command prop-
agation fails, or if command execution fails on the secondary node, the primary node executes the
command and logs an error. Command propagation uses port 3011.

In a high availability pair configuration, command propagation is enabled by default on both the pri-
mary and secondary nodes. You can enable or disable command propagation on either node in a
high availability pair. If you disable command propagation on the primary node, commands are not
propagated to the secondary node. If you disable command propagation on the secondary node,
commands propagated from the primary are not executed on the secondary node.

Note: After reenabling propagation, remember to force synchronization.

Note: If synchronization occurs while you are disabling propagation, any configuration-related
changes that you make before the disabling of propagation takes effect are synchronized with the
secondary node. This is also true for cases in which propagation is disabled while synchronization is
in progress.
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To enable or disable propagation on the primary node

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and
then click High Availability.

2. In the details pane, on the Nodes tab, select a node and then click Edit.
3. Under HA propagation, do one of the following:

• To disable high availability propagation, clear the Primary node will propagate configura-
tion to the Secondary check box.

• To enable high availability propagation, select the Primary node will propagate configura-
tion to the Secondary check box.

4. Click OK.

Troubleshooting command propagation

October 5, 2020

The following list describes the reasons command propagation may fail, as well as solutions for restor-
ing the setting:

• Network connectivity is not active. If a command propagation fails, check the network connec-
tion between the primary and secondary NetScaler Gateway appliances.

• Missing resources on secondary NetScaler Gateway. If a command execution succeeds on the
primary NetScaler Gateway but fails to propagate to the secondary NetScaler Gateway, run the
command directly on the secondary NetScaler Gateway to see the error message. The error
may have occurred because the resources required by the command are present on the primary
NetScaler Gateway and are not available on the secondary NetScaler Gateway. Also, verify that
the license files on each appliance match.

For example, verify that all of your Secure Sockets Layer (SSL) certificates are present on each
NetScaler Gateway. Verify that any initialization script customization exists on both NetScaler
Gateway appliances.

• Authentication failure. If you receive an authentication failure error message, verify the RPC
node settings on each appliance.

Configure fail-safe mode

October 5, 2020
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In a high availability configuration, fail-safe mode ensures that one node is always primary when
both nodes fail the health check. Fail-safe mode ensures that when a node is only partially available,
backup methods can activate and can handle traffic.

You configure high availability fail-safe mode independently on each node.

The following table shows some of the fail-safe cases. The NOT_UP state means that the node failed
the health check and yet the node is partially available. The UP state means that the node passed the
health check.

Table 1. Fail-safe mode cases

Node A (primary)
health state

Node B
(secondary)
health state

Default high
availability
behavior

Fail-safe enabled
high availability
behavior Description

NOT_UP (failed
last)

NOT_UP (failed
first)

A (Secondary), B
(Secondary)

A (Primary), B
(Secondary)

If both nodes
fail, one after the
other, the node
that was the last
primary node
remains
primary.

NOT_UP (failed
first)

NOT_UP (failed
last)

A (Secondary), B
(Secondary)

A (Secondary), B
(Primary)

If both nodes
fail, one after the
other, the node
that was the last
primary node
remains
primary.

UP UP A (Primary), B
(Secondary)

A (Primary), B
(Secondary)

If both nodes
pass the health
check, no
change in
behavior with
fail-safe
enabled.
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Node A (primary)
health state

Node B
(secondary)
health state

Default high
availability
behavior

Fail-safe enabled
high availability
behavior Description

UP NOT_UP A (Primary),
B(Secondary)

A (Primary), B
(Secondary)

If only the
secondary node
fails, no change
in behavior with
fail-safe
enabled.

NOT_UP UP A (Secondary),
B(Primary)

A (Secondary),
B(Primary)

If only the
primary fails, no
change in
behavior with
fail-safe
enabled.

NOT_UP UP (STAYSEC-
ONDARY)

A (Secondary), B
(Secondary)

A (Primary), B
(Secondary)

If the secondary
is configured as
STAYSEC-
ONDARY, the
primary remains
primary even if it
fails.

To configure fail-safe mode

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and
then click High Availability.

2. In the details pane, on the Nodes tab, select a node and then click Edit.
3. In the Configure Node dialog box, under Fail-Safe Mode, select Maintain one Primary node even

when both nodes are unhealthy and then click OK.

Configuring the virtual MAC address

October 5, 2020

The virtual MAC address is shared by the primary and secondary NetScaler Gateway appliances in a
high availability setup.
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In a high availability setup, the primary NetScaler Gateway owns all the floating IP addresses, such
as the mapped IP address or the virtual IP address. It responds to address resolution protocol (ARP)
requests for these IP addresses with its own MAC address. As a result, the ARP table of an external
device (such as a router) is updated with the floating IP address and the primary NetScaler Gateway
MAC address. When a failover occurs, the secondary NetScaler Gateway takes over as the new pri-
mary NetScaler Gateway. It then uses gratuitous address resolution protocol (GARP) to advertise the
floating IP addresses that it acquired from the primary appliance. The MAC address, which the new
primary appliance advertises, is that of its own interface.

Some devices do not accept GARP messages generated by NetScaler Gateway. As a result, some of the
external devices retain the old IP-to-MAC mapping advertised by the old primary NetScaler Gateway.
This situation can cause a site to become unavailable. To resolve the problem, you configure a virtual
MAC address on both NetScaler Gateway appliances of a high availability pair. This configuration im-
plies that both NetScaler Gateway appliances have identical MAC addresses. As a result, when failover
occurs, the MAC address of the secondary NetScaler Gateway remains unchanged and ARP tables on
the external devices do not need to be updated.

To create a virtual MAC address, create a virtual router identifier (ID) and bind it to an interface. In a
high availability setup, the user needs to bind the ID to the interfaces on both the appliances.

When the virtual router ID is bound to an interface, the system generates a virtual MAC address
with the virtual router ID as the last octet. An example of the generic virtual MAC address is
00:00:5e:00:01:<VRID>. For example, if you created a virtual router ID of value 60 and bind it to an
interface, the resulting virtual MAC address is 00:00:5e:00:01:3c, where 3c is the hex representation
of the virtual router ID. You can create 255 virtual router IDs ranging from 1 through 254.

You can configure virtual MAC addresses for IPv4 and IPv6.

Configuring IPv4 virtual MAC addresses

October 5, 2020

When you create a IPv4 virtual MAC address and bind it to a interface, any IPv4 packet sent from the
interface uses the virtual MAC address that is bound to the interface. If there is no IPv4 virtual MAC
address bound to an interface, the interface’s physical MAC address is used.

The generic virtual MAC address is of the form 00:00:5e:00:01:<VRID>. For example, if you create a VRID
with a value of 60 and bind it to an interface, the resulting virtual MAC address is 00:00:5e:00:01:3c,
where 3c is the hex representation of the VRID. You can create 255 VRIDs with values from 1 to 255.
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Creating or modifying an IPv4 virtual MAC address

October 5, 2020

You create an IPv4 virtual MAC address by assigning it a virtual router ID. You can then you bind the vir-
tual MAC address to an interface. You cannot bind multiple virtual router IDs to the same interface. To
verify the virtual MAC address configuration, you should display and examine the virtual MAC address
and the interfaces bound to the virtual MAC address.

Parameters for configuring a virtual MAC address

• VrID

The virtual router ID that identifies the virtual MAC address. Possible values: 1 to 255.

• ifnum

The interface number (slot/port notation) to be bound to the virtual MAC address.

To configure a virtual MAC address

1. In the configuration utility, on the Configuration tab, expand System > Network and then click
VMAC.

2. In the details pane, on the VMAC tab, click Add.
3. In the Create VMAC dialog box, in Virtual Router ID, type the value.
4. Under Associated Interfaces, in Available Interfaces, select a network interface, click Add, click

Create and then click Close.

After you create the virtual MAC address, it appears in the configuration utility. If you selected a net-
work interface, the virtual router ID is bound to that interface.

To delete a virtual MAC address

To delete a virtual MAC address, you need to delete the corresponding virtual router ID.

1. In the configuration utility, on the Configuration tab, expand System > Network and then click
VMAC.

2. In the details pane, select an item and then click Remove.

To bind and unbind a virtual MAC address

When you created the virtual router ID, you selected a network interface on NetScaler Gateway and
then bound the virtual router ID to the network interface. You can also unbind a virtual MAC address
from the network interface, but leave the MAC address configured on NetScaler Gateway.
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1. In the configuration utility, on the Configuration tab, expand System > Network and then click
VMAC.

2. In the details pane, select an item and then click Open.
3. Under Configured Interfaces, select a network interface, click Remove, click OK and then click

Close.

Configuring IPv6 virtual MAC addresses

October 5, 2020

The NetScaler Gateway supports virtual MAC addresses for IPv6 packets. You can bind any interface
to a virtual MAC address for IPv6, even if an IPv4 virtual MAC address is bound to the interface. Any
IPv6 packet sent from the interface uses the virtual MAC address bound to that interface. If there is no
virtual MAC address bound to an interface, an IPv6 packet uses the physical MAC.

Creating or modifying a virtual MAC address for IPv6

October 5, 2020

You create an IPv6 virtual MAC address by assigning it an IPv6 virtual router ID. You can then you bind
the virtual MAC address to an interface. You cannot bind multiple IPv6 virtual router IDs to an inter-
face. To verify the virtual MAC address configuration, you should display and examine the virtual MAC
addresses and the interfaces bound to the virtual MAC address.

Parameters for configuring a virtual MAC address for IPv6

• Virtual Router ID

The virtual router ID that identifies the virtual MAC address. Possible values: 1 to 255.

• ifnum

The interface number (slot/port notation) to be bound to the virtual MAC address.

To configure a virtual MAC address for IPv6

1. In the configuration utility, on the Configuration tab, expand System > Network and then click
VMAC.

2. In the details pane, on the VMAC6 tab, do one of the following:
• To create a new virtual MAC address, click Add.
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• To modify an existing virtual MAC address, click Open.
3. In the Create VMAC6 or Configure VMAC6 dialog box, in Virtual Router ID, enter the value, such

as vrID6.
4. In Associate Interfaces, click Add, click Create and then click Close. A message appears in the

status bar, stating that the virtual MAC address is configured.

To remove a virtual MAC address for IPv6

1. In the configuration utility, on the Configuration tab, expand System > Network and then click
VMAC.

2. In the details pane, on the VMAC6 tab, select the virtual router ID that you want to remove and
then click Remove. A message appears in the status bar, stating that the virtual MAC address is
removed.

Configuring high availability pairs in different subnets

November 12, 2020

A typical high availability deployment is when both appliances in a high availability pair reside on the
same subnet. A high availability deployment can also consist of two NetScaler Gateway appliances
in which each appliance is in a different network. This topic describes the latter configuration, and
includes sample configurations and a list of differences among the high availability configurations
within one network and across networks.

You can also configure link redundancy and route monitors. These NetScaler Gateway functions are
helpful in a cross-network high availability configuration. The functions also cover the health check
process used by each NetScaler Gateway to ensure that the partner appliance is active.

How independent network configuration works

The NetScaler Gateway appliances are connected to different routers, called R3 and R4, on two differ-
ent networks. The appliances exchange heartbeat packets through these routers. A heartbeat packet
is a signal that occurs at regular intervals that ensures the connection is still active. You can expand
this configuration to accommodate deployments involving any number of interfaces.

Note: If you use static routing on your network, you must add static routes between all the systems to
ensure that heartbeat packets are sent and received successfully. (If you use dynamic routing on your
systems, static routes are unnecessary.)

When the appliances in a high availability pair reside on two different networks, the secondary
NetScaler Gateway must have an independent network configuration. This means that NetScaler

© 1999-2021 Citrix Systems, Inc. All rights reserved. 406



NetScaler Gateway 12.0

Gateway appliances on different networks cannot share mapped IP addresses, virtual LANs, or
network routes. This type of configuration, in which the NetScaler Gateway appliances in a high avail-
ability pair have different configurable parameters, is known as independent network configuration
or symmetric network configuration.

The following table summarizes the configurable parameters for an independent network configura-
tion, and shows how you must set them on each NetScaler Gateway:

Configurable parameters Behavior

IP addresses NetScaler Gateway specific. Active only on that
appliance.

Virtual IP address Floating.

Virtual LAN NetScaler Gateway specific. Active only on that
appliance.

Routes NetScaler Gateway specific. Active only on that
appliance. A link load balancing (LLB) route is
floating.

access control lists (ACLs) Floating (common). Active on both appliances.

Dynamic routing NetScaler Gateway specific. Active only on that
appliance. The secondary NetScaler Gateway
must also run the routing protocols and peer
with upstream routers.

L2 mode Floating (common). Active on both appliances.

L3 mode Floating (common). Active on both appliances.

Reverse Network Address Translation (NAT) NetScaler Gateway specific. Reverse NAT with
a virtual IP address because the NAT IP address
is floating.

Note:

IPSET in INC mode is supported with public IP addresses. For details, see Citrix ADC High Avail-
ability with Azure Load Balancer Front End IP Validated Reference Design.

Adding a remote node

October 5, 2020
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When two nodes of a high availability pair reside on different subnets, each node must have a differ-
ent network configuration. Therefore, to configure two independent systems to function as a high
availability pair, you must specify independent network computing mode during the configuration
process.

When you add a high availability node, you must disable the high availability monitor for each inter-
face that is not connected or being used for traffic.

To add a remote node for independent network computingmode

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and
then click High Availability.

2. In the details pane, click the Nodes tab, and then click Add.

3. In the High Availability Setup dialog box, in the Remote Node IP Address text box, type the
NetScaler Gateway IP address of the appliance that is the remote node.

To use an IPv6 address, click the IPv6 check box before entering the IP address.

4. If you want to add the local node to the remote node automatically, select Configure remote
system to participate in High Availability setup. If you do not select this option, you need to log
on to the appliance represented by the remote node and add the node that you are currently
configuring.

5. Click to enable Turn off HA monitor on interfaces/channels that are down.

6. Click to enable Turn on INC (Independent Network Configuration) mode on self mode.

7. Click OK. The Nodes page displays the local and remote nodes in your high availability configu-
ration.

To remove a remote node

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and
then click High Availability.

2. In the details pane, click the Nodes tab.
3. Select the node that you want to remove, click Remove and then click Yes.

Configuring routemonitors

October 5, 2020
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You can use route monitors to make the high availability state dependent on the internal routing table,
whether or not the table contains any dynamically learned or static routes. In an high availability
configuration, a route monitor on each node checks the internal routing table to make sure that a
route entry for reaching a particular network is always present. If the route entry is not present, the
state of the route monitor changes to DOWN.

When a NetScaler Gateway appliance has only static routes for reaching a network, and you want to
create a route monitor for the network, you must enable monitored static routes for the static routes.
The monitored static route removes unreachable static routes from the internal routing table. If you
disable monitored static routes on static routes, an unreachable static route can remain in the internal
routing table, defeating the purpose of having the route monitor.

Route monitors are supported on either enabled or disabled Independent Network Configuration set-
tings. The following table shows what occurs with route monitors in a high availability setup and with
Independent Network Configuration enabled or disabled.

Route Monitors in high availability in disabled
Independent Network Configuration mode

Route Monitors in high availability in enabled
Independent Network Configuration mode

Route monitors are propagated by nodes and
exchanged during synchronization.

Route monitors are neither propagated by
nodes nor exchanged during synchronization.

Route monitors are active only in the current
primary node.

Route monitors are active on both the primary
and the secondary node.

The NetScaler Gateway appliance always
displays the state of a route monitor as UP
irrespective of the whether the route entry is
present or not in the internal routing table.

The NetScaler Gateway appliance displays the
state of the route monitor as DOWN if the
corresponding route entry is not present in the
internal routing table.

A route monitor starts monitoring its route in
the following cases, in order to allow NetScaler
Gateway to learn the dynamic routes, which
may take up to 180 seconds: reboot, failover,
set route6 command for v6 routes, set route
msr enable/disable command for v4 routes,
adding a new route monitor

Not applicable.

Route monitors are useful when you disable Independent Network Configuration mode and you want
a gateway from a primary node as unreachable as one of the conditions for high availability failover.

For example, you disable Independent Network Configuration in a high availability setup in a two-arm
topology that has NetScaler Gateway appliances NS1 and NS2 in the same subnet, with router R1 and
switches SW1, SW2, and SW3, as shown in the following figure. Because R1 is the only router in this
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setup, you want the high availability setup to failover whenever R1 is not reachable from the current
primary node. You can configure a route monitor (say, RM1 and RM2, respectively) on each of the
nodes to monitor the reachability of R1 from that node.

With NS1 as the current primary node, the network flow is as follows:

1. Route monitor RM1 on NS1 monitors NS1’s internal routing table for the presence of a route entry
for router R1. NS1 and NS2 exchange heartbeat messages through switch SW1 or SW3 at regular
intervals.

2. If switch SW1 fails, the routing protocol on NS1 detects that R1 is not reachable and therefore
removes the route entry for R1 from the internal routing table. NS1 and NS2 exchanges heartbeat
messages through switch SW3 at regular intervals.

3. Detecting that the route entry for R1 is not present in the internal routing table, RM1 initiates a
failover. If route to R1 is down from both NS1 and NS2, failover happens every 180 seconds till
one of the appliances is able to reach R1 and restore the connection.
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Adding or removing routemonitors

October 5, 2020

When the appliances of a high availability pair reside on different networks, the high availability state
of NetScaler Gateway depends on if the appliance can be reached or not. In a cross-network high
availability configuration, a route monitor on each NetScaler Gateway scans the internal routing table
to make sure that an entry for the other NetScaler Gateway is always present.

To add a routemonitor

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and
then click High Availability.

2. In the Bind/Unbind Route Monitors dialog box, on the Route Monitors tab, click Action, and then
click Configure.

3. Under Specify Route Monitor, in Network, type the IP address of the network of the other
NetScaler Gateway appliance.

To configure an IPv6 address, click IPv6 and then type the IP address.

4. In Netmask, type the subnet mask of the other network, click Add and then click OK.

When this procedure is complete, the route monitor is bound to NetScaler Gateway.

Note: When a route monitor is not bound to a NetScaler Gateway, the high availability state of either
appliance is determined by the state of the interfaces.

To remove a routemonitor

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and
then click High Availability.

2. On the Route Monitors tab, click Action, and then click Configure.
3. Under Configured Route Monitors, select the monitor, click Remove and then click OK.

Configuring link redundancy

October 5, 2020

Link redundancy groups network interfaces together to prevent failover due to a failure on one net-
work interface of an NetScaler Gateway that has other functioning interfaces. The failure of the first
interface on the primary NetScaler Gateway triggers failover, although the first interface can still use
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its second link to serve user requests. When you configure link redundancy, you can group the two
interfaces into a failover interface set, preventing the failure of a single link from causing failover to
the secondary NetScaler Gateway, unless all interfaces on the primary NetScaler Gateway are non-
functional.

Each interface in a failover interface set maintains independent bridge entries. The monitor interfaces
that are enabled and high availability on an NetScaler Gateway that are not bound to a failed interface
set are known as critical interfaces, because if any of these interfaces fails, failover is triggered.

To configure link redundancy

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and
then click High Availability.

2. On the Failover Interface Set tab, click Add.
3. In Name, type a name for the set.
4. In Interfaces, click Add.
5. Under Available Interfaces, select an interface and then click the arrow to move the interface to

Configured.
6. Repeat Steps 4 and 5 for the second interface, and then click Create.

You can add as many interfaces as you need for failover between the interfaces.

To remove interfaces from the failover interface set

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and
then click High Availability.

2. On the Failover Interface Set tab, select a set and then click Remove.

To remove a failover interface set

If you no longer need a failover interface set, you can remove it from NetScaler Gateway.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and
then click High Availability.

2. On the Failover Interface Set tab, select a set and then click Remove.

Understanding the causes of failover

October 5, 2020

The following events can cause failover in a high availability configuration:
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1. If the secondary node does not receive a heartbeat packet from the primary node for a period of
time that exceeds the dead interval set on the secondary. For more information about setting
the dead interval, see Configuring Communication Intervals. Possible causes for a node not
receiving heartbeat packets from a peer node include:

• A network configuration problem prevents heartbeats from traversing the network
between the high availability nodes.

• The peer node experiences a hardware or software failure that causes it to freeze (hang),
reboot, or otherwise stop processing and forwarding heartbeat packets.

2. The primary node experiences a hardware failure of its SSL card.
3. The primary node does not receive any heartbeat packets on its network interfaces for three

seconds.
4. On the primary node, a network interface that is not part of a Failover Interface Set (FIS) or a

Link Aggregation (LA) channel and has the high availability Monitor (HAMON) enabled, fails. The
interfaces are enabled, but go to a DOWN state.

5. On the primary node, all interfaces in an FIS fail. The interfaces are enabled, but go to a DOWN
state.

6. On the primary node, an LA channel with HAMON enabled fails. The interfaces are enabled, but
go to a DOWN state.

7. On the primary node, all interfaces fail. In this case, failover occurs regardless of the HAMON
configuration.

8. On the primary node, all interfaces are manually disabled. In this case, failover occurs regard-
less of the HAMON configuration.

9. You force a failover by issuing the force failover command on either node.
10. A route monitor that is bound to the primary node goes DOWN.

Forcing failover from a node

October 5, 2020

You might want to force a failover if, for example, you need to replace or upgrade the primary node.
You can force failover from either the primary or the secondary node. A forced failover is not propa-
gated or synchronized. To view the synchronization status after a forced failover, you can view the
status of the node.

A forced failover fails in any of the following circumstances:

• You force failover on a standalone system.
• The secondary node is disabled.
• The secondary node is configured to remain secondary.

The NetScaler Gateway appliance displays a warning message if it detects a potential issue when you
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run the force failover command. The message includes the information that triggered the warning
and requests confirmation before proceeding.

Forcing failover on the primary or secondary node

October 5, 2020

If you force failover on the primary node, the primary becomes the secondary and the secondary be-
comes the primary. Forced failover is possible only when the primary node can determine that the
secondary node is UP.

If the secondary node is DOWN, the force failover command returns the following error message: “Op-
eration not possible due to invalid peer state. Rectify and retry.”

If the secondary system is in the claiming state or inactive, the command returns the following error
message: “Operation not possible now. Please wait for system to stabilize before retrying.”

If you run the force failover command from the secondary node, the secondary node becomes primary
and the primary node becomes secondary. A force failover can occur only if the secondary node’s
health is good and the node is not configured to stay secondary.

If the secondary node cannot become the primary node, or if secondary node was configured to stay
secondary (using the STAYSECONDARY option), the node displays the following error message: “Op-
eration not possible as my state is invalid. View the node for more information.”

To force failover on the primary or secondary node

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and
then click High Availability.

2. In the details pane, on the Nodes tab, select the primary node, and then in Actions, click Force
Failover.

3. In the Warning dialog box, click Yes.

Forcing the primary node to stay primary

October 5, 2020

In a high availability configuration, you can force the primary NetScaler Gateway to stay primary even
after appliance failover. You can only configure this setting on standalone NetScaler Gateway appli-
ances and on the NetScaler Gateway that is the primary appliance in a high availability pair.
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To force the primary node to stay primary

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and
then click High Availability.

2. In the details pane, on the Nodes tab, select a node and then click Edit.
3. Under High Availability Status, click Stay Primary and then click OK.

You can clear this configuration only by using the following command:

clear configuration full

The following commands do not change the NetScaler Gateway high availability configuration:

clear configuration basic

clear configuration extended

Forcing the secondary node to stay secondary

October 5, 2020

In a high availability setup, you can force the secondary NetScaler Gateway to stay secondary, inde-
pendent of the state of the primary NetScaler Gateway. When you configure NetScaler Gateway to
stay secondary, it remains secondary even if the primary NetScaler Gateway fails.

For example, in an existing high availability setup, suppose that you need to upgrade the primary
NetScaler Gateway and that this process takes a specified amount of time. During the upgrade, the
primary NetScaler Gateway could become unavailable, but you do not want the secondary NetScaler
Gateway to take over. You want it to remain the secondary NetScaler Gateway, even if it detects a
failure in the primary NetScaler Gateway.

If the status of a NetScaler Gateway in a high availability pair is configured to stay secondary, it does
not participate in high availability state machine transitions. You can check the status of the NetScaler
Gateway in the configuration utility on the Nodes tab.

This setting works on both a standalone and a secondary NetScaler Gateway.

When you set the high availability node, it is not propagated or synchronized and affects only the
NetScaler Gateway on which the setting is configured.

To force the secondary node to stay secondary

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and
then click High Availability.

2. In the details pane, on the Nodes tab, select a node and then click Edit.
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3. Under High Availability Status, click Stay Secondary (Remain in Listen Mode) and then click OK.

To return NetScaler Gateway to service as an active high availability appliance

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System and
then click High Availability.

2. In the details pane, on the Nodes tab, select the appliance that is going to stay the primary node
and then click Open.

3. Under High Availability Status, click Enabled (Actively Participate in HA) and then click OK.

Using Clustering

October 5, 2020

NetScaler Gateway can be deployed in cluster configurations to provide high throughput, high avail-
ability, and scalability for VPN client traffic. In a cluster, a group of NetScaler Gateway appliances
or VMs operates as a single system image to coordinate user sessions and manage traffic to network
resources. A NetScaler Gateway cluster can be built with a minimum of two and a maximum of 32
NetScaler Gateway appliances or virtual machines configured as cluster nodes.

Read the
NetScaler Clustering documentation before starting to configure your NetScaler Gateway cluster. Pay
special attention to the following topics in that documentation.

• See Hardware and Software Requirements to verify that the systems you plan to use meet the
requirements.

• See How Clustering Works for a description of clustering concepts.

• See Setting up Inter-Node Communication to plan the deployment and identify any caveats that
might be relevant to your environment.

A NetScaler Gateway cluster operates as a spotted VIP configuration type NetScaler cluster.

Important: The XenApp and XenDesktop wizard is not supported for clustering and hence you
do not find the XenApp and XenDesktop wizard in the GUI > Navigation pane > Integrate with
Citrix Products section.

Configuring Clustering

October 5, 2020
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The primary tasks in setting up NetScaler Gateway clustering are:

1. Decide which NetScaler Gateway appliance or VM will be the configuration coordinator, and
create a cluster instance on that system (if one is not already present).

2. Join NetScaler Gateway systems to the cluster as nodes.
3. Create a node group on the cluster instance, with the STICKY option set.
4. Bind a single cluster node to the cluster node group.
5. Configure a NetScaler Gateway virtual server on the configuration coordinator and bind it to

cluster node group.

Note that multiple methods are available for configuring a NetScaler cluster. The following set of tasks
uses the most direct method available in the configuration utility.

To create a NetScaler Gateway cluster instance by using the configuration utility

Once you have all of the deployment details in order, begin the configuration on the NetScaler Gate-
way that will be the configuration coordinator.

Caution: Creating the cluster instance clears the configuration. If you need to save the existing sys-
tem configuration for reference, archive a copy before continuing with the cluster configuration. Any
existing settings to be used in the cluster can be reapplied on the configuration coordinator after the
cluster is established.

1. Log on to the NetScaler configuration utility at the NSIP address.
2. Expand the System node, then the Cluster subnode.
3. In the details pane, click Manage Cluster.
4. In the Cluster Configuration dialog box, set the parameters required to create the cluster.

a) Enter a Cluster instance ID. This is the numeric identifier for the cluster instance. The de-
fault value is 1 but you can set it to any number from 1 to 16.

b) Enter the Cluster IP address. This will be the cluster’s configuration coordinator IP address,
which is the management IP address for the cluster.

c) Select the preferred Backplane interface. This is this NetScaler Gateway interface to use
for communication among the cluster nodes.

5. Click Create.
6. At the prompt to confirm system reboot, click Yes.
7. Wait for system to restart. Once available, log on to the configuration utility at the Cluster IP

address configured in step 4b.
8. Note, in the System Information detail pane, that the local Node at the NSIP address is reported

as configuration coordinator. This confirms that the base cluster instance is now operating.

The local node of the configuration coordinator is automatically added to the cluster. More nodes can
be added in the following task.
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Adding Nodes to a NetScaler Gateway Cluster

Once the cluster instance has been established, you can begin to add other NetScaler Gateway nodes
to the cluster.

To add more NetScaler Gateway systems to the cluster, you can use the configuration utility to re-
motely issue the cluster-node-creation and join-cluster settings.

Note: Adding nodes to the cluster should be completed before configuring your NetScaler Gateway
setup. This way, you will not have to repeat the NetScaler Gateway configuration if something goes
wrong with your cluster configuration and you want to remove the cluster and begin again.

1. Log on to the NetScaler configuration utility at the Cluster IP address.
2. Expand the System node, then the Cluster subnode.
3. In the details pane, click Manage Cluster.
4. In the Cluster Nodes details pane, click Add.
5. In the Create Cluster Node pane, enter a unique Node id for this node.
6. Enter the NetScaler IP address of the system to add as a cluster node.
7. In the Cluster Node credentials pane, enter the NetScaler Gateway username and password for

the remote NetScaler Gateway system.
8. In the Configuration Coordinator credentials pane, enter the password for the local authorized

user.
9. Click Create.

10. When prompted, click YES to allow the system configuration to be saved and perform a warm
reboot of the remote NetScaler Gateway.

Repeat steps 4 through 9 for each additional remote NetScaler Gateway system that you want to con-
figure as a cluster node.

Verify that the cluster nodes are included in the Active Node List in the Cluster Nodes detail pane. If
any nodes are missing, repeat steps 4 through 10 until all of the necessary nodes are listed.

Creating a Cluster Node Group

Once the cluster nodes have been added, a cluster node group can be created.

1. Log on to the NetScaler configuration utility at the Cluster IP address.
2. Expand the System node, then the Cluster subnode.
3. Click Node Groups.
4. In the details pane, click Add.
5. Enter a name for the cluster node group.
6. Select the Sticky option. This is required to support the NetScaler Gateway virtual server type.
7. Click Continue.
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The cluster node group is now established. Before leaving this area of the configuration utility, you
can bind the local NetScaler Gateway node to the new cluster node group. This will be the only node
bound to the cluster group.

Bind the local cluster node to the cluster node group

Because a NetScaler Gateway cluster configuration is a spotted type, only one node can be bound to
the node group. The following procedure binds the local node on the configuration coordinator to the
node group, but any node in the cluster can be used for this binding.

1. In the Advanced pane, expand Cluster Nodes.
2. In the middle Cluster Nodes pane, select No Cluster Node.
3. On the Cluster Node configuration screen, click Bind.
4. Select the local node represented by the NSIP address for this NetScaler Gateway system.
5. Click Insert.
6. Click OK.
7. Click Done.

The cluster is now populated and ready to share a NetScaler Gateway virtual server as configured by
the following task.

Binding a NetScaler Gateway Virtual Server to the Cluster Node Group

With a cluster established, you can proceed to build the NetScaler Gateway configuration the clus-
ter deployment is intended to serve. To tie the configuration to the cluster, you need to create the
NetScaler Gateway virtual server and bind it to a cluster node group that is set to type Sticky. After
the virtual server is bound to the cluster node group, you can continue to configure the NetScaler
Gateway.

If multiple NetScaler Gateway virtual servers are configured, those must be bound to the cluster node
group as well.

Note: If NetScaler Gateway virtual servers have not yet been configured, you might have to first enable
the NetScaler Gateway and Authentication, Authorization and Auditing features first under
System > Settings > Configure Basic Features.

1. Log on to the NetScaler configuration utility at the Cluster IP address.
2. Expand the System node, then the Cluster subnode.
3. Click Node Groups.
4. In the Node Group pane, select the desired node group name, and then click Edit.
5. In the Advanced pane on the right, expand the Virtual Servers option, and then click the + icon

to add a virtual server.
6. Choose the VPN Virtual Server type, and then click Continue.
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7. Click Bind.
8. If the needed virtual server is listed, select it, then click Insert, and then click OK.
9. If you have to create a new virtual server, click Add. Proceed through the NetScaler Virtual Server

configuration. Minimally, all that is needed is to create the virtual server so that it can be bound
to the cluster node group.

10. Once the virtual server is available in the NetScaler Gateway Virtual Servers list, select it, and
then click Insert.

11. Click OK.
12. Click Done.

Note: If multiple NetScaler Gateway virtual servers are configured, those must be bound to the cluster
node group as well using this same method.

Maintaining and Monitoring the System

October 5, 2020

Once you complete configuration of your NetScaler Gateway, you need to maintain and monitor the
appliance. You can do so in the following ways:

• You can upgrade NetScaler Gateway to the latest version of the software. When you log on to
the Citrix web site, you can navigate to the NetScaler Gateway download site and the download
the software. You can find the readme for maintenance builds in the Citrix Knowledge Center.

• You can assign NetScaler Gateway configuration and management tasks to different members
of your group. With delegated administration, you can assign access levels to individuals which
restricts them to performing specific tasks on NetScaler Gateway.

• You can save the NetScaler Gateway configuration either to the appliance or a file on your com-
puter. You can compare the current running and saved configuration. You can also clear the
configuration from NetScaler Gateway.

• You can view, refresh, and end user sessions within the NetScaler Gateway configuration utility.
• You can configure logging on NetScaler Gateway. The logs provide important information about

the appliance and are useful in case you experience problems.

Configuring Delegated Administrators

October 5, 2020

NetScaler Gateway has a default administrator user name and password. The default user name and
password is nsroot. When you run the Setup Wizard for the first time, you can change the administrator
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password.

You can create additional administrator accounts and assign each account with different levels of ac-
cess to NetScaler Gateway. These additional accounts are called delegated administrators. For exam-
ple, you have one person who is assigned to monitor NetScaler Gateway connections and logs and
another person who is responsible for configuring specific settings on NetScaler Gateway. The first
administrator has read-only access and the second administrator has limited access to the appliance.

To configure a delegated administrator, you use command policies and system users and groups.

When you are configuring a delegated administrator, the configuration process is:

• Add a system user. A system user is an administrator with specified privileges. All administrators
inherit the policies of the groups to which they belong.

• Add a system group. A system group contains systems users with specific privileges. Members
of the system group inherit the policies of the group or groups to which they belong.

• Create a command policy. Command policies allow you to define what parts of the NetScaler
Gateway configuration a user or group is allowed to access and modify. You can also regulate
which commands, such as command groups, virtual servers, and other elements administrators
and groups are permitted to configure.

• Bind the command policy to the user or group by setting the priority. When configuring dele-
gated administration, assign priorities to the administrator or group so NetScaler Gateway can
determine which policy takes precedence.

NetScaler Gateway has a default deny system command policy. Command policies cannot be bound
globally. You must bind the policies directly to system administrators (users) or groups. If users and
groups do not have an associated command policy, the default deny policy is applied and users cannot
execute any commands or configure NetScaler Gateway.

You can configure custom command policies to define a greater level of detail for user rights assign-
ments. For example, you can give one person the ability to add session policies to NetScaler Gateway,
but not allow the user to perform any other configuration.

Configuring Command Policies for Delegated Administrators

October 5, 2020

NetScaler Gateway has four built-in command policies that you can use for delegated administration:

• Read-only. Allows read-only access to show all commands except for the system command
group and ns.conf show commands.

• Operator. Allows read-only access and also allows access to enable and disable commands on
services. This policy also allows access to set services and servers as “access down.”
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• Network. Permits almost complete system access, excluding system commands and the shell
command.

• Superuser. Grants full system privileges, such as the privileges granted to the default adminis-
trator, nsroot.

Command policies contain built-in expressions. You use the configuration utility to create system
users, system groups, command policies, and to define permissions.

To create an administrative user on NetScaler Gateway

1. In the configuration utility, in the navigation pane, on the Configuration tab, expand System >
User Administration and then click SystemUsers.

2. In the details pane, click Add.
3. In User Name, type a user name.
4. In Password and Confirm Password field, type the password.
5. To add users to a group, in Member of, click Add.
6. In Available, select a group and then click the right arrow.
7. Under Command Policies, in Action, click Insert.
8. In the Insert Command Policies dialog box, select the command, click OK, click Create and then

click close.

Creating Administrative Groups

Administrative groups contain users who have administrative privileges on NetScaler Gateway. You
can create administrative groups in the configuration utility.

To configure an administrative group by using the configuration utility

1. In the configuration utility, in the navigation pane, on the Configuration tab, expand System >
User Administration and then click System Groups.

2. In the details pane, click Add.
3. In Group Name, type a name for the group.
4. To add an existing user to the group, in Members, click Add.
5. Under Available, select a user and then click the right arrow.
6. Under CommandPolicies, in Action, click Insert, select a policy or policies, clickOK, click Cre-

ate and then click Close.
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Configuring Custom Command Policies for Delegated Administrators

October 5, 2020

When configuring a custom command policy, you provide a policy name and then configure the policy
components to create the command specification. With the command specification, you can limit
the commands administrators are allowed to use. For example, you want to deny administrators the
ability to use the remove command. When configuring the policy, set the action to deny and then
configure the parameters.

You can configure a simple or advanced command policy. If you configure a simple policy, you config-
ure a component on the appliance, such as NetScaler Gateway and authentication. If you configure
an advanced policy, you select the component, called an entity group and then select the commands
administrators are allowed to perform in the group.

To create a simple custom command policy

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System >
User Administration and then click Command Policies.

2. In the details pane, click Add.

3. In Policy Name, type a name for the policy.

4. In Action, select Allow or Deny.

5. Under Command Spec, click Add.

6. In the Add Command dialog box, on the Simple tab, in Operation, select the action that dele-
gated administrators can perform.

7. Under Entity Group, select one or more groups.

You can press the CTRL key to select multiple groups.

8. Click Create and then click Close.

To create an advanced custom command policy

1. In the configuration utility, in the navigation pane, on the Configuration tab, expand System >
User Administration and then click Command Policies.

2. In the details pane, click Add.

3. In Policy Name, type a name for the policy.

4. In Action, select Allow or Deny.
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5. Under Command Spec, click Add.

6. In the Add Command dialog box, click the Advanced tab.

7. In Entity Group select the group to which the command belongs, such a authentication or high
availability.

8. Under Entity, select the policy.

You can press the CTRL key to select multiple items in the list.

9. In Operation, select the command, click Create and then click Close.

You can press the CTRL key to select multiple items in the list.

10. Click Create and then click Close.

11. In the Create Command Policy dialog box, click Create and then click Close.

When you click Create, the expression appears under Command Spec in the Create Command Policy
dialog box.

After creating the custom command policy, you can bind it to a user or a group.

Note: You can only bind custom command policies to users or groups you create. You cannot
bind a custom command policy to the user nsroot.

To bind a custom command policy to a user or group

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand System >
User Administration and then click SystemUsers or click Systems Groups.

2. In the details pane, select a user or group from the list and then click Open.
3. Under Command Policies, select the policy and then click OK.

Configuring Auditing on NetScaler Gateway

October 5, 2020

NetScaler Gateway allows you to log the states and status information that the appliance collects. You
can use the audit logs to view the event history in chronological order. The messages within the logs
contain information about the event that generated the message, a time stamp, the message type,
and predefined log levels and message information. You can configure settings that determine the
information that is logged and the location where the messages are stored.

NetScaler Gateway currently supports two log formats: a proprietary log format for local logs, and the
syslog format for use with syslog servers. You can configure the audit logs to provide the following
information:
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Level Description

EMERGENCY Logs major errors only. Entries in the log
indicate that NetScaler Gateway is
experiencing a critical problem that is causing
it to be unusable.

ALERT Logs problems that might cause NetScaler
Gateway to function incorrectly, but are not
critical to its operation. Corrective action
should be taken as soon as possible to prevent
NetScaler Gateway from experiencing a critical
problem.

CRITICAL Logs critical conditions that do not restrict the
operation of NetScaler Gateway, but might
escalate to a larger problem.

ERROR Logs entries that result from a failed operation
on NetScaler Gateway.

WARNING Logs potential issues that could result in an
error or a critical error.

NOTICE Logs more in-depth issues than the
information level log, but serves the same
purpose as notification.

INFORMATION Log actions taken by NetScaler Gateway. This
level is useful for troubleshooting problems.

The NetScaler Gateway audit log also stores compression statistics for NetScaler Gateway if you con-
figure TCP compression. The compression ratio achieved for different data is stored in the log file for
each user session.

NetScaler Gateway uses the log signature SessionID. This allows you to track logs per session rather
than per user. Logs that are generated as part of a session have the same SessionID. If a user estab-
lishes two sessions from the same user device with the same IP address, each session has a unique
SessionID.

Important: If you have written custom log parsing scripts, you need to make this signature
change within the custom parsing scripts.
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Configuring Logs on NetScaler Gateway

October 5, 2020

When you configure logging on NetScaler Gateway, you can choose to store the audit logs on NetScaler
Gateway or send them to a syslog server. You use the configuration utility to create auditing policies
and configure settings to store the audit logs.

To create an auditing policy

1. In the configuration utility, on the Configuration tab, expand NetScaler Gateway > Policies >
Auditing.

2. In Name, type a name for the policy.
3. Select one of the following:

• Syslog if you want to send the logs to a Syslog server.
• Nslog to store the logs on NetScaler Gateway.

Note: If you select this option, logs are stored in the /var/log folder on the appliance.

4. In the details pane, click Add.
5. Type the following information for the server information where the logs are stored:

• In Name, type the name of the server.
• Under Server, type the name or the IP address of the log server.

6. Click Create and then click Close.

After you create the auditing policy, you can bind the policy to any combination of the following:

• Globally
• Virtual servers
• Groups
• Users

To bind an auditing policy globally

1. In the configuration utility, on the Configuration tab, expand NetScaler Gateway > Policies >
Auditing.

2. Select either Syslog or Nslog.
3. In the details pane, click Action and then click Global Bindings.
4. In the Bind/Unbind Auditing Policies to Global dialog box, under Details, click Insert Policy.
5. Under Policy Name, select a policy and then click OK.
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Tomodify an auditing policy

You can modify an existing auditing policy to change the server to which the logs are sent.

1. In the configuration utility, on the Configuration tab, expand NetScaler Gateway > Policies >
Auditing

2. Select either Syslog or Nslog.
3. In the details pane, click a policy and then click Open.
4. In Server, select the new server, and then click OK.

To remove an auditing policy

You can remove an auditing policy from NetScaler Gateway. When you remove an auditing policy, the
policy is unbound automatically.

1. In the configuration utility, on the Configuration tab, expand NetScaler Gateway > Policies >
Auditing.

2. Select either Syslog or Nslog.
3. In the details pane, click a policy and then click Remove.

Configuring ACL Logging

October 5, 2020

You can configure NetScaler Gateway to log details for packets that match an extended access control
list (ACL). In addition to the ACL name, the logged details include packet-specific information, such
as the source and destination IP addresses. The information is stored either in a syslog or nslog file,
depending on the type of logging (syslog or nslog) that you enable.

You can enable logging at both the global level and the ACL level. However, to enable logging at the
ACL level, you must also enable it at the global level. The global setting takes precedence.

To optimize logging, when multiple packets from the same flow match an ACL, only the first packet’s
details are logged. The counter is incremented for every other packet that belongs to the same flow.
A flow is defined as a set of packets that have the same values for the following parameters:

• Source IP
• Destination IP
• Source port
• Destination port
• Protocol (TCP or UDP)
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If the packet is not from the same flow, or if the time duration is beyond the mean time, a new flow
is created. Mean time is the time during which packets of the same flow do not generate additional
messages (although the counter is incremented).

Note: The total number of different flows that can be logged at any given time is limited to 10,000.

The following table describes the parameters with which you can configure ACL logging at the rule
level for extended ACLs.

Parameter Name Description

Logstate State of the logging feature for the ACL.
Possible values: ENABLED and DISABLED.
Default: DISABLED.

Ratelimit Number of log messages that a specific ACL
can generate. Default: 100.

To configure ACL logging by using the configuration utility

You can configure logging for an ACL and specify the number of log messages that the rule can gener-
ate.

1. In the configuration utility, in the navigation pane, expand System > Network and then click
ACLs.

2. In the details pane, click the Extended ACLs tab and then click Add.
3. In the Create Extended ACL dialog box, in Name, type a name for the policy.
4. Select the Log State check box.
5. In the Log Rate Limit text box, type the rate limit that you want to specify for the rule and then

click Create.

After you configure ACL logging, you can enable it on NetScaler Gateway. Create an auditing policy
and then bind it to a user, group, virtual server, or globally.

To enable ACL or TCP logging on NetScaler Gateway

1. In the configuration utility, in the navigation pane, expand NetScaler Gateway > Policies > Au-
diting.

2. Select either syslog or nslog.
3. On the Servers tab, click Add.
4. In the Create Auditing Server dialog box, in Name, type a name for the server and then config-

ure the server settings.
5. Click ACL Logging or TCP Logging and then click Create.
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Enabling NetScaler Gateway Plug-in Logging

October 5, 2020

You can configure the NetScaler Gateway Plug-in to log all errors to text files that are stored on the user
device. Users can configure the NetScaler Gateway Plug-in to set the level of logging on the user device
to record specific user activities. When users configure logging, the plug-in creates the following two
files on the user device:

• hooklog<num>.txt, which logs interception messages that the NetScaler Gateway Plug-in gen-
erates.

• nssslvpn.txt, which lists errors with the plug-in.

Note: The hooklog.txt files are not deleted automatically. Citrix recommends deleting the
files periodically.

User logs are located in the following directories in Windows on the user device:

• Windows XP (all users): %SystemDrive%:\Documents and Settings\All Users\Application
Data\Citrix\AGEE

• Windows XP (user-specific): %SystemDrive%:\Documents and Settings\%username%\Local
Settings\Application Data\Citrix\AGEE

• Windows Vista (all users): %SystemDrive%:\ProgramData\Citrix\AGEE
• Windows Vista (user-specific): %SystemDrive%:\Users\%username%\AppData\Local\Citrix\AGEE
• Windows 7 (all users): %SystemDrive%:\ProgramData\Citrix\AGEE
• Windows 7 (user-specific): %SystemDrive%:\Users\%username%\AppData\Local\Citrix\AGEE
• Windows 8 (all users): %SystemDrive%:\ProgramData\Citrix\AGEE
• Windows 8 (user-specific): %SystemDrive%:\Users\%username%\AppData\Local\Citrix\AGEE

You can use these log files to troubleshoot the NetScaler Gateway Plug-in. Users can email the log
files to Technical Support.

In the Configuration dialog box, users can set the level of logging for the NetScaler Gateway Plug-in.
The logging levels are:

• Record error messages
• Record event messages
• Record NetScaler Gateway Plug-in statistics
• Record all errors, event messages, and statistics

To enable logging

1. On the user device, right-click the NetScaler Gateway icon in the notification area and then click
Configure NetScaler Gateway.
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2. Click the Trace tab, select the log level and then click OK.

Note: Users must be logged on with the NetScaler Gateway Plug-in to open the
Configuration dialog box.

Tomonitor ICA connections

October 5, 2020

You can monitor active user sessions on your server farm by using the
ICA Connections dialog box. This dialog box provides the following information:

• User name of the person connecting to the server farm
• Domain name of the server farm
• IP address of the user device
• Port number of the user device
• IP address of the server running XenApp or XenDesktop
• Port number of the server running XenApp or XenDesktop

1. In the configuration utility, in the navigation pane, click NetScaler Gateway.
2. In the details pane, under Monitor Connections, click ICA connections to view the monitoring

dialog box.

Integrating with Citrix Products

October 5, 2020

If you are a system administrator responsible for installing and configuring NetScaler Gateway, you
can configure the appliance to work with App Controller, StoreFront, and the Web Interface.

Users can connect directly to App Controller from the internal network or from a remote location.
When users connect, they can access their web, SaaS, and mobile apps. They can also work with
documents located in ShareFile from any device.

To allow user connections to a server farm through NetScaler Gateway, you configure settings in either
StoreFront or the Web Interface, and on NetScaler Gateway. When users connect, they have access to
published applications and virtual desktops.

The configuration steps for integrating NetScaler Gateway with App Controller, StoreFront, and the
Web Interface assume the following:

• NetScaler Gateway resides in the DMZ and is connected to an existing network.
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• NetScaler Gateway is deployed as a standalone appliance and remote users connect directly to
NetScaler Gateway.

• StoreFront, App Controller, XenApp, XenDesktop, and the Web Interface reside in the secure
network.

• ShareFile is configured in App Controller. For more information about ShareFile, see ShareFile
topic and Configuring ShareFile for User Access topic.

How you deploy StoreFront and App Controller depends on the apps you provide to mobile devices. If
users have access to MDX apps that are wrapped with the MDX Toolkit, App Controller resides in front
of StoreFront in the secure network. If you are not providing access to MDX apps, StoreFront resides
in front of App Controller in the secure network.

HowUsers Connect to Applications, Desktops, and ShareFile

October 5, 2020

If you have App Controller in your deployment, users can connect in the following ways:

• NetScaler Gateway Plug-in that establishes a full VPN tunnel to resources in the internal net-
work. You create a session profile to select the NetScaler Gateway Plug-in for Windows or the
NetScaler Gateway Plug-in for Mac. When users log on by using the plug-in , endpoint analysis
scans can run on the user device.

Note: To allow endpoint analysis scans to run on Mac computers, you must install NetScaler
Gateway 10.1, Build 120.1316.e or newer.

• Citrix Receiver to connect to web, SaaS, and Enterprise applications, web links, and documents
from ShareFile through App Controller. When users log on with Receiver, NetScaler Gateway
routes the connection to App Controller. When Receiver establishes the connection, users’ ap-
plications and documents appear in Receiver. If users log on with Receiver and connect to App
Controller directly, you must enable clientless access in NetScaler Gateway. This deployment
does not require StoreFront.

• Receiver to connect to published applications and virtual desktops through StoreFront or the
Web Interface. When users log on with Receiver, NetScaler Gateway routes the connection to
StoreFront or the Web Interface. When Receiver establishes the connection, user applications
and desktops appear in Receiver.

• Worx Home to connect to iOS and Android apps, including WorxMail and WorxWeb, from mo-
bile devices through App Controller. When users log on to Worx Home, they have access to the
mobile apps that you configure in App Controller, When NetScaler Gateway establishes the Mi-
cro VPN connection, users mobile apps appear in the Worx Home window. Users can start the
apps from Worx Home. Some apps require users to download and install the app on the mobile
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device.

In any of the preceding scenarios, if users want to connect through NetScaler Gateway, they do the
following:

• Users log on by using the NetScaler Gateway Plug-in or Receiver. To log on for the first time,
users open a web browser and type the fully qualified domain name (FQDN) of NetScaler Gate-
way or Receiver. Users with mobile devices log on with Worx Home.

• On the logon page, users enter their credentials and are authenticated.
• After authentication, the user session redirects to StoreFront or App Controller depending on

your deployment.
• If you deploy both StoreFront and App Controller, NetScaler Gateway contacts the first server

in the deployment. For example, if you configure MDX mobile apps in App Controller, you de-
ploy StoreFront behind App Controller. If you are not providing access to MDX mobile apps, you
deploy App Controller behind StoreFront.

• All of the users’ desktops, documents, and web, SaaS, and Windows-based applications appear
in Receiver or Worx Home.

If users need to access other resources in the internal network, such as Exchange, file shares, or inter-
nal web sites, they can also log on with the NetScaler Gateway Plug-in. For example, if users want to
connect to a Microsoft Exchange server in the network, they start Microsoft Outlook on their computer.
The secure connection is made with the NetScaler Gateway Plug-in which connects to NetScaler Gate-
way. The SSL VPN tunnel is created to the Exchange Server and users can access their email.

Important: Citrix recommends configuring authentication on the NetScaler Gateway virtual
server. When you disable authentication in NetScaler Gateway, unauthenticated HTTP requests
are sent directly to the servers running the Web Interface, StoreFront or App Controller in the
internal network.

Deploying with XenMobile App Edition, XenApp, and XenDesktop

October 5, 2020

You can have users connect to Windows, web, SaaS, and mobile applications and virtual desktops
hosted in your network. You can provide access to your applications and desktops for remote and
internal users by using NetScaler Gateway, XenMobile App Edition, and XenApp and XenDesktop.
NetScaler Gateway authenticates users and then allows them to access their applications by using
Citrix Receiver or Worx Home.

Users connect to their Windows-based apps published in XenApp and virtual desktops published in
XenDesktop by using Receiver and StoreFront.
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XenMobile App Edition contains App Controller, which allows users to connect to web, SaaS, and MDX
applications. App Controller allows you to manage web, SaaS, and MDX applications for single sign-
on (SSO), along with ShareFile documents. You install App Controller in the internal network. Remote
users connect to App Controller through NetScaler Gateway to access their applications and ShareFile
data. Remote users can connect with either the NetScaler Gateway Plug-in, Receiver, or Worx Home
to access applications and ShareFile. Users who are in the internal network can connect directly to
App Controller by using Receiver. The following figure shows NetScaler Gateway deployed with App
Controller and StoreFront.

If your deployment provides access to MDX applications from App Controller and access to Windows-
based applications from StoreFront, you deploy App Controller in front of StoreFront as shown in the
following illustration:

Figure 1. Deploying NetScaler Gateway with App Controller in Front of StoreFront

If your deployment does not provide access to MDX applications, StoreFront resides in front of App
Controller, as shown in the following illustration:

Figure 2. Deploying NetScaler Gateway with StoreFront in Front of App Controller
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With each deployment, StoreFront and App Controller must reside in the internal network and
NetScaler Gateway must be in the DMZ. For more information about deploying App Controller, see
Installing App Controllertopic.
For more information about deploying StoreFront, see StoreFront topic.

Accessing XenApp and XenDesktop Resources with the Web Interface

October 5, 2020

One or more computers running XenApp or XenDesktop creates a server farm. If your enterprise net-
work contains a server farm, you can deploy NetScaler Gateway to provide secure Internet access to
published applications or virtual desktops by using the Web Interface.

In such deployments, NetScaler Gateway works with the Web Interface and the Secure Ticket Author-
ity (STA) to provide authentication, authorization, and redirection to published applications hosted
on a computer running XenApp or to virtual desktops provided by XenDesktop.

This functionality is achieved by integrating NetScaler Gateway with the Web Interface, XenApp, or
XenDesktop. This integration provides advanced authentication and an access control option to the
Web Interface. For more information about the Web Interface, see the Web Interface documentation
in the Citrix documentation library.

Remote connectivity to a server farm does not require the NetScaler Gateway Plug-in. To access pub-
lished applications or desktops, users connect by using Citrix Receiver.
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Integrating NetScaler Gateway with XenApp or XenDesktop

October 5, 2020

When you configure NetScaler Gateway for user connections, you can include settings for network traf-
fic to XenApp, XenDesktop, or both. To do so, you configure NetScaler Gateway and the Web Interface
to communicate with each other.

The tasks for integrating these products include:

• Creating a Web Interface site in the XenApp or XenDesktop farm.
• Configuring settings within the Web Interface to route user connections through NetScaler Gate-

way.
• Configuring NetScaler Gateway to communicate with the Web Interface and the Secure Ticket

Authority (STA).

You can also configure NetScaler Gateway to communicate with a XenApp server farm by deploying
NetScaler Gateway in a double-hop DMZ. For more information, see Deploying NetScaler Gateway in
a Double-Hop DMZ.

NetScaler Gateway and Web Interface use the STA and Citrix XML Service to establish user connections.
The STA and XML Service run on the XenApp or XenDesktop server.

Establishing a Secure Connection to the Server Farm

October 5, 2020

The following example shows how NetScaler Gateway deployed in the DMZ works with the Web Inter-
face to provide a secure, single point-of-access to published resources available in a secure enterprise
network.

In this example, all of the following conditions exist:

• User devices from the Internet connect to NetScaler Gateway by using Citrix Receiver.
• The Web Interface resides behind NetScaler Gateway in the secure network. The user device

makes the initial connection to NetScaler Gateway and the connection is passed to the Web
Interface.

• The secure network contains a server farm. One server within this server farm runs the Secure
Ticket Authority (STA) and the Citrix XML Service. The STA and the XML Service can run on either
XenApp or XenDesktop.
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Process Overview: User Access to Published Resources in the Server Farm

1. A remote user types the address of NetScaler Gateway; for example, https://www.ag.wxyco
.com, in the address field of a web browser. The user device attempts this SSL connection on
port 443, which must be open through the firewall for the connection to succeed.

2. NetScaler Gateway receives the connection request and users are asked for their credentials.
The credentials are passed back through NetScaler Gateway, users are authenticated, and the
connection is passed to the Web Interface.

3. The Web Interface sends the user credentials to the Citrix XML Service running in the server farm.
4. The XML Service authenticates the user credentials and sends the Web Interface a list of the

published applications or desktops the user is authorized to access.
5. The Web Interface populates a Web page with the list of published resources (applications or

desktops) that the user is authorized to access and sends this Web page to the user device.
6. The user clicks a published application or desktop link. An HTTP request is sent to the Web

Interface indicating the published resource that the user clicked.
7. The Web Interface interacts with the XML Service and receives a ticket indicating the server on

which the published resource runs.
8. The Web Interface sends a session ticket request to the STA. This request specifies the IP address

of the server on which the published resource runs. The STA saves this IP address and sends the
requested session ticket to the Web Interface.

9. The Web Interface generates an ICA file containing the ticket issued by the STA and sends it to the
Web browser on the user device. The ICA file generated by the Web Interface contains the fully
qualified domain name (FQDN) or the Domain Name System (DNS) name of NetScaler Gateway.
Note that the IP address of the server running the requested resource is never revealed to users.

10. The ICA file contains data instructing the web browser to start Citrix Receiver. The user device
connects to NetScaler Gateway by using the NetScaler Gateway FQDN or DNS name in the ICA
file. Initial SSL/TLS handshaking occurs to establish the identity of NetScaler Gateway.

11. The user device sends the session ticket to NetScaler Gateway and then NetScaler Gateway con-
tacts the STA for ticket validation.

12. The STA returns the IP address of the server on which the requested application resides to
NetScaler Gateway.

13. NetScaler Gateway establishes a TCP connection to the server.
14. NetScaler Gateway completes the connection handshake with the user device and indicates to

the user device that the connection is established with the server. All further traffic between
the user device and the server is proxied through NetScaler Gateway. The traffic between the
user device and NetScaler Gateway is encrypted. The traffic between NetScaler Gateway and
the server can be encrypted independently, but is not encrypted by default.
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Deploying with the Web Interface

October 5, 2020

When you deploy NetScaler Gateway to provide secure remote access to XenApp or XenDesktop,
NetScaler Gateway works with the Web Interface and the Secure Ticket Authority (STA) to provide
access to published applications and desktops hosted in a server farm.

Deploying NetScaler Gateway in the DMZ is the most common configuration when NetScaler Gateway
operates with a server farm. In this configuration, NetScaler Gateway provides a secure single point-
of-access for the web browsers and Citrix Receiver that access the published resources through the
Web Interface. This section covers the basic aspects of about this deployment option.

The configuration of your organization’s network determines where you deploy NetScaler Gateway
when it operates with a server farm. You have the following two options:

• If your organization protects the internal network with a single DMZ, deploy NetScaler Gateway
in the DMZ.

• If your organization protects the internal network with two DMZs, deploy one NetScaler Gateway
in each of the two network segments in a double-hop DMZ configuration. For more information,
see Deploying NetScaler Gateway in a Double-Hop DMZ.
Note: You can also configure a double-hop DMZ with the second NetScaler Gateway appliance
in the secure network.

When you deploy NetScaler Gateway in the DMZ to provide remote access to a server farm, you can
implement one of the following three deployment options:

• Deploy the Web Interface behind NetScaler Gateway in the DMZ. In this configuration, as shown
in the following figure, both NetScaler Gateway and the Web Interface are deployed in the
DMZ. The initial user connection goes to NetScaler Gateway and is then redirected to the Web
Interface.
Figure 1. Web Interface Behind NetScaler Gateway in the DMZ

• Deploy NetScaler Gateway parallel to the Web Interface in the DMZ. In this configuration, both
NetScaler Gateway and the Web Interface are deployed in the DMZ, but the initial user connec-
tion goes to the Web Interface instead of NetScaler Gateway.
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• Deploy NetScaler Gateway in the DMZ and deploy the Web Interface in the internal network. In
this configuration, NetScaler Gateway authenticates user requests before relaying the request
to the Web Interface in the secure network. The Web Interface does not perform authentication,
but interacts with the STA and generates an ICA file to ensure that ICA traffic is routed through
NetScaler Gateway to the server farm.

The location in which you deploy the Web Interface depends on a number of factors, including:

• Authentication. When users log on, either NetScaler Gateway or the Web Interface can authen-
ticate user credentials. Where you place the Web Interface in your network is a factor that de-
termines, in part, where users authenticate.

• User software. Users can connect to the Web Interface with either the NetScaler Gateway Plug-
in or Citrix Receiver. You can limit the resources users can access by using Citrix Receiver only,
or give users greater network access with the NetScaler Gateway Plug-in. How users connect,
and the resources to which you allow users to connect can help determine where you deploy
the Web Interface in your network.

Deploying the Web Interface in the Secure Network

October 5, 2020

In this deployment, the Web Interface resides in the secure, internal network. NetScaler Gateway is
in the DMZ. NetScaler Gateway authenticates user requests before sending the requests to the Web
Interface.

When you deploy the Web Interface in the secure network, you must configure authentication on
NetScaler Gateway.

If you deploy the Web Interface with Citrix XenDesktop, deploying the Web Interface in the secure net-
work is the default deployment scenario. When the Desktop Delivery Controller is installed, a custom
version of the Web Interface is also installed.

Important:
When the Web Interface is in the secure network, you should enable authentication on NetScaler
Gateway. Users connect to NetScaler Gateway, type their credentials, and then connect to the
Web Interface. When you disable authentication, unauthenticated HTTP requests are sent di-
rectly to the server running the Web Interface. Disabling authentication on NetScaler Gateway is
recommended only when the Web Interface is in the DMZ and users connect directly to the Web
Interface.

Figure 1. Web Interface Located Inside the Secure Network
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Deploying the web interface parallel to NetScaler Gateway in the DMZ

October 5, 2020

In this deployment, the Web Interface and NetScaler Gateway both reside in the DMZ. Users connect
directly to the Web Interface by using a web browser or Citrix Receiver. User connections are first sent
to the Web Interface for authentication. After authentication, the connections are routed through
NetScaler Gateway. After users log on successfully to the Web Interface, they can access published
applications or desktops in the server farm. When users start an application or desktop, the Web In-
terface sends an ICA file containing instructions for routing ICA traffic through NetScaler Gateway as
if it were a server running the Secure Gateway. The ICA file delivered by the Web Interface includes a
session ticket produced by the Secure Ticket Authority (STA).

When Citrix Receiver connects to NetScaler Gateway, the ticket is presented. NetScaler Gateway con-
tacts the STA to validate the session ticket. If the ticket is still valid, the user’s ICA traffic is relayed to
the server in the server farm. The following figure shows this deployment.

Figure 1. The Web Interface installed parallel to NetScaler Gateway

When the Web Interface runs parallel to NetScaler Gateway in the DMZ, you do not need to configure
authentication on NetScaler Gateway. The Web Interface authenticates users.
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Deploying the web interface behind NetScaler Gateway in the DMZ

October 5, 2020

In this configuration, both NetScaler Gateway and the Web Interface are deployed in the DMZ. When
users log on with Citrix Receiver, the initial user connection goes to NetScaler Gateway and is then
redirected to the Web Interface. To route all HTTPS and ICA traffic through a single external port and
require the use of a single SSL certificate, NetScaler Gateway acts as a reverse web proxy for the Web
Interface.

Figure 1. Web Interface Located Behind NetScaler Gateway

When the Web Interface is deployed behind NetScaler Gateway in the DMZ, you can configure authen-
tication on the appliance but it is not required. You can have either NetScaler Gateway or the Web
Interface authenticate users because both reside in the DMZ.

Setting Up aWeb Interface Site to Work

October 5, 2020

The Web Interface provides users with access to XenApp applications and content and XenDesktop
virtual desktops. Users access their published applications and desktops through a standard Web
browser or through Citrix Receiver.

You can use the Access Management Console to configure Web Interface 5.1 sites and the Web Interface
Management console to create Web Interface sites for Versions 5.2, 5.3, and 5.4. You can install the
consoles on Windows-based platforms only.

To configure the Web Interface to work with NetScaler Gateway, you need to:

• Create the Web Interface site for the version you are using.
• Configure settings in the Web Interface.
• Configure Web Interface settings on NetScaler Gateway.
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Web Interface Features

October 5, 2020

Before you configure the Web Interface to work with NetScaler Gateway, you need to understand the
differences between Citrix XenApp Web sites and XenApp Services sites.

• XenApp Web sites. The Web Interface provides functionality to create and manage XenApp
Web sites. Users access published resources and streamed applications remotely using a Web
browser and a plug-in.

• XenAppServices sites. XenApp is a plug-in designed for flexibility and ease of configuration. By
using XenApp in conjunction with XenApp Services sites on the Web Interface, you can integrate
published resources with users’ desktops. Users access remote and streamed applications, and
remote desktops and content by clicking icons on their desktop or the Start menu, or by clicking
in the notification area of their computer desktop. You can determine the configuration options
your users can access and modify, such as audio, display, and logon settings.

Note: If you select this option, access to virtual desktops is not supported.

For more information, see the Web Interface documentation in the Technologies node in the Citrix
eDocs library.

Setting Up aWeb Interface Site

October 5, 2020

If you deploy the Web Interface in the secure network and configure authentication on NetScaler Gate-
way, when users connect to NetScaler Gateway, the appliance authenticates users.

Important: Install and configure the Web Interface before you configure NetScaler Gateway. For
more information, see the Web Interface documentation in the
Technologies node in the Citrix eDocs library.

The steps for creating a Web Interface site include:

• Select how users log on. This can be through a web browser, the NetScaler Gateway Plug-in, or
Citrix Receiver. For information, see Web Interface Features.

• Identify where users authenticate from. NetScaler Gateway or the Web Interface.

Note: When the Web Interface is in the secure network, you enable authentication on the vir-
tual server on the NetScaler Gateway. When you disable authentication, unauthenticated HTTP
requests are sent directly to the server running the Web Interface. Disabling authentication on
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NetScaler Gateway is recommended only when the Web Interface is in the DMZ and users connect
directly to the Web Interface.

Make sure you install a valid server certificate on NetScaler Gateway. For more information about
working with certificates, see Installing and Managing Certificates.

Important: For the Web Interface to work properly with NetScaler Gateway 10.1, the server run-
ning the Web Interface must trust the NetScaler Gateway certificate and be able to resolve the
virtual server fully qualified domain name (FQDN) to the correct IP address.

Creating a Web Interface 5.4 Site

October 5, 2020

The Citrix Web Interface Management console is a Microsoft Management Console (MMC) 3.0 snap-in
that enables you to create and configure XenApp Web and XenApp Services sites hosted on Microsoft
Internet Information Services (IIS). Web Interface site types are shown in the left pane. The central
results pane displays the sites available within the site type container selected in the left pane.

The Citrix Web Interface Management console enables you to perform day-to-day administration tasks
quickly and easily. The Action pane lists the tasks currently available. Tasks relating to items selected
in the left pane are shown at the top and actions available for items selected in the results pane are
shown below.

When using the console, your configuration takes effect when you commit your changes using the
console. As a result, some Web Interface settings may be disabled if their values are not relevant to
the current configuration and the corresponding settings are reset to their default values in WebInter-
face.conf. Citrix recommends that you create regular backups of the WebInterface.conf and config.xml
files for your sites.

The Citrix Web Interface Management console is installed automatically when you install Web Inter-
face for Microsoft Internet Information Services. Run the console by clicking Start > All Programs >
Citrix > Management Consoles > Citrix Web Interface Management.

Note:
You must ensure that MMC 3.0 is present on the server on which you install the Web Interface as
this is a prerequisite for installation of the Citrix Web Interface Management console. MMC 3.0 is
available by default on all the Windows platforms supported for hosting the Web Interface.

Using Configuration Files

You can edit the following configuration files to configure Web Interface sites:
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• Web Interface configuration file. The Web Interface configuration file, WebInterface.conf, en-
ables you to change many Web Interface properties; it is available on both Microsoft Internet In-
formation Services (IIS) and Java application servers. You can use this file to perform day-to-day
administration tasks and customize many more settings. Edit the values in WebInterface.conf
and save the updated file to apply the changes. For more information about configuring the Web
Interface by using WebInterface.conf, see the Web Interface documentation in the Technologies
node in Citrix eDocs.

• Citrix online plug-in configuration file. You can configure the Citrix online plug-in by using the
config.xml file on the Web Interface server.

Configuring Sites By Using the CitrixWeb InterfaceManagement Console

October 5, 2020

The Citrix Web Interface Management console is a Microsoft Management Console (MMC) 3.0 snap-in
that enables you to create and configure XenApp Web and XenApp Services sites hosted on Microsoft
Internet Information Services (IIS). Web Interface site types are shown in the left pane. The central
results pane displays the sites available within the site type container selected in the left pane.

The Citrix Web Interface Management console enables you to perform day-to-day administration tasks
quickly and easily. The Action pane lists the tasks currently available. Tasks relating to items selected
in the left pane are shown at the top and actions available for items selected in the results pane are
shown below.

When using the console, your configuration takes effect when you commit your changes using the
console. As a result, some Web Interface settings may be disabled if their values are not relevant to
the current configuration and the corresponding settings are reset to their default values in WebInter-
face.conf. Citrix recommends that you create regular backups of the WebInterface.conf and config.xml
files for your sites.

The Citrix Web Interface Management console is installed automatically when you install Web Inter-
face for Microsoft IIS. Run the console by clicking Start > All Programs > Citrix > Management Consoles
> Citrix Web Interface Management.

Note: You must ensure that MMC 3.0 is present on the server on which you install the Web Interface
as this is a prerequisite for installation of the Citrix Web Interface Management console. MMC 3.0 is
available by default on all the Windows platforms supported for hosting the Web Interface.
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Configuring NetScaler Gateway Settings in the Web Interface 5.4

October 5, 2020

To use NetScaler Gateway in your deployment, you must configure the Web Interface support the ap-
pliance. To do this, use the Secure Access task in the Citrix Web Interface Management console.

To configure NetScaler Gateway settings in the Web Interface

1. On the Windows Start menu, click All Programs > Citrix > Management Consoles > Citrix Web
Interface Management.

2. In the left pane of the Citrix Web Interface Management console, click either XenApp Web Sites
or XenApp Services Sites and then select your site in the results pane.

3. In the Action pane, click Secure Access.
4. On the Specify Access Methods page, do one of the following:

• Click Add to add a new access route.
• Select an existing route from the list and then click Edit.

5. From the Access method list, select one of the following options:
• If you want to send the actual address of the Citrix server to NetScaler Gateway, select

Gateway Direct.
• If you want to send the alternate address of the XenApp server to NetScaler Gateway, select

Gateway alternate.
Note: XenDesktop virtual desktops cannot be accessed if alternate addresses are used.

• If you want the address given to NetScaler Gateway to be determined by the address trans-
lation mappings set in the Web Interface, select Gateway translated.

6. Enter the network address and subnet mask that identify the client network. Use the Move
Up and Move Down buttons to place the access routes in order of priority in the User device
addresses table and then click Next.

7. If you are not using gateway address translation, continue to Step 10. If you are using gateway
address translation, do one of the following on the Specify Address Translations page:

• Click Add to add a new address translation.
• Select an existing address translation from the list and then click Edit.

8. In the Access Type area, select one of the following options:
• If you want NetScaler Gateway to use the translated address to connect to the Citrix server,

select Gateway route translation.
• If you configured a client translated route in the User device addresses table and want

both the Citrix client and NetScaler Gateway to use the translated address to connect to
the Citrix server, select User device and gateway route translation.

9. Enter the internal and external (translated) ports and addresses for the Citrix server, click OK
and then click Next.
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When NetScaler Gateway connects to the Citrix server, it uses the external port number and
address. Ensure that the mappings you create match the type of addressing being used by the
server farm.

10. On the Specify Gateway Settings page, specify the fully qualified domain name (FQDN) and port
number of the NetScaler Gateway appliance that clients must use. The FQDN must match what
is on the certificate installed on the gateway.

11. Select Enable session reliability if you want the Citrix server to keep disconnected sessions open
while the client attempts to reconnect automatically.

12. Select Request tickets from two STAs where available if you enabled session reliability and want
to use simultaneous ticketing from two Secure Ticket Authority (STA) servers. When you enable
this option, the Web Interface obtains tickets from two different STAs so that user sessions are
not interrupted if one STA becomes unavailable during the course of the session. If for any rea-
son the Web Interface is unable to contact two STAs, it falls back to using a single STA. Click
Next.

13. On the Specify Secure Ticket Authority Settings page, do one of the following:
- Click Add to specify the URL of a STA that the Web Interface can use.
- Select an entry from the list and then click Edit.

1 Use the Move Up and Move Down buttons to place the STAs in order of
priority.

2 STAs are included with the Citrix XML Service; for example, `http\[s\]:
//servername.domain.com/scripts/ctxsta.dll`.

3
4 You can specify more than one STA for fault tolerance; however, Citrix

recommends that you do not use an external load balancer for this
purpose.

14/. Select Use for load balancing to choose whether or not to enable load balancing between STAs.
Enabling load balancing allows you to evenly distribute connections among servers so that no one
server becomes overloaded.

1. Select Bypass failed servers for to specify the length of time that unreachable STAs should be
bypassed.

1 The Web Interface provides fault tolerance among the servers on the STA
URLs list so that if a communication error occurs, the failed
server is bypassed for the specified time period.
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Creating a Web Interface 5.3 Site

October 5, 2020

When you create a Web Interface 5.3 site, you can require users to log on with either a web browser,
Citrix Receiver, or Citrix Desktop Receiver. You can use the Citrix Web Interface Management console
to create multiple Web Interface sites.

You can only enable single sign-on with a smart card to the Web Interface with Web Interface 5.3. This
version of the Web Interface can run on XenApp 4.5, 5.0, and 6.0.

Web Interface 5.3 runs on the following operating systems:

• Windows Server 2003
• Windows Server 2008
• Windows Server 2008 R2

Note:
XenApp 6.0 runs only on Windows Server 2008 R2.

To create a Web Interface 5.3 site

1. Click Start > All Programs > Citrix > Management Consoles > Citrix Web Interface Management.

2. In the left pane, select XenApp Web Sites. Users log on to the Web Interface using a Web browser.

3. On the Action menu, click Create Site.

4. Keep the default Internet Information Services (IIS) site and path and then click Next.

The default site path is /Citrix/XenApp or you can specify a path.

Note:
If there are any preexisting XenApp Web sites that use the default path, an appropriate
increment is added to distinguish the new site.

5. In Specify where user authentication takes place, select one of the following:

• At Web Interface to have users authenticate using the Web Interface.

Select this option if the Web Interface is deployed as a standalone server parallel to
NetScaler Gateway in the demilitarized zone (DMZ).

• At Access Gateway to have users authenticate using the NetScaler Gateway appliance.

If you select this option, NetScaler Gateway authenticates users and initiates single sign-
on to the Web Interface if it is configured on the appliance.
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Note:
If SmartAccess is configured on NetScaler Gateway, this setting enables SmartAccess in
XenApp or XenDesktop.

6. Click Next.

7. in Step 5, in Authentication service URL, type the Web address to the NetScaler Gateway au-
thentication service URL, such as https://access.company.com/CitrixAuthService/
AuthService.asmx and then click Next.

8. Under Authentication Options, select how users log on.

• Explicit. Users log on by using a Web browser.
• Smart Card. Users log on by using a smart card.

9. Click Next.

10. If you selected Smart Card in Step 8, select one of the following:
- Prompt users for PIN. Users enter their personal identification number (PIN) when they start a
published application or desktop.
- Users do not have to enter their PIN when they start a published application or desktop.

You receive a summary screen showing your settings. Click
Next to create the Web Interface site. When the site is successfully created, you are then prompted to
configure the remaining settings in the Web Interface. Follow the instructions in the wizard to com-
plete the configuration.

Configuring NetScaler Gateway Settings in Web Interface 5.3

October 5, 2020

After you create the Web Interface 5.3 site, you can use Citrix Web Interface Management to configure
settings for NetScaler Gateway.

To configure Web Interface 5.3 settings for NetScaler Gateway

1. Click Start > All Programs > Citrix > Management Consoles > Citrix Web Interface Management.
2. In the left pane of Citrix Web Interface Management, click XenApp Web Sites.
3. In the Action pane, click Secure Access.
4. In the Edit Secure Access Settings dialog box, click Add.
5. In the Add Access Route dialog box, type the user device address, subnet mask, and in Access

Method, select Gateway direct, click OK and then click Next. If you do not specify the user device
address and subnet mask, the Gateway direct option applies to all user devices. The Gateway
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direct option is appropriate for user devices connecting from outside of the internal network,
whereas the Direct option is appropriate for user devices connecting from within the internal
network.

6. In Address (FQDN), type the NetScaler Gateway fully qualified domain name (FQDN). This must
be the same FQDN that is used on the NetScaler Gateway certificate.

7. In Port, type the port number. The default is 443.
8. To enable session reliability, click Enable session reliability and then click Next.
9. Under Secure Ticket Authority URLs, click Add.

10. In Secure Ticket Authority URL, type the name of the master server running the XML Service on
XenApp, click OK and then click Finish. For example, type http://xenappsrv01/Scripts/
CtxSta.dll.

After you configure the settings in the Web Interface, you can then configure settings on NetScaler
Gateway.

Adding XenApp and XenDesktop to a Single Site

October 5, 2020

If you are running XenApp and XenDesktop, you can add both applications to a single Web Interface
site. This configuration allows you to use the same Secure Ticket Authority (STA) server from either
XenApp or XenDesktop.

Note:
XenDesktop supports the Web Interface. The minimum required version of the Web Interface is
5.0.

If you are using Web Interface 5.3or 5.4, you combine the XenApp and XenDesktop sites by using the
Web Interface Management console.

Note:
If the server farms are in different domains, you must establish two-way trust between the do-
mains.

To add XenApp or XenDesktop to a single site by using Web Interface 5.3 or 5.4

1. Click Start > All Programs > Citrix > Management Consoles > Citrix Web Interface Manage-
ment.

2. In the left pane, select XenAppWeb Sites.
3. In the Action pane, right-click a site and then click Server Farms.
4. In the Manage Server Farms dialog box, click Add.
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5. Complete the settings for the server farm and then click OK twice.

For the best experience when using XenDesktop, change the setting UserInterfaceBranding to Desk-
tops in the WebInterface.conf configuration file.

Routing User Connections Through NetScaler Gateway

October 5, 2020

In XenApp and XenDesktop, you can configure the servers to only accept connections that are routed
through NetScaler Gateway. In XenApp 6.5, you configure a policy in Citrix AppCenter to route connec-
tions through NetScaler Gateway. In XenDesktop 7.1, you use Citrix Studio to configure the settings.

To configure XenApp 6.5 server properties to accept connections routed through
NetScaler Gateway only

1. Click Start > Administrative Tools > Citrix > Management Consoles > Citrix AppCenter.
2. Expand NetScaler Resources > XenApp > farmName, where farmName is the name of the server

farm.
3. Click Policies.
4. In the center pane, click Computer or User and then click New.
5. In the New Policy wizard, in Name, type a name for the policy and then click Next.
6. Under Categories, click Server Settings.
7. Under Settings, next to Connection access control, click Add.
8. In theAddSetting - Connection access controldialog box, inValue, select Citrix AccessGate-

way connections only and then click OK.
9. Click Next two times and then click Create. XenApp creates the policy.

To configure XenDesktop server properties to accept connections routed through
NetScaler Gateway only

You can restrict access to a Delivery Group’s machines. You can restrict access for users by using Smar-
tAccess that filters user connections made through NetScaler Gateway. You can perform this task in
the Policy node in Studio, or through the policy settings.

1. In Studio, under Delivery Groups, select the Delivery Group you want to restrict.
2. Click Edit Delivery Group and then click Access policy.
3. On the Access Policy page, select Connections through NetScaler Gateway. Only connections

through the NetScaler Gateway are allowed.
4. To choose a subset of those connections, select Connections meeting any of the following filters:
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a) Define the NetScaler Gateway site.
b) Add, edit, or remove the SmartAccess strings that define the allowed user access scenarios

for the Delivery Group. For more information about configuring SmartAccess, see Config-
uring SmartAccess on NetScaler Gateway.

Configuring Communication with the Web Interface

October 5, 2020

You can configure NetScaler Gateway to communicate with the Web Interface running on Citrix XenApp
and Citrix XenDesktop. To do so, configure a virtual server on NetScaler Gateway. Next, bind a signed
server certificate and authentication, session, preauthentication, and post-authentication policies to
the virtual server. NetScaler Gateway uses the virtual server IP address to route user connections to
the Web Interface.

The Published Applications Wizard allows you to configure NetScaler Gateway to route user connec-
tions to the Web Interface. NetScaler Gateway uses the Secure Ticket Authority (STA) for user connec-
tions.

Configuring Policies for Published Applications and Desktops

October 5, 2020

To establish communication with XenApp and XenDesktop servers, you need to configure NetScaler
Gateway to recognize the servers. You can configure the settings globally or you can use policies that
are bound to users, groups, or virtual servers.

To configure the Web Interface globally on NetScaler Gateway

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Global Settings.

2. In the details pane, under Settings, click Change global settings.
3. In the Global NetScaler Gateway Settings dialog box, on the Client Experience tab, do the fol-

lowing:
a) In Plug-in type, select Java.
b) In Clientless Access, select Allow.

Note: Perform Step 3 to support VPN-capable Citrix Receiver, such as Receiver for
iOS or Receiver for Android. To support mobile Receiver, you must install a minimum
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of Access Gateway 10, Build 69.6 or Access Gateway 10, Build 71.6014.e. If you are
running Access Gateway 9.3, you do not need to perform this step.

4. On the Published Applications tab, next to ICA Proxy, select ON.
5. Next to Web Interface Address, type the Web address of the Web Interface and then click OK.

To configure a session policy for the Web Interface

You can configure a session policy and bind it to a virtual server to limit access to the Web Interface.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway Policies and then click Session.

2. In the details pane, on the Policies tab, click Add.
3. In the Create Session Policy dialog box, in Name, type a name for the policy.
4. Next to Request Profile, click New.
5. In the Create Session Profile dialog box, in Name, type a name for the profile.
6. On the Client Experience tab, do the following:

a) Next to Plug-in type, select Override Global and then select Java.
b) Next to Clientless Access, select Override Global and then select Allow.

7. Next to ICA Proxy, click Override Global and select ON.
8. Next to Web Interface Address, click Override Global, type the Web address of the Web Interface

and then click Create.
9. In the Create Session Policy dialog box, next to Named Expressions, select General, select True

value, click Add Expression, click Create and then click Close.

After you create a session policy, bind the policy to a virtual server.

To bind a session policy to a virtual server

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Virtual Servers.

2. In the details pane, select a virtual server and then click Open.
3. On the Policies tab, click Session and then click Insert Policy.
4. Select a session policy from the list, enter the priority number (optional) and then click OK

Configuring Settings with the Published Applications wizard

October 5, 2020

To configure NetScaler Gateway with the Web Interface, you need the following information:

• IP addresses of servers running XenApp or XenDesktop.
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• Fully qualified domain name (FQDN) of the server running the Web Interface.
• Virtual server configured on NetScaler Gateway.
• Session policy configured for SmartAccess.
• IP addresses of additional servers running the Web Interface if you are configuring Web Interface

failover.

To configure Web Interface settings by using the Published Applications wizard

1. In the configuration utility, click the Configuration tab and then in the navigation pane, click
NetScaler Gateway.

2. In the details pane, under Getting Started, click Published Applications wizard.
3. Click Next and then follow the instructions in the wizard.

You can configure and activate the Secure Ticket Authority (STA) from within the Published Applica-
tions wizard. When you complete the Published Applications wizard, the settings are bound globally.

Configuring the Secure Ticket Authority on NetScaler Gateway

October 5, 2020

The Secure Ticket Authority (STA) is responsible for issuing session tickets in response to connection
requests for published applications on XenApp and published desktops on XenDesktop. These session
tickets form the basis of authentication and authorization for access to published resources.

You can bind the STA globally or to virtual servers. You can also add multiple servers running the STA
when you configure a virtual server.

If you are securing communications between the NetScaler Gateway and the STA, make sure a server
certificate is installed on the server running the STA.

In a typical NetScaler Gateway GSLB deployment, all gateway virtual servers (in each site) must be
configured with the same back-end STA servers to avoid reconnection issues.

To bind the STA globally

1. Navigate to NetScaler Gateway > Global Settings.

2. In the details pane, under Servers, click Bind/Unbind STA Servers to be used by the Secure
Ticket Authority.

3. In the Bind/Unbind STA Servers dialog box, click Add.

4. In the Configure STA Server dialog box, enter the URL of the STA server, click Create, and then
click OK.
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5. In the STAServer dialog box, in URL, type the IP address or fully qualified domain name (FQDN)
of the server running the STA and then click Create.

Note: You can add more than one server running the STA to the list. The STAs that are listed
in the Web Interface must match the STAs that are configured on NetScaler Gateway. If you
are configuring multiple STAs, do not use load balancing between NetScaler Gateway and
the servers running the STA.

To bind a STA to the virtual server

1. Navigate to NetScaler Gateway > Virtual Servers.
2. In the details pane, select a virtual server and then click Edit.
3. On the Published Applications tab, under Secure Ticket Authority, click Add.
4. In the Configure STA Server dialog box, enter the URL of the STA server and then click Create.
5. Repeat Step 4 to add additional STA servers and then click OK.

References

• For details about STA, see the article NetScaler Gateway Secure Ticket Authority.

• For details on configuring your NetScaler Gateway to use a Cloud Connector as the Secure Ticket
Authority (STA) server, see How do I configure NetScaler Gateway to use a Cloud Connector as
a STA.

Configuring Additional Web Interface Settings on NetScaler Gateway

October 5, 2020

If you deploy NetScaler Gateway in a Web Interface environment, you can complete the following op-
tional tasks:

• Configuring Web Interface Failover Configure NetScaler Gateway to failover to a secondary
server running the Web Interface.

• Configuring Smart Card Access with the Web Interface Configure user sessions to log on directly
to the Web Interface by using Citrix Receiver and smart card authentication.

Configuring Web Interface Failover

October 5, 2020
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You can use the Published Applications Wizard to configure NetScaler Gateway to fail over to a sec-
ondary server running the Web Interface.

Web Interface failover allows user connections to stay active if the primary Web Interface fails. When
you configure failover, you define a new IP address in addition to the system IP address, mapped IP
address, or virtual server IP address. The new IP address must be on the same subnet as the system
or mapped IP address.

When you configure Web Interface failover on NetScaler Gateway, any network traffic that is sent to
the new IP address is relayed to the primary Web Interface. The virtual server that you select in the
Published Applications wizard serves as the network address translation (NAT) IP address. The real
IP address is that of the Web Interface. If the primary Web Interface fails, network traffic is sent to the
secondary Web Interface.

To configure Web Interface failover

1. In the configuration utility, click the Configuration tab and then in the navigation pane, click
NetScaler Gateway.

2. In the details pane, under Getting Started, click Published applications wizard.
3. Click Next, select a virtual server and then click Next.
4. On the Configure Client Connections page, click Configure Web Interface Failover.
5. Under Primary Web Interface, in Web Interface Server, type the IP address of the primary Web

Interface.
6. In Web Interface Server Port, type the port number for the primary Web Interface.
7. In Virtual Server IP, type the new IP address for failover.
8. In Virtual Server Port, enter the port number for the virtual server.
9. Under Backup Web Interface, in Web Interface Server, type the IP address of the server running

the Web Interface or select a server from the list.
10. In Web Interface Server Port, type the port number of the Web Interface and then click OK.
11. Click Next and then follow the instructions to complete the wizard.

Configuring Smart Card Access with the Web Interface

October 5, 2020

When you configure the Web Interface to use smart card authentication, you can configure the fol-
lowing deployment scenarios in order to integrate NetScaler Gateway, depending on how users log
on:

• If users log on directly to the Web Interface by using Citrix Receiver and smart card authentica-
tion, the Web Interface must be parallel to NetScaler Gateway in the DMZ. The server running
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the Web Interface must also be a domain member.

In this scenario, both NetScaler Gateway and the Web Interface perform SSL termination. The
Web Interface terminates secure HTTP traffic including user authentication, the display of pub-
lished applications, and the starting of published applications. NetScaler Gateway terminates
SSL for incoming ICA connections.

• If users log on with the NetScaler Gateway Plug-in, NetScaler Gateway performs the initial au-
thentication. When NetScaler Gateway establishes the VPN tunnel, users can log on to the Web
Interface by using the smart card. In this scenario, you can install the Web Interface behind
NetScaler Gateway in the DMZ or in the secure network.

Note:
NetScaler Gateway can also use the smart card for authentication by using a client certificate.

For more information, see
Configuring Smart Card Authentication

Configuring Access to Applications and Virtual Desktops in the Web
Interface

October 5, 2020

You can configure NetScaler Gateway to give users access to published applications and virtual desk-
tops with the NetScaler Gateway Plug-in instead of with Receiver. To configure access to applications
and desktops, you change the configuration on NetScaler Gateway from using Receiver only to con-
nect to NetScaler Gateway, to a configuration that enables connections by using the NetScaler Gate-
way Plug-in with single sign-on to the Web Interface. For example, you configure NetScaler Gateway
so that all users connect with the NetScaler Gateway Plug-in and use the Web Interface as the home
page. This scenario supports single sign-on to the Web Interface.

In addition to access to applications and desktops, users can also run applications installed on the
user device that make network connections through the VPN tunnel.

To start the configuration, use the following guidelines:

• Create a Web Interface site.
• Configure Advanced Access Control settings.
• Configure SmartAccess.
• Configure endpoint analysis on NetScaler Gateway.
• Configure policies and filters on Citrix XenApp and XenDesktop.
• Configure NetScaler Gateway so users log on by using the NetScaler Gateway Plug-in to access

published applications and virtual desktops.
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For more information, see the following topics in Citrix eDocs:

• Setting Up a Web Interface Site.
• How SmartAccess Works for XenApp and XenDesktop
• Configuring Endpoint Polices
• Configuring XenApp Policies and Filters
• To configure policies and filters in XenDesktop 5
• Configuring NetScaler Gateway to Communicate with the Web Interface

When configuring user logon to XenApp and XenDesktop, you first create a session profile to select the
NetScaler Gateway Plug-in for Windows. Then, you create a profile for intranet applications for access
to XenApp, XenDesktop, and the Web Interface.

To configure global settings for the NetScaler Gateway Plug-in for access to
applications and desktops

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Global Settings.

2. In the details pane, under Settings, click Change global settings.
3. On the Published Applications tab, next to ICA Proxy, select OFF.
4. In Web Interface Address, type the URL of the Web Interface site. This becomes the home page

for users.
5. In Single Sign-On Domain, type the Active Directory domain name.
6. On the Client Experience tab, next to Plug-in Type, select Windows/Mac OS X and then click OK.

To configure the intranet application

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway > Resources and then click Intranet Applications.

2. In the details pane, click Add.

3. In Name, type a name for the application.

4. Click Transparent.

5. In Protocol, select the TCP, UDP, or Any.

6. In Destination Type, select IP Address and Netmask . For example, type 172.16.100.0 and the
subnet mask 255.255.255.0 to represent all servers on the 172.16.100.x subnet. The IP address
of the Web Interface, XenApp, and all other servers to which users connect must be in one of the
subnets defined as an intranet application.

After you create the intranet application, you can bind it globally or to a virtual server.
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7. In IP Address and NetMask, type the IP address and subnet mask that represents your internal
network, click Create and then click Close.

After you create the intranet application, you can bind it globally or to a virtual server.

To bind an intranet application globally

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Global Settings.

2. In the details pane, under Intranet Applications, click Create mappings to TCP applications in
the secure network for the NetScaler Gateway Plug-in for Java.

3. In the Configure VPN Intranet Applications dialog box, click Add.
4. Under Available, select one or more intranet applications, click the arrow to move the intranet

applications to Configured and then click OK.

To bind an intranet application to a virtual server

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Virtual Servers.

2. In the details pane, select a virtual server and then click Open.
3. In the configure NetScaler Gateway Virtual Server dialog box, click the Intranet Applications tab.
4. Under Available Application Name, select the intranet applications, click Add and then click OK.

When users log on with the NetScaler Gateway Plug-in, the VPN tunnel is established and either Re-
ceiver or the Web Interface is used as the home page.

Configuring SmartAccess

October 5, 2020

You can use SmartAccess with XenApp and XenDesktop to intelligently deliver published applications
and virtual desktops to users.

SmartAccess allows you to control access to published applications and desktops on a server through
the use of NetScaler Gateway session policies. You use preauthentication and post-authentication
checks as a condition, along with other conditions, for access to published resources. Other condi-
tions include anything you can control with a XenApp or XenDesktop policy, such as printer bandwidth
limits, user device drive mapping, clipboard, audio, and printer mapping. You can apply a XenApp or
XenDesktop policy based on whether or not users pass an NetScaler Gateway check.

NetScaler Gateway can deliver XenDesktop by using the same options that are available with Web
Interface, ICA proxy access, clientless access, and NetScaler Gateway access.
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This functionality is achieved by integrating NetScaler Gateway components with the Web Interface
and XenApp or XenDesktop. This integration provides advanced authentication and an access con-
trol options to the Web Interface. For more information, see the Web Interface documentation in the
Technologies node in the Citrix eDocs library.

Remote connectivity to a server farm does not require the NetScaler Gateway Plug-in. Users can con-
nect with Citrix Receiver. Users can use the NetScaler Gateway Plug-in to log on and receive their
published applications and virtual desktops through the Access Interface, which is the default home
page for NetScaler Gateway.

How SmartAccess Works for XenApp and XenDesktop

October 19, 2020

To configure SmartAccess, you need to configure NetScaler Gateway settings on the Web Interface/S-
toreFront and configure session policies on NetScaler Gateway. When you run the Published Applica-
tions Wizard, you can select the session policies you created for SmartAccess.

After you configure SmartAccess, the feature works as follows:

1. When a user types the web address of a virtual server in a web browser, any preauthentication
policies that you configured are downloaded to the user device.

2. NetScaler Gateway sends the preauthentication and session policy names to the Web Interface/-
StoreFront as filters. If the policy condition is set to true, the policy is always sent as a filter
name. If the policy condition is not met, the filter name is not sent. This allows you to differen-
tiate the list of published applications and desktops and the effective policies on a computer
running XenApp or XenDesktop, based on the results of the endpoint analysis.

3. The Web Interface/StoreFront contacts the XenApp or XenDesktop server and returns the pub-
lished resource list to the user. Any resources that have filters applied do not appear in the user’s
list unless the condition of the filter is met.

You can configure SmartAccess endpoint analysis on NetScaler Gateway. To configure endpoint anal-
ysis, create a session policy that enables the ICA Proxy setting and then configure a client security
string.

When the user logs on, the endpoint analysis policy runs a security check of the user device with the
client security strings that you configured on NetScaler Gateway.

For example, you want to check for a specific version of Sophos Antivirus. In the expression editor,
the client security strings appear as:

1 client.application.av(sophos).version == 10.0.2
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After you configure the session policy, bind it to a user, group, or virtual server. When users log on,
the SmartAccess policy check starts and verifies whether the user device has Version 10.0.2 or later of
Sophos Antivirus installed.

When the SmartAccess endpoint analysis check is successful, the Web Interface/StoreFront portal ap-
pears in a clientless session. Otherwise, the Access Interface appears.

When you create a session policy for SmartAccess, the session profile does not have any settings con-
figured, which creates a null profile. In this case, NetScaler Gateway uses the Web Interface/StoreFront
URL configured globally for SmartAccess.

Configuring XenApp Policies and Filters

October 5, 2020

After you create the session policy on NetScaler Gateway, you configure policies and filters on the
computer running XenApp that are applied to users according to the endpoint analysis configuration.

To configure XenApp 6.5 policies and filters

1. On the server running XenApp, click Start > Administrative Tools > Citrix > Citrix XenApp. If
prompted, configure and run discovery.

2. In the left pane, expand NetScaler Resources > XenApp > farmName, where farmName is the
name of the server farm.

3. Click Applications.
4. In the center pane, right-click an application and then click Application properties.
5. In the navigation pane, under Properties, click Advanced > Access control.
6. In the right pane, click Any connection that meets any of the following filters and then click Add.
7. In Access Gateway farm, type the name of the NetScaler Gateway virtual server.
8. In Access Gateway filter, type the name of the endpoint session policy and then click OK.
9. In the Application Properties dialog box, clear Allow all other connections and then click OK.

To configure a session policy for SmartAccess

October 5, 2020

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway > Policies and then click Session.

2. In the details pane, on the Policies tab, click Add.
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3. In the Create Session Policy dialog box, in Name, type a name for the policy, such as ValidEnd-
point.

4. In Request Profile, click New and in Name, type a name for the profile, such as Null and then
click Create.

5. In the Create Session Policy dialog box, create a client security expression, click Create and then
click Close.

The client security expression is used to differentiate between valid and invalid endpoints. You can
provide different levels of access to published applications or desktops based on the results of end-
point analysis.

After you create the session policy, bind it either globally or to a virtual server.

Configuring User Device Mapping on XenApp

October 5, 2020

You can use NetScaler Gateway filters that are applied to policies on a computer running XenApp.
Filters give users access to XenApp capabilities, such as user device drive mapping, printer mapping,
or clipboard mapping based on the results of the endpoint analysis.

Citrix Receiver supports the mapping of devices on user devices so users can access external devices
within user sessions. User device mapping provides:

• Access to local drives and ports
• Cut-and-paste data transfer between a user session and the local clipboard
• Audio (system sounds and .wav files) playback from the user session

During logon, the user device informs the server of the available user drives and COM ports. In XenApp
6.5, user drives are mapped to the server and use the user device drive letter. These mappings are
available only for the current user during the current session. The mappings are deleted when the
user logs off and recreated the next time the user logs on.

After enabling the XML Service, you need to configure policies for user device mapping.

To enforce user device mapping policies based on SmartAccess filters, you create the following two
policies on the server:

• A restrictive ICA policy that disables user device mapping and applies to all NetScaler Gateway
users.

• A full ICA policy that enables user device mapping and applies only to users who fulfill the end-
point analysis session policy
Note: The filtered non-restrictive ICA policy must be given a higher priority than the restrictive
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ICA policy, so that when it applies to a user, the non-restrictive policy overrides the policy that
disables user device mapping.

You configure restrictive and non-restrictive policies on XenApp 6.5 by using Citrix AppCenter.

To configure a restrictive policy on XenApp 6.5

October 5, 2020

1. Click Start > Administrative Tools > Management Consoles > Citrix AppCenter.
2. In the left pane, expand XenApp, expand the server and then click Policies.
3. In the Policies pane, click the User tab and then click New.
4. In Name, type a name for the policy and then click Next.
5. Under Categories, click All Settings.
6. Under Settings, in Auto connect client drives, click Add.
7. In the Add Setting dialog box, click Disabled, click OK and then click Next.
8. Under Categories, click All Filters.
9. Under Filters, in Access Control, click Add.

10. In the New Filter dialog box, click Add.
11. In Mode, click Deny.
12. In Connection Type, select With Access Gateway.
13. In AG Farm, type the virtual server name.
14. In Access Condition, type or select the session policy name that is configured on NetScaler Gate-

way, click OK two times, click Next and then click Create to complete the wizard.

To configure a non-restrictive policy on XenApp 6.5

October 5, 2020

1. Click Start > Administrative Tools > Management Consoles > Citrix AppCenter.
2. In the left pane, expand XenApp, expand the server and then click Policies.
3. In the Policies pane, click the User tab and then click New.
4. In Name, type a name for the policy and then click Next.
5. Under Categories, click All Settings.
6. Under Settings, in Auto connect client drives, click Add.
7. Click Enabled, click OK and then click Next.
8. Under Categories, click All Filters.
9. Under Filters, in Access Control, click Add.
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10. In the New Filter dialog box, click Add.
11. In Mode, click Allow.
12. In Connection Type, select With Access Gateway.
13. In AG Farm, type the virtual server name.
14. In Access Condition, type or select the session policy name that is configured on NetScaler Gate-

way, click OK two times, click Next and then click Create to complete the wizard.

Enabling XenApp as a Quarantine Access Method

October 5, 2020

If you have endpoint analysis configured on NetScaler Gateway, users who pass an endpoint scan
can access all the resources that you configure on NetScaler Gateway. You can put users who fail
an endpoint scan in a quarantine group. These users can access published applications from XenApp
only. Success or failure of the endpoint analysis scan determines the access method available to users.

For example, you create an endpoint analysis scan to check whether or not Notepad is running on the
user device when users log on. If Notepad is running, users can log on using the NetScaler Gateway
Plug-in. If Notepad is not running, users receive only the list of published applications.

To configure restricted user access, create a quarantine group on NetScaler Gateway. You create the
quarantine group within a session profile and then add the profile to a session policy.

Creating a Session Policy and Endpoint Analysis Scan for a Quarantine
Group

October 5, 2020

To enable XenApp as a quarantine access method, create a group on NetScaler Gateway that you use
as the quarantine group. Then, create a session policy where you select the group.

After you create the session policy, bind the policy to the quarantine group. After you configure the
policies and bind them to the group, test the results. For example, for users to successfully log on,
Notepad must be running on the user device. If Notepad is running, users can log on by using the
NetScaler Gateway Plug-in. If Notepad is not running, users can log on with Citrix Receiver.

For more information about configuring endpoint analysis policies, see Configuring Endpoint Polices.
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To create an endpoint analysis scan and add a quarantine group

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway > Policies and then click Session.

2. In the details pane, on the Policies tab, click Add.
3. In the Create Session Policy dialog box, in Name, type a name for the policy.
4. Next to Request Profile, click New.
5. In the Create Session Profile dialog box, in Name, type a name for the profile.
6. On the Security tab, click Advanced.
7. In the Security Settings - Advanced dialog box, under Client Security, click Override Global and

then click New.
8. In the Create Expression dialog box, next to Match Any Expression, click Add.
9. In Expression Type, select Client Security.

10. In Component, select Process.
11. In Name, type notepad.exe, click OK and then click Create.
12. In the Security Settings - Advanced dialog box, in Quarantine Group, select the quarantine

group, click Create, click OK and then click Create.
13. In the Create Session Policy dialog box, next to Named Expressions, select True value, click Add

Expression, click Create and then click Close.

Configuring XenDesktop for SmartAccess

October 5, 2020

NetScaler Gateway enables XenDesktop to deliver secure desktops to remote users. XenDesktop can
use the SmartAccess capabilities of NetScaler Gateway to intelligently deliver desktops. When you use
the Delivery Services Console in XenDesktop to create desktop groups, you then configure policies and
filters for access control.

To configure NetScaler Gateway to deliver published desktops, you use the same options that are
available with the Web Interface, ICA proxy access, clientless access, and NetScaler Gateway access.

When you create a session policy and configure settings on the Published Applications tab, use the
web address for the XenDesktop Web Interface site. After you create the policy, bind it to a virtual
server. Then, create a null session profile in which you do not configure settings. The Web Interface
configuration is inherited from global settings.
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To configure a session policy for SmartAccess with XenDesktop

October 5, 2020

You configure SmartAccess on NetScaler Gateway to access XenDesktop by creating a session policy
bound to a virtual server.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway > Policies and then click Session.

2. In the details pane, on the Policies tab, click Add.
3. In the Create Session Policy dialog box, in Name, type a name for the policy, such as XenDesk-

topPolicy.
4. In Request Profile, click New.
5. In the Create Session Profile dialog box, in Name, type a name for the profile, such as XenDesk-

topProfile.
6. On the Published Applications tab, next to ICA Proxy, click Override Global and then select ON.
7. In Web Interface Address, click Override Global and then type the URL to the XenDesktop Web

Interface site.
8. In Single Sign-on Domain, click Override Global, type the domain name and then click Create.
9. In the Create Session Policy dialog box, next to Named Expressions, select True Value, click Add

Expression, click Create and then click Close.

You also need to create a null session policy which is bound to the virtual server. The session profile
does not contain any configuration, making it a null profile. In the session policy, add the True Value
expression and then save the policy.

After you create both session policies, bind both policies to the virtual server.

To configure policies and filters in XenDesktop 5

October 5, 2020

You can configure settings in XenDesktop 5 by using either the Desktop Studio or the Group Policy
Editor. When you configure NetScaler Gateway settings in XenDesktop, use the NetScaler Gateway
virtual server name and the session policy name. Then, configure access control to allow connections
to meet defined filters. You can also use SmartAccess policies.

1. On the XenDesktop server, click Start > All Programs > Citrix > Desktop Studio.

2. In the left pane, click to expand HDX Policy and then click the User tab in the middle pane.

3. Under Users, click New.
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4. In the New Policy dialog box, under Identify your policy and then in Name, type a name.

5. Click Next twice.

6. In the New Policy dialog box, on the filters tab, under Filters, click Access Control and then click
Add.

7. In the New Filter dialog box, click Add.

8. In the New Filter Element dialog box, in Connection Type, select With Access Gateway.

To apply the policy to connections made through NetScaler Gateway without considering
NetScaler Gateway policies, leave the default entries in AG farm name and Access condition.

9. If you want to apply the policy to connections made through NetScaler Gateway based on exist-
ing NetScaler Gateway policies, do the following:

a) In AG farm name, type the virtual server name.
b) In Access condition, type the name of the endpoint analysis policy or session policy.

Important: XenDesktop does not validate the NetScaler Gateway virtual server, endpoint
analysis policy, or session policy names. Make sure the information is correct.

10. Click OK twice, click Next and then click Create.

To add the Desktop Delivery Controller as the STA

October 5, 2020

To establish ICA connections with XenDesktop, you add the IP address of the Desktop Delivery Con-
troller to the virtual server as the Secure Ticket Authority (STA).

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Virtual Servers.

2. In the details pane, select a virtual server and then click Open.
3. On the Published Applications tab, under Secure Ticket Authority, click Add.
4. In the Configure STA Server dialog box, enter the URL of the STA server, and then click Create.
5. Repeat Step 4 to add additional STA servers and then click OK In the configure NetScaler Gate-

way Virtual Server dialog box.

Configuring SmartControl

November 17, 2020
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SmartControl allows administrators to define granular policies to configure and enforce user envi-
ronment attributes for Citrix Virtual Apps and Desktops on NetScaler Gateway. SmartControl allows
administrators to manage these policies from a single location, rather than at each instance of these
server types.

SmartControl is implemented through ICA policies on NetScaler Gateway. Each ICA policy is an expres-
sion and access profile combination that can be applied to users, groups, virtual servers, and globally.
ICA policies are evaluated after the user authenticates at session establishment.

The following table lists the user environment attributes that SmartControl can enforce:

ConnectClientDrives Specifies the default
connection to the client
drives when the user logs on.

ConnectClientLPTPorts Specifies the automatic
connection of LPT ports from
the client when the user logs
on. LPT ports are the Local
Printer Ports.

ClientAudioRedirection Specifies the applications
hosted on the server to
transmit audio through a
sound device installed on the
client computer.

ClientClipboardRedirection Specifies and configures
clipboard access on the client
device and maps the
clipboard on the server.

ClientCOMPortRedirection Specifies the COM port
redirection to and from the
client. COM ports are the
COMmunication ports. COM
ports are serial ports.

ClientDriveRedirection Specifies the drive redirection
to and from the client.

Multistream Specifies the multistream
feature for specified users.
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ClientUSBDeviceRedirection Specifies the redirection of
USB devices to and from the
client (workstation hosts
only).

Localremotedata Specifies the HTML5 file
upload download capability
for the Citrix Workspace app.

ClientPrinterRedirection Specifies the client printers to
be mapped to a server when a
user logs on to a session.

Policies Action Access Profiles

Add Edit Delete

Show Bindings Policy Manager Action

Policies

An ICA policy specifies an Action, Access Profile, Expression and optionally, a Log Action. The following
commands are available from the Policies tab:

• Add
• Edit
• Delete
• Show Bindings
• Policy Manager
• Action

Add

1. Go to NetScaler Gateway > Policies and then click ICA.
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2. In the details pane, on the Policies tab, click Add.

3. In the Name dialog box, type a name for the policy.

4. Next to Action do one of the following:

• Click the > icon to select an existing action. For details see [Select an action] under
(#common-processes).

• Click the + icon to create an action. For details see [Create a new action] under (#common-
processes).

• The pencil icon is disabled.

5. Create an expression.

6. Create a Log Action. For more details see Create a Log Action.

7. Enter a message into the Comments box. The comment writes to the message log. This field is
optional.

8. Click Create.  

Edit

1. Go to NetScaler Gateway > Policies and then click ICA.

2. Select the ICA policy from the list.

3. In the details pane, on the Policies tab, click Edit.

4. Verify the policy name.
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5. To revise the Action do one of the following:

• Click the > icon to revise an existing Action. For detail see [Select an action] under
(#common-processes).

• Click the + to icon create an Action. For detail see [Create a new action] under (#common-
processes).

• Click the pencil icon to revise the [Access Profile].

6. Revise the Expression as desired. For details see [Expressions] under (#common-processes).

7. To revise the Log Action do one of the following:

• Click the + to create a Log Action.

• Click the pencil icon to configure an Audit Message.

8. Revise the comments as desired.

9. Click OK.  

Delete

1. Go to NetScaler Gateway > Policies and then click ICA.

2. Select the desired ICA policy from the list.

3. In the details pane, on the Policies tab, click Delete.

4. Confirm that you want to delete the policy by clicking Yes.

Show Binding

1. Go to NetScaler Gateway > Policies and then click ICA.
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2. Select the ICA policy from the list.

3. In the details pane, on the Policies tab, click Show Bindings.

Policy Manager

1. Go to NetScaler Gateway > Policies and then click ICA.

2. Select the desired ICA policy from the list.

3. In the details pane, on the Policies tab, click Policy Manager

4. From the Bind Point dialog box, select one of the following policies.

• Override Global
• VPN Virtual Server
• Cache Redirection Virtual Server
• Default Global

5. From the Connection Type dialog box, select a binding policy from the menu.

6. If you select either the VPN Virtual Server or the Cache Redirection Virtual Server, you connect
to the server using the menu.

7. Click Continue.

Add Binding

1. After selecting Continue, this screen appears.
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2. Select a Policy to attach the Binding.

3. Select Add Binding.

Policy Binding

1. After selecting Done, this screen appears.

• Click the > icon to select an existing policy. For detail see Select an existing policy.

• Click the + con to create a policy. For detail see Create a new policy.
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Unbind Policy

1. Select the policy you want to unbind, and click the Unbind button.

2. Click Done

3. Click the Yes button on the pop-up screen to confirm that you desire to unbind the selected
entity.

Bind NOPOLICY

1. Select policy that requires NOPOLICY, and click the Bind NOPOLICY button.

2. Click Done

Edit

You can edit from the ICA Policy Manager.

1. Select the policy you want to edit, and select Edit.
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2. You can make the following edits: [Edit Binding,] [Edit Policy], [Edit Action].

Edit Binding

1. With the policy selected, click Edit Binding.

2. Verify that you are editing the desired policy. This Policy Name is not editable.
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3. Set the Priority as desired.

4. Set Goto Expression as desired.

5. Click the Bind button.

Edit Policy

1. With the policy selected, click Edit Policy.

2. Verify the policy Name to ensure you are editing the desired policy. This field is not editable.
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3. To revise the Action policy, do one of the following:

• Click the > icon to select an existing Action. For details see [Select an action] under
(#common-processes).

• Click the + icon to create an action. For details see [Create a new action] under (#common-
processes).

• Click the pencil icon to revise the Access Profile. For details see [Select an existing Access
Profile] under (#common-processes).

4. Revise the Expression as desired. For more details see [Expressions] under (#common-
processes).

5. Select the desired type of message from the menu. To create a Log Action, do one of the follow-
ing:

• Click the + icon to create an action. For details see Create a Log Action.
• Click the pencil icon to revise the Configure Audit Message Action. For details see Config-

ure Audit Message Action.

6. Enter comments about the ICA Policy.

7. Click OK when the edit is complete.

Edit Action

1. With the policy selected, click Edit Action.

2. Verify the Action Name to confirm you are editing the desired Action. This field is not editable.

3. Next to Access Profile do one of the following:

• Click the > icon to select a different Access Profile. For detail see Configure Action.
• Click the + icon to select a new Channel Profile. Create an Access Profile.
• Click the pencil icon to revise the Access Profile. For details see [Select an existing Access

Profile] under (#common-processes).

4. Click OK.
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Action

The Policies > Action commands are used to rename the action.

1. Select the desired ICA Action from the list.

2. On the ICA Policies tab, click Action. Select Rename from the menu.

3. Rename the action.

4. Click OK

Action

An Action connects a policy with an Access Profile. The following commands are available from the
Policies tab:

• Add
• Edit
• Delete
• Action

Add

1. Go to NetScaler Gateway > Action and then click ICA.
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2. In the details pane, on the Action tab, click Add.

© 1999-2021 Citrix Systems, Inc. All rights reserved. 478



NetScaler Gateway 12.0

• Click the > icon to select an existing Access Profile. For detail see [Select an existing Access
Profile] under (#common-processes).

• Click the + icon to create an Access Profile. For detail see Create an Access Profile..

• The pencil icon is disabled for this screen.

3. Click Create.

Edit

1. Select the desired ICA policy from the list.

2. In the details pane, on the Action tab, click Edit.

Configure Action

1. Verify the Action Name to confirm you are editing the desired Action. This field is not editable.

2. Next to Access Profile do one of the following:
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• Click the > to select an existing Access Profile. For detail see [Select an existing Access Pro-
file] under (#common-processes).

• Click the + to create an Access Profile. For detail see Create an Access Profile.
• Click the pencil icon to Configure Access Profile.

3. Click OK.

Delete

1. Go to NetScaler Gateway > Action and then click ICA.

2. Select the desired ICA Action from the list.

3. In the details pane, on the Action tab, click Delete.

4. Confirm the Action you want to delete the policy by clicking Yes.
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Action

The ICA Action > Action commands are used to rename the action.

1. Go to NetScaler Gateway > Action and then click ICA.

2. Select the desired ICA Action from the list.

3. In the details pane, on the Action tab, click Action.

4. Select Action > Rename from the menu.

5. Rename the action.

6. Click OK

Access Profiles

An ICA profile defines the settings for user connections.

Access profiles specify the actions that are applied to a user’s Citrix Virtual Apps and Desktops envi-
ronment ICA if the user device meets the policy expression conditions. You can use the GUI to create
ICA profiles separately from an ICA policy and then use the profile for multiple policies. You can only
use one profile with a policy.

You can create Access Profiles independently of an ICA policy. When you create the policy, you can
select the access profile to attach to the policy. An Access Profile specifies the resources available to
a user. The following commands are available from the Policies tab:

• Add
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• Edit
• Delete

Creating an Access Profile with the GUI

1. Go to NetScaler Gateway > Policies and then click ICA.

2. In the details pane, click the Access Profiles tab and then click Add.

3. Configure the settings for the profile, click Create, and then clickClose. After you create a profile,
you can include it in an ICA policy.

Add an Access Profile to a policy using the GUI

1. Go to NetScaler Gateway > Policies and then click ICA.

2. On the Policies tab, do one of the following:

• Click Add to create an ICA policy.

• Select a policy and then click Open.

3. In the Action menu, select an Access Profile from the list.

4. Finish configuring the ICA policy and then do one of the following:

a) Click Create and then click Close to create the policy.

1. Click OK and then click Close to modify the policy.

Add

1. Go to NetScaler Gateway > Policies and then click ICA.
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2. In the details pane, on the Access Profiles tab, click Add.**
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3. In Name, type a name for the Access Profile.

4. Select Default or Disable from the menus shown to create the Access Profile.

5. Click Create.

Edit

1. Select the Access Profile you want to edit.

2. In the details pane, on the Access Profiles tab, click Edit.
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Configure Access Profile

1. Verify that the Name is the one you want to revise.

2. Select Default or Disable from the menu to configure as required.

3. Click OK.

Delete

1. Go to NetScaler Gateway > Action, and then click ICA.

2. Select the desired ICA Action from the list.

3. In the details pane, on the Action tab, click Delete.
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4. Confirm the Access Profile you want to delete by clicking Yes.

Common Processes

Create an action

1. Type a Name for the Action.

2. Select one of the following to supply the Access Profile:

• Click the > to select an existing Access Profile. See for details [Select an existing Access
Profile] under (#common-processes).

• Click the + to create an Access Profile. See for details Create an Access Profile.

• The pencil icon is disabled.

3. Click Create.

Select an action

1. Select an Action by clicking the radio button to the left of it. The associated Access Profile spec-
ifies the allowed user functions.

2. Click the Select button.
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Create an Access Profile

1. Name the Access Profile.

2. You can configure the Access Profile from this menu.

3. Click Create.

Select an existing Access Profile

1. Select an Access Profile by clicking it.
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2. Click Edit.

3. Configure the Access Profile. For details see Configure Access Profile.

Expressions

1. To create or revise an existing Expression, select Clear.

The expressions are the typical ICA Expressions. For the HTTP expressions enter the name with
the “” and remove the ().

ICA.SERVER.PORT This expression checks that the port specified
matches the port number on the Citrix Virtual
Apps and Desktops that the user is attempting
to connect.

ICA.SERVER.IP This expression checks that the IP specified
matches the IP address on the Citrix Virtual
Apps and Desktops that the user is attempting
to connect.

HTTP.REQ.USER.IS\\_MEMBER\\_OF(“”)
.NOT

This expression checks that the current
connection is accessed by a user that is NOT a
member of the specified group name.

HTTP.REQ.USER
.IS_MEMBER_OF(“groupname”)

This expression checks that the user accessing
the current connection is a member of the
specified group.
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HTTP.REQ.USER.NAME.CONTAINS(“”).NOT This expression checks that the user accessing
the current connection is NOT a member of the
specified group.

HTTP.REQ.USER.NAME.CONTAINS(“enter
user name”) Specifies the resources for a user
name.

This expression checks that the current
connection is accessed by the specified name.

CLIENT.IP.DST.EQ(enter the IP address
here).NOT

This expression checks that the destination IP
of the current traffic is NOT equal to the
specified IP address.

CLIENT.IP.DST.EQ(enter the IP address here) This expression checks that the destination IP
of the current traffic is equal to the specified IP
address.

CLIENT.TCP.DSTPORT.EQ (enter port
number).NOT

This expression checks that the destination
port is NOT equal to the specified port number.

CLIENT.TCP.DSTPORT.EQ (enter port number) This expression checks that the destination
port is equal to the specified port number.

2. Simultaneously, select Control and the Space bar. Then your options are visible.

3. Type the period. Make your selection, and press the Space bar.

4. At each period of the expression in the previous table, type the period. Make your selection, and
press the Space bar.

5. Click OK.
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Group Identification

The preauthentic or session functions define the expression with a group name variable.

Preauthentication

1. Select Preauthentication from the configuration pane.
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1. Select a name from the Preauthentication Policies.
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2. Select Edit from the Preauthentication Policies tab.

3. Select the pencil icon or + next to the Request Action dialog box.

4. Define the (“<groupname>”) in the Default EPA Group dialog box.
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Session

1. Select Session from the configuration pane.
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Create a Log Action

1. In the Configure Policy screen, next to the Log Action dialog box select the + icon

Create Audit Message Action

1. TheCreateAuditMessageAction screen appears. Name the Audit Message. The Audit message
only accepts numbers, letters, or an underscore character.

2. From the menu specify the Audit Log Level.

Emergency Events that indicate an immediate crisis on the
server.

Alert Events that might require action.

Critical Events that indicate an imminent server crisis.

Error Events that indicate some type of error.

Warning Events that require action soon.

Notice Events that the administrator must know
about.

Informational All but low-level events.

Debug All events, in extreme detail.

1. Enter an Expression. The Expression defines the format and content of the log.

2. The check boxes.
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• Check the log in newnslog to send the message to a new ns log.
• Select Bypass Safety Check to bypass the safety check. This allows unsafe expressions.

3. Click Create.

Revise a Log Action

1. In the Configure Policy screen, next to the Log Action dialog box click the icon.
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Configure Audit Message Action

The following are editable fields:

1. From the menu specify the Audit Log Level.

2. Enter an Expression. The Expression defines the format and content of the log.

3. The check boxes:

• Check the Log in newnslog to send the message to a new ns log.

• Select Bypass Safety Check to bypass the safety check. This allows unsafe expressions.

4. Click OK.

Select an existing policy

1. Click the > icon to select an existing policy.

2. Select the radio button of the desired policy.
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Create a policy

1. In Name, type a name for the policy.

2. Click the + to create a policy.

3. Create an Action. For details see Create a new action.

4. Name the Access Profile.
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5. Configure the Access Profile from this menu.

6. Click Create.

7. Click Bind.

Configuring pre-authentication and post-authentication end point analysis

This section describes how to configure post-authentication and pre-authentication end point analy-
sis (EPA).

To configure post-authentication EPA with SmartControl use the Smartgroup parameter from the
VPN session action. The EPA expression is configured on the VPN session policy.

You can specify a group name for the smart group parameter. This group name can be any string. The
group name does not need to be an existing group on the active directory.
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Configure the ICA policy with the expression, HTTP.REQ.IS_MEMBER_OF (“groupname”). Use the
group name that was previously specified for the smart group.

To configure pre-authentication EPA with SmartControl use the Default EPA group parameter from the
pre-authentication profile. The EPA expression is configured on the pre-authentication policy.

You can specify a group name for the Default EPA group parameter. This group name can be any string.
The group name does not need to be an existing group on the active directory.

Configure the ICA policy with the expression, HTTP.REQ.IS_MEMBER_OF (“groupname”), use the
group name that was previously specified for the Default EPA Group.

Post-authentication configuration

Use the following procedure to set up smart groups for Post-authentication configuration.

1. Go to NetScaler Gateway > Policies> Session.
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2. Go to Session Profiles> Add.

Create NetScaler Gateway Session Profile

1. Select the Security tab.

2. Enter a Name for your NetScaler Gateway Profile (action).
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3. Select the box to the right of the menu and select the desired Default Authorization Action.

Specify the network resources that users have access to when they log on to the internal net-
work. The default setting for authorization is to deny access to all network resources. Citrix
recommends using the default global setting and then creating authorization policies to define
the network resources users can access. If you set the default authorization policy to DENY, you
must explicitly authorize access to any network resource, which improves security.

4. Select the box to the right of the menu and select the desired Secure Browse.

Allow users to connect through NetScaler Gateway to network resources from iOS and Android
mobile devices with Citrix Workspace app. Users do not need to establish a full VPN tunnel to
access resources in the secure network.

5. Select the box to the right of the menu and enter the Smartgroup name.

This is the group in which the user is placed when the session policy associated with this ses-
sion action succeeds. The VPN session policy does the post authentication EPA check and if the
check succeeds the user is placed in the group specified with a smart group. The is_member_of
(http.req.user.is_member_of) expression can then be used with policies to check if the EPA has
passed on the user belonging to this smart group.

6. Click Create.

7. Go to NetScaler Gateway > Policies > Session.

8. Go to Session Policies > Add.

9. Enter the Name for the new session policy that is applied after the user logs on to NetScaler
Gateway.

10. Select the Profile action using the menu.

The Action applied by the new session policy if the rule criterion is met.

Note: If the desired profile must be created select the +. For more details see Create NetScaler
Gateway Session Profile.

11. Enter Expression in this field.

This field defines the named expression that specifies the traffic that matches the policy. The
expression can be written in either default or classic syntax. The maximum length of a literal
string for the expression is 255 characters. A longer string can be split into smaller strings of up
to 255 characters each, and the smaller strings concatenated with the + operator. For example,
you can create a 500-character string as follows: ‘”” + “”’

The following requirements apply only to the Citrix ADC CLI:

• If the expression includes one or more spaces, enclose the entire expression in double
quotation marks.
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• If the expression itself includes double quotation marks, escape the quotations by using
the character.* Alternatively, you can use single quotation marks to enclose the rule, in
which case you do not have to escape the double quotation marks.

12. Click Create.

13. Go to Session Policies.

14. Select the Name of the Session Policy.

15. Select Global Bindings from the Action menu.

16. Select Add Binding.

17. Select the > to choose an existing policy.

Note: Select + to create a policy. For more details see section Create NetScaler Gateway Session
Profile.

18. Choose a name from the list and press the Select button.

19. Enter the Priority and click Bind.

20. Click Done

21. The check shows that your selection is Globally Bound.

Pre-authentication configuration

Use the following procedure to set up the pre-authentication configuration.

1. Go to Citrix NetScaler>Policies> Preauthentication.
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2. Select the Preauthentication Profiles tab and select Add.
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3. Enter the Name for the preauthentication action.

The name must begin with a letter, number, or the underscore character (_), and must consist
only of letters, numbers, and the hyphen (-), period (.) pound (#), space ( ), at (@), equals (=),
colon (:), and underscore characters. Cannot be changed after preauthentication action is cre-
ated.

Note: The following requirement applies only to the Citrix ADC CLI:
If the name includes one or more spaces, enclose the name in double or single quotation marks.

4. Select a Request Action that the policy is to invoke when a connection matches the policy.

Note: If you want to or create a Preauthentication Profile, select the +. For more information
see Create Preauthentication Profile

5. Enter an Expression that is the name of the Citrix ADC named rule, or default syntax expression
that defines the connections that match the policy.

6. Click Create.

7. Go to the Preauthentication Policies tab and select the desired policy.

8. Select Global Binding from the Action menu.

9. Select Add Bindings.

10. Select the > to select an existing policy.

Select the + to create a policy. For more details see, Create NetScaler Gateway Session
Profile.

11. Select Policy.

12. Enter the Priority and click Bind.

13. Click Done.

14. The check shows that the Preauthentication Policy is Globally Bound.

Create Preauthentication Profile

1. Enter the Name for the preauthentication action

The name must begin with a letter, number, or the underscore character (_), and must consist
only of letters, numbers, and the hyphen (-), period (.) pound (#), space ( ), at (@), equals (=),
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colon (:), and underscore characters. Cannot be changed after preauthentication action is cre-
ated.

Note: If the name includes one or more spaces, enclose the name in double or single quotation
marks. This is applicable only to the Citrix ADC CLI:

2. Enter the Action from the menu.

This option will Allow or Deny logon after endpoint analysis (EPA) results.

3. Processes to be Canceled

This option identifies a string of processes that the endpoint analysis (EPA) tool must terminate.

4. Files to be deleted

This option identifies a string specifying the paths and names of the files that the endpoint anal-
ysis (EPA) tool must delete.

5. Default EPA Group

The default EPA group is the group that is chosen when the EPA check succeeds.

6. Click Create.

Configuring Single Sign-On to the Web Interface

October 5, 2020

You can configure NetScaler Gateway to provide single sign-on to servers in the internal network that
use web-based authentication. With single sign-on, you can redirect the user to a custom home page,
such as a SharePoint site or to the Web Interface. You can also configure single sign-on to resources
through the NetScaler Gateway Plug-in from a bookmark configured in the Access Interface or a web
address that users type in the web browser.

If you are redirecting the Access Interface to a SharePoint site or the Web Interface, provide the web
address for the site. When users are authenticated, either by NetScaler Gateway or an external au-
thentication server, users are redirected to the specified home page and logged on automatically.
User credentials are passed transparently to the web server. If the web server accepts the creden-
tials, users are logged on automatically. If the web server rejects the credentials, users receive an
authentication prompt asking for their user name and password.

You can configure single sign-on to web applications globally or by using a session policy.

You can also configure single sign-on to the Web Interface by using a smart card. For details, see Con-
figuring Single Sign-On to the Web Interface by Using a Smart Card.

NetScaler Gateway works with the following versions of the Web Interface:
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• Web Interface 4.5
• Web Interface 5.0
• Web Interface 5.1
• Web Interface 5.2
• Web Interface 5.3
• Web Interface 5.4

Before you configure single sign-on, make sure the Web Interface is already configured and working
with NetScaler Gateway.

To configure single sign-on to Web applications globally

October 5, 2020

Applying single sign-on globally will allow a Web service to authenticate all Web application sessions
rather than authenticating those sessions on the NetScaler Gateway.

1. In the configuration utility, on theConfiguration tab, in the navigation pane, expandNetScaler
Gateway and then click Global Settings.

2. In the details pane, under Settings, click Change global settings.
3. In the Global NetScaler Gateway Settings dialog box, on the Client Experience tab, click Sin-

gle Sign-on to Web Applications and then click OK.

To configure single sign-on to Web applications by using a session policy

October 5, 2020

1. In the configuration utility, on theConfiguration tab, in the navigation pane, expandNetScaler
Gateway > Policies and then click Session.

2. In the details pane, on the Profiles tab, select a policy and then click Add.
3. In the Configure Session Policy dialog box, next to Request Profile, click Modify.
4. In the Configure Session Profile dialog box, on the Client Experience tab, next to Single Sign-

On to Web Applications, click Global Override, click Single Sign-On to Web Applications and
then click OK.

To define the HTTP port for single sign-on to web applications

October 5, 2020
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Single sign-on is attempted only for network traffic where the destination port is considered to be an
HTTP port. To allow single sign-on to applications that use a port other than port 80 for HTTP traffic,
add one or more port numbers on NetScaler Gateway. You can enable multiple ports. You configure
the ports globally.

1. In the configuration utility, on theConfiguration tab, in the navigation pane, expandNetScaler
Gateway and then click Global Settings.

2. In the details pane, under Settings, click Change global settings.

3. On the Network Configuration tab, click Advanced Settings.

4. In HTTP Ports, type the port number, click Add and then click OK.

Note: If web applications in the internal network use different port numbers, type the port
number and then clickAdd. You must define the HTTP port number to allow single sign-on
to web applications, including the Web Interface.

Additional Configuration Guidelines

October 5, 2020

When you configure the Web Interface for single sign-on, use the following guidelines:

• The Authentication Service URL must begin with https.
• The server running the Web Interface must trust the NetScaler Gateway certificate and be able

to resolve the certificate fully qualified domain name (FQDN) to the virtual server IP address.
• The Web Interface must be able to open a connection to the NetScaler Gateway virtual server.

Any NetScaler Gateway virtual server can be used for this purpose; it does not have to be the
virtual server to which users log on.

• If there is a firewall between the Web Interface and NetScaler Gateway, firewall rules could pre-
vent user access, which disables single sign-on to the Web Interface. To work around this issue,
either relax your firewall rules or create another virtual server on NetScaler Gateway to which
the Web Interface can connect. The virtual server must have an IP address that is in the inter-
nal network. When connecting to the Web Interface, use the secure port 443 as the destination
port.

• If you are using a certificate from a private Certificate Authority (CA) for the virtual server, in the
Microsoft Management Console (MMC), use the certificates snap-in to install the CA root certifi-
cate in the local computer certificate store on the server running the Web Interface.

• When users log on and receive an access denied error message, check the Web Interface event
viewer for more information.
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• For successful user connections to published applications or desktops, the Secure Ticket Au-
thority (STA) that you configured on NetScaler Gateway must match the STA that you configured
on the Web Interface.

To test the single sign-on connection to the Web Interface

October 5, 2020

After you configure single sign-on for the Web Interface, from a client device, open a web browser, and
test for a successful connection.

1. In a web browser, type https://NetScalerGatewayFQDN, where NetScalerGatewayFQDN is
the fully qualified domain name (FQDN) in the certificate bound to the virtual server.

2. Log on to a domain user account in Active Directory. At logon, you are redirected to the Web
Interface.

Applications appear automatically with no additional authentication. When users start a published
application, Citrix Receiver directs traffic through the NetScaler Gateway appliance to servers in the
farm.

Configuring Single Sign-On to the Web Interface by Using a Smart Card

October 5, 2020

If you use smart cards for user logon, you can configure single sign-on to the Web Interface. You config-
ure settings on NetScaler Gateway, and then you configure the Web Interface to accept single sign-on
with a smartcard. Single sign-on is also called pass-through authentication.

Web Interface Versions 5.3 and 5.4 support single sign-on to the Web Interface using a smart card. If
you enable the Web Interface on NetScaler feature available in NetScaler version 10, you can also use
single sign-on with a smartcard. For more information about configuring this feature, see Using Smart
Card Authentication for Web Interface through NetScaler Gateway.

Users can be in multiple CN groups in Active Directory for single sign-on to work, as long as the user
name extraction in the certificate action is SubjectAltName:PrincipalName. If you use the parameter
Subject:CN, users cannot be part of multiple CN groups.

To configure NetScaler Gateway for single sign-on to the Web Interface by using a smart card, you need
to do the following:

• Install a signed server certificate from a Certificate Authority (CA). For more information, see
Installing the Signed Certificate on NetScaler Gateway.
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• Install a root certificate on NetScaler Gateway and the user device.
• Create a virtual server as the logon point for the Web Interface. When you configure the vir-

tual server, you must set the client certificate SSL parameter to Optional. For more information
about configuring a virtual server, see Creating Virtual Servers.

• Create a secondary virtual server in which client authentication is disabled in the SSL parame-
ters. This configuration prevents users receiving a secondary request for their personal identifi-
cation number (PIN).

• Create a client certificate authentication policy. In the User Name Field, use the parameter Sub-
jectAltName:PrincipalName to extract users from multiple groups. Leave the Group Name Field
blank.

• Create a session policy and profile on NetScaler Gateway. Within the session profile, you enable
ICA proxy and specify the Web Interface and domain that you use for single sign-on.

You can use the following procedure to create a session profile for single sign-on with a smart card.

To create a session profile for single sign-on by using a smart card

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway Policies and then click Session.

2. In the details pane, click the Profiles tab and then click Add.

3.On the Client Experience tab, next to Home Page, click Override Global and then clear Display Home
Page.

1. Next to Single sign-on to Web Applications, click Override Global and then click Single sign-on
to Web Applications.

2. Click the Published Applications tab.

3. Next to ICA Proxy, click Override Global and then select ON.

4. In Web Interface Address, click Override Global and then type the fully qualified domain name
(FQDN) or the Web Interface.

5. In Single Sign-on Domain, click Override Global and then type the domain name.

Note: You must use the format domain and not the format domain.com.

6. Click Create and then click Close.

After you have completed the session profile, configure the session policy and use the profile as part
of the policy. You can then bind the session policy to the virtual server.
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To configure the client certificate for single sign-on by using a smart card

October 5, 2020

If you configure single sign-on to the Web Interface using a smart card, you must select
Client Authentication on the
Certificates in the virtual server dialog box and then configure the client certificate as
Optional. If you select
Mandatory, single sign-on to the Web Interface fails.

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway and then click Virtual Servers.

2. In the details pane, click a virtual server and then click Open.
3. In the configure NetScaler Gateway Virtual Server dialog box, on the Certificates tab, click SSL

Parameter.
4. In the Configure SSL Params dialog box, under Others, click Client Authentication.
5. In Client Certificate, select Optional and then click OK twice.

To configure single sign-on for XenApp and file shares

October 5, 2020

If users are connecting to servers running Citrix XenApp and using SmartAccess, you can configure
single sign-on for users connecting to the server farm. When you configure access to published appli-
cations by using a session policy and profile, use the domain name for the server farm.

You can also configure single sign-on to file shares in your network.

1. In the configuration utility, on theConfiguration tab, in the navigation pane, expandNetScaler
Gateway > Policies and then click Session.

2. In the details pane, on the Policies tab, select a session policy and then click Open.
3. In the Configure Session Policy dialog box, next to Request Profile, click Modify.
4. In the Configure Session Profile dialog box, on thePublished Applications tab, in Single-sign-

on Domain, click Override Global, type the domain name and then click OK twice.

Allowing File Type Association

October 5, 2020
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File type association allows users to open documents in applications published through Citrix XenApp
or Citrix XenDesktop 7. You can use this permission to allow users to open and edit documents on
servers in the trusted environment and avoid sending the document to the user device. You can use
file type association only for document types that are associated with a published application and
only if you correctly configure the virtual server properties on NetScaler Gateway.

Providing file type association as the only means for editing resource documents can help to heighten
security because it requires that editing occur on the server and not on the user device. For example,
you might choose to grant file type association for a file share in which employees post reports of
ongoing project meetings, without providing the ability to download or upload.

Providing file type association requires that:

• Users run Citrix Receiver on the user device.
• Users connect through a virtual server that has a traffic policy bound to it and that you configure

the policy for XenApp.
• Users are assigned to the desired applications in XenApp or XenDesktop 7.
• Administrators configure XenApp to work with NetScaler Gateway.

The steps for creating file type association include:

• Creating a Web Interface site.
• Configuring file type association using a traffic policy on NetScaler Gateway.
• Defining file extensions in XenApp or XenDesktop 7.

Creating a Web Interface Site

October 5, 2020

To configure the Web Interface to work with file type association, you first create the Web Interface site.
The Web Interface site can be in Direct or Advanced Access Control. Copy the following directories to
your Web Interface site:

• app_data
• auth
• site

When you copy these directories to the Web Interface site, the existing directories are overwritten.

If you are using Web Interface 4.6 or 5.0, open the web.config file in the Web Interface site directory
and add the following code. You can download this code from the Citrix Support site at http://support.
citrix.com/article/ctx116253.
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1 pre codeblock
2 <location path=”site/contentLaunch.ica”>
3 <system.web>
4 <httpHandlers>
5 <add verb=”*” path=”*.ica” type=”System.Web.UI.PageHandlerFactory”/>
6 </httpHandlers>
7 </system.web>
8 </location>
9 <location path=”site/contentLaunch.rad”>

10 <system.web>
11 <httpHandlers>
12 <add verb=”*” path=”*.rad” type=”System.Web.UI.PageHandlerFactory”/>
13 </httpHandlers>
14 </system.web>
15 </location>

This code must be added after the following section in the web.config file:

1 pre codeblock
2 <location path=”site/launch.rad”>
3 <system.web>
4 <httpHandlers>
5 <add verb=”*” path=”*.rad” type=”System.Web.UI.

PageHandlerFactory”/>
6 </httpHandlers>
7 </system.web>
8 </location>

Configuring NetScaler Gateway for File Type Association

October 5, 2020

Before you configure file type association on NetScaler Gateway, configure a Web Interface site to
work with file type association. After you create and configure the Web Interface, you need to create
settings on NetScaler Gateway. The steps include:

• Creating a new virtual server or using an existing one. For more information about creating a
virtual server, see Creating Virtual Servers.

• Creating a new session policy and profile that has the Web Interface configured.
• Binding the session policy to the virtual server.
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• Creating a traffic policy.

After you create the session policy and bind it to the virtual server, create the traffic policy and also
bind it to the virtual server.

When you configure a traffic policy for file type association, you create an expression to define the file
extensions. For example, you want to enable file type association for Microsoft Word and Microsoft
Excel. An example expression is:

REQ.HTTP.URL == /\*.doc || REQ.HTTP.URL == /\*.xls

To create a session policy and profile for file type association

1. In the configuration utility, click theConfiguration tab and then in the navigation pane, expand
NetScaler Gateway > Policies and then click Session.

2. In the details pane, on the Policies tab, click Add.
3. In Name, type a name for the policy.
4. Next to Request Profile, click New.
5. In Name, type a name for the profile.
6. On the Published Applications tab, configure the following settings:

a) Next to Web Interface Address, click Override Global and then type the Web address of
the Web Interface.

b) Next to Web Interface Portal Mode, clickOverride Global and then select either Normal or
Compact.

c) Next to Single Sign-on Domain, click Override Global, type the name of the domain in
which the user accounts reside and then click Create.

7. In the Create Session Policy dialog box, next to Named Expression, select True value, click
Add Expression, click Create and then click Close.

To create a traffic profile for file type association

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway Policies and then click Traffic.

2. In the details pane, click the Profiles tab and then click Add.
3. In Name, type a name for the profile.
4. In File Type Association, select ON, click Create and then click Close.

To configure file type association in a traffic policy

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway Policies and then click Traffic.

2. In the details pane, on the Policies tab, click Add.
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3. In Name, type a name for the policy.
4. In Request Profile, select a profile.
5. In theCreate Traffic Policydialog box, under Expressions, select Advanced Free-Form and then

click Add.
6. In the Add Expression dialog box, do the following:

a) In Expression Type, click General.
b) In Flow Type, select REQ.
c) In Protocol, select HTTP.
d) In Qualifier, select URL.
e) In Operator, select = =.
f) In Value, type /*.FileExtensionType, where .FileExtensionType is the file type, such as .doc

or .xls and then click OK.
7. In the Create Traffic Policy dialog box, under Expressions, next to Advanced Free-Form, click

OR.
8. Repeat Steps 4, 5 and 6 for each file extension you want to include, click Create and then click

Close.

Integrate NetScaler Gateway with XenApp and XenDesktop

October 5, 2020

StoreFront servers are deployed and configured to manage access to published resources and data.
For remote access, adding NetScaler Gateway in front of StoreFront is recommended.

Note

For detailed configuration steps on how to integrate XenApp and XenDesktop with NetScaler
Gateway, see the StoreFront documentation.

The following diagram illustrates an example of a Citrix simplified Citrix deployment that includes
NetScaler Gateway. NetScaler Gateway communicates with StoreFront to protect apps and data de-
livered by XenApp and XenDesktop. The user devices run Citrix Receiver to create a secure connection
and access their apps, desktops, and files.
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Users log on and authenticate using NetScaler Gateway. NetScaler Gateway is deployed and secured
in the DMZ. Two-factor authentication is configured. Based on the user credentials, users are provided
with the relevant resources and applications. Applications and data are on appropriate servers (not
shown on the diagram). Separate servers used for security sensitive applications and data.

Integrate NetScaler Gateway with StoreFront

October 5, 2020

XenApp and XenDesktop wizard is used to integrate StoreFront with NetScaler Gateway. The inte-
gration facilitates access to hosted virtual desktops (XenDesktop) and hosted Windows virtual apps
(XenApp) through the NetScaler Gateway.

For NetScaler Gateway integration with StoreFront, the XenApp and XenDesktop wizard workflow is
now enhanced with the following capabilities.

• Retrieval of the Stores configured on the supported StoreFront: The Stores configured on
supported StoreFront can be retrieved with a click. This retrieval method helps avoid manual
intervention therefore avoiding human errors (typos).

• Export support for StoreFront configuration file: The StoreFront configuration files can be ex-
ported at Citrix Gateway. The StoreFront configuration file can then be downloaded and eventu-
ally imported on a supported StoreFront server. Once the file is imported, StoreFront completes
the NetScaler integration.

• StoreFront as an authentication server: Authentication is simplified by introducing an ad-
vanced authentication action to use StoreFront as an Authentication Server for authentication
services.
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Note
The Authentication Server can be used for non–XenApp and XenDesktop deployments as well.

How to configure NetScaler Gateway to use with StoreFront

Prerequisites

You must have the following information to integrate NetScaler with StoreFront:

• IP address of the NetScaler Gateway virtual server
• Fully Qualified Domain Name (FQDN) of StoreFront server
• A server certificate for the NetScaler Gateway
• Authentication server details

Also ensure the following:

• Firewall port between NetScaler Gateway and StoreFront is open
• StoreFront has LAN access

To Integrate StoreFront with NetScaler Gateway using NetScaler Gateway GUI:

1. Click the Configuration tab.

2. In Integrate with Citrix Products, click XenApp and XenDesktop.

3. Click Get Started.

4. Select StoreFront and Click Continue.

5. Enter the values for the following fields in the NetScaler Gateway area and click Continue.

• Gateway FQDN – FQDN of NetScaler Gateway
• Gateway IP Address – IP address of NetScaler Gateway
• Port – Port of NetScaler Gateway

6. Import the following files in the Server Certificate area and click Continue. Certificate File -
Server certificate for the NetScaler Gateway.

7. Provide the following information in the StoreFront area and click Continue.

• StoreFront URL – URL of StoreFront server

• Receiver forWebPath - Path to Receiver for website already configured on the StoreFront

• Default Active Directory Domain - Single sign-on domain to be used for single sign-on
applications in the internal network

• Secure Ticket Authority URL – The Secure Ticket Authority URL, typically present on the
delivery controller.
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Note: Upon choosing “
Retrieve Stores” NetScaler Gateway contacts StoreFront and returns all the Stores
information which is configured on StoreFront. You can then select preferred Store
from the drop-down menu. “
Retrieve Stores” option works for the latest StoreFront server only.

8. With the new Authentication settings a user can create an Authentication Policy or you can use
an existing Authentication policy.

To create a new Domain Based Authentication Policy, enter the values for the following fields in
and click Continue.

9. Choose Authentication Type - Select Domain from the drop-down menu

10. Select Add new server or Use existing server based on your requirement

• IP Address – IP address for the Domain server
• Port – Port of the Domain server
• Base DN - The base DN under which users are located
• Service Account - The account used to query Active Directory
• Password - The password required to log on to the Domain server
• Time out - The time duration for which the Domain directory is looked up
• Server Logon Name Attribute - The name attribute used by the NetScaler appliance to

query the external Domain server or an Active Directory.

You can optionally click Test Connection to ensure that the server is reachable and valid cre-
dentials are provided.

Note:To use an existing Authentication policy, select the required Authentication Type
from Choose Authentication Type list and provide the information as listed previously.

11. On the NetScaler Gateway Settings page, Click Done.

12. Click Download file.

Following are the configuration steps required at the StoreFront GUI:

1. Copy the Gatewayconfig.zip file to StoreFront.
2. Click Stores.
3. Select Manage NetScaler Gateways and click Imported from file link in Manage NetScaler

Gateways window.
4. Under Select File area in Import NetScaler Configuration window, click Next.
5. Under Select Logon Type area, optionally provide a Callback URL for StoreFront to contact

NetScaler Gateway and click Next.
6. Under Secure Ticket Authorities click Next.
7. Under Review changes click Next.
8. Click Finish.
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Configuring Settings for Your XenMobile Environment

October 5, 2020

The Citrix ADC for XenMobile wizard guides you through the configuration of Citrix ADC features for
your XenMobile deployment. You can use the wizard to:

• Set up aMicro VPN. In this scenario, remote users can access apps and desktops in the internal
network.

– For XenMobile MAM-only mode, you must use Citrix Gateway for authentication.

– For MDM deployments, Citrix recommends Citrix Gateway for mobile device VPN.

– For ENT deployments, if a user opts out of MDM enrollment, the device operates in the
legacy MAM mode and enrolls using the Citrix Gateway FQDN.

• Configure certificate-based authentication. The default configuration for XenMobile is user
name and password authentication. To add another layer of security for enrollment and access
to XenMobile environment, consider using certificate-based authentication.

• LoadbalanceXenMobile servers. Citrix ADC load balancing is required for all XenMobile device
modes if you have multiple XenMobile servers or if the XenMobile is inside your DMZ or internal
network (and therefore traffic flows from devices to Citrix ADC to XenMobile). In this scenario,
the Citrix ADC appliance resides in the DMZ between the user device and the XenMobile servers
to load balance encrypted sent data from mobile devices to the XenMobile servers.

• LoadbalanceMicrosoftExchange serverswith email filtering. In this scenario, the Citrix ADC
appliance is between the user device and the XenMobile Citrix ADC Connector (XNC), and be-
tween the user device and the Microsoft Exchange CAS servers. All requests from user devices
go to the Citrix Gateway appliance, which then communicates with the XNC to retrieve informa-
tion about the device. Depending on the response from the XNC, the Citrix ADC appliance either
forwards the request from a whitelisted device to the server in the internal network, or drops
the connection from a blacklisted device.

• Load balance ShareFile StorageZones Connectors based on the type of content requested.
This scenario prompts you for basic information about your StorageZones Controller environ-
ment and then generates a configuration that does the following:

– Load balances traffic across StorageZones Controllers.
– Provides user authentication for StorageZones Connectors.
– Validates URI signatures for ShareFile uploads and downloads.
– Terminates SSL connections at the Citrix ADC appliance.

For more information about configuring ShareFile, see Configure Citrix ADC for StorageZones Con-
troller.
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Important

Before you use the XenMobile wizard, be sure to refer to these XenMobile Deployment articles
for design and deployment information and recommendations:

XenMobile Integration

Integrating with Citrix Gateway and Citrix ADC

SSO and Proxy Considerations for MDX Apps

Authentication

You can use the Citrix ADC for XenMobile wizard only once. If you want multiple XenMobile in-
stances, such as for test, development, and production environments, you must configure Citrix
ADC for the additional environments manually. The following support articles list the commands
run by the wizard and provides instructions for running them to create a new Citrix ADC instance:

Commands Generated by XenMobile Wizard on Citrix ADC - SSL Bridge

Commands Generated by XenMobile Wizard on Citrix ADC - SSL Offload

License Requirements for Citrix ADC Features

You must install licenses to enable the following Citrix ADC features:

• XenMobile MDM load balancing requires a Citrix ADC standard license.
• ShareFile load balancing with StorageZones requires a Citrix ADC standard license.
• Exchange load balancing requires a Citrix ADC license or a Enterprise license with the addition

of an Integrated Caching license.

Citrix ADC for XenMobile Wizard

This section provides an example of using the Citrix ADC for XenMobile wizard to:

• Set up micro VPN access for remote user connections to XenMobile-managed resources in your
internal network

• Configure certificate-based authentication. For information about obtaining and installing a
public SSL certificate, see Installing and Managing Certificates.

• Configure load balancing for XenMobile servers.

To use the wizard:

1. In the configuration utility, click the Configuration tab and then click XenMobile.
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2. Select your XenMobile version and then click Get Started.

3. Select the checkboxes for the features you want to configure. Keep in mind that you can use
this wizard only once, so you’ll need to perform subsequent configuration manually. These in-
structions assume that you select the following settings: Access through Citrix Gateway (for
XenMobile running in ENT or MAM modes)
Load Balance XenMobile Servers

4. On the Citrix Gateway Settings page, enter values for the external facing Citrix Gateway IP
Address, Port, and Virtual Server Name.
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5. On the Server Certificate for Citrix Gateway page, from theCertificate File drop-down menu,
choose the certificate file from Local or Appliance. If your certificate is on a local machine:

If your certificate is on the appliance:
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6. In the Authentication Settings page, in the Primary authentication method field, select
Client Certificate.

This will automatically select Use existing certificate policy and Cert Auth in the next two
fields. The following steps assume that you already have a certificate policy.

If you need to create a certificate policy, click Create certificate policy and complete the set-
tings. On theXenMobileCertificate screen, choose an existing server certificate or install a new
certificate. If you’re running multiple XenMobile servers, you will add a certificate for each one.
ForServer LogonNameAttribute, specifyuserPrincipalNameor samAccountName, per your
requirements.

• a. Select Click here to change the CA certificate and then in the Browse list, navigate to
the CA certificate you want.
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• b. With client certificate as your primary authentication type, you have the option of con-
figuring LDPA (or RADIUS) as the secondary authentication type.

To use client certificate authentication only, leave Second authentication method as
None and then click Continue.

To use client certificate + domain (LDAP) authentication, change Second authentication
method to LDAP and configure the authentication server settings.

• c. On the Device certificate screen, if the certificate is not already installed, you must
export this certificate from the XenMobile console: From the console, click the gear icon in
the upper-right corner to open the Settings screen.

• d. Click Certificate and then choose the CA certificate from the list.

• e. Click Export.

• f. Return to the Citrix ADC wizard and select the certificate you exported (downloaded) to
install it.

• g. Click Continue.

The XenMobile IP addresses that you’ve configured will appear.

7. Configure the XenMobile App Management Settings.
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• Enter the XenMobile FQDN. This is the load balancing FQDN for MAM.
• Enter a MAM-only Internal Load Balancing IP Address for the virtual server that load bal-

ances XenMobile servers. Citrix Gateway communicates with the XenMobile through this
MAM load balancing virtual IP.

• This is an SSL offload deployment, so select HTTP in Communication with XenMobile
Server.

• The Split DNSmode for MicroVPN field automatically sets to BOTH.

If your deployment requires split tunneling, select Enable split tunneling. You must configure
Intranet Application Binding, next, if you enable split tunneling.

By default, Secure Web access is tunneled to the internal network, which means that Secure
Web uses a per-application VPN tunnel back to the internal network for all network access and
the Citrix ADC appliance uses split tunnel settings.
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8. To configure interception rules for user connections on Citrix Gateway, you must configure In-
tranet Application Binding. Click + to add a binding.
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9. Complete the parameters for allowing network access and then click Create.
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10. Add the XenMobile certificate. This will be used for the MAM load balancing virtual server.

11. Under XenMobile Servers, click Add Server to add the XenMobile IP Address to bind to the
load balancing virtual IP.
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12. On the Citrix ADC dashboard, confirm that Citrix Gateway and XenMobile load balancing are
configured as follows.
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If you will use sAMAccount attributes in the user certificates as an alternative to User Principal
Name (UPN), configure the certificate profile as described in Manually Configuring Citrix Gate-
way for Client Certificate Authentication.
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Configuring Load Balancing Servers for XenMobile or Citrix Endpoint
Management

October 5, 2020

After using theNetScaler for XenMobilewizard for initial setup, use the NetScaler Gateway configura-
tion utility to configure load balancing, as described in this section. For Citrix Endpoint Management,
use SSL Offload. For XenMobile Server, be sure to refer to the recommendations for load balancing
modes under “Deployment Summary” in Integrating with NetScaler Gateway and NetScaler.

To use SSL Bridgemode for NetScaler VIPs

Use SSL Bridge mode if XenMobile is in the DMZ. When you load balance XenMobile server with
NetScaler VIPs in SSL Bridge mode, Internet traffic flows directly to XenMobile server, where
connections terminate. SSL Bridge mode is the simplest mode to set up and troubleshoot.

1. Before configuring SSL Bridge mode, go to XenMobile App Management Settings and verify
that Communication with XenMobile Server is HTTPS.

2. After you log on to the configuration utility, on the Home tab, in MDM Server LB, click Config-
ure.

3. Under LB Virtual Server for Device Management, in Name, type a name for the server.

4. In IP Address, type the IP address for the virtual server and then click Continue.

5. On theLoadBalanceXenMobileMDMServerspage, repeat Steps 3 and 4 and then clickCreate.

6. Verify that the settings are correct and then click Done.
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7. To verify the load balancing configuration, go to Traffic Management > Virtual Servers.

To use SSL Offloadmode for NetScaler VIPs

Use SSL Offload for Citrix Endpoint Management. Also use SSL Offload, if required to meet security
standards, when the on-premises XenMobile server is in the internal network. When you load balance
Citrix Endpoint Management or XenMobile server with NetScaler VIPs in SSL Offload mode, Internet
traffic flows directly to the NetScaler appliance, where connections terminate. NetScaler Gateway
then establishes new sessions from the appliance to Citrix Endpoint Management or the XenMobile
server. SSL Offload mode involves additional complexity during setup and troubleshooting.

1. Before configuring SSL Offload mode, go to XenMobile App Management Settings and verify
that Communication with XenMobile Server is HTTP.

2. Log on to the configuration utility. On the Home tab, in MDM Server LB, click Configure.

3. Under LB Virtual Server for Device Management, in Name, type a name for the server.

4. In IP Address, type the IP address for the virtual server and then click Continue.

5. On theLoadBalanceXenMobileMDMServerspage, repeat Steps 3 and 4 and then clickCreate.

6. Verify the settings and then click Done.

7. When prompted to add a server certificate, choose the server certificate and click Continue.
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8. Specify the CA certificate and click Continue.

9. Keep the same XenMobile IP address. Click Done.
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10. To verify the load balancing configuration, go to Traffic Management > Virtual Servers.

Configuring Load Balancing Servers for Microsoft Exchange with Email
Security Filtering

October 5, 2020

1. On the Home tab, in MDM Server LB, click Configure.

2. Under LB Virtual Server for Exchange CAS, in Name, type a name for the server.

3. In IP Address, type the IP address for the virtual server.

4. In Port, type the port number. To add more ports, click the plus (+) sign and then type the port
number.

5. Click Continue.
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6. Under Certificates, either choose an existing certificate or install one that’s on your computer
(Local) or on the NetScaler appliance (Appliance).

7. Click Continue.

8. Under Exchange CAS Service Instances, type a name, IP address, and port number for the vir-
tual server. Then, click Add and Continue.
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When you click Done, the fields for configuring the XenMobile NetScaler Connector (XNC) ActiveSync
Filtering appear.

Configuring XenMobile NetScaler Connector (XNC) ActiveSync Filtering

October 5, 2020

The XenMobile NetScaler Connector (XNC) provides a device level authorization service of ActiveSync
clients to NetScaler which acts as a reverse proxy for the Exchange ActiveSync protocol. Authorization
is controlled by a combination of policies defined within XenMobile and by rules defined locally by the
XNC.

1. Under XenMobile NetScaler Connector (XNC) ActiveSync Filtering, for Callout Protocol, se-
lect http or https.

2. In XNC IP Address, type the IP address of the XenMobile NetScaler Connector.

3. In Port, type 9080 for HTTP network traffic or 9443 for HTTPS network traffic, and then click
Continue.

Your configuration appears.
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Allowing Access fromMobile Devices with Citrix Mobile Productivity
Apps

October 5, 2020

The NetScaler for XenMobile wizard configures the settings required to allow users to connect from
supported devices through NetScaler Gateway to mobile apps and resources in the internal network.
Users connect by using Secure Hub (previously, Worx Home), which establishes a Micro VPN tunnel.
When users connect, a VPN tunnel opens to NetScaler Gateway and then is passed to XenMobile in the
internal network. Users can then access their web, mobile, and SaaS apps from XenMobile.

To ensure that users consume a single Universal license when connecting to NetScaler Gateway with
multiple devices simultaneously, you can enable session transfer on the virtual server. For details, see
Configuring Connection Types on the Virtual Server.

If you need to change your configuration after using the NetScaler for XenMobile wizard, use the sec-
tions in this article for guidance. Before changing settings, make sure that you understand the impli-
cations of your changes. For more information, refer to the XenMobile Deployment articles.

Configuring Secure Browse in NetScaler Gateway

You can change Secure Browse as part of global settings or as part of a session profile. You can bind the
session policy to users, groups, or virtual servers. When you configure Secure Browse, you must also
enable clientless access. However, clientless access does not require you to enable Secure Browse.
When you configure clientless access, set Clientless Access URL Encoding to Clear.

To configure Secure Browse globally:

1. In the configuration utility, on theConfiguration tab, in the navigation pane, expandNetScaler
Gateway and then click Global Settings.

2. In the details pane, under Settings, click Change global settings.
3. In theGlobalNetScalerGatewaySettingsdialog box, on theSecurity tab, clickSecureBrowse

and then click OK.
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To configure Secure Browse in a session policy and profile:

1. In the configuration utility, on theConfiguration tab, in the navigation pane, expandNetScaler
Gateway > Policies and then click Session.

2. In the details pane, do one of the following:
• If you are creating a session policy, click Add.
• If you are changing an existing policy, select a policy and then click Open.

3. In the policy, create a profile or modify an existing profile. To do so, do one of the following:
• Next to Request Profile, click New.
• Next to Request Profile, click Modify.

4. On the Security tab, next to Secure Browse, click Override Global and then select Secure
Browse.

5. Do one of the following:
• If you are creating a profile, click Create, set the expression in the policy dialog box, click

Create, and then click Close.
• If you are modifying an existing profile, after making the selection, click OK twice.

To configure traffic policies for Secure Web in Secure Browse mode:

Use the following steps to configure traffic policies to route Secure Web traffic through a proxy server
in Secure Browse mode.

1. In the configuration utility, on the Configuration tab, expand NetScaler Gateway > Policies
and then click Traffic.

2. In the right pane, click the Traffic Profiles tab and then click Add.

3. In Name, enter a name for the profile, select TCP as the Protocol, and leave the rest of the
settings as-is.

4. Click Create.

5. Click the Traffic Profiles tab and then click Add.

6. In Name, enter a name for the profile and then select HTTP as the Protocol.
This Traffic Profile is for both HTTP and SSL. CVPN traffic is HTTP traffic by design, regardless of
the destination port or service type. Thus, you specify both SSL and HTTP traffic as HTTP in the
traffic profile.

7. In Proxy, enter the IP address of the proxy server. In Port, enter the port number of the proxy
server.

8. Click Create.

9. Click the Traffic Profiles tab and then click Add.

10. Enter the Name of the traffic policy and, for Request Profile, select the Traffic Profile you cre-
ated in Step 3. Enter the following Expression and then click Create:
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REQ.HTTP.HEADER
HOST
con-
tains
Ac-
tiveSync-
Server

REQ.HTTP.HEADER
User-
Agent
CON-
TAINS
Worx-
Mail

REQ.HTTP.HEADER
User-
Agent
CON-
TAINS
com.zenprise

REQ.HTTP.HEADER
User-
Agent
CON-
TAINS
Worx-
Home

REQ.HTTP.URL
CON-
TAINS
AGSer-
vices

REQ.HTTP.URL
CON-
TAINS
StoreWeb

That rule performs a check based on the host header. To bypass the Activesync traffic from the
proxy, replace ActiveSyncServer with the appropriate ActiveSync server name.

11. Click the Traffic Profiles tab and then click Add. Enter the Name of the traffic policy and, for
Request Profile, select the Traffic Profile created in Step 6. Enter the following Expression and
then click Create:

(REQ.HTTP.HEADER
User-Agent
CONTAINS
Mozilla

REQ.HTTP.HEADER
User-Agent
CONTAINS
com.citrix.browser

REQ.HTTP.HEADER
User-Agent
CONTAINS
WorxWeb) &&
REQ.TCP.DESTPORT
== 80

12. Click the Traffic Profiles tab and then click Add. Enter the Name of the Traffic Policy and, for
Request Profile, select the Traffic Profile created in Step 6. Enter the following Expression and
then click Create:

(REQ.HTTP.HEADER
User-Agent
CONTAINS
Mozilla

REQ.HTTP.HEADER
User-Agent
CONTAINS
com.citrix.browser

REQ.HTTP.HEADER
User-Agent
CONTAINS
WorxWeb) &&
REQ.TCP.DESTPORT
== 443

13. Navigate to NetScaler Gateway > Virtual Servers, select the virtual server in the right pane,
and then click Edit.

14. On the Policies row, click +.

15. From the Choose Policy menu, select Traffic.
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16. Click Continue.

17. Under Policy Binding, across from Select Policy, click >.

18. Select the Policy you created in Step 10 and then click OK.

19. Click Bind.

20. Under Policies, click Traffic Policy.

21. Under VPN Virtual Server Traffic Policy Binding, click Add Binding.

22. Under Policy Binding, next to the Select Policy menu, click > to view the policy list.

23. Select the policy you created in Step 17 and then click OK.

24. Click Bind.

25. Under Policies, click Traffic Policies.

26. Under VPN Virtual Server Traffic Policy Binding, click Add Binding.

27. Under Policy Binding, next to the Select Policy menu, click > to view the policy list.

28. Select the policy you created in Step 18 and then click OK.

29. Click Bind.

30. Click Close.

31. Click Done.

Be sure to configure the Secure Web (WorxWeb) app in the XenMobile console. Go to Configure >
Apps, select the Secure Web app, click Edit, and then make these changes:

• On the App information page, change Initial VPNMode to Secure Browse.
• On the iOS page, change Initial VPNMode to Secure Browse.
• On the Android page, change Preferred VPNMode to Secure Browse.

Configuring Application and MDX Token Time-Outs

When users log on from an iOS or Android device, an application token or an MDX token is issued. The
token is similar to the Secure Ticket Authority (STA).

You can set the number of seconds or minutes the tokens are active. If the token expires, users cannot
access the requested resource, such as an application or a web page.

Token time-outs are global settings. When you configure the setting, it applies to all users who log on
to NetScaler Gateway.

1. In the configuration utility, on theConfiguration tab, in the navigation pane, expandNetScaler
Gateway and then click Global Settings.
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2. In the details pane, under Settings, click Change global settings.
3. In the Global NetScaler Gateway Settings dialog box, on the Client Experience tab, click Ad-

vanced Settings.
4. On the General tab, in Application Token Timeout (sec) enter the number of seconds before

the token expires. The default is 100 seconds.
5. In MDX Token Timeout (mins), enter the number of minutes before the token expires and then

click OK. The default is 10 minutes.

Disabling Endpoint Analysis for Mobile Devices

If you configure endpoint analysis, you need to configure the policy expressions so that the endpoint
analysis scans do not run on Android or iOS mobile devices. Endpoint analysis scans are not supported
on mobile devices.

If you bind an endpoint analysis policy to a virtual server, you must create a secondary virtual server
for mobile devices. Do not bind preauthentication or post-authentication policies to the mobile device
virtual server.

When you configure the policy expression in a preauthentication policy, you add the User-Agent string
to exclude Android or iOS. When users log on from one of these devices and you exclude the device
type, endpoint analysis does not run.

For example, you create the following policy expression to check if the User-Agent contains Android,
if the application virus.exe does not exist, and to end the process keylogger.exe if it is running by using
the preauthentication profile. The policy expression might look like this:

REQ.HTTP.HEADER
User-Agent NOTCONTAINS
Android &&
CLIENT.APPLICATION.PROCESS(keylogger.exe)
contains

CLIENT.APPLICATION.PROCESS
(virus.exe) contains

After you create the preauthentication policy and profile, bind the policy to the virtual server. When
users log on from an Android or iOS device, the scan does not run. If users log on from a Windows-
based device, the scan does run.

For more information about configuring preauthentication policies, see Configuring Endpoint Polices.

Supporting DNS Queries by using DNS Suffixes for Android Devices

When users establish a Micro VPN connection from an Android device, NetScaler Gateway sends split
DNS settings to the user device. NetScaler Gateway supports split DNS queries based on the split DNS
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settings you configure. NetScaler Gateway can also support split DNS queries based on DNS suffixes
you configure on the appliance. If users connect from an Android device, you must configure DNS
settings on NetScaler Gateway.

Split DNS works in the following manner:

• If you set split DNS to Local, the Android device sends all DNS requests to the local DNS server.
• If you set split DNS to Remote, all DNS requests are sent to the DNS servers configured on Citrix

Gateway (remote DNS server) for resolution.
• If you set split DNS to Both, the Android device checks for the DNS request type.

– If DNS request type is not “A”, it sends the DNS request packet to both local and remote
DNS servers.

– If DNS request type is “A”, the Android plugin extracts query FQDN and matches that FQDN
against the DNS suffix list configured on Citrix ADC. If DNS request’s FQDN matches, DNS
request is sent to remote DNS server. If FQDN does not match, DNS request is sent to local
DNS servers.

The following table summarizes split DNS working based on type A record and suffix list.

Split DNS setting Is it a type A record? Is it on suffix list?
Where the DNS
request is sent

Local both Yes or No both Yes or No Local

Remote both Yes or No both Yes or No Remote

Both No NA Both

Both Yes Yes Remote

Both Yes No Local

To configure a DNS suffix:

1. In the configuration utility, on theConfiguration tab, in the navigation pane, expandNetScaler
Gateway > Policies and then click Session.

2. In the details pane, on the Policies tab, select a session policy and then click Open.
3. Next to Request Profile, click Modify.
4. On the Network Configuration tab, click Advanced.
5. Next to Intranet IP DNS Suffix, click Override Global, type the DNS suffix and then click OK

three times.

To configure split DNS globally on NetScaler Gateway:

1. In the configuration utility, on theConfiguration tab, in the navigation pane, expandNetScaler
Gateway and then click Global Settings.
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2. In the details pane, under Settings, click Change global settings.
3. On the Client Experience tab, click Advanced Settings.
4. On the General tab, in Split DNS, select Both, Remote, or Local and then click OK.

To configure split DNS in a session policy on NetScaler Gateway:

1. In the configuration utility, on theConfiguration tab, in the navigation pane, expandNetScaler
Gateway > Policies and then click Session.

2. In the details pane, on the Policies tab, click Add.
3. In Name, type a name for the policy.
4. Next to Request Profile, click New.
5. In Name, type a name for the profile.
6. On the Client Experience tab, click Advanced Settings.
7. On the General tab, next to Split DNS, click Override Global, select Both, Remote, or Local

and then click OK.
8. In the Create Session Policy dialog box, next to Named Expressions, select General, select

True, click Add Expression, click Create, and then click Close.

Configuring Domain and Security Token Authentication for XenMobile

October 5, 2020

You can configure XenMobile to require users to authenticate with their LDAP credentials plus a one-
time password, using the RADIUS protocol. This section describes the required NetScaler Gateway
configuration for that two-factor authentication type.

Prerequisites

If you have not already run the NetScaler for XenMobile wizard, see the NetScaler for XenMobile Wiz-
ard section in Configuring Settings for Your XenMobile Environment. Make sure that your NetScaler
configuration includes the following:

• LDAP port number = 636 (which is the default port for secure LDAP connections)
• Server Logon Name Attribute = samAccountName or the userPrincipalName as per your re-

quirements

To configure domain and security token authentication

1. Go to NetScaler Gateway > Virtual Servers. Select the virtual server and then click Edit.

2. Click No CA Certificate.
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3. From Select CA Certificate, choose a certificate, click OK, click Bind, and then click Done.

4. Go toPolicies >Session>SessionProfiles, select the profile which starts withAC_OS, and click
Edit.

5. Click the Client Experience tab and go to the bottom of the page.

6. From Credential Index, choose SECONDARY.
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7. Click OK.

8. Go to Policies > Authentication > LDAP, click the LDAP Policy tab, and click Edit.

9. To use separate NetScaler Gateway VIPs for XenMobile and XenApp/XenDesktop, in Expression,
replace NS_TRUE with the following:
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REQ.HTTP.HEADER User-Agent CONTAINS CitrixReceiver

10. Go to Policies > Authentication > RADIUS and then click the Servers tab.

11. Click Add, enter the Radius server details, and click Create.
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12. Go to Policies and then click Add.

13. Enter a Name for the policy. From the Server drop-down menu, select the Radius server name
(Radius_Server in our example).

14. ForExpression, enterREQ.HTTP.HEADERUser-AgentCONTAINSCitrixReceiverand clickCre-
ate.
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15. Select the virtual server and then click Edit.

16. Under Primary Authentication, click LDAP Policy.
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17. Select the policy, click Unbind, and click Close.

18. On the Authentication row, click + to add the Radius authentication.
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19. Under Choose Type, from Choose Policy, select RADIUS.

20. Click Bind.

21. Select the Radius authentication policy you created earlier and then click Insert.

22. Click OK.
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23. To add LDAP as the secondary authentication policy: On the Authentication row, click +.

24. From Choose Policy, choose LDAP.

25. From Choose Type, choose Secondary.

26. From Select Policy, choose the LDAP policy.
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27. Select the policy and then click OK.

28. Click Bind.

29. Click Done.
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30. Verify that the policies you created have the highest priority. This ensures that they will have
the highest priority even if additional policies get added for non-mobile users. For more infor-
mation, see Setting Priorities for Authentication Policies.

Configuring Client Certificate or Client Certificate and Domain
Authentication

October 5, 2020

You can use the NetScaler for XenMobile wizard to perform the configuration required for XenMobile
when using NetScaler certificate-only authentication or certificate plus domain authentication. You
can run the NetScaler for XenMobile wizard one time only. For information about using the wizard,
see Configuring Settings for Your XenMobile Environment.

If you’ve already used the wizard, use the instructions in this article for the addition configuration
required for client certificate authentication or client certificate plus domain authentication.

To ensure that the user of a device in MAM-only mode can’t authenticate using an existing certificate
on the device, see “NetScaler Certificate Revocation List (CRL)” later in this article.
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Manually Configuring NetScaler Gateway for Client Certificate Authentication

1. UnderTrafficManagement > LoadBalancing > Virtual Servers, go to each virtual server (both
443 and 8443), update the SSL Parameters, and set Enable Session Reuse to DISABLED.

2. On the NetScaler Gateway virtual server, onEnableClientAuthentication ->ClientCertificate,
select Client Authentication and for Client Certificate, select Mandatory.

3. Create a new authentication Certificate policy so XenMobile can extract the User Principal
Name or the sAMAccount from the client certificate provided by Secure Hub to NetScaler
Gateway. For details, see Citrix ADC for XenMobile Wizard.

4. Set the following parameters for the certificate profile:

Authentication Type: CERT

Two Factor: OFF (for certificate only authentication)

User Name Field: Subject: CN

Group Name Field: SubjectAltName:PrincipalName
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5. Bind only the certificate authentication policy as the Primary Authentication in the NetScaler
Gateway virtual server.

6. Bind the Root CA certificate to validate the trust of the client certificate presented to NetScaler
Gateway.
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Manually Configuring NetScaler Gateway for Client Certificate and Domain
Authentication

1. UnderTrafficManagement > LoadBalancing > Virtual Servers, go to each virtual server (both
443 and 8443), update the SSL Parameters, and set Enable Session Reuse to DISABLED.

2. Go to Policies > Authentication > Cert, select the Servers tab, and click Add.

3. Enter theName of the profile, set Two Factor toON, and fromUser Name Field, select Subjec-
tAltNamePrincipalName.
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4. Go to Policies and click Add.

5. Enter the Name of the policy, from Server select the certificate profile, set the Expression as
ns_true, and click Create.
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6. Go to Virtual Servers, select the virtual server, and click Edit.

7. Beside Authentication, click + to add the certificate authentication.
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8. To select the authentication method: From Choose Policy, select Certificate.

9. FromChooseType, selectPrimary. This binds certificate authentication as the primary authen-
tication with the priority same as the LDAP authentication type.

10. Under Policy Binding, click Click to Select to select the certificate policy created earlier.
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11. Select the certificate policy created earlier and click OK.

12. Set the Priority to 100 and then click Bind. Use the same priority number when you configure
the LDAP authentication policy in the subsequent steps.

13. On the row for LDAP Policy, click >.
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14. Select the policy and then, from the Edit drop-down menu, click Edit Binding.

15. Enter the same Priority value that you specified for the certificate policy. Click Bind.

16. Click Close.

17. Under Advanced, click SSL Parameters.
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18. Select the Client Authentication checkbox, from Client Certificate choose Mandatory, and
click OK.

19. Click Done.
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NetScaler Certificate Revocation List (CRL)

XenMobile supports Certificate Revocation List (CRL) only for a third party Certificate Authority. If
you have a Microsoft CA configured, XenMobile uses NetScaler to manage revocation. When you con-
figure client certificate-based authentication, consider whether you need to configure the NetScaler
Certificate Revocation List (CRL) setting, Enable CRL Auto Refresh. This step ensures that the user
of a device in MAM-only mode can’t authenticate using an existing certificate on the device; XenMo-
bile re-issues a new certificate, because it doesn’t restrict a user from generating a user certificate if
one is revoked. This setting increases the security of PKI entities when the CRL checks for expired PKI
entities.

Optimizing network traffic with CloudBridge

October 5, 2020

When users log on with the NetScaler Gateway Plug-in, the connection can be optimized by using
the CloudBridge Plug-in, which installs on the user device from CloudBridge. When the connection is
optimized through the use of the CloudBridge Plug-in, network traffic is compressed and accelerated
through NetScaler Gateway. When CloudBridge is enabled for a connection, TCP compression policies
on the NetScaler Gateway are disabled.

The CloudBridge Plug-in is deployed and works with the NetScaler Gateway Plug-in.

NetScaler Gateway supports Versions 5.5 and 6.1 of the Repeater Plug-in and Versions 6.2 and 7.0 of
the CloudBridge Plug-in.
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CloudBridge optimization and flow control take precedence over NetScaler Gateway optimization fea-
tures that require dynamic content modification. If CloudBridge optimization is enabled for HTTP
traffic, the following NetScaler Gateway features are not available:

• Single sign-on to Web applications
• File type association
• HTTP authorization

To allow single sign-on to Web applications, you can disable acceleration on HTTP. To do so, you use
the command line. Log on to the NetScaler Gateway serial console and then at a command prompt,
type:

add vpn trafficAction ssoact http -SSO ON

Network traffic destined for a configured HTTP port on NetScaler Gateway is excluded automatically
from CloudBridge optimization. This is the default setting. If you configure a traffic policy for Cloud-
Bridge optimization on an HTTP port, the traffic policy is honored and the network traffic is optimized
by CloudBridge. However, the NetScaler Gateway optimization features are disabled for all traffic af-
fected by that policy. CloudBridge can accelerate network traffic destined for non-HTTP ports without
affecting other NetScaler Gateway features.

You use a traffic policy to configure user connections to use the CloudBridge Plug-in. You can then
bind the policy to users, groups, virtual servers, or globally. The policy is prioritized based on where
you bind the policy or by the priority number you give the policy.

To create a traffic policy

1. In the configuration utility, on the Configuration tab, in the navigation pane, expand NetScaler
Gateway Policies and then click Traffic.

2. In the details pane, click Add.
3. In Name type a name for the policy.
4. Next to Request Profile, click New.
5. In Name, type a name for the profile.
6. In Branch Repeater, select ON and then click Create.
7. In the Create Traffic Policy dialog box, next to Add Expression, select or enter an expression

that represents the traffic types to enable CloudBridge acceleration click Add Expression, click
Create and then click Close.

When adding an expression, choose a network expression to use the same IP addresses and port
ranges for which the CloudBridge is configured to accelerate. For CloudBridge acceleration to occur,
the traffic types configured on NetScaler Gateway must match the Service Class Policies configured
on CloudBridge.
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All TCP traffic benefits from CloudBridge acceleration. If you are planning to use single sign-on, do not
accelerate HTTP traffic because the acceleration disables single sign-on.

RfWebUI Persona on Gateway UX Configuration

October 5, 2020

RfWebUI Persona is a theme that provides a new logon and portal page for NetScaler Gateway users
logging on through NetScaler Gateway. The portal presents Receiver, StoreFront, and XenMobile users
with the same GUI as when they access one of those products directly.

When to Use RfWebUI Persona

Use the RfWebUI persona in NetScaler Gateway when you need a single-pane view of all the applica-
tions provided by different CITRIX products, such as web and Software as a Service (SaaS) applica-
tions, virtual Windows applications, and desktops.

The following scenarios illustrate the use of RfWebUI Persona.

• A user accesses StoreFront using Gateway and finds a GUI different than the one they see upon
accessing the product without Gateway.
Solution: When the user accesses StoreFront using Gateway, the RfWebUI theme provides a
similar user interface as they see upon accessing the product without using the Gateway.

• A user accesses Receiver, StoreFront, and XenMobile applications using Gateway and struggles
to locate the desired applications as the applications are not grouped in a logical fashion.
Solution: The RfWebUI persona provides a single pane view user experience by creating a log-
ical bundling of applications provided by different products, such as Receiver, StoreFront, Xen-
Mobile, and so on.

Functionalities Provided by RfWebUI Persona

The new RfWebUI provides the following features:

• GO
• Aggregation of applications
• User Configured RDP proxy links
• Favorite applications
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GO

GO: The Go feature provides access to webpages through clientless VPN (CVPN). The user just types
the URL in the URL section on the Bookmark tab and clicks GO.

Currently, the GO feature supports only Outlook Web Application (OWA) and SharePoint URLs.

Note
The GO tab is visible only if the clientlessAccessVPNMode parameter in the session policy is En-
abled.

Aggregation of applications

Aggregation of applications: The RfWebUI theme provides a single-pane view by bundling the ap-
plications provided by different products under descriptive banners. For example, all the VPN URLs
configured by a NetScaler administrator are in a bundle named Web and SaaS Applications, and
user-specific web bookmarks are under Personal Bookmarks. If XenApp or XenDesktop application
bundles are configured in StoreFront, the single pane view in NetScaler Gateway lists these bundles
as well.

User Configured RDP Proxy Links

Users can add Remote Desktop Protocol (RDP) proxy link as personal bookmarks. The personal book-
marks appear under the Desktops tab.

The following RDP modes are supported:

• Single gateway
• Stateless (Dual) gateway

Note
User can add RDP Proxy Links only if an RDPclientprofile is configured. For more information on
RDP configurations, see RDP Proxy documentation.

Favorite applications

Users can add the desired applications listed under Web and SaaS Application and under Personal
Bookmarks to FAVORITES tab by clickingAdd to Favorites link present next to the application name.
The applications once added can be seen under FAVORITES tab. The same can also be removed from
the FAVORITES tab by clicking REMOVE link present next to the application inside FAVORITES tab.

Considerations While Enabling the RfWebUI Persona

The RfWebUI persona does not fully support the following:
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Fileshare feature: The fileshare feature, for accessing SMB file shares, is not supported.
EmailHome: TheEmailHomeVPN parameter is not available as an embedded view for the NetScaler
Gateway portal. It can be accessed as an application in the Web and SaaS Apps bundle under the
APPS tab of RfWebUI.
Java Client: The browser based Java client for establishing an SSL tunnel is not available in this
theme.

Configuring RfWebUI Persona

To apply the RfWebUI Persona:

1. In the NetScaler interface, navigate to Configuration > NetScaler Gateway Portal Themes.
2. On the Portal Themes page, select the RfWebUI check box.
3. Click the Save icon on the top right corner of the Portal Themes page.
4. In the Save Confirmation dialog box, click Yes.

RDP Proxy

October 5, 2020

RDP Proxy Overview and Enhancements through NetScaler Gateway

The following RDP Proxy features provide access to a remote desktop farm through NetScaler Gate-
way:

• Secure RDP traffic through clientless VPN or ICA Proxy mode (without Full Tunnel).

• Single sign on (SSO) to RDP servers through NetScaler Gateway.

(Also provides an option to disable SSO if needed).

• Enforcement (SmartAccess) feature, where NetScaler administrators can disable certain RDP
capabilities through NetScaler Gateway configuration.

• Single/Stateless(Dual) Gateway solution for all needs (VPN/ICA/RDP/XenMobile).

• Compatibility with native Windows MSTSC client for RDP without the need for any custom
clients.

• Use of existing Microsoft-provided RDP client on MACOSX, iOS, and Android.

© 1999-2021 Citrix Systems, Inc. All rights reserved. 567



NetScaler Gateway 12.0

Deployment Overview

The RDP Proxy functionality is provided as part of the NetScaler Gateway. In a typical deployment,
the RDP client runs on a remote user’s machine. The NetScaler Gateway appliance is deployed within
the DMZ, and the RDP server farm is in the internal corporate network. The remote user connects
to the NetScaler Gateway public IP address, establishes an SSL VPN connection, and authenticates
himself/herself, after which the user can access the Remote desktops through the NetScaler Gateway
appliance.

The RDP-proxy feature is supported in clientless VPN and ICA Proxy modes.

Note: Citrix Gateway does not support Remote Desktop Session Host (RDSH)/Remote App/RDS
multiuser RDP sessions.

Deployment Through clientless VPN

In this mode the RDP links are published on the Gateway home page or portal, as bookmarks, through
the ‘add vpn url’ configuration or through an external portal. The user can click these links to get
access to the Remote Desktop.

Deployment Through ICA Proxy

In this mode a custom home page is configured on the Gateway VIP by using the wihome parameter.
This home page can be customized with the list of Remote desktop resources that the user is allowed
to access. This custom page can be hosted on NetScaler, or if external, it can be an iFrame in the
existing Gateway portal page.

In either mode, after the user clicks the provisioned RDP link or icon, an HTTPS request for the cor-
responding resource arrives at the NetScaler Gateway. The Gateway generates the RDP file content
for the requested connection and pushes it to the client. The native RDP client is invoked, and it con-
nects to an RDP listener on Gateway. Gateway does SSO to the RDP server by supporting enforcement
(SmartAccess). The gateway blocks client access to certain RDP features, based on the NetScaler con-
figuration, and then it proxies the RDP traffic between the RDP client and the server.
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Enforcement Details

The NetScaler administrator can configure certain RDP capabilities through NetScaler Gateway config-
uration. NetScaler Gateway provides the “RDP enforcement” feature for important RDP parameters.
NetScaler ensures that the client cannot enable blocked parameters. If the blocked parameters are
enabled, the RDP enforcement feature supersedes the client-enabled parameters, and they are not
honored.

Important: Enforcement feature is applicable only if SSO is enabled.

Supported RDP Parameters for Enforcement

Enforcement for following redirection parameters is supported. These parameters are configurable
as part of an RDP client profile.

• Redirection of ClipBoard

• Redirection of Printers

• Redirection of Disk Drives

• Redirection of COM ports

• Redirection of pnp devices

Connection Flow

Connection flow can be divided into two steps:

• RDP resource enumeration and RDP file download.

• RDP Connection launch.

Based on the above connection flow, there are two deployment solutions:

• Stateless (Dual) gateway solution (Where the RDP resource enumeration and RDP file download
happen through Authenticator gateway but RDP connection launch happens through RDP Lis-
tener gateway).

• Single gateway solution (Where the RDP resource enumeration, RDP file download, and RDP
connection launch happen through the same gateway).
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Stateless (Dual) Gateway Compatibility

• User connects to the Authenticator Gateway VIP and provides the credentials.

• After a successful login to the Gateway, user is redirected to the home page or external portal,
which enumerates the remote desktop resources that the user can access.

• Once the user selects an RDP resource, the Authenticator Gateway VIP receives the request in the
format https://vserver-vip/rdpproxy/rdptarget/listener indicating the published
resource that the user clicked. This request has the information about the IP address and port
of the RDP server that the user has selected.

• The Authenticator Gateway processes the /rdpproxy/ request. Because the user is already au-
thenticated, this request comes with a valid Gateway cookie.

• The RDPTarget and RDPUser information is stored on the STA server, and an STA Ticket is gener-
ated. The information stored on the STA server is encrypted by using the configured pre-shared
key. The Authenticator Gateway uses one of the STA servers that is configured on the Gateway
virtual server.

• The ‘Listener’ info obtained in the /rdpproxy/ request is put into the .rdp file as the “fulladdress,”
and the STA ticket (pre-pended with the STA AuthID) is put into the .rdp file as the “loadbalan-
ceinfo.”

• The .rdp file is sent back to the client end-point.

• The native RDP client launches and connects to the RDPListener Gateway. It sends the STA ticket
in the initial packet.
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The RDPListener Gateway validates the STA ticket and obtains the RDPTarget and RDPUser informa-
tion. The STA server to be used is retrieved by using the ‘AuthID’ present in the loadbalanceinfo.

Single Gateway Compatibility

In the case of a single gateway deployment, the STA server is not required. The authenticator gateway
encodes the RDPTarget and the Citrix ADC AAA session cookie securely and sends them as the loadbal-
anceinfo in the .rdp file. When the RDP Client sends this token in the initial packet, the authenticator
gateway decodes the RDPTarget information, looks up the session, and connects to the RDPTarget.

License Requirements for RDP Proxy

Feature: RDP Proxy availability
License: Platinum edition, Enterprise edition

Note: RDP Proxy function is not available to customers who have only a Gateway platform license
or only the Standard edition.

RDP proxy feature has to be enabled for RDP proxy to work.

1 enable feature rdpProxy
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Configuration Steps

1. Enable the feature
2. Create Bookmarks on the Gateway portal or use a customized Gateway portal that enumerates

RDP resources
3. Configure an RDP Client Profile
4. Configure an RDP Server Profile

Enable the Required Features and Modes

• enable ns feature ssl

• enable ns feature sslvpn

• enable ns feature rdpproxy

• enable mode usnip

Creating Bookmarks

1. Create bookmarks on the portal page to access the RDP resources: (The actualURL starts with
rdp://).

2. Add vpn url <urlName> <linkName>  <actualURL>

• The URL must be in the following format: rdp://<TargetIP:Port>.

• For Stateless RDP proxy mode, The URL must be in the following format: rdp://<
TargetIP:Port>/<ListenerIP:Port>

• The URL is published on the portal in the format: https://<VPN-VIP>/rdpproxy/<
TargetIP:Port>

https://<VPN-VIP>/rdpproxy/<TargetIP:Port>/<ListenerIP:Port>

3. Bind the bookmarks to the user, or group, or the vpn virtual server, or vpn global.

Configuring a Client Profile

Configure the client profile on the authenticator gateway. The following is a sample configuration:

1 add rdpClient profile <name> [-addUserNameInRdpFile ( YES | NO )] [-
audioCaptureMode ( ENABLE | DISABLE )] [-keyboardHook <keyboardHook
>] [-multiMonitorSupport ( ENABLE | DISABLE )] [-psk <string>] [-
rdpCookieValidity <positive_integer>] [-rdpCustomParams <string>] [-
rdpFileName <string>] [-rdpHost <optional FQDN that will be put in

© 1999-2021 Citrix Systems, Inc. All rights reserved. 572



NetScaler Gateway 12.0

the RDP file as ‘ fulladdress>] [-rdpUrlOverride ( ENABLE | DISABLE
)] [-redirectClipboard ( ENABLE | DISABLE )] [-redirectComPorts (
ENABLE | DISABLE )] [-redirectDrives ( ENABLE | DISABLE )] [-
redirectPnpDevices ( ENABLE | DISABLE )] [-redirectPrinters ( ENABLE
| DISABLE )] [-videoPlaybackMode ( ENABLE | DISABLE )]

Associate the RDP client Profile with the vpn virtual server.

This can be done either by configuring a sessionAction+sessionPolicy or by setting the global vpn pa-
rameter.

Example:

1 add vpn sessionaction <actname> -rdpClientprofile <rdpprofilename>
2
3 add vpn sessionpolicy <polname> NS_TRUE <actname>
4
5 bind vpn vserver <vservername> -policy <polname> -priority <

prioritynumber>

OR

1 set vpn parameter ‒ rdpClientprofile <name>

Configuring a Server Profile

Configure the server profile on the listener gateway.

1 add rdpServer Profile <profilename> -rdpIP <IPV4 address of the RDP
listener> -rdpPort <port for terminating RDP client connections> -
psk <key to decrypt RDPTarget/RDPUser information, needed while
using STA>

The rdpServer Profile must be configured on the ‘vpn virtual server’.

1 add vpn vserver v1 SSL <publicIP> <portforterminatingvpnconnections> -
rdpServerProfile <rdpServer Profile>
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Sample Configuration

• Enable the required features and modes

1 enable ns feature ssl
2
3 enable ns feature sslvpn
4
5 enable ns feature rdpproxy
6
7 enable mode usnip

• Add VPN URL for the user with Target information

1 add aaa user Administrator ‒ password freebsd123$%^
2
3 add vpn url rdp RdpLink rdp://rdpserverinfo
4
5 add dns addrec rdpserverinfo 10.102.147.132
6
7 bind aaa user Administrator   ‒ urlName rdp

• Configure RDP client and server profile for the VPN connection

1 add rdp clientprofile p1 ‒ psk citrix -redirectClipboard ENABLE
2
3 add rdp serverprofile p1 -rdpIP 10.102.147.134 -psk citrix
4
5 add vpn vserver mygateway SSL  10.102.147.134 443 ‒

rdpserverprofile p1
6
7 set vpn parameter -clientlessVpnMode ON -defaultAuthorizationAction

ALLOW -rdpClientProfileName p1
8
9 add ssl certKey gatewaykey -cert rdp_rootcert.pem  -key rdp_rootkey
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10
11 bind ssl vserver mygateway -certkeyName gatewaykey

• ADD SNIP for connection from Citrix ADC to target

1 add ns ip 10.102.147.135  255.255.255.0 ‒ type SNIP

Option to Disable SSO

The SSO (Single sign On) feature with RDP proxy can be disabled by configuring NetScaler traffic poli-
cies so the user is always prompted for credentials. When SSO is disabled, RDP enforcement (Smar-
tAccess) doesn’t work.

Example Configuration:

1 add vpn trafficaction <TrafficActionName> HTTP -SSO OFF

Traffic policy can be configured as per the requirement, following are two examples:

• To disable SSO for all the traffic:

1 add vpn trafficpolicy <TrafficPolicyName>  ”url contains rdpproxy” <
TrafficActionName>

• To disable SSO based on Source/Destination IP/FQDN

1 add vpn trafficPolicy <TrafficPolicyName> ”HTTP.REQ.URL.CONTAINS(\”
rdpproxy\”) && CLIENT.IP.SRC.EQ(<IP>)” <TrafficActionName>

2 bind vpnvserver rdp -policy <TrafficPolicyName> -priority 10

Support for Single Listener

• Single Listener for Both RDP and SSL Traffic.

• The RDP file download and RDP traffic can be handled through the same 2 tuple (that is, IP and
Port) on NetScaler.
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Bookmark

RDP link generation through Portal. Instead of configuring the RDP links for the user or publishing
the RDP links through an external portal, you can give users an option to generate their own URLs
by providing targerIP:Port. For stateless RDP-proxy deployment, the administrator can include RDP
listener information in FQDN: Port format as part of the RDP Client Profile. This is done under the
rdpListener option. This configuration is used for the RDP link generation through the portal in Dual
Gateway mode.

RDP Proxy Configuration

Do the following to configure RDP Proxy:

1. Expand Citrix Gateway, expand Policies, right-click RDP, and click Enable Feature.
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2. Click RDP on the left. On the right, switch to the Client Profiles tab and click Add.

3. Give the Client Profile a name and configure it as desired. Scroll down
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4. In the RDP Host field, enter the FQDN that resolves to the RDP Proxy listener, which is typically
the same FQDN as the Citrix Gateway appliance’s FDQN.

5. Near the bottom is a Pre Shared Key. Enter a password and click OK. You need this later.
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6. Give the Server Profile a name.

7. Enter the IP address of the Gateway Virtual Server you’re going to bind this.

8. Enter the same Pre Shared Key you configured for the RDP Client Profile. Click Create.

9. If you want to put RDP bookmarks on the Clientless Access portal page, on the left, expandCitrix
Gateway, expand Resources, and click Bookmarks.
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10. On the right, click Add.

11. Give the Bookmark a name.

12. For the URL, enter rdp://MyRDPServer using IP or DNS.

13. Check the box next to Use Citrix Gateway As a Reverse Proxy and click Create.

14. Create more bookmarks as desired.

© 1999-2021 Citrix Systems, Inc. All rights reserved. 580



NetScaler Gateway 12.0

15. Create or edit a session profile or policy.

16. On the Security tab, set Default Authorization Action to ALLOW. Or you can use Authorization
policies to control access.
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17. On the Remote Desktop tab, select the RDP Client Profile you created earlier.

18. If you want to use Bookmarks, on the Client Experience tab, set Clientless Access to On.

© 1999-2021 Citrix Systems, Inc. All rights reserved. 582



NetScaler Gateway 12.0

19. On the Published Applications tab, make sure ICA Proxy is OFF.

20. Modify or Create your Gateway Virtual Server.

21. In the Basic Settings section, click More.
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22. Use the RDP Server Profile list to select the RDP Server Profile you created earlier.

23. Scroll down. Make sure ICA Only is not checked.
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24. Bind a certificate.

25. Bind authentication policies.

26. Bind the session policy/profile that has the RDP Client Profile configured.

27. You can bind Bookmarks to either the Citrix Gateway virtual server or to a Citrix ADC AAA group.
To bind to the Citrix Gateway virtual server, on the right, in the Advanced Settings section, click
Published Applications.
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28. On the left, in the Published Applications section, click No Url.

29. Bind your Bookmarks.
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30. Because ICA Only is not specified for this Citrix Gateway virtual server, make sure your Citrix
Gateway Universal licenses are configured correctly. On the left, expand Citrix Gateway and
click Global Settings.

31. On the right, click Change authentication AAA settings.

32. Change the MaximumNumber of Users to your licensed limit.
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33. If you want to connect to RDP servers by using DNS, make sure DNS servers are configured on
the appliance (Traffic Management > DNS > Name Servers).

34. If you want to use the short names instead of FQDNs, add a DNS Suffix (Traffic Management >
DNS > DNS Suffix).

35. Connect to your Gateway and log on.
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36. If you configured Bookmarks, click the Bookmark.

37. You can change the address bar to /rdpproxy/MyRDPServer. You can enter an IP address (for
example rdpproxy/192.168.1.50) or DNS name (/rdpproxy/myserver).
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38. Open the downloaded .rdp file.

39. You can view the currently connected users by going to Citrix Gateway Policies > RDP. On the
right is the Connections tab.

Stateless RDP Proxy

October 5, 2020

The Stateless RDP Proxy accesses a RDP host. Access is granted through the RDPListener on Citrix
Gateway when the user authenticates on a separate Citrix Gateway Authenticator. The information
required by the RDPListener for Citrix Gateway is securely stored on a STA Server.

The flow and new knobs created for this functionality are described here.

Prerequisites

• User is authenticated on Citrix Gateway authenticator.

• The initial /rdpproxy URL and RDP Client are connected to a different RDPListener Citrix Gate-
way.

• The RDPListener Gateway information is securely passed by the Authenticator Gateway using a
STA Server.

© 1999-2021 Citrix Systems, Inc. All rights reserved. 590



NetScaler Gateway 12.0

Configuration

• Add a new rdpServer profile. The server profile is configured on the RDPListener Gateway.

1 add rdpServer Profile [profilename] -rdpIP [IPV4 address of the
RDP listener] -rdpPort [port for terminating RDP client
connections] -psk [key to decrypt RDPTarget/RDPUser
information, needed while using STA].

For stateless RDP proxy, the STA Server validates the STA ticket, which is sent by the RDP client,
to obtain the RDP Target/RDPUser information.

The rdpServer Profile is configured on the vpn virtual server using the following command:

1 add vpn vserver v1 SSL [publicIP] [
portforterminatingvpnconnections] -rdpServerProfile [rdpServer
Profile]

Warning
Once the rdpServerProfile is configured on the vpn vserver, it cannot be modified. Also,
the same serverProfile cannot be reused on another vpn vserver.

The rdp profile command was renamed as rdpClient profile and has new parameters. The multi-
MonitorSupport command was added. Also, an option to configure custom params, which are not
supported as part ofthe RDP client profile, has been added. The clientSSL param was removed, since
the connection is always secured. The client profile is configured on the authenticator Gateway.

1 add rdpClient profile <name> -rdpHost <optional FQDN that will be put
in the RDP file as ‘ fulladdress’ > [-rdpUrlOverride ( ENABLE |
DISABLE )] [-redirectClipboard ( ENABLE | DISABLE )] [-
redirectDrives ( ENABLE | DISABLE )]

2
3 [-redirectPrinters ( ENABLE | DISABLE )] [-keyboardHook <

keyboardHook>] [-audioCaptureMode ( ENABLE | DISABLE )] [-
videoPlaybackMode ( ENABLE | DISABLE )]

4
5 [-rdpCookieValidity <positive_integer>][-multiMonitorSupport (

ENABLE | DISABLE )] [-rdpCustomParams <string>] The ‒
rdpHost configuration is used in a single Gateway deployment
.
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• Associate the RDP Profile with the vpn virtual server.

This can be done either by configuring a sessionAction+sessionPolicy or by setting the global vpn pa-
rameter.

Example

1 add vpn sessionaction <actname> -rdpClientprofile <rdpprofilename>
2
3 add vpn sessionpolicy <polname> NS_TRUE <actname>
4
5 bind vpn vserver <vservername> -policy <polname> -priority <

prioritynumber>
6
7 OR
8
9 set vpn parameter ‒ rdpClientprofile <name>

Connection Counter

A new connection counter ns_rdp_tot_curr_active_conn was added, which keeps the record of num-
ber of active connections in use. It can be viewed as a part of nsconmsg command on NetScaler shell.
Later, we will be providing a new CLI command to view this counters.

Connection Flow

There are two connections involved in the RDP Proxy flow. The first connection is the user’s SSL VPN
connection to the Citrix Gateway VIP, and enumeration of the RDP resources.

The second connection is the native RDP client connection to the RDP listener (configures using rd-
pIP and rdpPort) on the Citrix Gateway, and subsequent proxying of the RDP client to server packets
securely.

© 1999-2021 Citrix Systems, Inc. All rights reserved. 592



NetScaler Gateway 12.0

1. User connects to the Authenticator Gateway VIP and provides his/her credentials.

2. After successful login to the Gateway, user is redirected to the homepage/external portal which
enumerates the remote desktop resources that the user can access.

3. Once the user selects a RDP resource, a request is received by the Authenticator Gateway
VIP, in the format https://AGVIP/rdpproxy/ip:port/rdptargetproxy indicating the
published resource that the user clicked. This request has the information about the IP and
port of the RDP server that the user has selected.

4. The /rdpproxy/ request is processed by the Authenticator Gateway. Since the user is already
authenticated, this request comes with a valid Gateway cookie.

5. The RDPTarget and RDPUser information is stored on the STA server and a STA Ticket is gener-
ated. The information is stored as an XML blob which is optionally encrypted using the config-
ured pre-shared key. If encrypted, the blob is base64 encoded and stored. The Authenticator
Gateway will use one of the STA servers that is configured on the Gateway Vserver.

6. The XML blob will be in the following format

<Value name=”IPAddress”>ipaddr</Value>\n<Value name=”Port”>port</Value>\n

<Value name=”Username”>username</Value>\n<Value name=”Password”>pwd</Value>

7. The “rdptargetproxy” obtained in the /rdpproxy/ request is put as the ‘fulladdress’ and the STA
ticket (pre-pended with the STA AuthID) is put as the ‘loadbalanceinfo’ in the .rdp file.

8. The .rdp file is sent back to the client end-point.
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9. The native RDP client launches and connects to the RDPListener Gateway. It sends the STA ticket
in the initial x.224 packet.

10. The RDPListener Gateway validates the STA ticket and obtains the RDPTarget and RDPUser infor-
mation. The STA server to be used is retrieved using the ‘AuthID’ present in the loadbalanceinfo.

11. A Gateway session is created for storing authorization/auditing policies. If a session already
exists for the user, it is re-used.

12. The RDPListener Gateway connects to the RDPTarget and single signs on using CREDSSP.

Single Gateway Compatibility

If the RDP file is generated using the /rdpproxy/rdptarget/rdptargetproxy URL, we will generate a STA
ticket, otherwise the current method of the ‘loadbalanceinfo’ referring to the session directly will be
used.

In case of a single gateway deployment, the /rdpproxy URL comes to the Authenticator Gateway itself.
A STA server is not required. The authenticator gateway encodes the RDPTarget and the AAA session
cookie securely and sends this as the ‘loadbalanceinfo’ in the .rdp file. When the RDP Client sends
this token in the x.224 packet, the authenticator gateway decodes the RDPTarget information, looks
up the session and connects to the RDPTarget.
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Upgrade Notes

Earlier configuration doesn’t work with this new release, since the parameters rdpIP and rdpPort,
which were earlier configured on vpn vserver has been updated to be part of the rdpServerProfile
and ‘rdp Profile’ has been renamed as ‘rdp ClientProfile’ and the old parameter clientSSL has been
removed.

Create RDP Server Profile

1. Go to Citrix Gateway > Policies > RDP.
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2. Go to Server Profiles tab and click Add.

3. Enter the following information to create the RDP Server Profile.
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Configure RDP Client Profile

1. Go to Citrix Gateway > Policies > RDP
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2. Go to Client Profiles tab and click Add.
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3. Enter the following information to configure the RDP Server Profile.

Setup a Virtual Server

1. Go to Citrix Gateway > Virtual Server.
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2. Click Add to create a new RDP Server.
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3. Complete the data on this Basic Settings page and click OK.

4. Click the pencil to edit the page.
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NetScaler Gateway Enabled PCoIP Proxy Support for VMware Horizon
View

October 5, 2020

NetScaler Gateway 12.0 supports the PC-over-IP (PCoIP) protocol, which is the remote display proto-
col for several non-Citrix VDI solutions, including VMware Horizon View. PCoIP is analogous to Citrix
HDX/ICA protocol and Microsoft RDP protocol. PCoIP uses UDP port 4172.

When PCoIP is proxied through NetScaler Gateway, NetScaler Gateway can replace the traditional
PCoIP remote access solutions, like View Security Server, or VMware Access Point.

The following scenarios illustrate the use of NetScaler Gateway enabled VMWare Horizon View
Solution.

• VMware Horizon PCoIP users needing to remotely access VMware Horizon View desktop pools
and application pools through the NetScaler Gateway without deploying a Horizon View Secu-
rity Server or VMware Access Point.

• PCoIP users remotely accessing other PCoIP-based virtual desktop solutions through NetScaler
Gateway.
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Note

NetScaler Gateway is deployed as a remote access solution.

Configuring NetScaler Gateway Enabled PCoIP proxy for VMware
Horizon View

October 5, 2020

Prerequisites

Version - NetScaler 12.0 or above

Universal License - PCoIP Proxy uses the Clientless Access feature of NetScaler Gateway, which
means every NetScaler Gateway connection must be licensed for NetScaler Gateway Universal. On
the NetScaler Gateway Virtual Server, ensure ICA Only is cleared.

Horizon View infrastructure - A functional internal Horizon View infrastructure. Ensure you are able
to connect to Horizon View Agents internally without NetScaler Gateway. Ensure that the Horizon
View HTTP(S) Secure Tunnel and PCoIP Secure Gateway are not enabled on the View Connection
Servers that NetScaler will proxy connections to.
Following versions of VMware Horizon view are supported.

• Connection Server: 7.0.1 and above
• Horizon Client: 4.2.0 and above (Windows and Mac)

Firewall Ports:

Ensure the following:

• UDP 4172 and TCP 443 must be open from Horizon View Clients to the NetScaler Gateway VIP.
• UDP 4172 must be open from the NetScaler SNIP to all internal Horizon View Agents.
• PCoIP Proxy is supported on NetScaler deployed behind NAT. Following are the important points

to consider:
– Support is based on VPN virtual server FQDN parameter setting
– Supports only publicly accessible FQDN and not IP
– Supports only 443 and 4172 ports
– Must be a static NAT

Certificate – A valid certificate for the NetScaler Gateway Virtual Server.

Authentication – An LDAP authentication policy/server using Classic Syntax.
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Unified Gateway (optional) – If Unified Gateway, create the Unified Gateway before adding PCoIP
functionality.

RfWebUI Portal Theme – For web browser access to Horizon View, the NetScaler Gateway Virtual
Server must be configured with the RfWebUI theme.

HorizonViewClient – The Horizon View Client must be installed on the client device, even if accessing
Horizon published icons using the NetScaler RfWebUI portal.

To configure NetScaler Gateway to support PCoIP proxy for VMware Horizon View

1. Navigate to Configuration > NetScaler Gateway > Policies > PCoIP.

2. Create a virtual server profile and a PCoIP profile on thePCoIP Profiles and Connections page.

a) To create a virtual server profile, on the VServer Profiles tab, click Add.

b) Enter a name for the virtual server profile.

c) Enter an Active Directory Domain Name that is used for single sign-on to View Connection
Server, and then click Create.

Note: Only a single Active Directory domain is supported per NetScaler Gateway Virtual Server.
Also, the domain name specified here is displayed in the Horizon View Client.

a) Click Login.

3. To create a PCoIP profile, on the Profiles tab, click Add.

a) Enter a name for the PCoIP profile.

b) Enter the connection URL for the internal VMware Horizon View Connection Server, and
then click Create.

4. Navigate to Configuration> NetScaler Gateway> Policies> Session.

5. On the right, select the Session Profiles tab.

6. On theNetScaler Gateway Session Policies and Profiles page, create or edit a NetScaler Gate-
way Session Profile.

a) To create a NetScaler Gateway session profile, click Add, and provide a name.

b) To edit a NetScaler Gateway session profile, select the profile, and click Edit.

7. On the Client Experience tab, ensure that the Clientless Access value is set to On.

8. On the Security tab, ensure that the Default Authorization Action value is set to ALLOW.

9. On the PCoIP tab, select the required PCoIP profile, and then click Create. You can also create
or edit PCoIP Profiles from this tab.

10. Click Create or OK to finish creating or editing the Session Profile.
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11. If you created a Session Profile, then you must also create a corresponding Session Policy.

a) Navigate to Configuration> NetScaler Gateway> Policies> Session.

b) On the right, select the Session Policies tab.

c) Click Add, provide a name for the Session Policy, and select the required session profile
name from the Profile menu.

d) If you want to create the Session Policy using Default Syntax, in the Expression area, type
“true” (without the quotes), and then clickCreate. Note: Unified Gateway defaults to Clas-
sic Syntax.

e) If you want to create the Session Policy using Classic Syntax, first click Switch to Classic
Syntax. Then in the Expression area, type “ns_true” (without the quotes), and then click
Create.

12. Bind the created PCoIP virtual server profile and session policy to a NetScaler Gateway Virtual
Server.

a) Go to NetScaler Gateway > Virtual Servers.

b) On the right, either Add a new NetScaler Gateway Virtual Server, or Edit an existing
NetScaler Gateway Virtual Server.

c) If you are editing an existing NetScaler Gateway Virtual Server, in the Basic Settings sec-
tion, click the pencil icon.

d) For both adding and editing, in the Basic Settings section, click More.

e) Use the PCoIP VServer Profile menu to select the required PCoIP virtual server Profile.

f) Scroll down and ensure that ICA Only is cleared. Then click OK to close the Basic Settings
section.

g) If you are creating a new NetScaler Gateway Virtual Server, bind a certificate, and bind an
LDAP authentication policy.

h) Scroll down to the Policies section and click the plus icon.

i) The Choose Type page defaults to Session and Request. Click Continue.

j) In the Policy Binding section, click Click to select.

k) Select the required Session Policy that has the PCoIP Profile configured, and click Select.

l) In the Policy Binding page, click Bind.

m) If you want to use a web browser to connect to VMware Horizon View, then on the right, un-
der Advanced Settings, add the Portal Themes section. If you are only using the Horizon
View Client to connect to NetScaler Gateway, then you don’t must perform this step.

n) Use the Portal Theme menu to select RfWebUI and click OK.
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o) Horizon View published icons are added to the RfWebUI portal.

Note: VMware uses two or more protocols when using any protocol other than
RDP. This can cause the requests to be load balanced across two different back-end
servers. You can resolve this issue by setting up a single persistency group across all
protocols ensuring all connections remain on the same Citrix virtual server.

Update Content Switching Expression for Unified Gateway

If your NetScaler Gateway Virtual Server is behind a Unified Gateway (Content Switching Virtual
Server), then you must update the Content Switching Expression to include the PCoIP URL paths.

1. In the NetScaler GUI, navigate to Configuration> Traffic Management > Content Switching >
Policies.

2. Append the following expression under the Expression area, and then click OK.

http.req.url.path.eq(“/broker/xml”)http.req.url.path.contains(“/broker/resources”)http.req.url.path.eq(“/pcoip-
client”)

Use PCoIP Gateway

1. To connect, you must have Horizon View Client installed on the client device. Once installed,
you can either use the Horizon View Client’s User Interface to connect to NetScaler Gateway,
or you can use the NetScaler Gateway RfWebUI portal page to view the icons published from
Horizon.

2. To view the active PCoIP connections, go to NetScaler Gateway > PCoIP.

3. On the right, switch to theConnections tab. The active sessions are displayed with the following
data: user name, Horizon View Client IP, and Horizon View Agent Destination IP.

4. To terminate a connection, right-click Connection tab, and click Kill Connection. Or click Kill
All Connnections to terminate all PCoIP connections.

Configuring VMware Horizon View Connection Server

October 5, 2020

To support PCoIP Proxy through NetScaler Gateway:

1. Login to VMware Horizon Administrator Console.
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2. Navigate to Inventory –> View Configuration –> Servers.

3. Select Connection Servers tab.

4. Select a listed Connection Server and Click Edit.

5. Under General tab, deselect Use Secure Tunnel connection to machine option under HTTP(S)
Secure Tunnel.

6. Click OK to close the Edit Connection Server Settings window.

7. Run through Steps from 4 to 6 on all listed Connection Servers.

HDX enlightened data transport support

October 5, 2020

Enlightened Data Transport (EDT) support for NetScaler Gateway ensures a high definition in-session
user experience of virtual desktops for users running Citrix Receiver.

Also, end-to end encryption with DTLS 1.0 for EDT termination between Receiver and VDA is facili-
tated. For more information on DTLS configuration, click https://docs.citrix.com/en-us/netscaler/12/
ssl/support-for-dtls-protocol.html.

EDT enabled NetScaler Gateway delivers a good user experience on both LAN and WAN conditions,
without any administrative or user configuration when roaming from one to the other. The benefit is
most visible in high-latency networks with moderate packet loss, where user experience would gen-
erally lag with alternatives. For more information, see HDX.

When to Use Enlightened Data Transport Support

October 5, 2020

The following scenarios illustrate the use of EDT enabled NetScaler Gateway.

• A user wants an experience as good as in a LAN environment while remotely accessing business
resources.

• A user wants a rich virtual application and desktop user experience on Wi-Fi and cellular net-
works where network quality is poor because of congestion, high packet loss, and high latency.

The following points are to be kept in mind while using EDT.

• The DTLS knob at the virtual server level is enabled by default.
• EDT is now supported on all the platforms except MPX FIPS platform.
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• SNI with DTLS is not supported.
• IPv6 with DTLS is not supported.
• Smart control policies and ICA policies do not work if DTLS is enabled.
• Also, the appliance can now be configured for Double-hop functionality for EDT traffic between

Receiver and VDA. For more information, click Deploying in a Double-Hop DMZ.

Configuring NetScaler Gateway to Support Enlightened Data Transport

October 5, 2020

If you use Enlightened Data Transport (EDT), Datagram Transport Layer Security (DTLS) must be en-
abled to encrypt the UDP connection used by EDT. The DTLS parameter must be enabled at the Gate-
way VPN virtual-server level, and XenApp and XenDesktop components must be correctly upgraded
and configured to achieve encrypted traffic between the Gateway VPN virtual server and the user de-
vice.

Note: UDP port (for example port 443) configured for the NetScaler Gateway front-end virtual
server must be opened in the DMZ for the virtual server to receive the DTLS connections. DTLS
and CGP are prerequisites for EDT to work with NetScaler Gateway.

The following scenarios are supported:

Scenario EDT support

NetScaler Gateway Yes

NetScaler Gateway with High Availability (HA) Yes

NetScaler Gateway with High Availability (HA)
optimization

Yes

NetScaler with Unified Gateway Yes

NetScaler Gateway with GSLB Yes

NetScaler Gateway with Cluster Yes

Citrix Receiver to NetScaler Gateway DTLS
encryption

Yes

Dual Secure Ticket Authority (STA) on
NetScaler Gateway

Yes

NetScaler Gateway ICA session timeout Yes

NetScaler Gateway Multi-Stream ICA Yes
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Scenario EDT support

NetScaler Gateway session reliability (Port
2598)

Yes

NetScaler Gateway Double-Hop Yes

NetScaler to VDA DTLS encryption No

HDX Insight No

NetScaler Gateway in IPv6 mode No

NetScaler Gateway SOCKS (Port 1494) No

NetScaler pure LAN proxy No

Note: EDT support for NetScaler Gateway is available for port 2598 and not for port 1494.

To configure NetScaler Gateway to support EDT

1. Deploy and configure NetScaler Gateway to communicate with StoreFront and authenticate
users for XenApp and XenDesktop.

2. On the Configuration tab in the NetScaler GUI, expand NetScaler Gateway and select Virtual
Servers.

3. Click Edit to display Basic Settings for the VPN Virtual Server, and then verify the state of the
DTLS setting.
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4. Click More to display other configuration options.
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5. Select DTLS to provide communications security for datagram protocols. Click OK. The Basic
Settings area for the VPN virtual server shows that the DTLS flag is set to True.

Microsoft Intune Integration

October 5, 2020

The integration of Microsoft Intune with NetScaler Gateway provides best-of-class application access
and data protection solution offered by NetScaler Gateway and Intune.

You get the most complete suite of secure productivity apps, including email, calendar, contacts,
note-taking, document editing, and remote access—all which can be centrally managed across
different platforms. Intune and NetScaler Gateway integration provides world-class Mobile Device
Management (MDM) functionalities, while the NetScaler Gateway client side technology empowers
these Intune enlightened applications to access corporate data and application securely through the
NetScaler Gateway.

The integration allows NetScaler Gateway to pull compliance data from Intune, enabling conditional
access policies. The conditional access policies give NetScaler Gateway a finer control on regulating
the access based on device functionalities and so on. For example, an administrator can create a
policy wherein only the devices with “Camera” disabled are granted access.

NetScaler Gateway supports Azure Active Directory Libraries (ADAL) token authentication once the
NetScaler Gateway virtual server is configured. Upon configuration, a mobile application wrapped
with the Citrix Network-Only wrapper or SDK accesses NetScaler Gateway by using an ADAL token
that the app the can fetch directly from AAD.

When to Use the Integrated Intune MDM Solution

October 5, 2020

The following scenarios illustrate the use of the integrated Intune MDM Solution:
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• A new customer decides to onboard Intune with on-prem NetScaler Gateway deployment
• An existing NetScaler Gateway user wants to add mobile device management with Intune
• An existing Intune user wants to allow mobile device and/or applications to access data located

inside company network with a NetScaler Gateway physical or virtual appliance in the company
DMZ

Note

Only iOS and Android clients are supported.

Understanding the NetScaler Gateway-Intune MDM Integration

October 5, 2020

Following is an example of flow of events in a typical NetScaler Gateway-Intune MDM integration:

1. Enroll a mobile device with Intune.
2. Corporate approved applications and device-policies are pushed to the device.
3. Browse SharePoint (on premise application) from the device.
4. The browser request goes to NetScaler Gateway.
5. The NetScaler Gateway appliance checks with Intune for the enrolment status of the device.
6. If a compliant device is enrolled successfully, the SharePoint access is granted.

When a Conditional Access (CA) policy is not met by the device, NetScaler Gateway VPN client displays
an error message to the user with a link to a page hosted by Intune to enroll or remediate the device
compliance status.
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Configuring Network Access Control device check for the NetScaler
Gateway virtual server for single factor login

February 1, 2021

Important:

• The following section lists steps to configure Intune with NetScaler Gateway.

• NetScaler Enterprise Edition license is required for the following functionality.

To add a NetScaler Gateway Virtual Server with nFactor for Gateway deployment

1. Navigate to NetScaler Gateway > Virtual Servers.

2. Click Add.

3. Provide the required information in the Basic Settings area and click OK.
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4. Select Server Certificate.

5. Select required server certificate and click Bind.

6. Click Continue.

7. Click Continue.

8. Click Continue.
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9. Click the plus icon [+] next toPolicies and select Session from theChoose Policy list and select
Request from the Choose Type list and click Continue.

10. Click the plus icon [+] next to Select Policy.

11. On the Create NetScaler Gateway Session Policy page, provide a name for the Session policy.

12. Click the plus icon [+] next to Profile and on the Create NetScaler Gateway Session Profile
page, provide a name for the Session profile.

13. On the Client Experience tab, click the check box next to Clientless Access and select Off from
the list.

14. Click the check box next to Plug-in Type and select Windows/Mac OS X from the list.

15. Click Advanced Settings and select the check box next to Client Choices and set its value to
ON.

16. On the Security tab, click the check box next toDefault Authorization Action and select Allow
from the list.

17. On the Published Applications tab, click the check box next to ICA Proxy and select OFF from
the list.

18. Click Create.

19. EnterNS_TRUEunderExpression area on theCreateNetScalerGatewaySessionPolicypage.

20. Click Create.

21. Click Bind.

22. Select Authentication Profile in Advanced Settings.

23. Click the plus icon [+] and provide a name for the Authentication Profile.
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24. Click the plus icon [+] to create an authentication virtual server.

25. Specify name and IP address type for authentication virtual server under Basic Settings area
and click OK. The IP address type can be Non Addressable as well.

26. Click Authentication Policy.

27. Under the Policy Binding view, click the plus icon [+] to create an authentication policy.
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28. Select OAUTH as an Action Type and click the plus icon [+] to create an OAuth action for NAC.

29. Create an OAuth action using Client ID, Client Secret, and Tenant ID.

Client ID, Client Secret, and Tenant ID are generated after configuring the NetScaler Gateway
application on the Azure portal.

Ensure that you have an appropriate DNS name server configured on your appliance to resolve
and reach https://login.microsoftonline.com/, https://graph.windows.net/,
and *.manage.microsoft.com.
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30. Create authentication policy for OAuth Action.

Rule:

1 http.req.header(”User-Agent”).contains(”NAC/1.0”)&& ((http.req.
header(”User-Agent”).contains(”iOS”) &&    http.req.header(”
User-Agent”).contains(”NSGiOSplugin”)) || (http.req.header(”
User-Agent”).contains(”Android”) &&    http.req.header(”User-
Agent”).contains(”CitrixVPN”)))
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31. Click the plus icon [+] to create the nextFactor policy label.

32. Click the plus icon [+] to create a login schema.
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33. Select noschema as an authentication schema and click Create.

34. After selecting the created login schema, click Continue.

© 1999-2021 Citrix Systems, Inc. All rights reserved. 620



NetScaler Gateway 12.0

35. In Select Policy, select an existing authentication policy for user login or click the plus icon + to
create an authentication policy.
For details on creating an authentication policy, see Configuring advanced authentication poli-
cies.

36. Click Bind.
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37. Click Done.

38. Click Bind.
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39. Click Continue.

40. Click Done.

© 1999-2021 Citrix Systems, Inc. All rights reserved. 623



NetScaler Gateway 12.0

41. Click Create.

42. Click OK.

43. Click Done.
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To bind authentication login schema to authentication virtual server to indicate VPN
plug-ins to send device ID as part of /cgi/login request

1. Navigate to Security > AAA - Application Traffic > Virtual Servers.

2. Select the previously selected virtual-server and click Edit.

3. Click Login Schemas under Advanced Settings.

4. Click Login Schemas to bind.

5. Click [>] to select and bind the existing builtin login schema policies for NAC device check.
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6. Select the required login schema policy appropriate for your authentication deployment and
click Select.

In the explained deployment, single factor authentication (LDAP) along with the NAC OAuth Ac-
tion policy is used, hence lschema_single_factor_deviceid has been selected.

7. Click Bind.

8. Click Done.
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Configuring a NetScaler Gateway application on the Azure portal

February 2, 2021

The following section lists steps to configure a NetScaler Gateway application on the Azure portal.

Prerequisite

• Azure global admin credentials
• Intune licensing is enabled
• For Intune Integration you need to create a NetScaler Gateway application on Azure portal.
• Once the NetScaler Gateway application is created, configure the OAuth policy on NetScaler

Gateway using the following application specific information:
– Client ID / Application ID
– Client Secret / Application Key
– Azure Tenant ID

• NetScaler Gateway uses the app client id and client secret to communicate with Azure and check
for NAC compliance.

To create NetScaler Gateway App on Azure

1. Log in to portal.azure.com

2. Click Azure Active Directory.

3. Click App registrations and click New registration.
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4. On the Register an application page, enter an app name and click Register.

5. Navigate to Authentication, click Add URI, enter FDQN for NetScaler Gateway, and click Save.
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6. Navigate to the Overview page to get Client ID, Tenant ID, and Object ID.

7. Navigate to API permissions and click Add a permission.
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8. Click the Microsoft Graph tile to configure API permissions for Microsoft Graph.

9. Click the Delegated permissions tile.

10. Select the following permissions, and click Add permissions.

• Email
• openid
• Profile
• Directory.AccessAsUser.All
• User.Read
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• User.Read.All
• User.ReadBasic.All

11. Click the Intune tile to configure API permissions for Intune.
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12. Click the Application permissions tile and the Delegated permissions tile to add permissions
for Get_device_compliance and Get_data_warehouse respectively.

13. Select the following permissions and click Add permissions.

• Get_device_compliance - Application permissions
• Get_data_warehouse - Delegated permissions
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14. The following page lists the configured API permissions.
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15. Navigate to Certificates & secrets and click New client secret.

16. Under the Add a client secret page, enter description, select expiry, and click Add.
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17. The following screen shows the configured client secret.

Note

The client secret is displayed only once when it is generated. You must copy the displayed
client secret locally. Use the same client secret along with client ID associated with the
newly registered app while configuring the OAuth action on the NetScaler Gateway appli-
ance for Intune.
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The application configuration on Azure portal is now complete.

Understanding Azure ADAL Token Authentication

October 5, 2020

Following is the flow of events in a typical NetScaler Gateway-Microsoft ADAL token authentication:

1. When an app is launched in iOS or Android, the app contacts Azure. The user is prompted to log
on with user credentials. After a successful logon, the app gets an ADAL token.

2. This ADAL token is presented to a NetScaler Gateway, which has been configured to validate the
ADAL token.

3. NetScaler Gateway validates the signature of the ADAL token with the corresponding certificate
from Microsoft.

4. After a successful validation, NetScaler Gateway extracts the User’s Principal Name (UPN) and
grants the app VPN access to the internal resources.

Configuring NetScaler Gateway Virtual Server for Microsoft ADAL Token
Authentication

October 5, 2020

To configure a NetScaler Gateway virtual server for monitoring Microsoft ADAL token authentication,
you need the following information:

• certEndpoint: URL of the endpoint that contains Json Web Key (JWK) for ADAL token verifica-
tion.

• Audience: FQDN of the NetScaler virtual server to which the app sends the ADAL token.
• Issuer: Name of the AAD issuer. Gets populated by default.
• TenantID: Tenant ID for Azure ADAL registration.
• ClientID: A unique ID given to the Gateway app as part of ADAL registration.
• ClientSecret: A secret key given to the Gateway app as part of ADAL registration.

1. Create an OAuthAction:

add authentication OAuthAction <oauth_action_name>
-OAuthType INTUNE –clientid <client_id> -
clientsecret <client_secret>
-audience <audience>
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-tenantid <tenantID>
-issuer <issuer_name> -
userNameField upn-certEndpoint <certEndpoint_name>

Example:

add authentication OAuthAction tmp_action -OAuthType INTUNE -clientid id 1204 -clientsecret
a -audience “
http://hello” -tenantid xxxx -issuer “
https://hello” -userNameField upn -certEndpoint
https://login.microsoftonline.com/common/discovery/v2.0/keys

2. Create an authentication policy to associate with the newly created OAuth:

add
authentication Policy <policy_name>
-rule true -action <oauth intune action>

Example:

add authentication Policy oauth_intune_pol -rule true -action tmp_action

3. Bind the newly created OAuth to AuthVS:

bind authentication vserver <auth_vserver>
-policy <oauth_intune_policy>
-priority 2 -gotoPriorityExpression END

Example:

bind authentication vserver auth_vs_for_gw1_intune -policy oauth_pol -priority 2 -gotoPriorityExpression
END

4. Create a LoginSchema:

add authentication loginSchema <loginSchemaName>
-authenticationSchema <authenticationSchema”location”>

add authentication loginSchemaPolicy <loginSchemaPolicyName>
-rule true -action <loginSchemaName>

Example:

add authentication loginSchema oauth_loginschema -authenticationSchema “/nsconfig/login-
schema/LoginSchema/OnlyOAuthToken.xml”

add authentication loginSchemaPolicy oauth_loginschema_pol -rule true -action oauth_loginschema 

5. Bind AuthVS with LoginSchema:

bindauthenticationvserver<auth_vs> -policy<oauth _pol> -priority2 -gotoPriorityExpression
END
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Example:

bind authentication vserver auth_vs_for_gw1_intune -policy oauth_loginschema_pol -priority
2 -gotoPriorityExpression END

6. Add an authnprofile and assign it to a VPN virtual server:

add authnprofile <nfactor_profile_name>-authnvsName <authvserver>

set vpn vserver <vserverName>-authnprofile <nfactor_profile_name >

Example:

add authnprofile nfactor_prof_intune -authnvsName auth_vs_for_gw1_intune

set vpn vserver gw1_intune-authnprofile nfactor_prof_intune

Type of Service Support for UDP traffic

October 5, 2020

Type of Service (ToS) support for UDP ensures that once a ToS value is configured for a UDP packet by
a sender, NetScaler Gateway retains the value until the packet reaches its destination. On the basis of
the configured value and the destination network’s configuration, the destination network places the
UDP packet in a prioritized outgoing queue.

Note
Using ToS information, you can assign a precedence to each IP packet and request a specific
treatment such as high throughput, high reliability, low latency, and so on.

Proxy Auto Configuration for Outbound Proxy support for NetScaler
Gateway

October 5, 2020

When you configure the NetScaler Gateway appliance to support Proxy Auto Configuration (PAC), the
URL of a PAC file is pushed to the client browser. The traffic from the client is then redirected to the
respective proxies as determined by the conditions defined in the PAC file.

Following are some common use cases for PAC for outbound proxy:

• To configure multiple proxy servers that handle client traffic.
• To load-balance the proxy traffic across subnets.
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Configure NetScaler Gateway global parameters to support PAC for outbound proxy by
using the CLI

At the command prompt, type:

1 set vpn parameter -proxy BROWSER -autoProxyUrl <URL>

To configure NetScaler Gateway to support PAC in a session profile by using the CLI

At the command prompt, type:

1 add vpn sessionAction <name> -proxy BROWSER -autoProxyUrl <URL>

Where;

• URL – URL for the proxy server
• Name – Name of the VPN sessionAction

Configure NetScaler Gateway global parameters to support PAC for outbound proxy by
using the GUI

1. Navigate to Configuration > NetScaler Gateway > Global Settings.
2. On the Global Settings page, click Change Global Settings, and then select the Client Experi-

ence tab.
3. On the Client Experience tab, select Advanced Settings, and then select the Proxy tab.
4. On the Proxy tab, select Browser, and then select Use Automatic Configuration.
5. In the URL To Auto Proxy Config File field, type the URL for the required PAC file.
6. Click Create.

Configure NetScaler Gateway to support PAC on Session Profile by using the GUI

1. Navigate to Configuration> NetScaler Gateway> Policies> Session.
2. On the NetScaler Gateway Session Policies and Profiles page, create a NetScaler Gateway Ses-

sion Profile.
3. Select the Session Profiles tab, click Add, and enter a name.
4. On the Client Experience tab, select Advanced Settings and then select the Proxy tab.
5. On the Proxy tab, select Browser, and then select Use Automatic Configuration.
6. In the URL To Auto Proxy Config File field, type the URL for the required PAC file.
7. Click Create.
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8. Click Create.

Outbound ICA Proxy support

October 5, 2020

Outbound ICA Proxy support for NetScaler Gateway enables the network administrators to avail
SmartControl functionalities even when Receiver and NetScaler Gateway are deployed in different
organizations.

The following scenario illustrates the use of the Outbound ICA Proxy Solution:

A network administrator requires control over the ICA session related capabilities when Receiver and
NetScaler Gateway are deployed in different organizations.

Understanding the Outbound ICA Proxy support

To bring the SmartControl functionality to the enterprise organization, company A, which has the re-
ceiver, we need to add a NetScaler appliance which acts as a LAN Proxy. The NetScaler LAN Proxy
enforces SmartControl and proxies the traffic to the NetScaler Gateway of Company B. In this deploy-
ment scenario, the Receiver forwards the traffic to the NetScaler LAN Proxy which allows the network
administrator of Company A to enforce SmartControl.

In this scenario, the traffic between the LAN Proxy and the NetScaler Gateway is over SSL.
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Note: Do not enable client certificate based authentication on the NetScaler Gateway.

Configuring Outbound ICA Proxy

October 5, 2020

To configure an Outbound ICA Proxy by using CLI, follow these steps:

1. Add a Cache Redirection Vserver:

add cr vserver <name> <serviceType> <IPAddress> <port> -cacheType <cacheType>

Service must be HDX

CacheType must be FORWARD

Example:

add cr vserver CR_LAN_Proxy HDX 10.217.208.197 8080 -cacheType FORWARD

2. Add an ICA SmartControl Profile:

add
ica ac-
cesspro-
file
<name>
-
ConnectClientLPTPorts
( DE-
FAULT

DISABLED
)
Clien-
tAu-
dioRedi-
rec-
tion (
DE-
FAULT

DISABLED
) -
LocalRemoteDataSharing
( DE-
FAULT

DISABLED
) -
ClientClipboardRedirection
( DE-
FAULT

DISABLED
) -
ClientCOMPortRedirection
( DE-
FAULT

DISABLED
) -
ClientDriveRedirection
( DE-
FAULT

DISABLED
) -
ClientPrinterRedirection
( DE-
FAULT

DISABLED
) -
Multistream
( DE-
FAULT

DISABLED
) -
ClientUSBDriveRedirection
( DE-
FAULT

DISABLED)

Example:

1 add ica accessprofile disableCDM -ConnectClientLPTPorts DEFAULT -
ClientAudioRedirection DEFAULT ‒ LocalRemoteDataSharing DEFAULT
-ClientClipboardRedirection DEFAULT -ClientCOMPortRedirection
DEFAULT ‒ ClientPrinterRedirection DEFAULT -Multistream DEFAULT
-ClientUSBDriveRedirection DEFAULT

3. Add an ICA Action:

add ica action <name> -accessProfileName <string>
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Example:

1 add ica action disableCDM\_action -accessProfileName disableCDM

4. Add an ICA Policy:

add ica policy <name> -rule <expression> -action <string> -comment <string> -logAction
<string>

5. Bind the ICA Policy to the Virtual Server or Global:

a. Bind to Virtual Server

1 **bind cr vserver** \<name\> **-policyName** \<string\> **-
priority** \<positive\_integer\>

Example:

1 bind cr vserver CR\_LAN\_Proxy ‒ policyname disableCDM\_pol ‒
priority 10

b. Bind to Global

1 **bind ica global -policyName** \<string\> -**priority** \<
positive\_integer\>

Example:

1 bind ica global ‒ policyName disableCDM\_pol ‒ priority 10

Note

Set the Secure ICA Ports:This value is the port number on the NetScaler Gateway to which the LAN
Proxy makes an outbound connection. By default it is set to 443. Use the following command to
change the port.

set ns param -secureicaPorts<port>

Example:
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set ns param -secureicaPorts 8443

Integrate NetScaler Gateway with XenApp and XenDesktop

October 5, 2020

StoreFront servers are deployed and configured to manage access to published resources and data.
For remote access, adding NetScaler Gateway in front of StoreFront is recommended.

Note:
For detailed configuration steps on how to integrate XenApp and XenDesktop with NetScaler
Gateway, see the StoreFront documentation.

The following diagram illustrates an example of a Citrix simplified Citrix deployment that includes
NetScaler Gateway. NetScaler Gateway communicates with StoreFront to protect apps and data de-
livered by XenApp and XenDesktop. The user devices run Citrix Receiver to create a secure connection
and access their apps, desktops, and files.

Native OTP support for authentication

November 3, 2020

NetScaler Gateway supports one-time passwords (OTPs) without having to use a third-party server.
One-time password is a highly secure option for authenticating to secure servers as the number or
passcode generated is random. Previously, specialized firms, such as RSA with specific devices that
generate random numbers offered the OTPs. This system must be in constant communication with
the client to generate a number expected by the server.
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In addition to reducing capital and operating expenses, this feature enhances the administrator’s con-
trol by keeping the entire configuration on the Citrix ADC appliance.

Note: Because third-party servers are no longer needed, the Citrix ADC administrator has to con-
figure an interface to manage and validate user devices.

User must be registered with a NetScaler Gateway virtual server to use the OTP solution. Registration
is required only once per unique device, and can be restricted to certain environments. Configuring
and validation of a registered user is similar to configuring an extra authentication policy.

Advantages of having Native OTP support

• Reduces operating cost by eliminating the need to have an extra infrastructure on an authenti-
cating server in addition to the Active Directory.

• Consolidates configuration only to Citrix ADC appliance thus offering great control to adminis-
trators.

• Eliminates the client’s dependence on an extra authentication server for generating a number
expected by clients.

Native OTPworkflow

The native OTP solution is a two-fold process and the workflow is classified as the following:

• Device registration
• End user login

Important: You can skip the registration process if you are using third-party solutions or managing
other devices apart from the Citrix ADC appliance. The final string that you add must be in the Citrix
ADC specified format.

The following figure depicts the device registration flow to register a new device to receive OTP.

Note: The device registration can be done using any number of factors. The single factor (as specified
in the previous figure) is used as an example to explain the device registration process.

The following figure depicts the verification of OTP through the registered device.
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Prerequisites

To use the native OTP feature, make sure the following prerequisites are met.

• Citrix ADC feature release version is 12.0 build 51.24 and later.
• Advanced or Premium edition license is installed on NetScaler Gateway.
• NetScaler Gateway is configured with management IP and the management console is accessi-

ble both using a browser and command line.
• Citrix ADC is configured with authentication, authorization, and auditing virtual server to au-

thenticate users.
• Citrix ADC appliance is configured with Unified Gateway and the authentication, authorization,

and auditing profile is assigned to the Gateway virtual server.
• Native OTP solution is restricted to nFactor authentication flow. Advanced policies are required

to configure the solution. For more details, see article CTX222713.

Also ensure the following for Active Directory:

• A minimum attribute length of 256 characters.
• Attribute type must be ‘DirectoryString’ such as UserParameters. These attributes can hold

string values.
• Attribute string type must be Unicode, if device name is in non-English characters.
• Citrix ADC LDAP administrator must have write access to the selected AD attribute.
• Citrix ADC appliance and client machine must be synced to a common Network Time Server.

Configure Native OTP using the GUI

The native OTP registration is not just a single factor authentication. The following sections help you
to configure the single and second factor authentication.

Create Login Schema for first factor

1. Navigate to Security AAA > Application Traffic > Login Schema.

2. Go to Profiles and click Add.
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3. On the Create Authentication Login Schema page, enter lschema_single_auth_manage_otp
under the Name field and click Edit next to noschema.

4. Click the LoginSchema folder.

5. Scroll down to select SingleAuth.xml and click Select.

6. Click Create.

7. Click Policies and Click Add.

8. On the Create Authentication Login Schema Policy screen, enter the following values.

Name: lpol_single_auth_manage_otp_by_url
Profile: select lpol_single_auth_manage_otp_by_url from the list.
Rule: HTTP.REQ.COOKIE.VALUE(“NSC_TASS”).EQ(“manageotp”)

Configure authentication, authorization, and auditing virtual server

1. Navigate to Security > AAA – Application Traffic > Authentication Virtual Servers. Click to
edit the existing virtual server.

2. Click the + icon next to Login Schemas under Advanced Settings in the right pane.

3. Select No Login Schema.

4. Click the arrow and select the lpol_single_auth_manage_otp_by_url Policy.

5. Select the lpol_single_auth_manage_otp_by_url policy and Click Select.

6. Click Bind.

7. Scroll up and select 1 Authentication Policy under Advanced Authentication Policy.

8. Right-click the nFactor Policy and select Edit Binding.

9. Click the + icon present under Select Next Factor, create a Next Factor, and click Bind.

10. On the Create Authentication PolicyLabel screen, enter the following, and click Continue:

Name: manage_otp_flow_label

Login Schema: Lschema_Int

11. On the Authentication PolicyLabel screen, click the + icon to create a Policy.

12. On the Create Authentication Policy screen, enter the following:

Name: auth_pol_ldap_otp_action

13. Select the Action type using the Action Type list.

14. In the Action field, click the + icon to create an Action.
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15. In the Create Authentication LDAP server page, select Server IP radio button, deselect the
check box next to Authentication, enter the following values, and select Test Connection.

Name: ldap_otp_action

IP Address: 192.168.10.11

Base DN: DC=training, DC=lab

Administrator: Administrator@training.lab

Password: xxxxx

16. Scroll down to the Other Settings section. Use the drop-down menu to select the following
options.
Server Logon Name Attribute as New and type userprincipalname.

17. Use the drop-down menu to select SSOName Attribute as New and type userprincipalname.

18. Enter “UserParameters” in the OTP Secret field and click More.

19. Enter the following Attributes.

Attribute 1 = mail
Attribute 2 = objectGUID
Attribute 3 = immutableID

20. Click OK.

21. On the Create Authentication Policy page, set the Expression to true and click Create.

22. On the Create Authentication Policylabel page, click Bind, and click Done.

23. On the Policy Binding page, click Bind.

24. On the Authentication policy page, click Close and click Done.

Note

The authentication virtual server must be bound to the RFWebUI portal theme. Bind a server
certificate to the server. The server IP ‘1.2.3.5’ must have a corresponding FQDN that is,
otpauth.server.com, for later use.

Create login schema for second factor OTP

1. Navigate to Security > AAA-Application Traffic > Virtual Servers. Select the virtual server to
be edited.

2. Scroll down and select 1 Login Schema.
3. Click Add Binding.
4. Under the Policy Binding section, click the + icon to add a policy.

© 1999-2021 Citrix Systems, Inc. All rights reserved. 647



NetScaler Gateway 12.0

5. On the Create Authentication Login Schema Policy page, enter Name as OTP, and click the +
icon to create a profile.

6. On the Create Authentication Login Schema page, enter Name as OTP, and click the icon next
to noschema.

7. Click the LoginSchema folder, select DualAuthManageOTP.xml, and then click Select.
8. Click Create.
9. In the Rule section, enter True. Click Create.

10. Click Bind.
11. Notice the two factors of authentication. Click Close and click Done.

Configure content switching policy for manage OTP

The following configurations are required if you are using Unified Gateway.

1. Navigate to TrafficManagement > Content Switching > Policies. Select the content switching
policy, right click, and select Edit.

2. Edit the expression to evaluate the following OR statement and click OK:

is_vpn_url HTTP.REQ.URL.CONTAINS(“manageotp
”)

Configure Native OTP using the CLI

You must have the following information to configure the OTP device management page:

• IP assigned to authentication virtual server
• FQDN corresponding to the assigned IP
• Server certificate for authentication virtual server

Note: Native OTP is a web-based solution only.

To configure the OTP device registration andmanagement page

Create authentication virtual server

1 add authentication vserver authvs SSL 1.2.3.5 443
2 bind authentication vserver authvs -portaltheme RFWebUI
3 bind ssl vserver authvs -certkeyname otpauthcert

© 1999-2021 Citrix Systems, Inc. All rights reserved. 648



NetScaler Gateway 12.0

Note: The authentication virtual server must be bound to the RFWebUI portal theme. Bind a
server certificate to the server. The server IP ‘1.2.3.5’ must have a corresponding FQDN that is,
otpauth.server.com, for later use.

To create LDAP logon action

1 add authentication ldapAction <LDAP ACTION NAME> -serverIP <SERVER IP>
- serverPort <SERVER PORT> -ldapBase <BASE> -ldapBindDn <AD USER> -
ldapBindDnPassword <PASSWO> -ldapLoginName <USER FORMAT>

Example:

1 add authentication ldapAction ldap_logon_action -serverIP 1.2.3.4 -
serverPort 636 -ldapBase ”OU=Users,DC=server,DC=com” -ldapBindDn
administrator@ctxnsdev.com -ldapBindDnPassword PASSWORD -
ldapLoginName userprincipalname

To add authentication policy for LDAP Logon

1 add authentication Policy auth_pol_ldap_logon -rule true -action
ldap_logon_action

To present UI via LoginSchema

Show user name field and password field to users upon logon

1 add authentication loginSchema lschema_single_auth_manage_otp -
authenticationSchema ”/nsconfig/loginschema/LoginSchema/
SingleAuthManageOTP.xml”

Display device registration andmanagement page

Citrix recommends two ways of displaying the device registration and management screen: URL or
host name.

• Using URL

When the URL contains ‘/manageotp’
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– add authentication loginSchemaPolicy lpol_single_auth_manage_otp_by_url
-rule ”http.req.cookie.value(”NSC_TASS”).contains(”manageotp”)”-

action lschema_single_auth_manage_otp
– bind authentication vserver authvs -policy lpol_single_auth_manage_otp_by_url

-priority 10 -gotoPriorityExpression END

• Using hostname

When the host name is ‘alt.server.com’

– add authentication loginSchemaPolicy lpol_single_auth_manage_otp_by_host
-rule ”http.req.header(”host”).eq(”alt.server.com”)”-action

lschema_single_auth_manage_otp
– bind authentication vserver authvs -policy lpol_single_auth_manage_otp_by_host

-priority 20 -gotoPriorityExpression END

To configure the user login page using the CLI

You must have the following information to configure the User Logon page:

• IP for a load balancing virtual server

• Corresponding FQDN for the load balancing virtual server

• Server certificate for the load balancing virtual server

bind ssl vserver lbvs_https -certkeyname lbvs_server_cert

Back-end service in load balancing is represented as follows:

1 add service iis_backendsso_server_com 1.2.3.210 HTTP 80
2 bind lb vserver lbvs_https iis_backendsso_server_com

To create OTP passcode validation action

1 add authentication ldapAction <LDAP ACTION NAME> -serverIP <SERVER IP>
-serverPort <SERVER PORT> -ldapBase <BASE> -ldapBindDn <AD USER> -
ldapBindDnPassword <PASSWORD> -ldapLoginName <USER FORMAT> -
authentication DISABLED -OTPSecret <LDAP ATTRIBUTE>

Example:

© 1999-2021 Citrix Systems, Inc. All rights reserved. 650



NetScaler Gateway 12.0

1 add authentication ldapAction ldap_otp_action -serverIP 1.2.3.4 -
serverPort 636 -ldapBase ”OU=Users,DC=server,DC=com” -ldapBindDn
administrator@ctxnsdev.com -ldapBindDnPassword PASSWORD -
ldapLoginName userprincipalname -authentication DISABLED -OTPSecret
userParameters

Important: The difference between the LDAP logon and OTP action is the need to disable the
authentication and introduce a new parameter OTPSecret. Do not use the AD attribute value.

To add authentication policy for OTP passcode validation

1 add authentication Policy auth_pol_otp_validation -rule true -action
ldap_otp_action

To present the two-factor authentication through LoginSchema

Add the UI for two factor authentication.

“‘add authentication loginSchema lscheme_dual_factor -authenticationSchema “/nsconfig/login-
schema/LoginSchema/DualAuth.xml”
add authentication loginSchemaPolicy lpol_dual_factor -rule true -action lscheme_dual_factor

1 #### To create passcode validation factor via the policy label
2
3 Create a manage OTP flow policy label for the next factor (first factor

is LDAP logon)

add authentication loginSchema lschema_noschema -authenticationSchema noschema
add authentication policylabel manage_otp_flow_label -loginSchema lschema_noschema

1 #### To bind the OTP policy to the policy label

bind authentication policylabel manage_otp_flow_label -policyName auth_pol_otp_validation
-priority 10 -gotoPriorityExpression NEXT
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1 #### To bind the UI flow
2
3 Bind the LDAP logon followed by the OTP validation with the

authentication virtual server.

bind authentication vserver authvs -policy auth_pol_ldap_logon -priority 10 -nextFactor man-
age_otp_flow_label -gotoPriorityExpression NEXT
bind authentication vserver authvs -policy lpol_dual_factor -priority 30 -gotoPriorityExpression END
“‘

Register your device with Citrix ADC

1. Navigate to your Citrix ADC FQDN (first public facing IP), with a /manageotp suffix. For example,
https://otpauth.server.com/manageotp Login with user credentials.

2. Click the + icon to add a device.

3. Enter a device name and press Go. A barcode appears on the screen.

4. Click Begin Setup and then click Scan Barcode.

5. Hover the device camera over the QR code. You can optionally enter the 16 digit code.
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Note: The displayed QR code is valid for 3 minutes.

6. Upon successful scan, you are presented with a 6 digit time sensitive code that can be used to
log in.

7. To test, click Done on the QR screen, then click the green check mark on the right.

8. Select your device from the drop-down menu and enter the code from Google Authenticator
(must be blue, not red) and click Go.

9. Make sure to log out using the drop-down menu at the top right corner of the page.

Log in to Citrix ADC using the OTP

1. Navigate to your first public facing URL and enter your OTP from Google Authenticator to log
on.

2. Authenticate to the Citrix ADC splash page.

Configuring Server Name Indication Extension

October 5, 2020

A NetScaler Gateway appliance can now be configured to include a server name indication (SNI) exten-
sion in the SSL “client hello” packet sent to the backend server. The SNI extension helps the backend
server identify the FQDN being requested during the SSL handshake and respond with the respective
certificates.
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Note

Enable SNI support when multiple SSL domains are hosted on same server.

To configure NetScaler Gateway to support SNI using GUI:

1. In the NetScaler GUI, navigate to Configuration> Citrix NetScaler> Global Settings.

2. Click the Change Global Settings link and from the Backend Server SNI drop-down, select
Enabled.

To configure NetScaler Gateway to support SNI using command line interface, at the command
prompt, type:

1 set vpn parameter backendServerSni <ENABLED><DISABLED>

Validating the Server Certificate During an SSL Handshake

October 5, 2020

The NetScaler Gateway appliance can now be configured to validate the server certificate provided by
the back-end server during an SSL handshake.

To configure NetScaler Gateway global parameters to support PAC for outbound proxy by using the
configuration utility

Bind the CA certificate

1. Navigate to Configuration > NetScaler Gateway > NetScaler Gateway Policy Manager > Cer-
tificate Bindings.**

2. On the Certificate Bindings screen, click the + icon.
3. On the CA Certificate(s) Binding screen, click Add Binding and click Install.
4. Select the certificate file name in the Certificate File Name field and click Install.
5. On the CA Certificate(s) Binding screen, select the certificate and click Bind.
6. Click Done.

Enabling the certificate validation:

1. Navigate to NetScaler Gateway> Global settings.
2. Click Change Global Settings.**
3. Select Enabled from the Backend Server Certificate Validation drop-down menu and click

OK.

© 1999-2021 Citrix Systems, Inc. All rights reserved. 654



NetScaler Gateway 12.0

To configure NetScaler Gateway global parameters to support server certificate with the command
line

At the command prompt, type the following commands:

1 bind vpn global cacert DNPGCA1
2
3 set vpn parameter backendcertValidation ENABLED

Using Advance Policy to Create VPN Policies

February 8, 2021

Classic Policy Engine (PE) and Advance Policy Infrastructure (PI) are two different policy-configuration-
and-evaluation frameworks that NetScaler currently supports.

Advance Policy Infrastructure consists of powerful expression language. The expression language can
be used to define rules in a policy, define various parts of Action, and other entities supported. The
expression language can parse through any part of the request or response and also enables you to
look deeply through the headers and payload. The same expression language expands and works
through every logical module NetScaler supports.

Note:
You are encouraged to use advanced policies for creating policies.

WhyMigrate from Classic Policy to Advance Policy

Advanced Policy has a rich expression set and offers much greater flexibility than Classic Policy. As
NetScaler scales and caters to a vast variety of clients, it is imperative to support expressions which
vastly exceed the Advanced Policies. For more information, see Policies and Expressions topic.

Following are the added capabilities for Advance Policy.

• Ability to access the body of the messages.
• Supports many other protocols.
• Accesses many other features of the system.
• Has more number of basic functions, operators, and data types.
• Caters to the parsing of HTML, JSON, and XML files.
• Facilitates fast parallel multi-string matching (patsets, and so on).

Now the following VPN policies can be configured using Advance Policy.
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• Session Policy
• Authorization Policy
• Traffic Policy
• Tunnel Policy
• Audit Policy

Also, End Point Analysis (EPA) can be configured as an nFactor for authentication feature. EPA is used
as a gatekeeper for endpoint devices trying to connect to the Gateway appliance. Before the Gateway
logon page is displayed on an endpoint device, the device is checked for minimum hardware and
software requirements, depending on the eligibility criteria configured by the gateway administrator.
Access to the gateway is granted based on the outcome of the performed checks. Previously EPA was
configured as part of session policy. Now it can be linked to nFactor providing more flexibility, as to
when it can be performed. For more information on EPA, see How endpoint policies work topic. For
more on nFactor, see nFactor authentication topic.

Use Cases:

Pre-authentication EPA using Advanced EPA

Pre-authentication EPA scan happens before a user provides the logon credentials. For information
on configuring NetScaler Gateway for nFactor authentication with pre-authentication EPA scan as one
of the authentication factors, see CTX224268 topic.

Post authentication EPA using Advanced EPA

Post-authentication EPA scan happens after user credentials are verified. Under the classic policy
infrastructure, post authentication EPA was configured as part of the session policy or session action.
Under Advanced policy infrastructure, the EPA scan is to be configured as an EPA factor in nFactor
authentication. For information on configuring NetScaler Gateway for nFactor authentication with
post-authentication EPA scan as one of the authentication factors, see CTX224303 topic.

Pre-authentication and post-authentication EPA using Advanced policies

EPA can be performed before authentication and post authentication. For information on configuring
NetScaler Gateway for nFactor authentication with pre-authentication and post-authentication EPA
scans, see CTX231362 topic.

Periodic EPA scan as a factor in nFactor authentication

Under the classic policy infrastructure, the periodic EPA scan was configured as part of session policy
action. Under the advanced policy infrastructure, it can be configured as part of the EPA factor in
nFactor authentication.
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For more information on configuring Periodic EPA scan as a factor in nFactor authentication,
click CTX231361 topic.

Troubleshooting:
The following points are to be kept in mind for troubleshooting.

• Classic and Advance policies of the same type (for example, Session policy) cannot be bound to
the same entity/bind point.

• Priority is mandatory for all PI policies.
• Advance Policy for VPN can be bound to all bind points.
• Advance Policy with the same priority can be bound to a single bind point.
• If none of the configured authorization policies get hit then the global authorization action con-

figured in the VPN parameter is applied.
• In authorization policy, the authorization action is not reversed if the authorization rule fails.

Commonly used Advanced Policy equivalent expressions for Classic Policy:

Classic Policy expressions Advance Policy expressions

ns_true true

ns_false false

REQ.HTTP HTTP.REQ

RES.HTTP HTTP.RES

HEADER “foo” HEADER(“foo”)

CONTAINS ”bar” .CONTAINS(“bar”) [Note use of “.”.]

REQ.IP CLIENT.IP

RES.IP SERVER.IP

SOURCEIP SRC

DESTIP DST

REQ.TCP CLIENT.TCP

RES.TCP SERVER.TCP

SOURCEPORT SRCPORT

DESTPORT DSTPORT

STATUSCODE STATUS

REQ.SSL.CLIENT.CERT CLIENT.SSL.CLIENT_CERT
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